
 

 

 

 
Pulsonix Design System 

Users Guide 

 

 
 

 

 

 



2   Pulsonix Users Guide 



 Pulsonix Users Guide   3 

Copyright Notice 

 

Copyright  WestDev Ltd. 2001-2023 
Pulsonix is a Trademark of WestDev Ltd.  All rights reserved. E&OE 

Copyright in the whole and every part of this software and manual belongs to WestDev Ltd. and may 
not be used, sold, transferred, copied or reproduced in whole or in part in any manner or in any media 
to any person, without the prior written consent of WestDev Ltd. If you use this manual you do so at 
your own risk and on the understanding that neither WestDev Ltd. nor associated companies shall be 
liable for any loss or damage of any kind. 

WestDev Ltd. does not warrant that the software package will function properly in every hardware 
software environment. 

Although WestDev Ltd. has tested the software and reviewed the documentation, WestDev Ltd. 
makes no warranty or representation, either express or implied, with respect to this software or 
documentation, their quality, performance, merchantability, or fitness for a particular purpose. This 
software and documentation are licensed 'as is', and you the licensee, by making use thereof, are 
assuming the entire risk as to their quality and performance. 

In no event will WestDev Ltd. be liable for direct, indirect, special, incidental, or consequential 
damage arising out of the use or inability to use the software or documentation, even if advised of the 
possibility of such damages. 

WestDev Ltd. reserves the right to alter, modify, correct and upgrade our software programs and 
publications without notice and without incurring liability. 

Microsoft, Windows, Windows NT and Intellimouse are either registered trademarks or trademarks of 
Microsoft Corporation. 

All other trademarks are acknowledged to their respective owners. 

Pulsonix, a division of WestDev Ltd. 

Printed in the UK. Issue date: 23/06/23 Issue 1 

Pulsonix 
20 Miller Court 
Severn Drive 
Tewkesbury 
Glos, GL20 8DN 
United Kingdom 

Technical  +44 (0)1684 296 570 
Sales +44 (0)1684 296 551 
Email  sales@pulsonix.com 
Web www.pulsonix.com 

 



4   Pulsonix Users Guide 

 
 



 Contents   5 

Contents 

CONTENTS .................................................................................................................................... 5 

CHAPTER 1. GETTING STARTED .................................................................................................... 13 

Welcome ...................................................................................................................................... 13 

About this Manual ........................................................................................................................ 13 

The contents of this manual.................................................................................................... 13 

Where to find additional information ..................................................................................... 13 

System Requirements ................................................................................................................... 13 

Hardware required .................................................................................................................. 13 

Program security .................................................................................................................... 14 

Installation .................................................................................................................................... 14 

For new users (normal installation) ........................................................................................ 14 

Moving the Installation .......................................................................................................... 15 

Updating Pulsonix from the web ............................................................................................ 15 

Updating Pulsonix Using Hot Fixes ....................................................................................... 15 

Floating Network Licensing ................................................................................................... 15 

Uninstalling Pulsonix ............................................................................................................. 16 

Contacting Technical Support Resources ..................................................................................... 16 

CHAPTER 2. USING PULSONIX ....................................................................................................... 17 

Introduction to Pulsonix ............................................................................................................... 17 

Starting Pulsonix .................................................................................................................... 17 

The Status Bar .............................................................................................................................. 18 

The On-line Help System ............................................................................................................. 20 

Customising Pulsonix ................................................................................................................... 20 

Overview ................................................................................................................................ 20 

Light and Dark UI .................................................................................................................. 20 

Toolbars ................................................................................................................................. 21 

Commands and Shortcuts ....................................................................................................... 23 

Dockable Windows and Browsers ................................................................................................ 24 

Overview ................................................................................................................................ 24 

Component Bin ...................................................................................................................... 25 

Part Browser ........................................................................................................................... 27 

World-view ............................................................................................................................ 29 

Design Browser ...................................................................................................................... 29 

DRC and ERC Error Browsers ............................................................................................... 30 

Layers ..................................................................................................................................... 31 

Find ........................................................................................................................................ 33 

The Item Filter in Browser Windows ..................................................................................... 35 

Selection Mask Window ........................................................................................................ 36 

Inspector Bar (Dynamic Properties) ....................................................................................... 37 

Other Browser Bars Available ............................................................................................... 40 

Attribute Editor ............................................................................................................................ 41 

Mouse Operation .......................................................................................................................... 43 

Viewing the Design ...................................................................................................................... 43 

Design Item Selection .................................................................................................................. 44 

Context menus .............................................................................................................................. 49 

The Design Settings Dialog .......................................................................................................... 50 

The Options Dialog ...................................................................................................................... 50 



6   Contents 

The Properties Dialog ................................................................................................................... 51 

CHAPTER 3. GENERAL UTILITIES ................................................................................................... 55 

Undo/Redo ................................................................................................................................... 55 

Interactive Operations .................................................................................................................. 55 

Moving Items ............................................................................................................................... 55 

Mirror ........................................................................................................................................... 57 

Rotating Items .............................................................................................................................. 58 

Lock and Unlock .......................................................................................................................... 61 

Cut, Copy, Paste and Duplicate .................................................................................................... 62 

Grouping Items ............................................................................................................................. 64 

Deleting Items .............................................................................................................................. 65 

Inserting Text ............................................................................................................................... 67 

Mitring and Filleting Corners ....................................................................................................... 72 

CHAPTER 4. SETTING UP THE DESIGN ........................................................................................... 75 

Overview ...................................................................................................................................... 75 

Using Folders and Files ................................................................................................................ 75 

Folders.................................................................................................................................... 75 

Files ........................................................................................................................................ 78 

Security Copies and Backups ....................................................................................................... 79 

Units ............................................................................................................................................. 82 

Grids ............................................................................................................................................. 82 

Changing the Design Area Size .................................................................................................... 86 

Changing the Design Origin ......................................................................................................... 86 

Changing the Design Origin ................................................................................................... 86 

Working in Absolute and Relative Modes .................................................................................... 87 

Changing the Relative Coordinate origin ............................................................................... 87 

Technology Files .......................................................................................................................... 88 

Creating and saving Technology files .................................................................................... 89 

Styles ...................................................................................................................................... 90 

Introduction to Net Items ....................................................................................................... 91 

Net Styles ............................................................................................................................... 92 

Rules ...................................................................................................................................... 93 

What is a rule? ........................................................................................................................ 93 

Creating and applying Rules .................................................................................................. 94 

Wildcard Wizard .................................................................................................................... 95 

Colours ................................................................................................................................... 97 

Load Technology .......................................................................................................................... 98 

Profile Files ................................................................................................................................ 100 

Design Defaults .......................................................................................................................... 101 

Working With Attributes ............................................................................................................ 102 

The Pulsonix Vault ..................................................................................................................... 111 

Key Concepts of the Vault ......................................................................................................... 112 

What can be stored in the Vault? .......................................................................................... 112 

What is an ‘item’? ................................................................................................................ 112 

Other Vault item properties .................................................................................................. 113 

Cross References .................................................................................................................. 113 

Managing and updating Vault items..................................................................................... 113 

Vault Admin Tools ..................................................................................................................... 114 

Adding Vault Items to a Design ................................................................................................. 114 

CHAPTER 5. SCHEMATIC CAPTURE EDITOR .................................................................................. 115 

Getting Started ............................................................................................................................ 115 

Starting a New Drawing with Default Files ................................................................................ 115 

Design Options for Schematic Design ........................................................................................ 116 



 Contents   7 

Setting up your Technology ....................................................................................................... 118 

Schematic Technology dialog .............................................................................................. 119 

Rules .................................................................................................................................... 120 

Changing the Colours of the Schematic ..................................................................................... 120 

Using a Drawing Profile (Page Border) ...................................................................................... 121 

Using the Component Bin .......................................................................................................... 122 

Adding Components ................................................................................................................... 123 

Using Decoupling Capacitors ..................................................................................................... 127 

Adding Connectors ..................................................................................................................... 128 

Reloading Parts .......................................................................................................................... 130 

Adding Connections to the Design ............................................................................................. 131 

Add Connection Modes ........................................................................................................ 141 

Naming and Renaming Nets................................................................................................. 143 

Local and Global Nets .......................................................................................................... 143 

Defining Track & Vias styles in SCM and Translated to PCB ............................................. 144 

Electrical Rules Checking (ERC) ............................................................................................... 146 

ERC Modes of operation ...................................................................................................... 146 

Defining the Rules................................................................................................................ 148 

Pin Type Rules ..................................................................................................................... 148 

The ERC Error Browser ....................................................................................................... 150 

Documentation Symbols ............................................................................................................ 151 

Overview .............................................................................................................................. 151 

Using ‘general’ Doc Symbols .............................................................................................. 152 

Block Ports ........................................................................................................................... 153 

Block Symbols ..................................................................................................................... 154 

Block Port and Blocks .......................................................................................................... 154 

Branch Points ....................................................................................................................... 154 

Bus References ..................................................................................................................... 155 

Documentation Symbols ...................................................................................................... 155 

Mounting Holes .................................................................................................................... 155 

Net Labels ............................................................................................................................ 156 

Page Link ............................................................................................................................. 156 

Signal References ................................................................................................................. 158 

Power and Ground Symbols ................................................................................................. 159 

Cross Sheet References ........................................................................................................ 160 

Star Points ............................................................................................................................ 161 

Testpoints ............................................................................................................................. 161 

Using Busses .............................................................................................................................. 161 

Hierarchy .................................................................................................................................... 168 

What is hierarchy and why use it? ........................................................................................ 168 

Overview of Hierarchy ......................................................................................................... 168 

Connecting Through Hierarchy ............................................................................................ 170 

Setting up your design for hierarchy .................................................................................... 171 

Creating a new block to add to your design ......................................................................... 173 

Blocks, Pin Types and ERC ................................................................................................. 176 

Using an existing Hierarchical Block in the Design ............................................................. 177 

Creating a Hierarchical Block from an existing Schematic Design ...................................... 178 

Cutting an existing Schematic Circuit to a block ................................................................. 179 

Adding More Pages to the Design .............................................................................................. 184 

Combining Schematic Pages from other Designs ....................................................................... 185 

Building up the Design using Copy and Paste ............................................................................ 185 

Resolving Net Names when using Paste..................................................................................... 185 

Using Testpoints ......................................................................................................................... 187 

Adding Shapes ............................................................................................................................ 188 



8   Contents 

Use of Attributes in Schematic Capture ..................................................................................... 189 

Translating the Schematic to PCB .............................................................................................. 189 

Exporting Netlists ....................................................................................................................... 191 

Exporting Spice Netlists ............................................................................................................. 192 

Reverse Engineer ........................................................................................................................ 193 

Printing and Plotting the Schematic Design ............................................................................... 194 

Using the Print Option.......................................................................................................... 194 

Using the CAM/Plot option .................................................................................................. 195 

Printing to Active PDF ......................................................................................................... 201 

CHAPTER 6. PCB DESIGN EDITOR .............................................................................................. 205 

Getting Started with the Design .................................................................................................. 205 

Starting a New PCB Layout with Default Files .......................................................................... 205 

Design Setup for PCB Layout .................................................................................................... 206 

Setting up a PCB Technology .................................................................................................... 208 

PCB Technology dialog ....................................................................................................... 208 

Styles .................................................................................................................................... 208 

User Defined Pad Shapes ..................................................................................................... 211 

Hatch Styles ......................................................................................................................... 214 

Style Naming Rules Pages in the Technology Dialog .......................................................... 215 

Spacing Rules ....................................................................................................................... 217 

Special Design Level Rules .................................................................................................. 218 

Match Pair Level Rules ........................................................................................................ 218 

Import Spacings Rules using CSV Format Files .................................................................. 219 

DFM/DFT Rules .................................................................................................................. 220 

CAM Plot ............................................................................................................................. 222 

Layers ................................................................................................................................... 222 

Layer Classes ....................................................................................................................... 224 

Materials .............................................................................................................................. 225 

Layer Spans .......................................................................................................................... 226 

Displaying Layer Stacks ....................................................................................................... 227 

Changing the Colours in the PCB ............................................................................................... 228 

Translating from Schematics ...................................................................................................... 229 

Importing a Netlist...................................................................................................................... 229 

Creating a Board Outline ............................................................................................................ 230 

Insert Mounting Holes ................................................................................................................ 232 

Using Profile Files ...................................................................................................................... 233 

Setting the Design Origin ........................................................................................................... 235 

Inserting Components ................................................................................................................. 235 

Reloading Parts .......................................................................................................................... 238 

Using the Component Bin .......................................................................................................... 240 

Moving Components to/from the Bin ................................................................................... 241 

Placing Components around the Board Outline .......................................................................... 244 

On-line Design Rules Checking (DRC)...................................................................................... 245 

Placing Components interactively .............................................................................................. 248 

Adding Connections ................................................................................................................... 255 

Managing PCB Nets ................................................................................................................... 257 

Optimising Nets .......................................................................................................................... 260 

Manual Gate and Pin Swapping ................................................................................................. 260 

Manually Routing the Design ..................................................................................................... 263 

Track Breakouts (Fanouts) ......................................................................................................... 281 

Using the AutoDim option ......................................................................................................... 283 

Unrouting Tracks ........................................................................................................................ 284 

Using Shapes and Cutouts .......................................................................................................... 284 

Shapes .................................................................................................................................. 284 



 Contents   9 

Areas .................................................................................................................................... 295 

Merging Shapes .................................................................................................................... 297 

Cutouts ................................................................................................................................. 297 

Board Cutouts ...................................................................................................................... 298 

Inserting Copper ......................................................................................................................... 299 

Pouring Copper and Templates .................................................................................................. 302 

Using Teardrops ......................................................................................................................... 309 

Adding Dimensions .................................................................................................................... 311 

Adding Dimensions .............................................................................................................. 313 

Text Callouts .............................................................................................................................. 317 

Attached Callouts ................................................................................................................. 318 

Measure Tool.............................................................................................................................. 319 

Using PCB Attributes ................................................................................................................. 321 

Design Rules Checking .............................................................................................................. 322 

Locating Errors .................................................................................................................... 325 

Synchronising The Designs ........................................................................................................ 326 

Full ECO Back to the Schematic .......................................................................................... 327 

Cross Probing Designs ............................................................................................................... 329 

Printing the Design ..................................................................................................................... 331 

Assembly Variants ..................................................................................................................... 332 

Components in Variants ....................................................................................................... 334 

Fitted Component Variants .................................................................................................. 337 

Part Variants ......................................................................................................................... 338 

Component Variant Attributes ............................................................................................. 339 

Variant Attributes ................................................................................................................. 339 

Using the Database with Part Variants ................................................................................. 341 

Other considerations for Variants ......................................................................................... 342 

Using ‘Instances’ for Variants .............................................................................................. 344 

Variants Spreadsheet Editor ....................................................................................................... 345 

Micro-vias and Layer/Component Span Technology ................................................................. 346 

Micro-via Layer ‘Facing’ Switch ......................................................................................... 346 

Layer Spans .......................................................................................................................... 347 

Composite Micro-via Layer Spans ....................................................................................... 348 

Defining a Composite Via Span in Net Styles...................................................................... 348 

Using Composite Layer Spans ............................................................................................. 349 

Stacked and Tapered Micro-vias .......................................................................................... 349 

Outputs for drilling Micro-vias ............................................................................................ 351 

Advanced Technology Features ................................................................................................. 351 

Autorouting .......................................................................................................................... 351 

Interactive High Speed Design ............................................................................................. 351 

CHAPTER 7. OUTPUTS FOR PCB MANUFACTURING ...................................................................... 353 

Overview of manufacturing outputs ........................................................................................... 353 

The CAM Plot option ................................................................................................................. 354 

Using the CAM/Plot option .................................................................................................. 354 

Outputting a plot overview ................................................................................................... 354 

Outputting a Windows Print to File and PDF ....................................................................... 354 

Auto Generate Plots ............................................................................................................. 354 

The CAM/Plot dialog ........................................................................................................... 355 

Step & Repeat ...................................................................................................................... 358 

Plotting Variants................................................................................................................... 359 

Plot Groups .......................................................................................................................... 360 

Using the Plot Wizard .......................................................................................................... 360 

Drill Sizes ............................................................................................................................. 366 

Manufacturing Outputs ............................................................................................................... 368 



10   Contents 

Creating the plot types.......................................................................................................... 368 

Types of manufacturing plots ............................................................................................... 370 

Adding the board outline to plots ......................................................................................... 370 

Composite Power planes ...................................................................................................... 379 

Creating Split power planes ................................................................................................. 381 

Breaking Silkscreen ............................................................................................................. 383 

Creating an output for NC Drilling machines....................................................................... 384 

Outputting Drill drawings .................................................................................................... 385 

Combining plots ................................................................................................................... 390 

Plot Transformations and Positioning in Plot Preview ......................................................... 391 

Check Plots .......................................................................................................................... 393 

Using Fiducial Marks ........................................................................................................... 393 

Outputting other formats using the CAM Plot dialog ........................................................... 394 

Additional Manufacturing Exports using the Output menu .................................................. 394 

Outputting to Mechanical CAD Systems ............................................................................. 396 

Outputting for Documentation ............................................................................................. 396 

Outputting to ZIP Format ..................................................................................................... 397 

CHAPTER 8. OUTPUTTING REPORTS, PART AND NET LISTS ........................................................... 399 

Standard Reports ........................................................................................................................ 399 

Report Maker.............................................................................................................................. 400 

Advanced Format Scripts ..................................................................................................... 407 

CHAPTER 9. IMPORTING DESIGNS AND LIBRARIES ......................................................................... 413 

Overview .................................................................................................................................... 413 

Importing Alien Designs ............................................................................................................ 413 

Importing Netlists into Pulsonix PCB ........................................................................................ 414 

Importing Other Formats ............................................................................................................ 416 

Importing Gerber files .......................................................................................................... 416 

Importing DXF files ............................................................................................................. 416 

Importing IDF Files .............................................................................................................. 417 

Importing STEP Files ........................................................................................................... 417 

How to import DXF/IDF/Gerber files .................................................................................. 418 

How to import using the Intelligent Gerber option............................................................... 418 

CHAPTER 10. LIBRARY MANAGEMENT TOOLS .............................................................................. 419 

Understanding Pulsonix Libraries .............................................................................................. 419 

Libraries Overview ............................................................................................................... 422 

Overview of the Supplied Libraries ............................................................................................ 423 

Additional Library Content ........................................................................................................ 424 

The Library Manager .................................................................................................................. 425 

Overview .............................................................................................................................. 425 

Library folders ...................................................................................................................... 425 

Using the Library Manager .................................................................................................. 427 

Library Selection .................................................................................................................. 428 

Merging Libraries................................................................................................................. 430 

Creating Schematic Symbols ...................................................................................................... 430 

Using the Symbol Editor ...................................................................................................... 431 

Library Creation Wizards ........................................................................................................... 439 

Creating PCB Footprints ............................................................................................................ 439 

Using the Footprint Editor .................................................................................................... 440 

Breakouts in the Footprint .................................................................................................... 449 

Creating Parts ............................................................................................................................. 451 

Part entity correlation ........................................................................................................... 452 

Using Part Technology Files ................................................................................................ 453 

Creating Basic Parts ............................................................................................................. 453 



 Contents   11 

Associated Parts ................................................................................................................... 468 

Creating Unusual Parts ......................................................................................................... 470 

Documentation Symbols ............................................................................................................ 471 

Pulsonix Database Connection (PDC) ........................................................................................ 471 

Pulsonix Vault ............................................................................................................................ 471 

INDEX ....................................................................................................................................... 472 

 



12   Contents 

 



 Chapter 1 – Installation & Setup   13 

Chapter 1. Getting Started 

Welcome 

Welcome to the Pulsonix electronic design system. The system is built on an integrated design 
environment providing all the tools required to capture a schematic and simulate it using the Spice 
simulator interfaces, through to the design and layout of the printed circuit board (PCB) which is 
aided with a powerful shape-based auto router.  

Pulsonix appeals to all users, from the casual to the full time user because of its simplicity and 
straightforward approach. Pulsonix is structured in such a way that its menu structure and options 
naturally leads you through the design sequence, that in turn means you don't 'jump' about within the 
product hunting for functionality. 

About this Manual 

The contents of this manual 

Like all aspects of Pulsonix, the Users Guide has been written to be as usable as possible with the 
least amount of effort. It has been produced in a manner that will get you started in the quickest time 
possible by describing functionality based on the logical steps of a practical design cycle. Even if 
your design cycle doesn't follow the exact path in this manual you can get your questions answered by 
turning to the relevant sections. The manual does not take you through every detail but will guide you 
through the essentials to produce a design. The on-line help provides further information in context 
about each option. It is directed at users who understand the fundamentals of designing PCBs; it is not 
intended as a course in designing PCBs. 

Where to find additional information 

Additional information and help located in the accompanying HTML on-line help system. Once the 
Pulsonix product has been installed and is running, you can call help at any time by locating the Help 
index from the Help menu and selecting one of the options available. 

System Requirements 

Hardware required 

To run Pulsonix your PC hardware will need to conform to the following requirements: 

• A Pentium class processor (i7 minimum or better recommended) 

• Microsoft Windows 10 or 11 recommended * 

• At least 8Gb of RAM minimum 

• Graphics to support DirectX 10 

• 1.4Gb of hard disk space for the all files supplied, including libraries and run time files 

• 3 button mouse with wheel is recommended although any mouse will work 

* It is highly recommended that the most up-to-date Windows operating systems are always used. 

Please check our web site for the Pulsonix operating system support policy. 
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Program security 

The Pulsonix design system is protected by a security key or network address, plus an accompanying 
license code. The key is attached to the USB port for a node-locked system; you may also use a 
Network Address to replace the security key. If using this protection, a key would not have been 
supplied. For ‘floating’ network license systems the license resides on a server system, this will also 
be paired with a MAC address or USB key.  

If updating or upgrading your program from an earlier version you may require a new license. You 
will be supplied a new license if needed and you will be informed of the procedure to use it. 

Installation 

For new users (normal installation) 

To install any of the Pulsonix products, as a standard precaution we recommend that you first close all 
other applications, saving your work if necessary. 

This procedure is used for any ‘client’ installation, that is, an installation which is not using a network 
license scheme and for which the dongle resides on the same machine. For floating network licensing 
refer to the Network Licensing Installation Guide. 

USB Key Driver 

You must NOT connect the USB key (dongle) before installation is attempted. Once Pulsonix has 
been installed you will need to connect it. The Setup program will install a special HASP USB Key 
driver to use. Once Pulsonix is installed and the USB key attached, Windows will automatically 
detect the key and will use the new supplied driver. You cannot use the standard Windows Plug & 
Play driver. 

Licensing 

Normally, the license file will be supplied to you by email with the name license.lic or  
key _number.lic This license file includes any products and cost options purchased. Create a suitable 
folder and save it into this on your hard drive. During installation you will be asked to browse to it. 
You can use this location if changing from a Trial system to the licensed product once purchased. 
You can also use the License Manager to browse to the location of the license file if switching 
between the trial system and an evaluation license. 

MAC Address License 

A license may also be supplied to you that is locked to your computer’s MAC address. This is an 
alternative to using a USB key security mechanism. The procedure for installation will be exactly the 
same as with the USB key detailed above. 

Installation from a download 

If you have been provided with a download link to install Pulsonix from the Pulsonix web site, click 
on the link provided. This download a packed executable file which will run once setup has been 
double clicked.  

The Pulsonix Setup Wizard will guide you through installation of the software. Follow the steps 
displayed on-screen and press the <Next> or <Back> buttons to move through each stage. If you need 
to, you can abandon the installation at any time by clicking on the Cancel button and then Exit. 

All the Installation Notes and User’s Guides are available from the Pulsonix.com web site. 
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Moving the Installation 

If you wish to move Pulsonix from one machine to another, you cannot simply copy the installation, 
you must use the program executable file to re-install it. The Setup program must be used in order to 
install the required registry entries. You can move your Pulsonix settings from one machine to 
another Saving and Loading Configuration files. This is described in mor edetail in the online help. 

Updating Pulsonix from the web 

Pulsonix can be automatically updated through our web site with the latest fixes that become 
available from our development centre. This facility is available for all users with a current 
maintenance contract and a login account. 

To check and access the latest patches from the web site, from within Pulsonix, go to the Help menu 
and select Check For Updates… When selected, a dialog is displayed, this allows you to set up when 
you want to check for updates and where to check. It also allows you to force a check now. This will 
automatically direct you to the Pulsonix Updates page from where you can login and download the 
latest patch available. 

 

If a patch isn’t available, the dialog will report that none are available at this time. Before installing a 
new patch, ensure that Pulsonix isn’t running, if it is, it must be closed. 

You can also save the executable file to your local disk if you wish to install it at a later time or on 
another machine or over a local intranet network onto several machines. 

Updating Pulsonix Using Hot Fixes 

Occassionally, there is the need to fix critial issues before a service patch is released. A hot fix is 
issued to accommodate this in the form of a self-extracting executable that you would have been sent 
a link for in an email from our service centre. This will fix your issue until the next patch is released.  

Floating Network Licensing 

Floating network licensing is the ability to run any number of licenses from one central server without 
the need for a dongle on each machine to run the product. This type of licensing effectively floats on 
the network until booked out by Pulsonix and used. Pulsonix supports this as a cost option to the 
regular product.  

For installation instructions, an installation guide is supplied on the download page of our web site. 
Please refer to the Network License Installation notes for further information. 
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Uninstalling Pulsonix 

To uninstall the product from your hard drive you should use the Remove option from the main 
Installation program. For product updates or upgrades you do not need to uninstall existing product 
first regardless of its version. 

Contacting Technical Support Resources 

Access to our support engineers is available via the internet, e-mail and telephone (Monday to Friday 
10:00am to 5:00pm in the UK). Outside this location please contact your local support centre. 

Email: support@pulsonix.com 
Phone: +44 (0)1684 296 570 

Support is limited to: Installation assistance and questions regarding Pulsonix usage, design, 
manufacturing and library design, all answered in context of how to use the features. Consultancy is 
also available, for more information about this service, please contact our international sales office. 
After your free support has expired, extended support options can be purchased from our sales office. 

Whenever our technical desk is contacted, you will need to have your contact details (phone and 
email address) available, plus the product version number. It helps us and speeds up the process if any 
problems can be reproduced on our demo designs supplied. 

Please note that we can only support the current major version, especially when attempting to 
reproduce problems. 
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Chapter 2. Using Pulsonix 

Introduction to Pulsonix 

Starting Pulsonix  

The start location of the program can be set using the Folders option on the Setup menu. Please refer 
to the Setting up The Design Chapter, Using Folders and Files. 

The Pulsonix Desktop 

When you run Pulsonix, the main application window appears. Pulsonix operates a multiple 
document interface (MDI), so you can open any number and combination of different Pulsonix 
designs types, as well as libraries and additional tools. 

 

Pulsonix Menu Options 

The Menu bar contains options relevant to each application open within Pulsonix. The menus are set 
out logically to be used as you move through the design cycle starting from the left and moving right. 
This methodology is only applicable if you are following this basic principle. The basic principle still 
applies regardless of where you start in your design cycle. The menus are logical and intuitive to 
understand. The menu bar is similar to a toolbar in that it can be 'docked' in place or left 'floating' on 
the screen as you wish.  
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Using Multiple Screens 

Pulsonix can be used with more than one screen to provide you with Schematics on one and PCB on 
the other, for example. By default, Pulsonix is setup to use just the one screen but can be easily 
switched to use two. 

���� To enable multiple screen usage 

1. If you wish to use more than one screen, from the Tools menu, select Options. 

2. From the Multi-Screen tab, select either the Enable Multi-Screen Support check box. 

 

The Status Bar 

The status bar appears across the bottom of the Pulsonix framework. The bar contains two sets of 
information; the Prompt / Message box displays useful information about the current activity and 
also provides basic instruction to its use. If an option doesn't behave as expected this area should be 
checked first to see what the system is expecting you to do, a prompt message is displayed in this 
area.  

 

The Prompt/Message box is a single instruction box, the box to the right of this contains display 
Property information about any design items selected. The information in these boxes is not 
exhaustive but does contain commonly required information about the item selected. For more 
detailed information about any selected item, right click and click the Properties command from the 
context menu. 

The status bar displays Co-ordinate information about the position of the cursor within the design as 
an X and Y co-ordinate value. These co-ordinates are shown as either absolute [Abs] or relative 
[Rel] depending on the mode selected. The current design Units are also shown on the status bar.  
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When viewing the X,Y co-ordinates on the status bar you will notice that they sometimes display a + 
or - sign after the each of the co-ordinate numbers. This indicates that the value shown cannot be 
represented using the current units precision. 

 

The minus sign (-) (when displayed) indicates that the number is slightly less than the last digit 
shown, whereas the plus sign (+) indicates that the number is slightly more than the number shown. 
With the precision set in the Units dialog and the available space in the co-ordinate boxes this 
notation allows you to see instantly whether the number is precise or not.  

If using Relative co-ordinates, the status bar shows the co-ordinates relative to the relative origin. 
This will only return back to co-ordinates relative to the design origin if the system is swapped back 
to an Absolute co-ordinate system. Use the Design Properties dialog located on the Edit menu to 
switch modes and change the relative origin.  

The furthest box to the right displays the current design Units. 

Active Status Bar 

The Status bar is also active. This means that by double-clicking on a pane within it, relevant 
information can be modified. For example, clicking on the Abs word will toggle between Absolute 
and Relative modes. Other modes, such as Grid: will display the Grids dialog where a change can be 
made. The active Status bar includes: 

• Layer, Layer Span, Net, Style (text style, pad style, line style) also editable by clicking on Width, 
Size, Line Width, Side, Delta X, Delta Y, Angle and Radius (for arc) 

• Units (double-click on coords when not editing/moving item), Toggle Units (mm < > thou toggle) 

• Typed coordinatess (double-click on coords) 

• Absolute/Relative coords (toggle) 

• Current Grid 

• Variants 
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The On-line Help System 

Pulsonix provides an on-line help system with detailed information about every item within the 
product. You will also find help on general ‘topics’ as well as feature items. 

At any time, you can press the F1 key to access help in context of the current action, or run help from 
the Help menu and selecting Help. 

 

The help window is split into two main sections. The left hand navigation window displays the 
Contents list, the help Index, a word Search facility and a Favourites selection for retaining pages 
'marked' by you. The right hand Help window provides you with the context help pages. These pages 
are located from one of the options on the left hand window or by using the F1 key to obtain context 
help on each dialog. To view any of the topics that appear in the Index or Contents sections, double-
click the mouse while over the item required. Alternatively, select the item and click the Display 
button. 

When using the Search facility you can search for word strings by encapsulating the string in double 
quotes, e.g. “Free Angle” 

Customising Pulsonix 

Overview 

Pulsonix provides you with the ability to customise the user interface with your own Toolbars 
containing option buttons that allow instant access to tools within the program. You also have a 
complete command set of all the options within Pulsonix which can be assigned to a shortcut key 
from the keyboard. Other aspects of Pulsonix can also be customised such as the application look and 
and how the menus are revealed when you select them. 

Light and Dark UI 

Pulsonix can be run in Dark mode. By default, Pulsonix is installed as a new installation using the 
‘light’ mode. If you wish to change this, use the Tools menu and Customise option, then Application 
Look tab and select the ‘Dark’ radio button. 
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By selecting the Dark mode radio box and then pressing Apply Changes or the Close button, 
Pulsonix will then switch to using the dark interface for the application and all dialogs. 

Toolbars 

Toolbars in Pulsonix can be set to be both 'docked' and ‘floating'. They can also be customised to 
contain your own choice of options and can be named for instant recognition for particular tasks, for 
example named Edit Connection, for use in Schematics that might contain connection editing and 
naming options.  

Below is an example of a docked toolbar. The toolbar is docked below the Menu bar in the horizontal 
position. This is the default position but can be moved as required. 

 

In docked mode, a toolbar is fixed along any of the four borders of the main window framework in 
either a horizontal or vertical position and will have a Gripper bar across the top or down the left. 
You cannot modify the size of a toolbar when it is docked.  

 

The toolbar can be moved by selecting the window border and 'dragging' it away from its current 
location. By dragging it, it becomes detached from the framework. When the toolbar is then moved 
over another area of the framework to which it can be attached, it changes shape to indicate it can be 
docked there. You can also make it floating by Double-clicking on the window Gripper bar or in the 
toolbar area itself, but avoiding the buttons that will select an option. 

The toolbars can also be floating. This means the toolbar can be moved into free space on the design 
and outside the framework. This toolbar can now be reshaped to make it fatter or thinner by dragging 
the outer edge in or out. The toolbar can be shaped to be one tool wide or long by as many tools as are 
loaded on the toolbar in the opposite direction. By selecting the outer framework edges of the toolbar 
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a small arrow 'handle' will appear to indicate that the toolbar can now be reshaped. Drag the handle 
until you have the shape you require. 

 

You can restore the toolbar to its last docked position by double-clicking on the name caption on the 
toolbar. 

To move a floating toolbar, select and drag any part of the toolbar framework. The toolbar will move 
dynamically with the mouse movement. Release the mouse button to release the toolbar. 

How to customise toolbars 

Toolbars can be customised to contain the buttons (and underlying options) of your choice. Pulsonix 
provides a default set of toolbars that cover different design types and some designs tasks, such as 
editing etc.  

You can create toolbars for any task that appears on the menu or context menus. 

To edit or create your own toolbars you must use the Customise option on the Tools menu. Once in 
this dialog you can move tools on existing toolbars or add/create your own. Other than in this dialog, 
you cannot add or remove tools from toolbars but buttons can be moved by pressing the Alt key and 
dragging the button from one toolbar to another or off the toolbar to remove it altogether. 

���� To create a new toolbar 

1. On the Tools menu, click on Customise. Click on Toolbars. The Customise option is also 
available by clicking the right mouse button on the Pulsonix framework. 

 

The process for adding a new toolbar and adding tools to it would be: 

2. Click on the New button. 

3. Type in the name that you wish to use for the toolbar (this is the caption name that appears as the 
toolbar title), and click OK. 
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This name now appears in the list of available toolbars and is, by default, already selected at the top 
of the toolbar list. You will also be able to see the toolbar in the design window. You will now need 
to add the required commands to the toolbar. 

4. Click on the Commands tab. 

 

The Categories are arranged in the same order as the menus themselves. By clicking on each of the 
names in the Categories list you will see the buttons for the options found on those menus displayed 
in the Commands section next to it. You can also view all of the available commands by clicking on 
All Commands in the Categories list. 

5. Click on a command from the Commands list. 

You will see a brief description of the function of that button in the Description: box. These buttons 
can now be dragged onto a toolbar. Once the toolbar is populated with the tools you require, click the 
OK button to close the Customise dialog. 

���� To remove a button from a toolbar 

1. On the Tools menu, click on Customise. 

2. With the toolbar on which the tool to remove resides visible, select the tool button and drag it off 
the toolbar and into 'free' space. That is, space that is not part of this or any other toolbar. 

3. Once complete, click on the OK button to make the changes permanent. 

In addition to using the Customise option from the Tools menu, you can also use a more convenient 
method through a right mouse shortcut. 

The context menu is available when the cursor is hovered over any of the toolbars, menu bar or status 
bar. 

Commands and Shortcuts 

As well as the toolbars, Pulsonix has the ability for you to programme your keyboard for commonly 
used options or commands. This means that once programmed, you can press a key or key 
combination to enter a function or option. For experienced users, this makes the program's operation 
far more efficient.  

When Pulsonix is first installed, you will find a set of shortcuts already defined for you. These are 
only a default set and can be modified to your own preference through the Shortcuts dialog. Almost 
all of the keys on a standard keyboard can be utilised giving you extensive coverage of shortcuts. 
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���� To create a shortcut 

1. On the Tools menu, click on Shortcuts. 

 

Each of the currently Assigned Shortcuts is displayed when the command of the same name is 
selected. It is possible to assign more than one shortcut to a command if required. 

2. Select the option you wish to change and click the mouse in the Press New Shortcut window 
and then click the key(s) you wish to assign to it. 

3. Click the Assign button and that key combination will be assigned to the function chosen. 

4. If the key has already been used, a message will be displayed informing you that it is already 
assigned allowing you to overwrite it or Cancel. 

5. Before any shortcut keys are assigned ready for use you must exit the Shortcuts dialog by 
pressing OK. Simply, assigning the shortcut is not enough. 

A full report of all the assigned keys can be obtained from this dialog or can be run from the Reports 
option on the Output menu. Use the Shortcut Keys Report to generate the report.  

Selecting a Category from the list of categories at the top left of the dialog causes the command list 
to show the commands in that category. The <All Commands> category shows all available 
commands. The Description box displays a brief description of what the currently selected command 
does. These are categorised using in-build categories and cannot be changed. 

The Find Key and Filter options allow you to locate other shortcut keys. 

Dockable Windows and Browsers 

Overview 

As part of the design suite, you have a number of dockable windows and Browsers that can be used to 
view specific design information. These windows are available through the View menu, through 
Shortcut keys and through the popup toolbar/window menu. Each individual window can be 
specified to Allow Docking (enabled through the context menu for each window or browser). This 
means that if not allowed, regardless of where the window is placed, it will not 'attach' itself to the 
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framework. If you require it to be docked, the Allow Docking option must be checked (with the 'tick' 
showing as in the example below). 

 

Component Bin 

The Component Bin is provided to store and view unplaced components in the PCB design editor, 
and unused gates in the Schematic design editor.  

When used in Schematics it contains unused symbol Gates not yet placed. For example, if a 4xNAND 
gate is loaded into the design but only one gate placed, the other three gates are placed into the 
Component Bin ready for subsequent use. 

If used in the PCB design editor, the Component Bin is used to hold unplaced components. The 
Component Bin can be used as an integrated part of the auto place functionality. The components are 
automatically taken from the Component Bin and placed on the design, this can be a two way process 
for removal of components from the design.  

 

The Component Bin is a dockable toolbar. It can be left 'floating or 'docked' on one of the sides in the 
design area. To move it, simply click and drag an edge of the Bin to the desired location. The 
Component Bin will move while being dragged, as soon as you release the mouse button it will 
remain in its present location until moved further. 

The Component Bin contains two sets of information. 

The Component Bin Preview window shows the Component currently selected in the bin, along 
with its terminal/pad numbers and names. This updates automatically as each Component within the 
Bin is selected. 

The Component Bin window lists the components currently in the bin. This shows the Component 
reference name, the Component name and Component type and is sorted alphabetically on the 
Component reference name. For a schematic design and for a multi-gate Component, the gate name 
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and symbol name are listed for each gate of the Component. The components (or gates) are selected 
by clicking in this list. 

Using the Component bin 

Components can be placed in the Bin directly from Insert Component, from Translate to PCB or by 
dragging them manually into the Bin from the design. You can also select components in the design 
and send them to the Bin using functionality from the context menu. Any PCB Components within 
the Component Bin retain all connectivity but loose track information if previously routed in the 
design. You are warned that track information is lost before the move to the Bin can be made. 

Any Schematics gates moved to the Component Bin become completely unconnected (unused). 

Components within the Bin can be moved from it in a number of ways: 

You can select and drag a Component from the Preview window or from the Component list. This is 
the most basic mode but aids fast manual placement by making the design 'clutter' free during the 
placement phase. 

If you select Place Around Board and components are in the Component bin, they will be placed on 
the design around the board outline. 

Auto place (if authorised) can move components to and from the Component Bin automatically. 

Further selections in the Component bin 

By right clicking in the Component Bin you are presented with a number of choices: 

 Add to Bin will open the Insert Component dialog from where you can draw components and add 
them directly to the Bin without exiting this option or mode. 

Delete from Bin will allow you to delete individual components from the bin. This is only available 
in PCB if the PCB Safe Mode is not active in the Options dialog (available from the Settings menu). 
If active, you will not be able to add (Insert) or remove (Delete) items from the bin. 

Empty Bin will remove any whole unused components from the bin. If any gates or Connector pins 
are already in use in the design they will not be removed. 

Place Around Board From Bin will place selected components from the bin to around the board 
outline, provided one exists. 

  

The other browsers are also available for selection on the context menu. 

The Component Bin is discussed in more detail as it is used throughout this manual. 
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Part Browser 

The Part Browser provides a convenient way to add commonly used Parts to your design.  

 

Adding components to the current design 

You can add components to your design by selecting a Part in the browser and dragging it into the 
design, with the left mouse button held down. You will then have a Component on your cursor that 
you can place by releasing the mouse button. After the first Component is added, more copies of the 
Part are interactively added to the design until you cancel the current command, or begin a different 
command (including dragging another Part from the browser).  
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Configuring the Part browser 

The browser presents a list of Parts organised according to a category attribute. The list can be 
hierarchical by specifying an appropriate separator character to split the attribute value into a path. 
You can change the attribute used and the separator character by selecting the Change Part 
Categories on the context menu in the browser.  

 

You can select more than one Category to list in the Parts Browser. This uses a grid where each row 
defines a category name. This also allows you to Filter the Parts using wildcards on an attribute value, 
or specify the required Pin Count (No. Pins). 

Once the OK button on the Part Browser Categories dialog is clicked, the Part Browser will be 
updated with the new selection. 

These attributes are the ones currently in your library indexes, to change this list you must regenerate 
the library indexes using the Index option on the Parts Library Manager dialog.  
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World-view 

The world-view is a miniature view of the complete design with some detail included for co-
ordination. This world view is used to navigate around the design, and because you can see the whole 
design you do not need to resize the design first.  

 

This browser can be used docked or floating (shown above as floating). Not only does it provide a 
view of the design but can also be used for navigating the design as well. The Zoom in/out, Pan and 
Fame View commands are all operative in this view and are highlighted by the white Current View 
box. 

Options are also available on the context menu by clicking the right mouse in the window. 

By right clicking in the World View you are presented with three choices of the view to show: Show 
Design Extents, Show Board Extents and Show Working Area. 

The picture below shows the World View with the view set to Working Area. You can see all of the 
design area with the design represented within it. 

 

Other selections on the context menu will display the browser options also available. 

Design Browser 

The Design Browser is displayed as a configurable Dockable Window containing a list of all the 
currently open PCB and Schematic designs, technologies and profiles. For a Schematic, a tree 
showing all the pages in the design is shown, including any hierarchical blocks. The name of the 
design/page whose view is currently active in the main window is shown in bold typeface. A dimmed 
page icon indicates schematic pages that are not open as a view in the main design window.  
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As well as being a visual guide, the Design Browser is fully functional and provides access to a range 
of design level operations via its context menu.  

���� To show/hide the Design Browser 

1. From the View menu, select Design Browser, this will toggle the visibility of the Design 
Browser window. Alternatively a shortcut key can be defined using the Customise option.  

Using the Design Browser 

From within the Design Browser: 

• Double-click on a PCB design to make that the active view within the main design window.  

• Double-click on a Schematic design or one of its pages to make that the active view within the 
main design window.  

• Double-click on an already active Schematic to hide/show its pages.  

• Double-click on an unopened Schematic page to open it.  

• Click on any design or page to make that the currently selected Design Browser item.  

• Right click anywhere in the Design Browser window to display the context menu that provides a 
set of design/page level commands applicable to the currently selected item. Commands such as 
Close, New, Delete and Rename operations are available. 

DRC and ERC Error Browsers 

These browsers are used to view the design error markers that have been created by the Electrical 
Rules Checker, by the Design Rules Checker or by the on-line design rules checking options. The list 
is displayed in an 'active' browser. You can use a double click on one of the items in the list to locate 
the error marker in the design. This browser can be un-docked as a modeless dialog or docked as part 
of the Pulsonix framework. Use the right hand mouse button to make this selection.  

Before using the Errors Browsers you must first run a design rules check from the Tools menu to find 
and 'mark' the errors. Errors found during the on-line DRC/ERC processes will also be displayed in 
this list. 

The browser is categorised in hierarchical order of ‘rank’ starting with Design (number of DRC 
errors), then Layer, then Error type, then the Marker itself. 



 Chapter 2 – Using Pulsonix   31 

 

Each error marker is shown as an X,Y co-ordinate within the design. You can locate an error marker 
by double clicking on the co-ordinate. 

An error marker is a code used to denote a spacing or design rule violation and is created by the 
design rules checker. Design rules errors are created when two design items violate their respective 
spacing or design rule. A report can also be obtained for all of the error markers in the design by 
using the right hand mouse context menu when in the browser. 

Any error markers in the design should be cleared by running the design rules checker again. This 
will be an iterative process and you may need to be run the DRC option more than once or until all 
errors have been satisfactorily removed. 

Layers 

The Layers browser allows a fast display and switching of layers without using the Colours dialog. 
This modeless dialog is displayed as a configurable Dockable window containing a list of all the 
layers in the design. The checked layers are currently visible in the display window.  
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From the context menu you can also select options from the context menu. These further enhance the 
selection of layers and layer combinations. 

Switch Displayed Side is used to switch to the set of layers for the opposite side of the board, e.g. All 
Top or All Bottom. This is also available as a command from the Run Command option on the Edit 
menu. 

With an item selected in the design, the Show Item Layer will be displayed. You can then switch off 
all other layers other than that one. 

Double-clicking on one layer name will switch off all other layers. 

Active Layers 

The colour squares within the Layers bar can have a black square outline around both the default 
electrical and documentation layers. Click on the square itself to set that layer as the default.  If there 
is no common default (i.e. all categories do not have their default set to the same layer) the black 
outline is not drawn. 

 

When starting a new track or adding a new doc shape, the default layer defined here will be used. 

On the context menu within the Layers bar, the selections for the default layer change depending on 
the layer type selected (Electrical or Documentation Layers): 

  

Showing and Hiding Powerplane Layers 

Powerplane layers (Layers nominated as a Bias of Powerplane in the Technology file) are indicated 
by a small white thermal pad icon to the right of the layer colour square.  

 

If the powerplane is being displayed (using the View Powerplane mode), the icon is in negative. 
Click on the icon to display or hide the powerplane. The icon changes to a positive format to indicate 
the powerplane is active. 

 

The functions to display, regenerate and hide the powerplane are also on the Layers bar context 
menu. 
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More>> and <<Hide buttons 

The list at the bottom of the Layers bar contains other dockable bars that you may wish to use. If you 
click on one of these, it will become visible and replace the Layers On/Off bar. This allows you to use 
a dockable area for just 2 bars (for example) and keep replacing them with the next bar you wish to 
use. 

Find 

The Find item browser is available as a dockable bar. Using the shortcut key <Ctrl-F>, you can find 
and select design items using the drop down list box. 
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The dialog presents you with a list of items from which to choose. 

The list will show named items of the selected type in the design. In the example above, components 
are shown. If the item type does not have names (e.g. Copper) then a list of nets containing items of 
the chosen type will be shown. If the item type is Errors, a list of the possible error codes is shown. If 
the item type is Attribute, a list of the used attribute names is shown (see below). 

Click on a named item to find it in the design. It will be highlighted (or optionally selected) and 
optionally centred in the display window. If the list contains a list of nets, click on the required net or 
use <Search entire design>. The first item of the required type on the chosen net (or entire design) 
will be found. 

On the browser bar are two additional sets of icons. The set on the left side are permanent and are 
used to find components, Nets and X,Y positions. The second set on the right side is item sensitive 
and are not enabled for every item type. 

 

The ‘pin’ icon on the left hand side is for ‘latching’ this browser if ‘floating’ and is discussed below. 
The three other icons are for Finding the First item in the list, Finding for Next item and Finding 
for Previous item. 

Once items have been found (using any conditions from the Filter options, if filtering), the Find First 
will then start the search on the first item. Next and Previous will toggle through the list of found 
items if there is more than one item found. 

The Find context menu 

From the Find Browser you also have options available on the context menu to find and display 
found items. 
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The flashing of items is controlled by the Options dialog and Find page. 

 

The Item Filter in Browser Windows 

Some of the browser windows have a Filter mechanism so that item searches can be made on 
specified criteria.  

To use this option, click on the Use Filter or Change Filter button if you want to further define the 
search criteria and reduce the number of items to find. If the button has the text Change Filter, then a 
filter is currently being applied to the list. When the button is selected a set of extra filter controls will 
appear to use, these are detailed below. When the Hide Filter button is selected, these filter controls 
will disappear. 

Check the Filter Names checkbox to enable the name filter control. If the Find list contains a list of 
named items (e.g. components) or net names, type the filter string containing wildcard characters '*' 
and '?' into the control underneath the Filter Names checkbox. Use the drop down list to obtain filter 
strings previously used for this item type. When the filter string has been changed the Apply button 
will be enabled. Press Apply to apply the filter string to the list of names. 

 

Further filtering of items can be done using an attribute condition. Check the Attribute: checkbox to 
enable the attribute condition controls. Use the dropdown list underneath the Attribute checkbox to 
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choose the attribute name you wish to use. Next use the Is dropdown list to select the type of test to 
apply to the attribute value. Then, in the remaining edit box, type in a string representing the 
condition to test against. 

Press Apply to reduce the items to be found to items that satisfy the attribute condition. The attribute 
filter applies to unnamed items as well as named items.  

The ‘pin’ status of Dockable bars 

The pin on some Dockable bars is used to show whether the dialog is latched or not. In an unlatched 
status (shown in the picture below but only applicable if ‘floating’) once an item is selected from the 
list, the dialog dismisses itself. If the pin is latched, the dialog is persistent and always displayed until 
closed by you. 

  

Selection Mask Window 

The Selection Mask toolbar allows you to choose design items that are selectable within the design 
and save the mask for subsequent reuse.  

This option is available from the View menu and from the custom menu enabled by right clicking on 
any of the Pulsonix framework (enabled the same way as the Design Browser, Part Browser, World 
View etc.). It can also be enabled by right clicking on any of the existing open Browser windows and 
selecting it from the context menu. 
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Using the browser dialog 

You can use the Selection Mask on a task by task basis or you may prefer to create a selection mask 
and save it for subsequent use. 

You can create a list of selection masks that can be defined and saved. You might create a number of 
selection masks for all Track and Pads for example. 

To activate the Selection Mask and start to use it, select the Enable Select Masking check box. 
Without this selected, nothing happens. Initially, the <Default> selection mask is shown. This is the 
selection of check boxes in the list as currently set. If you change the selections and press the Save 
button, this then becomes the new <Default> selection. However, you may wish to be more specific 
about your choices and to reuse them.  

You can save multiple named selections by pressing the New button. When this button is pressed, the 
Create New Selection Mask dialog is displayed. When the Create button is pressed, the selection 
mask is saved. Using the Copy Current Selection Mask will enable you to make the selections, then 
save them. You could also use this to make slight modifications to an existing selection mask and 
save it to another named selection. 

 

The drop down list on the Selection Mask dialog displays all previously saved Selection Masks 

 

Check box options on the Selection Mask Dialog 

There are additional filters to enable refinement of the selection. With Pads selected, selecting the 
Additional Mask Parameters enables the Pad Style drop down list from where you can choose a pad 
style. This can a specific pad style or can be a wildcard name. The Wildcard wizard helps you create 
the name. 

  

With a Pad style selected, you can then only choose pads that match that style. 

Inspector Bar (Dynamic Properties) 

The Inspector Bar acts as a dynamic Properties windows, however, it is different.  
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Accessed by right clicking on the Pulsonix framework and selecting Inspector off the list of bars 
available, or access it from the View menu and selecting Inspector Bar. Generally speaking, the 
Inspector Bar would be left either docked open or floating so that it is accessible instantly.  

With an item selected, the Inspector Bar will display Properties for that item, for example, a selected 
Component in PCB: 

  

Context Menu Options 

By right clicking on the Inspector Bar, you can access additional commands: 

Change Group Order 

Select Change Group Order to rearrange the ordering of the 'groups' or sets of properties displayed 
in the Inspector Bar.  

Use the Up and Down arrows to move the selected group up or down in the Inspector Bar list. 
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Groups can be shown or hidden in the Inspector Bar using the check boxes next to the group or by 
using Show All/Hide All. 

 

Explore Net 

The group Explore Net enables you to see the nodes on a selected net and the nets on the component 
(if the node is from a component). This functionality also works in reverse, so for a selected 
component, the Inspector Bar will show all nets on that component.  

Selecting a node or net from one of the lists in the group will update the other list (Net or Component 
or vice-versa), allowing the connected nets and nodes to be traversed (or explored). 

 

Single Clicking to Navigate Nets & Nodes 

Single click will ‘navigate’ net and nodes, using a double click will highlight net. 

Find Options 

This offers the same finder functionality as the Find Bar, with the Find Bar options being used here 
as well. These options can be viewed and changed from the Inspector Bar by right-clicking anywhere 
on the bar and hovering over the Find Options context menu. 
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Other Browser Bars Available 

Other browser bars are available but are are only briefly described here: 

Shape Information/Editing Bar 

The Shape Information Bar appears as a dockable window accessible from the View menu and by 
right clicking on the Pulsonix framework. This displays detailed information about the currently 
selected shape in a grid format that also updates on the fly. It is available to use when editing PCB 
and Schematic designs, Symbols and Technology files. The text in the grid describes the shape details 
that may be edited allowing precise modifications to be made.  

 

Toggle Layers Bar 

The dockable Toggle Layers Bar allows you to activate any of your defined layer toggles on the fly, 
while in design. This is available from the View menu and by right clicking on the Pulsonix 
framework. 
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The Setup button will take you to the Setup Toggle Layers dialog from where you can define the 
Toggle Layers. 

Colours Files Bar 

This browser is used for displaying and selection of Colour files that you have saved previously. By 
selecting a file name, the colour settings within that file will be quickly applied to you design.  

 

Attribute Editor 

The Attribute Editor option presents all the attributes currently in a design (or library) using a 
‘spreadsheet style’ table, this is available as Attributes… from the Edit menu, or the Attributes 
button on the Libraries dialog.  
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You can use this editor to not only view all the attributes and values in use but also to manage 
attributes such as adding, removing and editing them. 

Attributes for different design items can be designated using the Attributes of: drop down list. The 
types of items available will depend on the type of design or library from where you have invoked 
this dialog. 

 

If an attribute has already been assigned to an item (along with a value), other items can also have a 
value assigned to them by simply editing the appropriate cell. Editing attribute values can be done 
directly in the grid, just like working with a spreadsheet. They can also be modified using the function 
buttons provided. 

Cells in the grid are coloured depending on their 'state', indicating for example whether a particular 
item has the attribute defined but empty, or defined but hidden, or defined and visible. 

The order in which items are displayed in the dialog can also be changed. Right-clicking on the 
column heading will display a context menu from which to Sort the Column. You can also use this to 
edit the name or add a new name (attribute) column heading. 

 

The columns are initially sorted alphabetically looking from left to right but the order can be modified 
to be user definable. Again, using the context menu, use the Move Column Right option. You also 
have the ability to Show and Hide Columns and to control their visibility using Column Visib 
button. 

As well as entering values directly, you can also Copy and Paste values between cells (or ranges of 
cells) in the grid or from an external source such as an Excel spreadsheet. Ranges can be copied and 
pasted using the buttons or by using standard Windows commands, Ctrl-C, Ctrl-V for Copy and 
Paste respectively. 

Use the Revert button if you have accidentally modified the wrong cells but don't want to cancel the 
whole dialog. Pressing Revert will return the selected cells to their original values, leaving other cells 
untouched. This button will only be enabled if one or more of the selected cells have been modified. 
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Mouse Operation 

The mouse is used extensively throughout the use of Pulsonix, not only for menu and option selection 
but also for interaction within the design.  

The standard left and right mouse buttons provide selection and context menu functionality 
respectively (these can be reversed using the mouse controls built into the Control Panel). 

Before using the 3-button wheel mouse, you may need to install a mouse driver that enables the wheel 
to be used. Use the Control Panel and Mouse control to setup and enable the mouse driver. Consult 
the manual that accompanies the mouse and driver if you are unsure about setup details.  

As well as the shortcut keys, Pulsonix has been equipped with the Pan and Zoom functions on the 
mouse wheel and wheel button, (e.g. available on the Microsoft® Intellimouse). This feature is only 
available when the wheel mouse is enabled using its own software, and if the wheel mouse pointing 
device is attached. 

 

When the wheel is pressed down and released, a single Pan is performed centralising the design to 
cursor position, (the same as the <P> key). Keeping the wheel button pressed down will enable 
panning of the design until released.  

When the wheel is rolled forwards (without being pressed) a Zoom In is performed to the current 
cursor position (the same as the <Z> key). If the wheel is rolled backwards (again, without being 
pressed), a Zoom Out is performed to the current cursor position, (the same as the <U> key).  

3D STEP Preview 

When using the 3D STEP Preview option in Pulsonix, you can also use the 3DConnexion 
SpaceMouse. This should be installed suing the appropriate mouse driver. Pulsonix will support the 
mouse buttons in 3D mode.  

A special note too about mouse operation within the 3D Preview – the right mouse buttom press 

requires the Ctrl key to also be pressed to enable a view rotation of the whole design. 

Viewing the Design 

With the advanced graphics of Pulsonix there are a number of methods of moving around the design 
and zooming in and out. You can use menu commands, Shortcut keys, the World View, and the 
Mouse Wheel button to achieve the same results. 

As discussed previously, the World View can be used to quickly locate known items or areas within 
the design. In normal design practice, the Zoom options will be required more often than not to get 
into detail of the design rather than into new locations of the design. 
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For this discussion we have concentrated on the primary objectives; zooming in and out quickly on 
the design using the most accessible methods. 

The Zoom and Pan shortcuts 

To zoom in and out using the default shortcut keys press <Z> for Zoom In At Cursor and <U> for 
Zoom Out At Cursor. These keys will zoom in and out respectively to the current cursor position.  

To zoom to the design extents (Zoom Extents), including the board outline and components (and 
also including any other design information such as page border etc.) use the <A> key.  

To Frame into a design area use the <F> key, click and drag an area around the items required.  

The Pan function is available on the <P> key or the middle mouse wheel button. The screen will pan 
and centre to the current cursor position, and keep panning if the <P> key remains pressed 

View selection allows you to select an item(s) and view just these in the design window without 
having to accurately frame the window around them.  

You also have the View Board and View Actual Size options. View Board is similar to View All but 
it allows you to frame into just the board outline area regardless of any other design items outside 
these extents, for example a page border would not be included in the view unless inside the board 
outline! There is no shortcut key assigned by default to this option. View Actual Size will enable you 
to visualise your PCB designs at a scale of 1:1 if this option is selected. You may need to calibrate 
your screen before using this. Do this from the Options dialog, Display page and Calibrate Actual 
Screen Width. Details about performing this can be found in the online help.  

View All can be used to view all of the design, this includes all drawing borders and text outside the 
actual board outline. Useful for viewing everything in a Schematic design as well.  

Design Item Selection  

Select Mode 

There are a number of ways that items in Pulsonix can be picked and selected.  

 

Single select 

 

Ctrl-select (modify) 

 

Shift-select (extend) 

Ctrl-shift select 

 
The diagram above shows the different modes of selection. The lighter grey shows the selected 
segment. 

Single Select 

A single click of the mouse will make a single selection of any item. By selecting another item, the 
first selected item will be deselected. Note that the item may be part of a larger entity, e.g. a single 
segment of a track. If you wish to have more than one item selected use the extended select option 
(see below). Once a selection has been made, a process or option can be performed on it. 
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Mouse Drag 

A single click of the mouse followed by a move of the mouse but keeping the mouse button pressed 
down will enable a 'drag' to be performed. This is often referred to as click and drag. In Pulsonix, this 
will perform a Move on an item, or with nothing under the cursor or within the picking tolerance, will 
perform a frame selection.  

If the Ctrl key is pressed before drag, the item being moved will also be duplicated, in this instance a 
new copy of the item will then be moved. 

Control (Ctrl) Select 

Using the Control (Ctrl) key while making a selection will modify the selected status of the current 
item. This means multiple items can be selected whether they are associated with items already 
selected or not. Using the Ctrl key will toggle the item to be selected or deselected.  

Extended (Shift) Select 

Use Shift select to increment the selection to the whole entity. This could be the complete net on any 
single page in Schematics, or the complete connection/track for all visible tracks on the net in PCB, or 
Component if a pad has been selected. By keeping the Shift key pressed and selecting the item again, 
the selection is further increased. This can be shown on a track that spans more than one device. The 
complete 'net' for the track would be selected.  

Some examples worthy of note for extended (shift) selection are; for any completely selected cutout 
using Shift will select the whole shape, and for a completely selected copper shape associated with a 
template using Shift will select all copper shapes on the template. 

Ctrl-Shift Select 

The Ctrl and Shift keys together add to the selection and increase the selection to the complete item. 
You might use this if attempting to select two track paths for tracks on different nets.  

Path Select 

An option on the context menu in select mode allows you to select all segments in a shape or a track 
path between two selected points. If the selected points are in the middle of segments, they are split. 
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The path select mode can also be accessed by simply dragging along the line or track segment 
(provided you have this mode enabled in the Options dialog on Select page under Drag). 

The process for inserting segments is to drag along a segment which selects part of the segment, and 
then drag the selected segment to create a ‘top hat’ shape as shown below. 

   

If you wish to select more of the shape, then simply drag further along the shape. Once the drag has 
been initiated and the shape segment picked up, the mouse movement will mimic the shape of the 
segment without having to follow it accurately. 

 

If you don’t want to drag to select the path, the Select Path option can also be used from the context 
menu. 

Possible usage 

Uses of this could include: 

• Dragging segments in a track or line shape to insert a ‘top hat’ 

• Unrouting a track between two points 

• Necking between two points (using the Select Path command followed by <S> Style to change 
the segment thickness) 

• Changes layer between two points 

Frame and Polygon Select 

Frame and Polygon Select are used to make selections based on areas drawn using the mouse. The 
difference between the two modes is that Frame Select allows you to draw a rectangular frame 
around items, whereas Polygon Select allows you to draw any shape to make the selection.  

During Frame/Polygon Select you can also use the shift key to select extended items. 

Frame Select is used by clicking and dragging the mouse around the objects required within the area. 
This is the default mode but if you wish to use Polygon Select, right click in free space and pick the 
Polygon Select option from the context menu. 

Both Frame Select and Polygon Select modes will act on individual track segments to facilitate 
segment picking. These operate with the check box in Options, Select page, Select if Completely 
Framed set to on or off. 
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Line Select 

With nothing selected in the design, right click and the new Line Select selection mechanism will be 
available, if something is already selected it will be on the Select sub folder. Use this to define a 
straight line to select only items that cross that line.  

 

Once selected from the menu, draw the line 
across the items you wish to select. 

The selection will then be made: 

 

  

Like Frame Select, keep the Ctrl key pressed down to alter the selection. Use the Shift key to extend 
the selection to whole items. 

Line Select is also available from the context menu in Align mode and Latched operations such as 
Move when nothing is initially selected. 

Double-click Editing 

By using double-click on an item you will automatically enter the edit mode. On Schematic 
connections and PCB track items this means the segment selected will be edited so that its path can 
be changed. On PCB connections the connection will be converted to a copper track ready to have the 
path created. This editing mode can also be used for all other shape based items or line editing.  
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For all other design items the Properties dialog for the selected item will automatically be displayed, 
allowing you to make edits based on the contents of the dialog. 

Auto-select Mode 

Pulsonix has an active architecture, with the database capable of extremely fast selection. To utilise 
this fast selection, you have an Auto-select mode of operation available. Auto-select allows you to 
move the cursor over items within the design and obtain instant selection without clicking the left 
mouse first. Clicking the mouse key now performs the 'Edit' function on the selected item.  

Cyclic picking 

When attempting to select items within a dense area of the design, it is not always easy to pick the 
item required at the first attempt. Under these circumstances Pulsonix has a system of picking that 
'cycles' through items in close proximity to aid the selection. This allows you to make a selection, 
then toggle through the design items adjacent to it until you select the item required.  

The keys used for the commands Select Next and Select Previous can be user defined but by default 
the Next command is set to <N>, the Previous command is not set by default.  

Select from popup list 

Holding down the Alt key and selecting overlapping items, a context menu will list all items at that 
position, allowing you to select a specific item based on its description rather than the item. This is an 
alternative to selecting the first item, then pressing the <N> key to get the new selected item within 
the picking tolerance.  

 

This feature can be disabled in the Select section of the Options dialog and Select page. 

Configurable selection flags 

In addition to the ability to select the next and previous items in the design using cyclic picking, 
Pulsonix also contains a mechanism for enabling and disabling design items. This mechanism is 
located on the Colours dialog alongside the Displayed selection.  
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By making a selection in the relevant check box, you can make individual design items selectable or 
not.  

'Latch' Mode 

Latch mode is a mode of operation that allows a tool to be pre-selected (latched) and applied to many 
items until it is toggled off (unlatched). For example, the Rotate mode can be latched down and 
rotations applied to many components in the design in turn.  

To exit latch mode, you can either select the option again to unlatch it, or press the <Esc> key on the 
keyboard to return to Select mode. You can also use the Cancel option from the context menu after 
right clicking the mouse. 

Context menus 

The right mouse button can be used extensively throughout Pulsonix to reveal context menus, these 
are also known as shortcut menus or pop-up menus. These menus can be accessed during an 
operation or by direct selection using a ‘right mouse click’, each menu has a set of relevant 
commands in 'context' for that option. 

Once familiar with the system, you can access the context menus by right clicking on an item rather 
than left mouse clicking to select and then right mouse clicking. By right clicking directly, you can 
select the item and display the appropriate context menu. 
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The example above shows the contents of a typical context menu, this one from the pin item in a 
Schematic design. Once displayed, the context menu will remain on the screen until an option from it 
is selected or the <Esc> key pressed. The menu options are selected using the left or right mouse 
button. 

The Design Settings Dialog 

Design-based options are defined on the Setup menu in Technology and Design Settings dialog. 
These are created for and saved with each individual design, they would also be saved to the 
Technology. 

 

The Options Dialog 

Much of the main option customisation is done through the Options dialog on the Tools menu with 
some set-up through the Folders option. These are generally options on the tools themselves, such as 
being able to set the editing angle of the lines etc. 

There are subtle differences between the Schematic and PCB Options dialogs but these relate mainly 
to the Track/Connection editing functionality and general PCB functionality, such as On-line Design 
Rules Checking and Move (because of Component Pushing etc.). 
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The tabs are set out so that they are grouped by logical areas of functionality. The General tab 
(shown above) is used to set Pulsonix system type information for example. 

More detailed information relating to setting up preferences through the Options dialog will be 
discussed in each section of the manual relating to particular features. 

The Properties Dialog 

Each item in the design contains a set of characteristics that can be viewed or edited using the 
Properties option. Some items within the design are made up of several parts, each of which is 
individually selectable and have its own properties that can be viewed. For example, a Schematic 
Component might contain a number of terminals (or pins), some lines that represent the symbol shape 
and some text. The terminals will also have their own properties, such as shape and size etc. 

In addition to item properties, there are also Design Properties and Document Properties. Design 
Properties are used to show design based information, such as Attributes and the Associated Parts.  
Document Properties shows general statistics about the current design being edited, plus you also 
have the Inspector Bar to use. 

Design item properties can be viewed by selecting the item and clicking on the Properties option 
from the context menu. The example below shows the Properties of an SCM Star Point. 
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You can also select the item and click the shortcut key <I> (this is the installed default and can be 
changed if required). 

From the Properties dialog you can view detailed information about the item selected and can also 
use it to make changes, such as the items name, its rotation/mirror status (if relevant), etc. Major item 
changes can also be made, such as a change to the footprint style from DIP to surface mount for 
example. 

Multi-Item Properties 

The Properties dialog is also capable of changing multi items of the same type. Only items of a 
similar type can show their Properties together. If the selection includes dissimilar items, Properties 
will not be available. 

The example design over shows the selection of multiple gates of a Part but one of the gates is 
rotated. All of the gates belong to the same device (U1) and all have different Positions in both the X 
and Y direction. In the design, only one gate has a different X position because it has been rotated, as 
shown by the Angle. The Y position would be different because they are placed in a line. All other 
details are the same. 

 

From this dialog you could now make all the gates the same rotation by changing the Angle: to a set 
value, and change their Position: in the Y axis so that they were all aligned vertically with each-other.  



 Chapter 2 – Using Pulsonix   53 

 

Once this was done, the <Different> indicators would show a value. This would be reflected in the 
item changed in the design. 

Attributes 

Another use of the Properties dialog is for adding attributes to design items. From the Attributes tab 
you can assign an attribute name and value, you could add a <Hyperlink> attribute on the Comp 
Attributes tab for example. 

 

You can also opt to show the attribute on the item by selecting the check box on the left of the 
attribute name and value. 

Adding Attributes from a file 

With the Attribute Properties dialog you can also take an external text file or selected text and 
simply drag and drop it onto the attributes page.  

The whole text file can be dropped onto the attributes to add new attributes or edit/update existing 
values. The format must in attribute=value, such as MFR=Motorola. Partial text values can be cut 
and pasted into the attributes page if you prefer not to use the whole text file. 
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Chapter 3. General Utilities 

Undo/Redo 

Pulsonix contains unlimited multi-level Undo and Redo capabilities for use through the product. 
Undo can be used to reverse the last operations that have been completed. Undo can be used 
sequentially to undo more than one operation. It can also be a useful and flexible tool to interactively 
try different iterations of an operation, manual routing for example.  

If you use lots of Undo levels, this will use up your memory. In this case, you should either install 
more memory or restrict the number of Undo levels. 

Undo and Redo steps are only available back to the maximum number of levels set. Not all operations 
are available to Undo/Redo, a list of unavailable operations is listed in the on-line help under Undo. 

The number of Undo levels is set up in the Tools menu under the Options function and General tab. 

 

With any Undo level set, say 4, when the fifth Undo step is required it will overwrite the first 
operation in the Undo buffer that is then lost. So care needs to be taken if using restricted levels of 
Undo. 

Using Undo and Redo 

Undo and Redo are invoked using the standard Windows shortcut keys <Ctrl-Z> and <Ctrl-Y> 
respectively. These have been defined as part of the installed set of default keys but can be changed if 
required; these are also available on the Standard toolbar as buttons. Redo is only available once an 
Undo has been performed, until then, it remains on the menu but is greyed out as unavailable.  

Interactive Operations 

Overview 

During operational use of Pulsonix there are a number of interactive operations that allow items to be 
moved, rotated, mirrored .and edited. The following sections cover this collective set of features and 
describes their use and how to set their mode of use where applicable.  

Moving Items  

There are two methods of moving objects in Pulsonix. The first and most widely used is the drag and 
drop methodology, for use when an interactive move is required. This is modeless in that it can be 
used without a mode selected. The second method is the Move mode. This can be accessed from the 
Edit toolbar button and from the context menu. It allows you to move items with the mouse button 
left up.  
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By clicking on any item in the design you can use click and drag to move that item. Depending on 
how much of the item is selected depends on what is moved. For example, if a segment of a shape is 
selected and dragged, the segment will be 'stretched' until released. If the whole shape is selected, the 
whole shape will be moved to a new location. Components are a special case for this type of move. 
When a Component is selected and regardless of how much of the Component is selected, the whole 
Component is moved. The Component is made up of individual entities 'grouped' together to form the 
Component library shape, thus is acts as a complete unit when moved. 

The alternative methods for moving items are to select the item first and click the Move button from 
the Edit toolbar, or Move from the context menu. Once in Move subsequent options are the same. 

You can also use Move in Latched mode. This means that Move can be selected from the Edit 
toolbar first, and then applied to items within the design. This mode will be retained as long at the 
Move button is latched. This option can be unlatched by selecting another option or by selecting the 
Select button or by pressing the <Esc> key. 

 

When in any move operation, a single click of the mouse will release the item in its 
current location. During this operation a modal cursor is displayed (this must be 
switched on in the Options dialog and General tab). 

During any move operation the context menu can be accessed to provide additional options for use, 
for example, Rotate, Mirror, Layer, Style etc. The options available depend on the current 
application and the item the Move is being applied to. 

The context menu example is split in half to show the extensiveness of the optiosn available: 

   

The context menu above shows typical functionality found when in the Move option. This example is 
for the Move Component option. 

When using Move, a Grids selection is available from the context menu, please refer to the next 
section headed Grids for more information. 

Line segments that are Mitred or Curved can also be moved but will retain their size and make the 
adjoining segments each side dynamic. To edit or move a Mitre or Curve you should use the edit 
facility. This can also be accomplished by double-clicking the mouse on the segment to be edited and 
then dragging the segment to the required position. 

The ends of straight line segments and corners in general on open shapes can be moved by selecting 
the end of the line and dragging it. 



 Chapter 3 – General Utilities   57 

 

A small circle appears at the end to indicate that it is the end segment that has been selected. From 
this point you can drag the line item to resize it. 

Mirror 

Mirror can be used on most items within the design including connections in Schematics. Sometimes 
also known as ‘Flip’ but called Mirror in Pulsonix. It is available from the Edit toolbar, using the 
shortcut key <M>, and from the context menu when an item is selected or being moved. Mirror is 
also available from the context menu within the Item Properties dialog for some items. It is not 
available for all selected design items.  

Mirror can also be used as part of Move. During the moving of an item Mirror can be selected from 
the context menu or from the keyboard using the shortcut key <M>. 

Mirror in Schematics 

Within Schematics, Mirror will flip a Component or Documentation Symbol using the centre of the 
symbols bounding box as the axis point. Text in Schematics cannot be mirrored. 

When used with connections, Busses and Shapes within Schematics any dynamic segments can be 
mirrored across to their opposite diagonal point. This applies to any two segments but does not apply 
to more than two segments or less than two segments. 

 

Mirror in PCB 

When used in the PCB editor, Mirror has three effects. The first will flip the complete Component, 
Documentation Symbol and Text to the other side of the design (if the alternative opposite side is 
available). When surface mounted components (with surface mounted pads defined on a surface 
layer) the pads will also be mirrored to the other side of the design automatically. The second effect 
will work on whole design shapes and will mirror the shape on the same layer. The third mode will 
work on any two dynamic segments. 
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Mirrored Components 

Components and Documentation Symbols are mirrored around their Component origin axis to 
maintain their position. The diagram below shows how the Component will look after rotation but has 
been moved over to the right for clarity.  

The axis points would actually be coincident once mirrored. 

 

Where whole shapes are selected, the shape is mirrored about its origin. This would be the pick point 
of the shape; in the example below the axis would be the edge of the shape.  

 

Where two dynamic segments are being edited, the segments are flipped to their opposite diagonal 
corner. The two examples below show the track segments flipping, and the dynamic segments of a 
shape flipping.  

   

Mirror can also be used in Latched mode. To use this, select the Mirror button from the Edit toolbar, 
and apply it to each item selected. You must deselect the option by selecting the Select button or 
another option before Mirror is unlatched. 

 

When used in this mode, a modal cursor is available. 

Rotating Items 

Rotate can be used on most items within the design. It is available from the Edit toolbar, using the 
<R> key as a shortcut, and from the context menu when an item is selected or being moved. Rotate is 
also available from the Item Properties dialog for some items either single or multiple items of the 
same type (it is not available for all design item types). This is particularly useful if a number of 
components are selected for rotation to the same angle, for example. 
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When moving an item, Rotate can be selected from the context menu or from the keyboard using the 
shortcut key <R>. For ease of use, rotation steps can be taken from the context menu as steps of 90 
degrees, or Rotate One Step to rotate by 90 degrees.  

Rotate can also be used in Latched mode. To use this, deselect everything and select the Rotate 
button from the Edit toolbar, and apply it to each item in turn. You must exit the option by selecting 
the Select button or another option. 

 

When used in this mode, a modal cursor is available 

Rotation steps can be defined down to 1/100,000th of a degree, this level of precision allows accurate 
rotation of items when using polar/radial grids. The precision and rotation unit type of Degrees or 
Radians can be defined from the Settings menu under Angle Units on the Units dialog.  

 

When using the rotation modes, the setup of the angle for which items use is defined from the Tools 
menu and Options. From the Interaction tab use Rotation Step to set the default rotation step of 
any item rotated. 

Rotation steps are always defined in an anti-clockwise (Counter-clockwise) direction but can be 
defined in a clockwise direction by specifying the rotation step as a -ve (negative) number, e.g. -90 
(degrees). Normally the rotation steps would be specified as a positive number. Rotation steps can be 
specified in any value or part value by typing in the number required.  

Polar Rotate 

Check this box to change the two edit boxes to accept an Angle and Magnitude to define the position 
of the selected items using absolute polar coordinates applied about the rotation point. The selected 
items will be rotated about the rotation point until their origin is at the required angle and then moved 
towards or away from the origin until the distance from the selection origin to the rotation point is 
equal to the required magnitude.  

Special cases of rotation 

Bus Terminals in Schematics 

The 45 degree line emerging from a bus is called a bus terminal. This terminal can be setup to be 
always Up or Down (and Left or Right on horizontal busses) but can never be mixed to show both Up 
and Down (and Left/Right).  
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The default direction of the bus terminals is set in the Design Settings dialog, under the Defaults tab. 
Once a direction has been set and a bus terminal used on the design, the direction can be changed 
using the Rotate option. 

Readable Text in Schematics 

When any item containing text or any text item is rotated in Schematics, the design can be setup so 
that the text is always readable from the bottom or the right of the design page. If the text item is 
rotated further than an angle that makes it unreadable it is automatically rotated back to a readable 
state. This mode is set in the Design Settings dialog under General and is defined setting the check 
box under All Text to Adjust To Readable Orientation.  

This mode can be overridden for individual terminals by using the Ignore Readable Orientation 
check box in the Text Properties dialog. This is also available in the Attribute Properties dialog. 
Selecting this switch disables the effect of the Adjust To Readable Orientation switch (from Design 
Settings – General dialog) for that specific text instance.. 

 

Grouped Items 

Grouped items (from Frame Select, Polygon Select or Multiple select) can be rotated and done 
using the centre point of the group as the rotation origin from where they are rotated. The bounding 
box of the group includes any text or origin items as well as any visible or invisible items.  

Design Repositioning 

The complete design may need to be rotated during the design process. This can easily achieved by 
right clicking the mouse in an area of free space on the design. From the context menu select 
Reposition Design. You can apply an X and Y positional shift or just apply a Rotation to the design.  

Bus terminal 
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Design Rotation for Output 

The complete design may require a rotation from Landscape to Portrait for example, to allow it to 
fit on a paper page when plotted. This is not required if this is the sole requirement, the CAM/Plot 
output feature enables you to plot the design rotated by the simple use of a Rotate Design check box 
on the Plot Positioning tab.  

Lock and Unlock 

Lock is used to fix design items so that they cannot be moved or edited. Unlock is used to 'release' or 
Unlock the item following a Lock operation.  

It is available from the Utilities menu and the Edit toolbar and from the context menu when an item is 
selected. Lock is also available from the Item Properties dialog. 

Unlock is only available on the context menu after a Lock has been performed on an item. 

Lock and Unlock can also be used in Latched mode. To use this, deselect all and select the Lock 
button from the Edit toolbar, and apply it to each item then selected. You must exit the option by 
selecting the Select button or another option. 

Model cursors are available to show the current Lock or Unlock mode being used. 

When attempting to perform an operation on an item that is locked you are presented with a warning 
dialog from where to make a choice of which action to make: 

 

This dialog tells you that the item is Locked but also gives you the option of continuing with the 
operation requested. 

By selecting one of the radio buttons, then the Perform Operation button, the operation can still be 
performed but is completely under your control. You also have the opportunity to not perform the 
operation, if selected by mistake for example.  

Special cases 

Importing from other systems 

When importing a design from another system using one of the built-in import filters, some items are 
automatically locked in place when the design is viewed in Pulsonix. These items can be subsequently 
unlocked using the Unlock option. 
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Track Locking in the Auto Router 

While using the integrated auto router option, you have the ability to lock tracks that already exist in 
the design and to lock new tracks added by the auto router. Once subsequently using the interactive 
features of Pulsonix you can lock or unlock any tracks as normal anyway. 

Track Locking 

Tracks can be locked in the PCB design editor. This maybe particularly useful when using 'fanout' 
type track patterns on a Component as it will prevent accidental removal of tracks and vias from the 
design. If using the auto router, you also have additional control over their removal, see above.  

Locking Vias 

Vias can be locked in isolation to the tracks that they are connected with. This will prevent their 
removal even if connected to tracks that become deleted. You may have critically positioned the via 
in the design and allocated it as a Testland. Even with no tracks connected to it, the via still remains 
connected as attached to the net.  

Cut, Copy, Paste and Duplicate 

Cut and Copy are used to copy and remove items from the design and place in the clipboard, or to 
take a direct copy of an item and place into the clipboard respectively.  

Paste is used after items have been placed in the clipboard (from using Cut or Copy) and adds them 
to the design.  

Duplicate is used to copy item(s) and paste them into the design. This option is used for direct copies 
within the same design.  

All of these options can be used on all design items. They are available from the Standard toolbar, as 
shortcut keys from the keyboard, and from the context menu when an item is selected. These options 
are also available as menu options from the Edit menu. 

As a default, the shortcut keys in Pulsonix include the standard Windows shortcuts where available 
but these can be redefined if required. 

Cut  <Ctrl-X> 
Copy  <Ctrl-C> 
Paste  <Ctrl-V> 
Duplicate <Ctrl-D> and <Ctrl-drag> 

As an additional shortcut method to using Duplicate, you can also use <Ctrl-drag> while making a 
selection. Instead of moving an item, the item is duplicated and the new copy moved ready for release 
in its new position. 

These options are available on selected groups of items regardless of whether they are similar or not. 
The same rules apply to groups as for individual items or multiple selected items. 

Special cases and rules of operation 

Paste/Duplicate into the same design will cause the Resolve Net Names dialog to be displayed if the 
selection contains any named nets. If the selection only contains default net names the net names are 
automatically incremented to the next available in the sequence while being added to the design. Any 
Component names within the selection are also automatically incremented to the next available in the 
sequence. 
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Schematics 

If the selection contains a portion of a multi-gated device, the unselected gates or unused gates are 
added to the Component Bin for later use. 

While Duplicate cannot be used across pages, Paste can be used. Selected items can be Cut and 
Copied to other sheets if required.  

Items being Pasted onto a page are checked across all pages, this applies to both net names and 
Component Names. 

Safe Mode 

When using Pulsonix in Safe Mode, Paste and Duplicate will not be available if it means adding in 
new design items that change the netlist in any way. In this mode, if you wish to change or add design 
items you must return to the Schematic design and make the changes there before using Synchronise 
Design to make the changes to the PCB. 

Copy to another shape type 

When using Copy/Paste on a shape, the shape can be added to the design as a new shape type. 

Before pasting the new shape into the design you put Pulsonix into the Insert Shape mode required 
for the new shape. For example, if copying a Board Outline shape to a Template shape, you should 
copy the board first, then select Insert Template shape and Paste. The new copied shape will be 
exactly the same shape as the board outline but will be a template ready to be placed. While in this 
Insert state, more options are available from the right mouse button, change layer, change style etc.  



64   Chapter 3 – General Utilities 

Grouping Items 

Items in the design can be grouped together for moving etc. When more than one item is selected, the 
Group option appears on the context menu. Selecting this option causes all the items to be added to a 
new group. If the items are deselected and then one of the items is selected, all other members of the 
group become selected.  

 

If the group is to be named, select the group and select Name Group from the context menu. 

 

Groups can be named and the group and name passed through from Schematics to PCB designs. If the 
group is to be translated to PCB, it must be named. Named Groups can be managed using the 
Technology dialog and Group Names tab. 

 

Groups are created as Tight groups, that is all members of the group act as one. If you want to make 
changes to individual members of the group, change the group type to Loose. This can be done by 
selecting the group and unchecking Tight Group on the context menu. Any group member when 
selected will then act individually. To change back to a tight group, select any member of the group 
and check Tight Group. 
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Create PCB Group from SCM Block 

You can also mark a Block instance (using Block Properties) to Create a PCB Group when in PCB. 

The equivalent group is added to the PCB and Synchronise Design will keep them in-line. The group 
has the same name as the Block, with an optional prefix (which is defined in the PCB, see below).  

 

Block Name Prefix 

If required, set the Block Name Prefix for use in the PCB from the Technology dialog, Design 
Settings – General/Defaults and Defaults button. Choose Block and type the name of the Block 
Group Name Prefix: 

When viewed as a group, the name will look like this, showing the Prefix first, followed by the Block 
Name. 

 

Deleting Items 

Delete can be used on almost any item within the design. Some exceptions are detailed in the Special 

cases section below. Delete can be used to delete selected item(s), or can be used in latched mode 
where the Delete option is selected first and applied to items within the design. When used in latched 
mode you can only exit it by selecting the Select button on the toolbar or another option.  

The Delete option can be selected by pressing the Del key on the keyboard or by using the Delete 
option from the Edit menu, or the Delete button on the Edit toolbar, or the Del option on the context 
menu. 

There is no confirmation to delete, however the Undo option can be used to recover any deleted 
design information, provided an option hasn't been used that removes the Undo levels from memory. 

 
When Delete is used in Latch mode, a modal cursor is available. 

There are 3 different ways to perform delete that are relevant to a Component or Symbol, for all other 
item types the Delete function deletes the item. 
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• Unextended Delete will just delete the Symbol leaving any connections ‘dangling’. This can be 
used in conjunction with the Auto Weld option in Schematics.  

• Extend Delete will delete the Symbol and connections leading from the pins on the Symbol back 
to the pin or junction at the other end of the connection.  

• The default Delete option behaves as Unextended Delete in Schematics and as Extend Delete in 
PCB. 

• The default hot key for Delete is the Delete key, with Shift-Delete for Extend Delete and Ctrl-
Delete for Unextended Delete.  

Special cases 

Schematics 

Deleting one gate of a multi-gate Component will not remove the Component completely if one of the 
other gates on the Component are still being used. It will put the deleted gate into the Component Bin 
as unused. This will happen to each until the last gate of the same Component is removed from the 
design, at this point all the gates for that Component will be removed from the Component Bin as 
well.  

 

In the previous example shown, if four gates of U1, a 7400 device, are placed on the design, when 
U1-b is deleted it appears in the Component bin and U1-a,c,d remain on the design. Finally, with just 
one gate left on the design, U1-c say, all other gates appear in the Component bin. When U1-c is 
removed, U1 with all four of its gates are removed from the Component Bin and the design. 

Safe Mode 

In either of the design editors you can run Pulsonix in Safe Mode (by selecting this mode in the 
Options, General dialog). This means that the netlist (nets and components) cannot be changed in 
that design editor without using the Synchronise Design option. In this mode, you cannot delete any 
nets or components that would affect the netlist. Safe mode can be chosen for either the Schematic or 
PCB designs deoending on which one you select as your ‘master’ design. 

Deleting Nets/Tracks 

To remove a connection in PCB you must use the Remove From Net option from the context menu 
once the connection has been selected.  

Delete on tracks in PCB has the same effect as Unroute Track. If you want to remove the track and 
the connection, you must use Remove From Net.  
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These modes can be used when the PCB is in context, i.e. either as the master when used with 
a schematic design or when being created without a schematic design. 

Inserting Text 

Single line and multi-line text can be added to both Schematic and PCB designs as well as library 
items. The style of the text used in the design is defined in the Technology dialog under the Text 
Styles tab. 

From the Technology dialog, you can also change the Text Styles to also include TrueType fonts as 
an alternative to the standard ‘stick’ system stroke font. 

 

The Name is used to define the name of the text style when used in the design. The Width and Line 
Width define the character width used and the thickness of each line 'stroke' making up the character. 
The Font can be defined from the list of installed Windows system fonts and the default <System 
Stroke Font>. 

As with all styles to be used in the design it is more efficient to define a range of relevant styles for 
Text. This will allow you to categorise the text being added into types, this makes it easier to change 
all of a type by changing the style values. 

You can also define text styles as you insert text into the design using Change Style from the context 
menu or pressing <S> on the keyboard. 
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From this dialog you can change the Size and Line Width of the text but will also allow you to 
change the style name or use the default style name presented to you. The style presented in this 
dialog is added to the Technology dialog under Text Styles. It can only be edited in the Technology 
dialog and not in the Text Styles dialog where it was initially added. This feature is in addition to 
adding the text style to the Technology dialog directly as part of setting up your design styles. If using 
this method you should also remember to alter the Technology file if the styles are required in other 
designs. Technology files are described in the next chapter. 

In PCB, text that is added to electrical layers becomes an electrical 'block' that is checked during 
Design Rules Checking and On-line DRC, and that has its own (Text) Spacing Rules defined in the 
Technology dialog. Text on non-electrical layers is not checked. 

The text origin can be changed for each individual text string. Multiple text items can also be selected 
and their origins changed together. Once the text items have been selected they can be changed 
through the Item Properties dialog on the context menu. You can select from one of nine Text 
Alignment positions. By default, the text position is always Bottom Left, this can be changed 
through this dialog or by using the Change Text Alignment option from the context menu. 

 

You can also change the colour of text items to contain their own colour rather than that defined in 
the Colours dialog for Text. Care should be taken when changing the colour of particular text items 
so that there isn't confusion identifying the layer for example that the item appears on. 

The text font can be changed from the Properties dialog also using the Text Style tab. 
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Vertical Text Alignment for Multi-line Text 

The switch, Multi-Line Text Vertical Align, in Design Settings, General, under All Text enables 
you to set the text position for multi-line text in the vertical axis. When enabled, this causes all multi-
line text to vertical align using the height of all the text, not just the first line alignment. This is a 
design setting, so it will change the vertical alignment of all multi-line text in your design so care 
must be taken if applying this after already having added multi-line text, especially on electrical 
layers.  

 

The two images below show the effect of this switch. To clarify where the alignment is taken from, 
horizontal and vertical construction lines have been added to the text to show the movement. 

The left image is before switch is activated (and as current product), the right-hand image is after: 

   

Special cases 
Pulsonix has the ability to cope with special text cases where formatting or style is required. 

Force to Upper Case 

By defining what text items should be forced to upper case (capitals) it then makes no difference 
whether upper or lower case text is typed in, the text will always appears in upper case. This is 
particularly useful for Component names that by default are forced to upper case.  

This feature is setup in the Technology, Design Settings dialog on the Naming tab. It is 
recommended that unless experienced with Pulsonix you should not change it.  
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Case sensitive pin names 

The case sensitivity of pin names can be changed using this check box. This means that both upper 
and lower case text can be typed in and the system recognises the differences, even if only subtle. For 
example, differences such as A1 and a1 would be understood, even if you typed one of them in by 
mistake!  

This mode is set in the Design Settings dialog under Naming and is defined by setting the check box 
under Pin Names to Case Sensitive. 

Adjust text to readable orientation 

When any item containing text or any text item is rotated in Schematics, the design can be setup so 
that the text is always readable from the bottom or the right of the design page. If the text item is 
rotated further than an angle that makes it unreadable it is automatically rotated back to a readable 
state. This mode is set in the Design Settings dialog under General and is defined setting the check 
box under All Text to Adjust To Readable Orientation.  

���� To add text to the design 

1. From the Insert menu, select Insert Text.  

2. Type the required text into the window. 
The text can be upper and lower case. Multi-line text can be added by pressing <Enter> at the 
appropriate places. You can use all the normal text editing facilities including copy and paste. 
The full ISO-Latin-1 character set is supported. You can also add barred text using the barring 
character. 
The Insert Text dialog changes slightly between the Schematic and PCB design editors shown 
below: 
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3. On completion click OK and position the text. 
The schematics Insert Text dialog has a drop down list for drawing on All Pages At This Level. 
Whenever text common to all pages is edited, the changes are reflected through all the pages. 
This is useful within company sheet outlines that are the same on all pages for example. 

4. The text will be positioned at the end of your cursor. 

5. Use the mouse to position the text at the exact location required. During positioning, you can use 
the options on the right hand mouse context menu to: Mirror or Rotate the text and also change 
the text Style and Font. The justification of the text string can be altered by selecting the text and 
using Properties. 

6. To release the text, click the mouse. This will release the current text item and put you back into 
the Insert Text dialog. Click the <Esc> key to exit this mode. 

Barred text 

Barred text can be added to the design (both Schematic and PCB). There are two steps to enable 
barred text. The first is for the definition of the barring character in the Design Settings dialog under 
the General/Defaults tab.  

 

This by default is the underscore ( __ ) character but can be changed if required. The second is to 
enclose the text string to be barred with the barring character. This must be doubled both before and 
after the text string to enable the bar. 

 

In this example the words Barred Text are enclosed with double underscore characters and the 
words Not Barred are not enclosed to highlight the differences. There is a subtle space character 
between the ending barring character and the word ‘Not’. 

When added to the design, the text appears like this: 
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Mitring and Filleting Corners 

Mitres (45 degree corners) and Fillets (curved corners) can be added to any shape or line item, 
including PCB tracks and Schematic connections. Mitres can only be added to 90 degree corners on 
straight segment lines. There are a number of methods for adding and editing them. 

Mitres and Curves behave in the same way and are added and edited the same way. 

Basic adding of Mitres 

Starting with two orthogonal segments creating a 90 degree corner, a Mitre can be added by double 
clicking on the corner. You must double click rather than picking and dragging, the pick drag function 
will move the corner and segments rather than adding the Mitre. You can also select the Mitre Corner 
option from the context menu if the corner is selected. 

 

When Mitre Corner is used, a modal cursor is displayed. 

The Mitre is a free moving 45 degree corner on the two orthogonal segments. This snaps to the grid 
points of the Track Grid or the Working Grid/Free Grid that has been previously used when inserting 
the shape or track. By using a grid rather than leaving the Mitre to be a free grid segment you can 
ensure that the corners of the Mitre are always on-grid. 

 

Once inserted, Mitres can be easily edited by double-clicking on the 45 degree segment. To remove a 
Mitre, double click on it and drag it out to make it a 90 degree corner again. 

For connections in Schematics you cannot used the double-click method, you must first select the 
corner and then use the Mitre option from the context menu. If you use the double-click method of 
editing an existing corner, the program will attempt to insert a connection and will therefore add a 
junction point to the corner instead of editing it. 

Fixed Mitre sizes 

If you require all Mitres to be the same size, you can set the size and set the snap to this size when the 
Mitre is inserted. 

The Mitre size is set in the Options dialog under either the Edit Track/Connection tab or the 
Interaction tab, depending on what type of item you are editing. Editing options of shape items 
except for Tracks and Connections (in Schematics only) are set through the Interaction tab. The 
example tab shown below is for Interaction but the information presented is the same for the Track 
and Connection tabs as well. 
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The setting used is Under the Orthogonal Mitre and Size. The Size will be set in the current Design 
Units. Orthogonal Mitre does not need to be selected for this option to operate. This is only selected if 
you require Auto Mitring to be operational, see below for description.  

To use this default Mitre size you must first be editing the corner. With the corner selected you can 
right mouse click and select Mitre Corner from the context menu, this will edit the corner. If you 
immediately right mouse click again you can select Default Mitre Size from the context menu. This 
will snap the Mitre to the default size set in the Options dialog. 

From the context menu, you also have the option to Fillet corner to make it curved. 
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Chapter 4. Setting Up The Design 

Overview 

There are a number of features and options that allow you to setup a design prior to starting the actual 
design work itself. Some of these features are highly desirable, like setting up the working Units for 
example or the interval of the security copies of the design. Others are not essential but preferences, 
like changing the colours to your own choice. With the differences between the Schematics and PCB 
design editors, only the major differences are discussed and some of the more important subtleties. 

Using Folders and Files 

Folders 

When saving files you can set up the save locations. The Folders option on the Setup menu contains 
the path setup information in one dialog of all the options that use paths. By default, during Setup the 
paths within the Folders dialog are set to the standard Pulsonix installation paths, these can be 
changed by editing the relevant one. 

 

The General tab defines the folder the program starts up in and the location that is used for ‘general’ 
non-design based reports, such as the shortcut keys report.  

The choices on this tab allow you to decide the best start-up location, it may be that you wish to start 
on a server or a local disk but in a working folder of a particular project etc. There are three options 
that give you a selection of start-up choices. This tab will allow you to choose a folder that could 
contain your current working design. When Saved, the design will overwritten at its current location. 
If Save As is used, the current folder of the design will be displayed and you can change this as 
required. 

The Design Backups tab is used for specifying the location of Design Security Copy files, Backup 
Copies of the design and Restore Points.  
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See below under Security Copies and Backups for details about specifying the format of the files 
during save. 

The CAM/Plot tab is used for specifying the location of CAM files and for specifying the name 
definition used of the CAM file output.  

 

You can define the filename and folder name using keywords that will be replaced with the relevant 
text when a plot file is created. This allows you, for example, to use the plot group name to separate 
plots that are project required as opposed to simple documentation. You can also use this section to 
specify that a particular plot type (PDF for example) will use its own folder to this type. Use the This 
Folder below design file: and set the folder to $(PlotDevice)  

Using the Plot Settings page in CAM Plots, use the Output File Names Template section with a 
template edit box and a popup menu button to make the name creation process more convenient when 
adding keywords. The popup menu button next to the folder edit box is used to make naming 
selections. 

Most keywords are obvious, but there are a few that need additional explanation: 
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$(PRE) and $(POST) are used to add pre-text and post-text either side of a variable field. For example 
“$(PRE)[$(Variant)]$(POST)” will be replaced by “[USA]” for a plot for variant “USA” and will 
produce nothing for a plot with no variant.  

$(DesignType) is replaced by “pcb” for a pcb design and “sch” for a schematic design. 

$(CombinedType) is the same as $(DesignType) but is only used if the filename is a combined output 
containing several plots (like pdf). 

The Reports tab is used for specifying the location of reports and for specifying the name used of the 
report file output. This has a drop down list, Report File Names Template section with a template 
edit box and a popup menu button to make it easier to add the keywords. There is also a popup menu 
button next to the folder edit box as well. 

 

The “$(Report Group)” keyword will be replaced with the report group the report is in. On the 
General Reports page there is a Report Group box to supply the group for each of the standard 
reports. User reports can have a report group assigned by including the new Set Report Group 
command in their script. 

This also has the added check box, Append To Existing Report which can be used to add the current 
report to an existing file. This might be useful where an audit trail of events is required. 

Libraries, Technology Files, Profile Files, Colour Files, Schematic Blocks and Format 
Files 

The Libraries, Technology Files, Profile Files, Colour Files, Schematic Blocks and Format Files 
tabs all contain default locations for these files. Each of these pages allows the Folder selection and 
the enabling or disabling of files within it. Multiple folders can also be chosen from anywhere 
accessible by your computer and network. 

  

The Folder and Search Order panel enables you to choose the folders to include in the search. This 
mechanism is the same for all four of the file types that appear on this dialog.  

The process is to use the Add button to add a new folder and Edit to change an existing folder path. If 
unsure where the folder is located or you need to browse to locate it on a network drive, use the 
Explore button. The Up and Down buttons allow you to position the folder in the search. This is 
important because if there is more than one item of the same name in the libraries or other files, the 
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order in which they appear in the search path will be how they are used. The first item required and 
found will be used. 

The Files Found panel will display any files found on the search path setup in the Folder and Search 
Order panel. Each file found is displayed along with its file extension to identify its type, and the 
path it was found on. 

 

The right hand side of the panel displays the file type when selected, the box below this displays the 
file name. 

You can enable or disable files to be used within the folder by using the Enabled check box. By 
selecting it, the file will be disabled and therefore not used. It does however remain in the search path. 

Delete, Move and Copy are used to manage the files within the chosen folder(s). Be warned though, 
Delete will erase the file completely from the folder, not just from this search list. 

Edit only appears for the folder items that can be edited. The file must be selected from the list in 
order for the Edit button to be active. This button appears on the Profile Files, Format Files, 
Schematic Blocks and Technology Files dialogs. When a file is selected and the Edit button pressed, 
the file is loaded into the respective editor. 

Files 

Saving files is an essential part of any Windows based product. In keeping to the Windows standard, 
Pulsonix provides both Save and Save As, as well as other special save options.  

Save allows you to save the current design to its existing name. If exiting the design without first 
saving it, you will be prompted to save the design or discard it. An indicator that a design has been 
edited but not saved is shown on both the Workbook mode tab and the title of the Pulsonix product as 
an asterisk ( * ). Once saved, this indicator disappears. 

Save As allows you save the design to a new name using the Save dialog. 

Save Technology allows you save the technology information in the design to a Technology File. 
This can be subsequently used when creating new designs to give them the same technology data as 
this design. 

Save Profile allows you save part of a design to a Profile File, for example, the page border or board 
outline. This can be subsequently used when creating new designs to provide the same Profile data as 
a starting point.  

Each of the save options has its own file extension that are predefined depending on the design type 
you are saving. 
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Saving libraries 

When using the Symbol, Footprint or Part editors, the menu contains Save, Save As and Save 
Technology as expected, but also Save To Library. Both Save and Save As are used to save the 
current symbol to a symbol file not the library. To save the Symbol being edited to the relevant 
library you should use Save To Library. If editing an existing Symbol from the Library, the Save 
button on the toolbar will allow you to Save To Library where you will be prompted for the library 
name and the symbol name when saving. 

Security Copies and Backups 

Pulsonix has the capability for security copies of your design to be made and you can set the interval 
and location of the files.  

Although Pulsonix has its own system for security copies of designs, we HIGHLY recommend that 
you make regular backups of all Pulsonix designs, libraries, technology files, profile files, reports and 
security copies.  

If at any time you think you have lost or deleted Pulsonix files DO NOT shut down the Windows 
operating system. Call the Pulsonix technical support desk straight away. If you shut down the 
operating system there is a much stronger chance of not being able to recover the data because of the 
files Windows writes to disk during its shutdown process.  

Within the Options dialog on the Design Backup tab is a collection of options to facilitate saving 
Backups, Security Copies and Restore Points of the design.  

 

User defined format of backup file names 

You can create user-defined formats of the backup name by typing fixed text and inserting tags that 
will be replaced a when a backup name is generated.  
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Tags are defined as the design name plus one of three numbering schemes – Increment, Decrement 
and Infinite. 

So for example, if number of copies is 3, Increment will produce copies 1 2 3 where 3 is the latest, 
Decrement - 3 2 1 where 1 is the latest, and Infinite 12 13 14 where 14 is the latest, i.e. it just keeps 
getting higher. 

For the Design Restore Points section, you can also select Restore Point Label from the context 
menu. 

Security copies 

This section enables you to choose security copy backups of your design that you are editing. They 
are automatically generated after a set time interval if the contents of the design file you are editing 
has changed. They provide the security of being able to save copies on a regular basis in case data is 
lost due to problems with Pulsonix or the operating system. 

 

Backups 

These are copies of your design automatically created when you save it. They give you the security of 
being able to restore the design to one of the recently saved versions. 

 

Save and Load Restore Points 

There is an additional backup type called a Restore Point; that is saved on request. It is used for 
saving a design that is in a known good state before starting on a session of changes.  
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The saved backup is restored using an option on the File menu named Restore Backup...  

From within the Options dialog and Design Backups page, you must provide a label for the restore 
point that will be inserted into its name. For this to happen, the name format must contain the label 
tag. 

 

For example if the name format was “$(DesignName) - $(Label)” then the user could create a restore 
point for design “MyDesign.Pcb” after autoplace with the label “Before Routing”, so the backup file 
will be called “MyDesign – Before Routing.pcb”. 

Restoring Backups 

There is an option on File menu named Restore Backup... to restore the contents of a design to be the 
same as a chosen backup file. This can be performed on the current design, or you can choose the 
design to have its contents restored from. When selected, this displays a list of backup files to choose 
from in the dialog.  
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Units 

The basic working units can be changed between Imperial and Metric, and between Degrees and 
Radians for angle units. These are the units of the co-ordinates and lengths displayed in the dialogs 
and edited by you. The Units dialog on the Setup menu is used to define these units and the precision 
at which they are displayed. 

The design units are stored in an internal database with a precision of 1/100 micron regardless of what 
the unit precision is set to. 

 

Imperial units can be set to Inches, Thou or Mils, Metric units can be set to Millimetres (mm), 
Centimetres (cm), Metres or Microns. Angle units can be set to Degrees or Radians. For each type 
of units, you can specify a precision. This is the number of decimal places displayed; the value is 
simply rounded to the nearest last digit. If you have the Rounding Indicator displayed, a + or - sign 
is shown at the end of the value to show that is has been rounded down or up. If Trailing Zeros are 
not displayed, the trailing zeros are not shown for values that do not require all the decimal places. 

You can quickly toggle between Metric and Imperial units by using the default shortcut keys <Ctrl-
U> or by double-clicking on the unit notation on the Status Bar. 

 

Grids 

Grids are used for both visible reference markers and to define the points or steps to which items will 
"snap" when they are placed. There are built-in grid names that can be setup for use with particular 
design items, for example, Track grid, Via grid, Component grid, Testpoint grid. You cannot rename 
or delete built-in grids. 

You can specify the X and Y grid steps and the visibility of grids. 

The <Working Grid> is a system grid that you cannot rename or delete. This is used for most of the 
interaction of Pulsonix, and is only substituted in particular cases where a specific option grid is 
available, for example Component or Testpoint grids.  
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Setting up grids 

The Grids dialog allows you to add or change the settings for any of the grids in the design. The 
Grids dialog is available on the Setup menu and is stored within your Technology. It can also be 
accesssed using the Grids button on the Grid Step dialog. 

Within the standard Pulsonix PCB Technology files are named grids that have been setup for you 
using names that represent possible design entities, such as component, Testpoint, Text etc. these can 
be renamed, defined and deleted by you as required. 

 

 

A set of user defined grids might look more like this: 

 

Defining your own grids 

You can define your own grids by first typing in a name using the New button. The grid Step should 
then be typed in and the Multiplier (and Divider if required). Use the Multiplier and Divider entries 
to create fractional grids that do not suffer from rounding errors. 

 

You can also set its visibility by selecting the Display setting from the drop down list. Selecting OK 
will save the grid and display it (if the zoom level allows it).  
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Grids can be defined relative to system origins in the design (System Coordinate Origin, Relative 
Origin and the Design Centre). 

 

Grid Steps 

The Grid Step dialog allows you to change the grid step setting in a simple dialog. As well as being 
available on the Setup menu, it is also accessible from the keyboard shortcut key <G>.  

 

The Grid Step dialog presents the Current Grid name as defined in the Grids dialog, both system 
and user defined, and the grid Step value. The grid step value is always defined in your current units. 
To change the Working grid value quickly you can type <G 25> followed by <Enter>. This will 
change the working grid to 25 (Units). 

Snapping to grid 

When moving a design item, you can access the Change Grid option from the context menu. 
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With the context menu you can change the grid of any item at any time. Any selected grid will be 
remembered for each type of item being sunsequently move. For example, moving a Component on a 
0.1mm Grid, the next time you move a Component, this grid step will be remembered.  

Setting grid visibility 

To set whether grids are displayed, you can use the Grids dialog or the keyboard shortcut key  
<Ctrl-G>. This will display all grids that have their Grids Displayable check box selected to on. 

 

Any grids can be displayed but care should be taken if displaying more than two grids at a time as this 
can easily lead to confusion as to which grid is being shown.  

You can change the display of the grid to draw any number of grid steps using the Draw nth Step 
box. This can be useful if the grid is only required every 10 grid points. The Style of the grid can also 
be changed between Dots, Lines, Crosses and X Crosses. A mix of each is also allowed for different 
displayed grids but the colours used should be chosen carefully.  

 

Snap Cursor To Grid 

There is a check box option on the Options dialog and General page named Snap Cursor to Grid. 
Select this option to make the cursor move only on the current grid when in the design area.  

 

Gridded cursors will still be shown when modal cursors are displayed.  

This option can only be used with the three cross cursors, it will not work with the standard windows 

cursor.  

There is also a command available in the Customise option and Keyboard called Toggle Cursor 
Gridding. This can be used to quickly toggle snapping on and off. 
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Changing the Design Area Size 

The design area is the area that you are allowed to work in. It is useful to have the ability to reduce 
the design size to be slightly larger than the maximum extents of the design. This makes the scroll 
bars more responsive and prevents you from 'losing' the design. Alternatively, if your design changes 
are to be larger than the design area then you may need to increase the size of the design area.  

This is achieved using the Design Settings dialog from the Setup menu and the Coordinate system 
page. 

 

The Design Area Size can be created based on a number of predefined and user defined area choices 
as well as an automatic choice. The size relates to an area, so 10 inches for example, would be 10x10 
inches from the 0,0 System Coordinate Origin point. 

1 Inch (1 Centimetre), 10 Inches(10 Centimetres), 30 Inches (1 Metre). This changes depending 
on whether you have Imperial or Metric units selected. User Defined where you can specify the 
exact design area required. The Fit button will automatically size the design area to fit around the 
design. You are provided with a dialog to define the Margin around the design extents for which the 
design area is calculated, this is defined in the current design units.  

 

Once this has been defined the design area is calculated and is shown in the value box. Any changes 
made to the design area can be viewed in the World View window that shows you the maximum 
design area, the design and the current view of the design. 

Changing the Design Origin 

The Coordinate System Origin is the point from where all other co-ordinates are shown relative to. 
You may wish, for example, to show all coordinates relative to the centre of the design or board.  

You have the ability to change the design origin in Pulsonix. The default is the bottom left hand 
corner of the working area. 

Changing the Design Origin 

If you wish to change the design origin you need to move the Coordinate System Origin. This can 
be done by using the Design Settings dialog from the Setup menu. You should type in the 
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coordinates of the new origin position required. The coordinates are defined as an offset to the lower 
left corner of the design area (0,0 origin). 

 

It can also be moved interactively by using the Place Coordinate Origin option on the context menu. 
To obtain this context menu, you should right click in free space in the design window.  

 

When the option is selected, you can drag the origin to its new location using the coordinates on the 
status bar to locate it. 

If you wish to reset the origin back to 0,0, select the origin marker and click the <Del> key on the 
keyboard. 

You cannot frame select any origins so you cannot accidentally move them. The Coordinate System 
Origin is locked by default so it cannot be accidentally moved. You can select and override the Move 
warning to perform the Move. 

Working in Absolute and Relative Modes 

Pulsonix allows you to work in both Absolute and Relative modes of operation. 

Relative Mode gives you a means of temporarily reporting co-ordinates on the status bar relative to a 
defined point. This may be useful, for example, for positioning a group of components relative to a 
mounting hole.  

Changing the Relative Coordinate origin 

The Relative Coordinate Origin can be changed by typing in new co-ordinates using the 
Technology, Design Settings dialog. The Relative Coordinates are displayed on the Status Bar by 
selecting the check box, this also enables this mode.  

 

You can also interactively move the Relative Coordinates origin by using the Relative Origin At 
Cursor command - shortcut keys <Shift-X>.  
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This will snap the origin marker to the current position of your cursor and the status bar will now 
display Rel for Relative Coordinates as well as displaying the coordinates relative to this origin. 

 

When editing or moving items the status bar also displays the difference between the current item 
position and its previous point, shown as dx: and dy: values. This could be the last corner for a 
connection or track, or the position of a moved item relative to its start position. You can reset the 
Delta coordinates at any time by assigning a shortcut key to the Reset Delta Coords command. This 
can be used in context while moving an item. 

The Relative Origin can be reset at any time or while in a 'mode' by pressing <Shift-X>. This will 
allow you to obtain a 'measured' distance while using an option if required, otherwise if left in one 
location all co-ordinates displayed will be relative to that point. 

To differentiate this origin from the System Co-ordinate Origin marker you can change its colour in 
the Colours dialog under the Others tab. 

If at any time you wish to go to the Relative co-ordinate origin in the design, you can click the <X> 
key on the keyboard. This shortcut key is set up by default for the Find Relative Origin command. 
This command is also available on the Edit menu under Find and Find Relative Origin. Once Find 
has been used, the Relative origin will be highlighted in the Highlight colour. You should use 
Remove Highlights to remove this colour. Remove Highlights is located on the Edit menu and on 
the context menu. 

You can switch between the Absolute and Relative co-ordinate modes by using the Relative Mode 
command - shortcut key <Shift-R>, this will toggle between the two modes using the previous 
Relative Origin point set and the Absolute co-ordinate origin. 

Technology Files 

Technology files are like the template files used in other general office products. They are a way of 
constraining a design to a specific set of predefined rules or parameters. They are also a quick method 
of starting designs based on known characteristics, from defined rule sets or previous designs. This 
makes it easier to obtain consistency between designs.  

A default set of Technology files have been supplied with Pulsonix that can be used and edited by you 
to match your own requirements. Any technology file name selected will be taken from the default 
Technology File folders defined in the Folders option. 

There are a number of options that allow you to load technology files as part of their process; 
anything that is started from new can be started with a Technology file, PCB design or Schematic 
design for example. Any library creation or editing of library contents, including the Symbol creation 
wizards, and also the Translate To PCB option. 

Schematics and PCB both have their own technology files and cannot share information between 
them. For example '4 layer.ptf' (the supplied 4 layer PCB technology file example) can be used on 
both PCB footprint libraries and the PCB design, but not for Schematics. 

It is advisable to use Technology files, although this isn't necessary because Pulsonix adds styles etc. 
when no match can be found when adding components for example. 

This section covers the concept of Technology files and the Technology dialog, each facet to the 
Technology file is described in more detail as each option is shown as you move through this manual. 
There are some special items of the Technology file that have been selected for more attention in this 
section. 
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The contents of Technology files 

The list below shows the items that make up the contents of Technology files: 

• All Technology dialog information (Spacing Rules, DFM/DFT Rules, Attributes, Net Names etc.) 

• Technology dialog Style and Style Naming rules 

• Technology dialog High Speed rules 

• Design Setting options including Defaults (but not Options dialog settings) 

• Grids 

• Units 

• Colours 

• CAM Plot output settings including Drill Sizes 

• Variants  

• Autoplace, Autorouter, Auto Gate & Pin Swap and Auto-Mitre parameters 

• DXF output dialog settings 

Creating and saving Technology files 

Technology files can be created as a stand-alone process to set these files up, or can be extracted from 
existing designs, for example from a Schematic design. Technology files do not hold all the design 
information, they only hold a sub-set containing items such as styles, rules, colours, grids and units 
etc. 

If creating a brand new Technology file you can use the New option on the File menu, use the 
Technologies & Profiles tab. If you wish to base your new file on an existing technology file you 
can select a Technology file by name provided it exists in the Technology file folder defined in the 
Folders option. For example, you may well be creating an 8 layer Technology file by starting with a 4 
layer file and adding another 4 more layers.  

You can also create a Technology file by extracting technology data from an existing design. 

You can save technology files from within all design editor or library editor options except the Parts 
Editor. The File menu contains the Save Technology option from where you can save technology file 
information. 

When editing a technology file, you should use the Save Technology option to save a technology file 
to the correct folder.  

Introduction to the Technology dialog 

Accessed from the Technology option on the Setup menu, the Technology dialog is used to manage 
the Styles and Rules of the design. Although it does not contain all of the technology file contents, the 
Technology dialog does make up many of the most important facets of the Technology file. Each of 
the tabs on the Technology dialog will be discussed in more detail as they are used throughout this 
manual. The example dialog shown below is for Attribute Names in a PCB technology: 
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As you will note, there are differences between each type of Technology dialog. The Schematic 
Technology dialog contains Styles entries mainly and some pre-defined names for Nets or Attributes. 
Whereas the PCB Technology dialog also contains Styles for the 'physical' items within the design, 
such as Pads, Tracks, Spacing Rules, DFM/DFT Rules and Layers etc. as well as the CAM Plot 
outputs. Part Technology files contain a minimal set of Technology is used for setting up pre-defined 
signal names and attribute names when creating or editing Parts. 

Styles 

Styles are used to define how an item will look when displayed in the design. For example, how thick 
a line should be, or what shape a pad is and what drill size it contains.  

By giving an item or items a style, you can define a group of similar items and give them the same 
look, but also be able to change their look by simply editing one corresponding value on the Styles 
page. This means that through the Line Style tab on the Technology dialog you could assign a Line 
Style of Symbol Outlines the Width of 6 (thou, defined in current units) to all the Component 
outlines used in the design (the style being assigned during the Symbol creation process). This would 
be a global style for all items that use this same style in the design. 
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This could then be changed to 10 thou by editing only the value on the Line Style tab again.  

You can also have local styles that are specific styles that only appear on one item. This means the 
system is flexible enough to allow small local changes to be made, but also powerful enough to allow 
changes throughout the design to be made. 

Introduction to Net Items 

Within the Technology, there are pages in the Nets section for defining facets that are properties of a 
net or multiple nets, Signal Paths, Sub-Nets, Differential Pairs and Chains of Differential Pairs. Each 
of these net items can have attributes assigned and rules added to them. 

Why and when to use each category 

To summarise each category, here is what they are used for in Pulsonix: 

Standard net items 

Nets – All Nets (Connections) within the design have a Net Name with a Type (see special note 

below about Type) and (optionally) a Guard Space. They can also have a set of attributes containing 
rules added, for example, a Track Length Rule. They can also have an optional Net Class associated 
with them. Net Names can be user defined or default names automatically assigned by Pulsonix.  

Net Class – Net Classes have a Net Class Name, a Type and a flag to Mark All Nets As One. It also 
contains Net Class based Track Length Rules. A Net Class is an alternative method of ‘grouping’ 
nets to which the same parameters can be associated. This is a general method for grouping categories 
of nets but can be achieved more efficiently using alternative methods. Nets do not require a Net 
Class now, all rules can be attached to a single net or multiple nets.  

Net Styles – All default [physical] styles (Tracks, Vias etc.) associated with a Net Class or Net 
Attribute are defined in the Net Styles dialog. This dialog is also used to define how tracking will 
behave on different Layers, within Areas and for Layer Spans.  

Net items for the High Speed Design Option 

Signal Paths – Signal Paths represent another level of net definition. The path is a named item 
containing an ordered list of pads that represent a signal path. You might use this within High-Speed 
designs for example where constraints are required. This could be where the overall track length of 
the signal path would require a specific defined length rule(s).  

Sub Net – These define part of a net which may require special considerations. These are defined in 
the Sub Nets dialog using an attribute name and value. Pins on the same net with attributes that 
match it are deemed to be in the same sub net. One definition can define sub nets in multiple nets. 
You may use this for example, when creating branch lengths or a specific daisy chain order in a High 
Speed design.  

Differential Pairs – The Differential Pairs dialog is used to define the Differential Pin Pairs and 
Differential Pair Chains (see below). All other Differential Pair specific rules such as Pair Gap and 
Pair Length are contained in their own dialog under the Rules – High Speed section.  
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Differential Pair Chain – A Differential Pair Chain is two or more (existing) Differential Pairs 
added to a named list to create an extended list. This is used for associating multiple Differential Pairs 
so that lengths or net rules can be defined for the overall ‘path’. This path may be split with a 
terminating component for example and will contain different net names. As with Differential Pairs, a 
design can contain multiple Differential Pair Chains.  

Type – a net always has a Type, this is assigned when the net is introduced to the design. It can be 

one of three states; Power, Ground or Signal. Type is used for some net-based options such as 

Optimise, Design Rules Checks, ERC and Autoplace.  

Net Styles 

Net Styles provide a means of defining the default track and via styles to be used when routing PCB 
designs.  

Net styles enables you to achieve the following:  

• Use wildcard characters in the net class name to reduce the number of duplicate default style 
definitions. 

• Define different default track styles for layers and areas. 

• Define different default via styles to be used for each layer span. 

• Define different default track and via styles to be used within specific areas. 

You may use the Net Styles dialog to create sophisticated rules on a per-layer or per area basis for 
example. 
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Rules 

What is a rule? 

A rule is a collection of specific conditions and characteristics that can be assigned to a net. Whereas 
previously these rules were bundled to be set on Net Classes, they are now individual facets that can 
be assigned to any net or sets of nets. Rules are attribute driven. Some ‘rules’ are system ‘attributes’ 
such as <Net Name>, <Net Class> etc. but user defined attributes can be added as well.  

User defined attributes would be created when system attributes do not provide enough range for 
rules coverage. For example, a Track Length rule might be applied to multiple net names that do not 
have a common name format, like CLK, RST, DQ1, ADD3 etc.  

What characteristic might a rule have? 

Rules can be standard items such as Copper Pour, Thermal connectivity, Teardrops and Net Styles 
etc. More advanced rules might include facets such as Track Length, Track Length Match, Serpentine 
and Track RF features so mention a few. 

What can a rule be assigned to? 

Rules can be assigned to any Net, Signal Path, Sub-Net, Differential Pair and Differential Pair Chain. 
This means one (or multiple) rules can be applied to multiple net categories. For example, a number 
of Thermal rules can be defined and applied to all signal or power style nets. Likewise, a Track 
Length Match rule can be applied to multiple sets of Differential Pairs to ensure they are all within 
length difference of each other. 

Rules may also still be assigned to a Net Class if required but with this style of rules structure is less 
likely to be used this way. 

In addition to assigning rules to Net items, in the Thermal Rules and Teardrop Rules dialogs, you can 
also assign rules to <Pad Style Name>. This means specific rules can be added for pad or via styles 
for ranges or specific pads. 

 Key headers used in the rules dialog 

There are some essential headers that are used within the rules dialogs and are highlighted below: 

 

Attribute Name – this is the name of attribute that will define the rule, for example, this could be one 
of the system ‘attributes’ such as <Net Name> or <Net Class Name>, or it could be your own user-
defined attribute name, such as TrackLengthRule 

Match Value – once an Attribute Name has been defined, you must give it the name of something to 
match. This could be a unique Net Name, CLK for example, or a range of Net Names to apply the 
rule to, such as ADD0 to ADD9. Using Ranges to match the attribute means a single rule can be 
applied to multiple instances. 
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Creating and applying Rules 

Rules can be created and applied using two methods: 

Method 1 

Create your rules first in the Rules sections (in the Technology dialog under DFM/DFT and High 
Speed) and apply them to the net(s) required. 

As an example, we’ll show the addition of a Track Length Rule but the principle applies to all rules. 
Create the rule by adding an Attribute Name and Match Value, plus your rule values: 

 

On the Nets page, if the new attribute matches the rule, the attribute name and value will be 
automatically adopted. If the rule doesn’t match automatically, apply the rule by typing the rule name 
in the Attribute field (or selecting it from the drop down list which will be populated from the list of 
available rules). 

The example below is specific to the Track Length rule as this is directly shown in the Nets dialog: 

 

All rules added to a net-based item are displayed in the relevant dialog in the Rules and Attributes 
tabs: 

 

Method 2 – Track Length Rule & Track Length Match Rule 

When using the Track Length Rule & Track Length Match Rules, an alternative is to write the 
rule directly into the dialog that requires it (Net Name, Net Classes, Signal Paths and Sub Nets). Once 
the attribute (Rule) is written, it then becomes a rule within its own right and appears in the relevant 
Rules page where it is available for use on other nets. 
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To do this: in the Nets dialog, write the rule into the Attribute cell along with the Match and Values 
to be used. In the example below, the <Net Name> system attribute has been selected. The typed 
Match will be FB0? And values of 22.0 and 27.0 for Min and Max Track Lengths respectively. This 
then matches the Net names FB01-04 but not FB011 (? will only match one character). 

 

Using Attribute Rules 

Once Attribute Rules have been defined, they can be matched on a net item by Rule Value or by Rule 
Name depending on which scheme best matches your requirements. 

Match the rule value - any item with the rule attached and matching the value. For example 
Attribute Name=TrackLength, Match Value=2.0. Where a net then contains an attribute of 
TrackLength and a Matched Value of 2.0, the rule will be applied. 

Match the rule name - any item with the rule attached, with no value (%# must be used as 
the value to show a field with no value), but match by rule (attribute) name. 

Rule Matching Examples 

Wildcards are a powerful way to create ranges for selection, below shows a selection of wildcard 
ranges:  

Attribute Name (Rule) Match Value Rule Values Description 

<Net Class> Signal xx A specific Net Class name of Signal has the rule 
applied (where xx is your rule value) 

<Net Name> DQS* xx Any net starting with DQS  

<Net Name> DQS%[1:7%] xx Any net between DQS1 to DQS7 

<Differential Pair Name> %{DQS*|DSM*%} xx Any Diff Pair starting with either DQS or DSM 
will have the rule applied. The strings are 

separated by a pipe ( | ) character. 

TrackLength 2.0 xx Any net that has the attribute with the name 
TrackLength matching a value of 2.0 will have 

the rule applied. 

TrackLength Blank (will be 
written as %#) 

xx Any net with the attribute name TrackLength 
with no value will have the rule applied. 

 Wildcard Wizard 

When a wildcard needs to be defined to create name ranges, you can use the Wildcard Wizard. This 
allows you to create wildcards, often, complex wildcard strings (or simple ones), that are presented in 
non-programming terms.  
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On dialogs where wildcards are accepted, there is a button to access the wizard. 

 

Pressing the button opens up the Wildcard Wizard dialog: 

 

Wildcard String expressions are defined from the drop down list: 

 

On selection of a String, you can type in the value to match. The Wildcard String is shown in the 
Wizard dialog. 

 

When OK is pressed, the wildcard string is shown as the Match value back in the host dialog. 
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Colours 

Pulsonix provides a powerful colours mechanism that enables you to configure the colour, 
selectability and true width of each design item type to suite your own preferences. The Colours 
dialog is accessed from the Setup menu. 

The specifics of each tab on the Colours dialog will be discussed as they are used in each chapter, 
this chapter introduces the Colours dialog. The dialog's use and feel are the same throughout 
Pulsonix, the main differences being the contents for each application type.  

Using the Colours dialog 

The Displayed and Selectable check boxes will set whether items in the design can be seen, and 
whether they can be selected. Items that cannot be seen in the design cannot be selected, even when 
using the Frame Select mode. 

 

To change a colour, you select the cell that you wish to change. A drop down colour palette will 
appear. On selecting the colour, the cell will change and the palette disappears.  

It the colour required does not appear in the standard 20 colour palette, you can use the Other button 
to display the standard Windows colours palette to create the colour required. The bottom row of the 
drop down colours palette will display the most recent colours used. 

Once a colour is set for a cell, that colour can be applied to a row or column by selecting the Apply 
to entire Row/Column option form the context menu. 
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This method of applying to entire Rows or Columns is the same for the Displayed and Selectable 
check boxes. Any selections made in these check boxes can also be applied to each Row or Column 
using the context menu. 

The main differences between the Schematic and PCB Colour dialogs is that the PCB dialog is 
‘layers’ based, whereas the Schematic is ‘flat’. 

Loading new Colour Schemes 

Complete Colour schemes can be loaded using the Load Colours from the Colours dialog, the Load 
Colours option from the Setup menu and from the Colour Files Bar.  

All files listed have been found in the search path setup in the Setup, folders option. 

 

Colours are an integral element within the Technology File and as such can also be loaded as part of 
this file. During Load Technology, you can select to only load the Colour elements of the design, 
ignoring any other elements. This enables you to load or reload the Display flag of any item(s), or the 
Selectability, or the Colour of an item(s) within the design.  

Changing the Colours in Properties 

There are some colour items that can be changed independently of the Colours dialog, e.g. 
Documentation Shapes and Text. Generally, these items can be changed in the Item Properties dialog 
for each item. When available, the Own Colour check box will be enabled and the local colour can 
be changed. The example dialog below shows a Doc Shape Properties dialog: 

 

Load Technology 

The Load Technology option is used to load or reload, all or part of an existing Technology file 
contents into the current design. You should use this if your current design does not contain 
technology elements that appear in another technology file. For example, a double sided PCB design 
may need to be increased to 4 or 6 layers, these additional layers can be loaded using this option (a 
simple example, obviously you could just add the extra layers quickly anyway!). 

Once loaded and a new mix of technology files obtained, this 'set' of elements can be Saved to 
another new Technology filename for use on another design. Use the Save Technology File option 
from the File menu to do this. 
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You can only use Technology files that are relevant to that design type, Schematics Technology files 
can only be used in the Schematics designs and not in the PCB designs etc. 

Using the Load Technology dialog 

The dialog is run from the Setup menu, using the Load Technology option. 

You select the Technology File to load from the drop down list, choose the Technology Elements to 
apply and start the process using Load. You are able to choose not to load items that don't already 
exist in the design or to load them if they are required using the Add if not already in the design 
check box. 

Below shows the Load Technology dialog used when editing a Schematic design: 

 

The Check All and Uncheck All buttons are used to make complete selections of the Elements check 
boxes. Quite often, it is easier to use the Check All button and deselect the items not required, or vice 
versa. 

The Report button will generate a report for you containing a list of all the technology items that will 
be updated in the design when the Load button is pressed. 
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Profile Files 

Profile files are files that can be loaded to create a design or to add to a design. They can contain 
drawing blanks, page borders and title blocks or the board outline (in PCB), Component pre-
placement and assembly information (in PCB). 

Profile Files can be used to load predefined 'documentation' information into a design. They differ 
from Technology files in that they only contain the documentation information rather than rules, 
styles, colours etc. 

Profiles files combined with Technology files can provide a giant step into getting a design started 
quickly, especially if using an existing set of files created from previous designs that may be similar. 
Using these files you can combine design facets from different designs, and even designs from 
different systems once imported.  

By default, the supplied Profile files are installed into the folder, Pulsonix\Profiles. This location can 
be changed or additional folders included using the Folders option and Profile Files dialog. 

Schematic Profile Files or Drawing Profiles 

Schematic Profile Files are actually called Drawing Profiles. They are normally used for drawing 
blanks and title blocks, rather than to predefine design information that is how PCB Profile Files are 
normally used.  

All Profile items that appear on Page1 of the design and items marked as Common to All Pages will 
appear on other pages as well. 

PCB Profile Files 

Board Profiles are stand-alone design files that contain data describing standard board types that you 
can use as a starting point when designing a PCB board of that type.  

They contain a board outline that has the shape and size required for manufacturing rather than just 
describing the outer edge of the board as an indicator. Pulsonix profiles also contain mounting holes, 
documentation and annotation required to manufacture the finished board.  

Loading Profile Files 

Once created, Profile files would normally be loaded when creating a new design but you can still 
load one using the Load Profile or the Load Drawing Profile options from the Setup menu. They 
are the same options for both Schematic and PCB editors but are named slightly differently. The 
Profiles can be loaded into a design the same as any other design item.  

When a PCB already contains a board profile and Load Profile is used, the old board will be replaced 
for the new one (board and associated Component pre-placement). This is the same principle for 
Schematic Drawing Profiles, one is replaced the new one being added.  
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You can also use other options to pre-load the Profile files during the initial design creation process. 
You can use New - Schematic and PCB Design, and Translate To PCB from within the Schematic 
design editor. 

Creating and Saving Profile files 

Profile can be created as a stand-alone process (from new) or can be extracted from existing designs 
by saving items from to a Profile file. Not all of the design can be saved to a Profile file but the 
program will save what is required. Use the Save Profile option from the Setup menu to do this. 

If creating a brand new profile you can use the New option on the File menu, use the Technologies & 
Profiles tab. If you wish to base your new Profile on an existing profile you can select it by picking it 
by name provided from the list. 

If using an existing design, when you use Save Profile in the PCB design editor, you are presented 
with a dialog from where to choose the Component name(s) to save into the file. Once the names are 
selected, you are presented with the standard Save dialog in which to enter the location and filename 
of the file. 

 

Design Defaults 

When adding new items to a design (schematic or PCB) and to create symbols, the option being used 
will take styles and layers etc. from a central source. This source is defined as part of your 
Technology and is loaded when you use a Technology file on a new design. 

All of these defaults are stored in the Technology, Design Settings dialog on the Settings menu. 
Within this dialog are the Default pages. The example below shows the Bus defaults used in the 
Schematic editor. Schematic and PCB defaults are different in that they contain different entities. 
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Working With Attributes  

What is an Attribute?  

An attribute is textual information attached to an item in the design, or to the design itself. This 
information can be provided by the system e.g. Last Saved Date, or entered by you. Some attributes 
are automatically added to items by the system e.g. Pin Names, others are inserted by yourself. 
Attributes can be optionally displayed and plotted, or hidden away to be used later in reports or 
outputs to drive third party tools. 

An attribute can also be attached to a net to provide a mechanism for which to associate particular 
rules created within the Technology file, such as Thermal Rules, Copper Pour rules, Teardrop Rules, 
or in the case where the High Speed option is available, high speed rules such as Track Length Rules 
or Serpentine Rules. 

An attribute has the following properties: 

• Attribute Name – Attributes provided by the system are identified by having angled brackets 
around them e.g. <Part Name>. All attribute names provided by you are collated together and 
presented in the Technology dialog. These names are also presented in a list when adding 
attributes, to make it easier to add common attributes to different items. If you have some 
attributes that are always used in your designs it is a good practice to add these names to your 
Technology files so they are always available when creating new PCB, Schematics or Part 
designs.  
You can make attribute names specific to certain types of item setting the Usage parameter. For 
example, a name can have usage Pin that means it can only be added to Component pins e.g. Pin 
Order. 
In the Colours Dialog you can set up each attribute name’s colour, whether they are displayed 
and, if displayed, whether they are selectable. This is a quick way of altering the appearance of all 
attributes using the same name. 

 

• Attribute Value – This is a text string either supplied by the system e.g. Date ‘12/3/99’, or 
supplied by you indirectly when performing certain operations e.g. Component Name ‘U1’ or 
inserted by you directly when adding an attribute e.g. Part Value ‘2K’. The value can be left 
blank if the attribute is only being used to ‘mark’ an item.  
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• Attribute Position – Each attribute is capable of having its value string displayed in the design. 
The visible attribute is known as an ‘attribute position’. When displayed you can move, rotate, 
and mirror the attribute position, and allocate its text style and layer (if in a PCB design). An 
attribute can have more than one attribute position, to display it on more than one layer for 
example.  

• Owner – Every attribute is attached to an owner item. This can be an item within a design, an 
item within a footprint or part, or attached to the design, footprint or part itself. Attributes cannot 
be attached to Text, other Attributes, Connections, Tracks, Dimensions or Origins. 
Moving a displayed attribute will highlight its owner. 

System Attributes 

System attribute names are predefined as they represent information that is provided from the system 
or from data already within the design.  

 These system attribute names are not presented in the Technology dialog, but can be used to add 
attribute positions to items in order to display the relevant information.  

 The system attribute information, or value, is added to items during the various stages of their 
creation, and can be ultimately displayed on the owner item. On some of these attributes, you can 
make them displayed and define their attribute position before the value has been provided. 

An example of this is the <Component Name> attribute. This is the reference name of the 
Component when added to the design e.g. IC44 or R21. When using this attribute in the Schematic 
design, it can also be used to identify individual Gates if setup in the Design Settings dialog under 
Naming. This attribute can be initially added and positioned within the footprint library item. 
Because the value is only added when the footprint is added to a PCB design, it is displayed in the 
footprint as an ‘unsatisfied attribute position’, also known as an ‘attribute place holder’. It is drawn as 
the attribute name enclosed within curly brackets e.g. {<Component Name>}.  

 

As soon as the Component is added to the PCB design and assigned the name ‘IC44’, the visible 
attribute position is changed to the correct value.  

User Defined Attributes 

In addition to the system provided attribute names you can add your own. These can be added directly 
through the Technology dialog so that they are available for use when adding attributes later, or they 
can be created whilst inserting attributes.  

When adding attribute names to the Technology dialog you should use the Attribute Names tab: 
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Attribute names and values can be selected for display using the Technology dialog and Attribute 
Names. You can choose to display the attribute Name (Show Name) or Value (Show Value).  

Your own attributes can be added to items in the design using one of the following options: 

• Insert Attribute, this is used to attach and attribute name and value to an item. 

• Insert Attribute Position, this is used to attach an attribute name to an item. The value would 
then be populated at a later point. For example, on a resistor, Value might be ?. When used in the 
design, this would be edited to provide a ‘real’ value, such as 10K 

Both features are defined below: 

Insert Attribute 

Use the Insert Attribute option from the Insert Menu to add an attribute to an item by picking it in 
the design, then choosing or typing an attribute name and typing an attribute value. This allows you to 
interactively place the attribute position, choosing its style and layer as well.  
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Add Attribute To - Only provided if a design item was NOT pre-selected. Use to specify the type of 
item you are adding the attribute to. This makes it easier to pick the item and restricts the list of 
attribute names you can use. Choose Design to add design level attributes. 

Attribute Name – Type in your own new name, or pick from a list of system attribute names or 
attribute names already added to the system.  

Attribute Value – Type the value for the attribute and choose whether it is to be visible. If this is a 
system attribute, this field is disabled and the value provided by the system is displayed.  

Use Defaults – Check this box if you wish to use the Attribute defaults defined in the Design 
Settings dialog under Attributes. If you wish to override them with local attribute settings, uncheck 
the box and define your own. 

Adding the Attribute 

If no item was pre-selected and you are not adding the attribute at design level, you will enter a 
‘picking’ phase to choose the item to add the attribute to. 

 

When Insert Attribute is used with an attribute that can be attached to multiple 
items a modal cursor is displayed. 

If the attribute is visible you will enter a phase enabling you to manually place the attribute position.  

Insert Attribute Position  

The Insert Attribute Position option offers the same functionality as Insert Attribute except it is 
only used for placing the attribute. The attribute value cannot be typed, so it’s only really used 
making existing attributes visible, or adding a ‘place holder’ attribute position on items that do not as 
yet, have the attribute value, but want it to be positioned and visible when it is added later. 



106   Chapter 4 – Setting Up The Design 

 

This is used mainly in PCB Footprints and Schematics Symbols to add place holders for items like 
Part Names, Values, Pin Names etc. where you want a specific position to be used. The attribute 
values are fulfilled from the Part and ‘applied’ to the attribute positions when the Part and 
Symbol/Footprint are added to a design as a Component. 

Properties 

Properties can be used from the context menu once an item is selected. Choose the attributes tab 
applicable to that item, for example if picking a Component Pad on a net, you have a Pad Attributes 
tab, a Component Attributes tab and a Net Attributes tab. This example shows the Comp 
Attributes tab after picking a Component.  

 

The list shows all current attributes on the item, and whether they are currently displayed. Use the 
New… button to add a new attribute to the item selected.  

Design Properties  

The Design Properties option has a similar interaction to the Properties option, but available on the 
Edit menu. Use the Attributes tab to add design level attributes.  

Part Attributes in the Part Editor 

You can insert Part level attributes within the Parts dialog on each of the pages using an interactive 
method or by using the Part Attribute Editor (this is discussed later on in this section). 
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The attributes will be saved to the library with the Part, and added to components inserted into PCB 
or Schematics designs. See the Changing Attributes section below for details of how to ‘over-ride’ 
these part attribute values with local Component ones. 

Footprint Attributes in the Footprint Editor 

You can insert attributes for the PCB Footprints within the Library Manager on the PCB 
Footprints tab using the Attributes button or by adding attributes from within the Footprint editor. 

 

Hyperlink Attributes 

Any attribute or text string can be a hyperlink. This feature is enabled through the Technology file 
and Attribute Names page. Select the Attribute Name and click the check box Use as Hyperlink. 

 

Where the hyperlink is used you can add a link to various file types. With the hyperlink displayed, 
you can select the Execute Hyperlink command from the context menu where Pulsonix will attempt 
to invoke the appropriate application to read the link. This will work the same as if you had selected a 
link from your Windows Explorer program. 

You can use filenames, such as Word and PDF files, and folders within the hyperlink name, or you 
can use an Internet URL. 
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You are prompted with a choice if the item has more than one hyperlink (multiple hyperlinks can be 
defined in the Technology dialog and Attributes page). 

 

Dynamic Attributes 

Attribute values can be ‘plugged’ with values from other attributes. A special substitution character 
introduces the name of another attribute in the value and also closes it off. The character must be 
‘doubled’ when using it, e.g. %%NAME%%  

When editing an attribute, you can easily create these using the Substitute Attribute button. Two or 
more attributes can be added together to make a substituted attribute string. 

 

For example, you could create a new ‘dynamic’ attribute by combining two (or more) other attributes. 
A Component with attributes of Vendor and Value, could be combined to create a dynamic attribute 
called Insert. The entry in the Edit Attribute dialog would look like: %%Vendor%% %% Value 
%%  In the design, this would be displayed with the values from each attribute inserted, say Farnell 
and 10K and respectively. Attribute display for this type of attribute is the same as any other attribute. 
Note that a space (or any other character) can be used in between each pair of %% characters. 

 

To change the Attribute Substitution Character use Design Settings options and the General tab.  
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You can also use attribute substitution in hyperlinks. You could use this for defining the folder path 
and the filename as two attributes which could then be substituted to one hyperlink.  

For example, attributes defined for a generic folder: %%c:\datasheets\%% and each unique datasheet: 
%%AD8592%% and %%PIC16F%% produces (when satisfied): 

c:\datasheets\AD8592 and c:\datasheets\PIC16F respectively. 

Changing Attribute Properties 

Once attributes have been added to a design, footprint or design item, all Properties of the selected 
attribute can be changed; Value (not for system attributes), Position (X,Y position, Angle, Mirrored 
status, Locked status), Layer and Text Style used, and Alignment. 

 

You can also select the visible attribute in the design and delete it. This removes the visible state of 
the attribute, the attribute still exists on the item though. Use the Properties dialog to remove it 
completely from the item. 

If the attribute is not visible, select its owner item and use Properties from the context menu. Choose 
the correct attributes tab, for example if picking a Component Pad on a net you have a Pad 
Attributes tab, a Component Attributes tab and a Net Attributes tab. The above example shows a 
selected Attribute for a Component. Note: system attributes are not editable from this list. 

If the attribute is not owned by the item, but owned by the Component’s Part or a Net for example, 
the Edit... and Delete buttons will be disabled. To over-ride these attribute values with a local copy 
on the item being edited, use the New… button to add an attribute using the same attribute name, but 
different value. When this is done the Edit… button is enabled and the Delete button turns into a 
Reset button to indicate it is a local value.  
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Use the Reset button to reset the attribute value back to the original value from the Part or Net. 

Attribute Validation 

You can define a wildcard validation string along with an Attribute name on the Technology dialog. 
This is used to allow you to define specific values or contents for attributes up-front, and then for 
Pulsonix to check and verify them.  

For example, you could define the ROHS Compliant Attribute in the Technology dialog with a 
Validation string of Yes. If this is then changed to No or another string, it will be flagged by the 
Design Rules Check option. 

 

Checking Validation strings 

Attribute Validation is checked by Design Rules Check, the Attribute Editor and Attribute 
Properties. If you attempt to change the value to one not matching the Validation characters, you are 
presented with a warning dialog:  

 

Plotting and printing attributes 

Sometimes you may wish to see attributes on certain layers on the screen for information purposes, 
but don’t want these attributes to appear on any plots output. To switch off these attributes use the 
following procedure:  

Select CAM/Plot from the Output menu and select the appropriate plot from the list provided. Use 
the Edit… button to enter the CAM Plot Wizard. On the Process stage of the wizard, select the 
Exclude Items… button. You will be presented with a dialog titled ‘Exclude items From The Plot’. 
Use this to move attribute names from the ‘Choose from’ list to the ‘NOT to be PLOTTED’ list to 
exclude them from the plot. Finish the wizard to apply the changes. 
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The Pulsonix Vault 

When setting up your design, you may choose to use the Pulsonix Vault to manage your Libraries, 
Designs, Technology files, Profile files and Block files. This allows the vault to be used a Revision 
Control and Management system for your Pulsonix documents.  

 

With the appropriate license enabled, the Vault 
management tool is primarily situated on the File menu. 

 

 

Below is a brief introduction to the Pulsonix Vault. More detailed information can be found in the 

Online Help and within the Pulsonix Vaults Users Guide.pdf file 

Installing the Vault 

By default, the Pulsonix Vault is not installed. Because it uses a separate database mechanism to save 
and manage data, it must be installed as a separate process. 

Everything required to install the Vault is provided in a self-contained file. 

CD Install 

If installing from the Pulsonix CD, browse to the Vaultserver folder and click on the 
VaultAdminSetup.exe file to start the installation. This file contains everything required to install the 
Vault. 

Download/Web Install 

If receiving Pulsonix via the internet, the Vault server installation is a separate download. This will be 
located with the Double click on the VaultServerSetup.exe program to start the installation. Again, 
this is a self-contained file containing everything required to install the Vault. 

For either method, the installation is a three part process: 

1. Install the PostgreSQL Server – this is the service that contains the Vault. 

2. Create Vault Database – you must create a Vault database to use with Pulsonix. 

3. Choose Data Folder – you must choose where Pulsonix will store Vault data. 

As already mentioned, this is a brief overview of the Vault in this document. Refer to the Online Help 

for more information. 

Once installed, the Vault is managed from within the Pulsonix program. 
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Vault Manager 

The Vault Manager controls all aspects of the revision control and management of Pulsonix design 
items: 

 

Key Concepts of the Vault 

What can be stored in the Vault? 

The Vault can hold the following types of ‘library’ data: Parts, Footprints, Schematic Symbols, and 
Schematic, PCB Doc Symbols, 3D Packages and STEP models. 

It can also hold the following types of design-based data: Schematic and PCB Designs, Schematic and 
PCB Technology Files, Schematic and PCB Profiles, Schematic Block Files and PCB Panels. 

In addition, ‘Generic’ files such as Gerber and Excellon, ODB++, BOMs and other non-native file 
formats can be stored within the Vault. 

The Vault is designed to provide you with a secure environment for managing your ‘published’ data. 
You may still use locally-stored design files and native libraries for developing data, and release your 
completed items to the Vault when you are ready to do so. 

What is an ‘item’? 

Each item that is placed into the Vault is given a unique item identifier, or “IID”. Each time that item 
is saved to the Vault, a new version of the item is created, with this latest version having a new 
version timestamp or “Version”. This is distinct from the “Revision”, which we will hear more about 
in a moment. In this way, the Vault contains a full history of all revisions of an item. 
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The IID combined with the Version uniquely identifies a specific version of an item. In this way a 
Part for example can know which exact version of a Footprint it is to use. Not just any version of the 
Footprint, only the specific version that is indicated by the IID and Version listed in the information 
held along with the Footprint name inside the Part. 

Other Vault item properties 

In addition to each item having its own Item ID, every Vault installation has its own Vault ID. This 
allows the application to clearly identify an item as belonging to the current Vault. This means you 
cannot share items across separate Vaults, because there is no safe way of ensuring the uniqueness of 
the item ID of items created in different Vaults. You can still take an item from one Vault and check 
it into your own Vault as a new item, at which point it will be assigned a new item ID. 

Cross References 

Depending on the settings you use when publishing your data to the Vault, the application will 
maintain cross-references between related items, allowing rapid access to information such as ‘Where 
Used’ without having to resort to time-consuming compilation of reports. 

Managing and updating Vault items 

There are four basic actions which you can use to manage your Vault items. Your Permissions will 
control which of these actions are available to you for the various types of item in the Vault.  

Check Out 

Check Out will “book out” an item from the Vault for you to make changes. This action will be 
recorded in the Audit Trail, and the item will be marked as checked-out by you to prevent other users 
from making changes to it at the same time. They will still be able to access the item, for example for 
a Part they will still be able to use that Part in one of their designs, but they will not be able to check it 
out to alter it until you have finished with it. 

Check In 

After modifying an item, Check In will “book it in” to the Vault to commit your changes. Another 
record is placed in the Audit Trail, the item you are checking in is given a new revision, the ‘lock’ on 
it is released, and the newly modified item is available for others to use. 

You can also Check In an item that is not yet in the Vault, including newly-created items such as 
Parts and Footprints. 

Uncheck 

If you have used Check Out to book out an item to change it and then change your mind, you can use 
Uncheck to release your hold on that item.  

Copy Out 

If you need to use an item for something without actually changing it, then Copy Out can be used to 
pull a copy of the item to be stored locally. You might want to use this for example to open a PCB 
design to generate manufacturing data or run reports, actions that don’t actually change the design in 
a way that you want to record. 
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Vault Admin Tools 

The Vault admin tools on the Setup menu allows you to control and manage aspects of the Vault 
system that are not directly related to revision control or data management.  

 

Adding Vault Items to a Design 

There are a number of ways to add components to your design from the Vault. Primarily, you can use 
the Insert component option or Part Browser bar.  
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Chapter 5. Schematic Capture Editor 

Getting Started 

There are a number of ways of starting a new Schematic within Pulsonix. 

• You can start with the supplied Technology files and/or Drawing Profile. This is the preferred and 
recommended method of starting a Pulsonix design. 

• You can start with an empty design, that is, no Technology files, and no Drawing Profiles. You 
would add the necessary styles etc. to the design as you need them. 

• You can start by importing a design from another system using the import mechanism. Once the 
Schematic has been imported, a Technology file can be made from it as can a Drawing Profile, 
and libraries imported or created from the design. 

The discussion below deals with the basic start, with and without Technology files and Drawing 
Profiles. It then builds the design using the natural design flow as a guide, adding design items as they 
are required, each topic deals with one feature of the process. 

Starting a New Drawing with Default Files 

Regardless of which active window is currently open in Pulsonix, you can start a new Schematic 
design using the New option. This dialog can also be used for starting new designs (Schematics and 
PCB), Library items, Technologies, Profiles and access to the Library item creation wizards. 

 

Once you've decided to start the new schematic, you then need to decide whether you require a 
Technology file and/or a Profile file. 

The Technology file contains information such as the Styles, predefined Net Names, Attribute Names 
and Colours. The Drawing Profile file can contain documentation items such as a Page Border. You 
can start without either of these files and add them to the design later. It is better practice to start with 
the Technology file at least, although the Drawing Profile file is also useful because it provides a 
localised area in which to work and also is a guide to the printed page size for later on. 
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���� To start a new Schematic design 

1. On the File menu, click New 
It is better to start with a Technology file. The styles and values used in it will be the same as the 
styles used in the supplied libraries. Although this is not too important, it makes it easier to 
understand if you are just getting started with Pulsonix. 

 

2. Click on the small 'down' arrow on the Technology drop down list 

3. From the list of Technology files select Default (White).stf 
This is one of the default files supplied until you create and save your own. 

4. Leave the Profile File: entry as [None], unless you require a page border. 

5. Use the Set Units to override the Units defined in the Technlogy file. 

6. Click the OK button to start a new Schematic design. 

Design Options for Schematic Design 

Before getting started on the design itself, you should check that when you start adding design items, 
the editor will behave as you expect or wish it to. 

Many characteristics of design items are set up in the Design Settings dialog from the Setup menu 
and in particular on the Defaults tab. Once you start editing the design and adding new items to it, 
you should also check on the Options dialog from the Tools menu, to ensure that the Edit 
Connection and Interaction tabs are set to your own preferences. Pulsonix is a very flexible system 
and allows many of the options to be customised to suite your particular style of working. 

The Defaults page sets up the styles and values used when adding new items to the design.  



 Chapter 5 – Schematic Capture Editor   117 

In this example, the Bus Terminal defaults are shown: 

 

Unless an item is pre-selected, the default style defined in this dialog is used. If a similar item is pre-
selected, inserting a new item of the same type will inherit the style of the item. For example, if text is 
added to a design and the text style then changed from say Normal to Large200 (Normal being the 
Default), if the text remains selected, the next text item added will use the Large200 style even 
though the default is Normal. 

The Naming page in the Options dialog contains very specific information regarding the 
characteristics of design items, items such as the leading character or symbol used for the default 
system net names, e.g. whether N0001, or $1 is used (or another character).  
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The General page in the Options dialog allows you to set up more general design items. 

 

These dialogs are pre-programmed with built-in settings and should only be changed if you 
understand what they do and need to change them. Some of the settings can only be changed before a 
design is started where there are no design items in the design itself already. Some items can be 
changed after the design is started but the system updates itself to adjust all the design items that 
already used these settings, e.g. Default Net Name stem. 

Saving Design Settings and Options 

All Design Settings options are saved in the design, and so only effect the design you are editing. 
Other parameters used in the Options dialog are saved to the system's Registry and so are set up for 
every design that you subsequently create or edit. 

The Design Settings options are saved with the Technology files and so, once your preferences have 
been worked out, this allows for the same settings to be used when the Technology files is selected in 
future Schematic designs. 

When setting up Design Settings, you must also consider whether your design will use hierarchy and 
what style that hierarchy might be, multiple-instanced or not. This is covered in more detail later on in 
this chapter under Hierarchy. 

Setting up your Technology 

The concept of Technology files has already been discussed in a previous Chapter. This section 
details specific uses of Technology with the Schematic design editor.  

One other important consideration when setting up Technologies is the final process of translating to 
the PCB design and how the PCB handles the items used in the Schematics. The Pulsonix PCB design 
editor will use any Net Names, Net Class Names, Net Class Rules and Attribute Names used in the 
Schematic when transferred. 
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Schematic Technology dialog 

The illustration below shows the major styles used in components and Documentation Symbols, 
Connectors and Testpoints. These are all accessed from the Technology dialog. 

 

Pin Styles are used to define the appearance of pins and junctions that connections are attached to. 
These can be one of any of the shapes available, with a Width and for some shapes a Length. An 
Offset value can also be defined for both X and Y offsets.  

 

This enables you to display the pin in an offset position from that of the actual connection point. 

Connections obtain their Line widths from the Connections dialog. 

The Line Styles dialog is used for the line widths of Symbol outlines, Blocks, Busses and all other 
line items.  

The Text Styles dialog is used for the appearance of Component Names, Pin numbers, Net names and 
all other text items. 

The Net Names dialog is used to list the user defined net names used in the Schematic. You can set a 
nets Net Class name (see below) and whether the net is Local (i.e. only to be used on one page), or 
Global, available to all pages of the design, e.g. VCC or GND. 

The CAM Plots dialog allows plots and prints to be setup in advance. These are saved in the 
Technology data along with the other design information. Plotting the design is covered in detail at 
the end of this chapter in the section under Plotting The Schematic. 

Other facets of the Technology are discussed as they are used in this manual. 
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Rules 

From within the Technology dialog you can also define Rules that will passed through from the 
Schematic to the PCB design. Different levels of rules can be passed through during the Translate To 
PCB phase. . For example, you can define rules for Spacings, Min and Max Track width, or Min and 
Max Pin Lengths. These net classes are then applied to a net or multiple nets within the design. 

All of this detail is then passed through into the PCB design where it can be used and checked again 
on the physical design. This allows the engineer to define some of the critical electrical parameters of 
the design that the board layout designer can then use. 

In the example below, the Differential Pair rule is shown: 

 

Changing the Colours of the Schematic 

All item colours within the Schematic design can be changed using the Colours dialog. The use of 
this dialog has been discussed in a previous chapter, Setting Up The Design.  

The illustration below shows how the design is constructed using different colours for the different 
design items: 

 

From within the Colours dialog, Text categories are also available for (free) Text, Sym Text and 
Doc Sym Text. 

Grid colours are set up in the Grids dialog as discussed previously. 
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Using a Drawing Profile (Page Border) 

There are three methods of adding a page border to a Schematic design depending on whether you are 
using predefined page border or are creating it from new. It is recommended that you use Drawing 
Profile files for this purpose.  

 

Drawing Profile file - predefined Drawing Profile files can contain page border outlines in various 
sizes to start the design. These may already exist to be loaded into any Schematic page, or created 
within a design and saved as a Drawing Profile file. The supplied Drawing Profile files can be edited 
and saved to suite your own style required. 

Created Interactively - using the Insert Shape and Insert Text options you can create the shape 
outlines and add any text required (this can then be saved to a Drawing Profile file to be used with 
other designs). 

Documentation Symbol - Documentation symbols created and stored in the Documentation Symbol 
library can be added to the design as 'ready-made' page borders to use, this method is used by many 
other systems. If importing from another system these page borders will be converted to the Pulsonix 
Doc Symbol library.  

Adding a Drawing Profile File 

Once created, Drawing Profile files can be added to the design like most other items. These can be 
added at any time during the design process but it does make sense to add them early on to give you a 
guide to the size of the page and the area you have to work in. Adding Drawing Profile files while 
using the New option is the most efficient way of doing this, but they can also be added later by using 
the following procedure. 

���� To add a Profile File 

1. On the Setup menu, select Load Drawing Profile. 
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2. From the list, select a Profile file from the list. This file should be one that suites your eventual 
printing or plotting output requirements. The list of Profile files available is taken from the 
path(s) defined in the Folders option. 

3. Click OK to add the drawing profile file to the design. 

4. The profile will be added to the design but remains selected for repositioning. Click in free space 
to deselect it. If you wish to move it, select the outline and drag to the new location. 

5. If a drawing profile already exists in the design, it will be replaced with the new one selected. 

Resolving Styles during Insert Profile 

When saving Drawing Profile Files, the contents of the file can contain Styles not defined in the 
Technology you choose for the Schematics, it could also be that the Styles in the Drawing Profile file 
and the Technology file match in name but not in definition within it. 

When a Profile is loaded, any Styles used in the file will be used if they already exist providing the 
name and the contents match. If they don't match, a new style is added to the Technology dialog. 
Most important, is that the Style contents are maintained, the thickness and sizes etc. 

When creating the Drawing Profile file, you should attempt to use the Technology file that will be 
intended for use with the Schematic designs. 

Adding Documentation Symbols 

Documentation Symbols can be used to define Page Borders. This is covered in the chapter headed 
Adding Documentation Symbols. 

Creating Page Borders interactively 

Page borders can be created interactively using the options provided within Pulsonix. Please refer to 
the chapter headed Adding Shapes for more details. 

Using the Component Bin 

This section details how the Component Bin is used in the Schematic design editor. An overview on 
how the Component Bin works generally can be found in the previous Chapter, Using Pulsonix.  

The Component Bin in Schematics is used mainly as an off-page Bin for unused components and 
connector pins. You would use it to hold components or Connector pins that are unplaced but that you 
know you will need later on, or unused gates that form part of multi-gated component already used in 
the design. When multi-gated components are deleted, the gates are put in the Bin until all of that 
component’s gates have been deleted from the design. 
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Schematic components can be added directly to the Component Bin during the Insert Component 
operation as shown earlier in this Chapter. However, if you have components in the design that you 
wish to move into the Bin temporarily while editing another area of the circuit you should be aware 
that if connected at the time, the connections will be lost. Unlike the PCB editor that removes tracks 
but retains the connectivity, the Schematic editor loses the connection. If you move a connected 
Schematic Component into the Bin by mistake, use the Undo option to retrieve it. 

Components, gates or Connectors placed in the Component Bin will not be transferred to the PCB 
design during Translate To PCB unless they form part of an existing multi-gated Component already 
used in the design. Any completely unused components etc. in the Bin will be ignored. 

Adding Components 

Once the Design Settings have been set and the Drawing Profile (Page Border) inserted, the 
Schematic editor is ready for the design to be created.  

One of the first processes to attempt is the insertion of Symbols into the Schematic design; Pulsonix 
provides the Insert Component function for this purpose.  

Part and Symbol contents are created and saved into corresponding libraries. The Part entry contains a 
Part name, a Footprint (optional if translate to PCB isn’t required) and a corresponding Schematic 
Symbol or multiple symbols if the Part represents a multi-gated Component. 

Note: In Schematics, an instance of a Part used in the design is called a Component. 

When using multi-gated components, in the Design Settings, Naming dialog, you can define whether 
the Gate Name is displayed or not by selecting the check box. This displays gates like this: U1-a, U1-
b etc. The Gate Separator character can also be defined depending on how you want it to look, U1-a, 
U2,a, U3/a etc. 

 

The creation of Parts is covered later on in the manual in the Chapter on Library Management. 
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Using the Insert Component dialog 

Using Insert Component will allow you to select the required Part from the appropriate library or 
libraries. 

 

Use Look In to choose the libraries you are going to search for the required Part. Normally [All 
Libraries] will be used to search all libraries in the Library folder, otherwise, select the library name 
or use [Current Design] to search components in the design. All other libraries available in the drop 
down list will be shown using their own name. 

Which Parts enables you to filter the search list to find specific Parts. You will notice that with no 
filter information or * (any), the Matched: numbers may be uneven, e.g. 1654 of 2952, this means 
that there are some Parts in the libraries that are PCB only Parts and as such, unavailable for 
Schematics. The Filter box can take any name and wildcard characters. 

Wildcards can be used to make the filter more efficient. (Wildcards are special characters that are 

used to match any character rather than being specific, for example * and ? ). For example, 74LS* 

More information about using Wildcards can be found in the on-line help. 

The Pins box is used to limit the matching parts to those with a known number of pins (blank means 
any pin count). 

Once a Part or range of Parts matching the Filter selection have been found, the first Part available 
will be shown in the Part list. This will display the full Part name (4608X-102 680) and the Library 
from where it came, shown in braces, e.g. {Resistor}. 

From the Part library entry, the available alternative Footprint entries will be loaded into the Part 
drop down list, e.g. SIP8. These may be surface mounted alternatives or different packages available 
for the Part. Choose the required Part and Footprint. 

The Name box shows the default name stem for this Part (taken from the Parts library default 
Component Name Stem entry) and the next available number in the sequence. Both the name stem 
and the number can be edited if required. 

Type in the name required of the Component. The default name presented will be constructed from 
the Name stem taken from the Part in the library, e.g. R and a number to form a unique name as yet 
unused in the design, change this if required. 

The Gates entry is only shown if the chosen part has multiple gates and you are not adding to the 
Component Bin (only whole components may be added to the bin).  
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The default gate identifier is the next free gate of this type that is not yet used in the design. For 
example, if U1-a and U1-b are already placed on a sheet in the design, then U1-c will be the default 
name. The list box will contain the names of unused gates on the Component using the typed name. 

The Component Bin check box can be selected if you wish to add the Component(s) to the 
Component Bin. These components can then be dragged from the Bin into the design at a later stage. 
The Number Of Copies box allows you to add multiple parts to the Bin in one operation. Please refer 
to the section below on Using Component Bin for more information. 

The Preview check box opens the preview window allowing you to view the Component before it is 
inserted into the design, this gives you chance to visually inspect it to ensure that it is the current one. 
Checking the Schematic & PCB box will also allow you to preview both design views of component 
selected. The Attributes button will preview Attributes associated with that component. 

The Vault button will display information about the Part if it has come from the Vault (the Vault 
must be installed and active for this button to be displayed). 

 

Once you have the Part you require (shown in the Preview window) and its Footprint and Name are 
correct, you can add it to the design using the Add button.  

If you are not adding to the Component Bin, the Add button will dismiss the dialog from view and 
will allow you to interactively add as many Parts of the type selected as you like to the design. If you 
require a different Part you should cancel this process by pressing the <Esc> key on the keyboard. 
This will immediately return you to the Insert Component dialog from where you can make further 
Part selections. If you wish to cancel Insert Component completely, having finished this process, 
use the Cancel button from the Add Component dialog. 

Adding Multiple Components in Arrays 

After selecting the Insert Component option, if you then right mouse click while the Component is 
dynamic, you can select the Insert Multiple Items option from the context menu. 

From this you are presented with the Insert Multiple Components dialog: 
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The Step Offset defines the distance each Component is offset from the previous one. There are 
separate values for X and Y and they may be negative to step in the reverse direction. 

The Number of Items defines the number of items in the X & Y directions. These numbers include 
the original as the first item (so they start from 1).  

Use Insert Order to define the order that the items are added. First select Insert Rows or Insert 
Columns to specify the items are added in rows or columns, and check the Switch Direction box to 
specify that the next row is started above the end of the previous row, or leave unchecked for each 
row to be added in the same direction.  

Press OK to add the multiple items. They will all be dynamically displayed on the cursor for you to 
click in the required position. Use Insert Multiple Items again to alter the item counts or gaps 
between them whilst placing the items. Set the counts to 1 to go back to adding a single item. 

Interactively positioning a Component 

Whilst using the mouse to add the Component or Gate, you can use the context menu to change its 
angle and to mirror it, for example, or to change the size of the grid steps that the Component is being 
moved by. This is explained in detail in the Chapter General Utilities under Moving Items.  

Use the Next In Sequence option from the context menu to increment the Component name and gate 
identifier to the next free Component or gate not used in the design. Click to position the Component 
or gate at the required position.  

 

Once in the design, components can be repositioned using the 
Move option or by selecting and dragging them. 
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Using Decoupling Capacitors 

Decoupling or bypass capacitors are frequently used in the design process. There are quite often equal 
amounts of decoupling capacitors to integrated circuits, on large digital designs this can mean a lot of 
work to add lots of these devices. Pulsonix has a short form notation for using one device to represent 
many devices by using a simple naming convention.  

When naming a single capacitor Component you can use the notation name[1-3] where 1-3 represents 
the number range, e.g. C[1-3]. After Translate To PCB, this will become 3 individual capacitors of 
the same Part type and will be named C1, C2 and C3. 

The Name Range characters used are set up in the Design Settings dialog under Naming.  

 

The Range Start and Range End are the characters used to enclose the range numbers e.g. C[1-3]. 
The Range Separator is used to 'split' the number range, e.g. C[1-3] and the Item Separator is used 
when there is more than one Component name or if the sequence is not sequential, e.g. C1, C[1-3] 

 

Note: this naming methodology applies to other components as well, not just capacitors. 

���� To add decoupling capacitors 

1. From the Insert menu, select Insert Component. 

2. Click on the Name box and type the name range required, for example C[1-4]  

3. The dialog will now recognise the name range and display the message Range of X components. 

 

���� Alternative method for naming decoupling capacitors 

1. Insert a capacitor Component into the design from the Insert Component dialog. 

2. Click on the Component Name e.g. C1, right click and select Properties, Component page. 
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3. Edit the Component Name to create the name range required, e.g. C[1-3]. This is verified with 
the message Range of X components as shown above. If the name range has been defined 
incorrectly, when you attempt to exit the dialog, it will tell you to correct the error first. 

4. Click OK to accept the new name. 

5. If the name range contains a name that has already been used, then a warning dialog will be 
displayed when you attempt to exit and you will need to correct it before you can apply the range. 

Note: As an alternative to using named ranges for decoupling capacitors, you can also use the Pin 

Network option. Please refer to the Online Help for further information.  

Adding Connectors 

Connectors in Pulsonix are Parts that have a special ‘connector’ flagged set during the Part creation. 
As a Schematic representation, they are usually pins on the designs that can be individually placed, 
but which refer to one PCB Component. In Pulsonix you can create connector Parts like this, or as 
one symbol containing many pins, again referencing one PCB footprint. Both methods are detailed 
below: 

In Pulsonix, the Connector can be represented in one of two ways: 

• As individual connector pins that can be placed anywhere on the Schematic design, but that refer 
to the same footprint using up to the maximum number of connector pins for that device e.g. PL1-
1, PL1-2 etc. 

• The single Connector pin has special properties: it can be selected from the Insert Connector 
dialog and placed anywhere on the Schematic. This means one pin could be used as an input pin 
on one side of the design, and another could be used on the right side of the design as an output 
pin. 

The second method of using connectors: 

• Like a ‘normal’ Component with single or multiple gates to show the Schematic representation, 
and a PCB footprint. This is less flexible in the Schematic design as the Schematic pins cannot be 
placed anywhere (unless you define multiple single pin gates). If you want this, create a proper 
Connector Part. 

Both have their uses. For this discussion the Connector Pins will be detailed. If you wish to use a 
normal Component as a Connector you should follow the chapter for Creating Parts later in the 
manual. 

From the Design Settings dialog and Naming, use the Display Connector Pin Name check box is 
used to decide if you want the pin number to be displayed as part of the Component Name. 

 

When naming Connector pins, Pulsonix uses the Connector Pin Separator character defined in the 
Options and Designs dialog to distinguish between the Connector Name and the pin in the 
sequence, e.g. PL1-1, PL1-2 etc. 

���� To add Connector pins  

1. Click the Insert menu, click the Connector Pin option.  

2. Select the Parts library you wish to use using the Look In:.drop down list. 
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3. A list of Connector Part Names will appear in the dialog. Only parts that were added to the 
library, as connectors will be shown. Use the Filter to reduce this list to the parts that you are 
interested in.  

 

4. Choose which connector part you wish to add from the list of Parts: using the drop down list. 

5. Change the pin number you want to add (if the default provided is not suitable) using Pin: 

6. Choose to add the connector (or a number of copies of it) directly to the Component Bin, or to 
add a connector pin interactively into the design using the Add button.  

7. If adding to the Component Bin, you are returned immediately to the dialog, else follow these 
next steps.  

8. Using the mouse, move the connector pin to the desired position and click to place it into the 
design.  

9. Continue to place connector pins using the same Part. Each pin is auto incremented to the next 
free pin number in the design, or, if all pins of the Component have been added, the Component's 
name is auto incremented to the next free name in the design. 

10. Press the <Esc> key, to return to the add connector pin dialog.  
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You can also insert connectors using the normal Insert component dialog. Check the Include 
Connectors switch to browse your connector parts as well. 

 

Reloading Parts 

Once components have been used into the design, you may need to change the Symbol or the Part 
definition in the library and then reload it into the design. 

You should select the Component you wish to reload. From the context menu you are provided with 
options to Reload From Library (once the Part and/or Symbol has been edited), Edit Part In 
Library and Edit Symbol In Library to edit the actual Part or Symbol items.  

 

If you select one of the two Edit options, you will be automatically placed into the Part or Symbol 
editor with that particular Part or Symbol loaded from its library ready for editing and saving. You 
should make your changes and save the updated library item. This is detailed later on in the Chapter 
on Library Management. 

Once the Part and/or Symbol item has been changed, you need to then reload it back into the design, 
effectively 'swapping' out the existing item for the new one. 

To do this, use the Reload From Library option. With the Component selected in the design, you 
can use the option from the context menu, or the Reload From Library options on the Utilities 
menu.  

When Reload is used, all other components in your design using the changed Part or Symbol will also 
be reloaded. You cannot have two different versions of the same Part or Symbol in a design. 



 Chapter 5 – Schematic Capture Editor   131 

The Reload From Library option reveals a control dialog that enables you to selectively choose how 
the Part will be reloaded. You can choose how items are loaded and which facets within them are 
retained aor overwritten. 

 

Pressing OK takes you to the summary page for confirmation and also the ability to view a report of 
the potential reloads before they are performed. 

 

Adding Connections to the Design 

Connections are added to the Schematic design to make electrical connectivity between Component, 
Connector and Documentation Symbol pins. You can add connections to other connections forming 
junctions. You can also add connections to the design that do not connect to any electrical pins, these 
are 'dangling' connections and are useful during the design process but should be resolved before the 
translation to PCB process.  
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As already demonstrated in the Technology section above, connections hold properties of the Net 
name and Style. When translated to PCB, all connections using the same net name are joined together 
to create the netlist from where the PCB is then created. 

Information about the connection being added is shown on the Status bar. 

Setting up Connection Options 

Before any connections are added to the design you should setup the default values used and any 
predefined Net Names or Net Classes to be used (setting up Net Names and Net Classes has already 
been discussed in the previous section). 

Default Connection and Net values are set up in the Design Settings dialog under Defaults.  

Connection sets up the Style of the connection. This will provide the displayed and plotted width 
when used in the design. 

Net sets up the default Net Class that new connections will use during insertion. The Name Style will 
be the default text style used if the Net Name is displayed in the design. 

Inserting Connections 

Once a connection has been started, each single click will add a corner until the destination has been 
reached. The finish marker F will be displayed and a single click on that pin or electrical ‘landing 
site’ will finish it.  

Connections can be added to the design in a number of ways: 

• Using the Insert Connection option from the Insert menu or from the Schematic Toolbar, click on 
the pin to start adding a connection, or; 

• Double-clicking on a Component pin to start a new connection, or; 

• 'Dragging' off an unconnected Component pin to start a new. 

Tip: If the 'drag off pin' mode is enabled you may find it difficult to move components if you select too 

close to a pin. To avoid this, select and keep pressed the Shift key, and the Component will be 

selected and moved. 

If you intend adding connections by 'dragging' off pins you must select the check box this first 
through the Options, Select dialog. If unchecked, a drag moves the Symbol as normal. 
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You can use double-click or drag method to add connections but these are only 'one off and only add 
a single connection. Once the connection is completed, you are automatically returned back into 
Select Mode. The Insert Connection mode allows you to continue 'stitching' in multiple connections 
until you exit this mode. 

At any point you can change the characteristics of the connection. You can change its Style, the Net 
Name and the Net Class Name.You can do this while adding the connection or after the connection 
has been added by editing its Properties. These options are available on the context menu or as 
shortcut keys as pre-defined. 

 

Changing the connection Style 

The Style of the connection can be changed from that defined in the Design Settings, Defaults 
dialog.  

���� To change a connection Style 

1. While adding the connection right click and select Style or press the <S> key on the keyboard. 

 

2. Select the New Style name from the drop down list, or edit the new Width required and type the 
new style name in. 

If the Style name is left blank, you will be prompted with a default name (style1 or the next available 
name in the sequence) that will be added to the technology if OK is pressed. 

The Apply To All Segments check box should be used if you wish the style change to be applied to 
all segments on that connection. 

Changing the net name during Insert Connection 

While inserting a connection you may wish to change the Net Name, this can be done using the 
Change Net Name option from the context menu or by clicking the <F2> key on the keyboard. 
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From the dialog displayed you can change the Net Name by typing in a new name, or by selecting an 
existing name from the drop down list. The net names list will contain both Local and non-local 
(Global) net names.  

If you have typed in a new net name, the Local Net check box is available. Check this to force the net 
name to only be used in the current scope. The scope is either all pages in the current block instance 
or all pages in the design top level (i.e. all pages not in a block instance). Alternatively, make it a non-
local net, a Global net, (i.e. available to all pages of the design) by unchecking the Local Net box. 
This might be a net name such as VCC or GND. If the selected net contains items connected to closed 
busses (i.e. busses that have a closed set of allowed net names, these are explained later on) then the 
list is limited to just the names allowed. 

You can also change the Net Class by selecting a name from the drop down list provided it has been 
defined in your Technology. A Net Class won’t be required if you’re using Net Styles. 

Tip: While adding connections, you can press <F2>, followed by the signal name and <Enter>. This 

will display the Change Net Names dialog, enter the signal name that you type and OK the dialog. 

Net Names that are unused in the design but that may have been used previously or typed in 
incorrectly can only be removed in the Net Names page of the Technology dialog. By pressing the 
Delete button on a selected Net Name in this dialog, you can remove it all together. By doing this, 
you will restore the Net Name to a system default net name using the next in the sequence. 

The Show Net Name check box can be selected if you wish to display the net name on the net. You 
can also set this status afterwards using the context menu of a selected net. 

Start & ending on different design items 

During the insertion of a connection, you can end the connection on a new, single pin design item, as 
well as any existing electrical pin. This feature can also be used to start a connection on but you must 
be in Insert Connection mode. 

During Insert Connection, before starting the connection you can right click to use the Start 
Connection On option from the context menu. After starting the connection you can right click to use 
the End Connection On option on the context menu. You will be presented with the following menu 
and sub-menu:  
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Connector Pin is used to add a PCB Connector pin. This displays the Insert Connector Pin dialog 
to choose the connector Part and which pin number to use. 

Signal Reference is used to add a reference to a Net Name. This displays the Insert Signal Ref 
dialog to choose which signal reference Symbol to add. Use this to add symbols to indicate the use of 
the net, for example, a ground symbol, a cross-page reference, or a sheet label. This displays the 
Insert Signal Ref dialog to choose which Net Label Symbol to add. 

Net Label is used for attaching to a net to highlight a particular net.  

Testpoint is used to add a Testpoint to the design. This displays the Insert Doc Symbol dialog to 
choose a Documentation Symbol to use for the testpoint (unless a testpoint has already been added to 
the design that it can copy). A unique testpoint name will be allocated by the system and attached to 
the Documentation Symbol's pin. Use this to indicate that a testpoint needs to be added to this net 
when Translate To PCB is performed.  

Branch Point – if you have the Interactive High Speed option, you will also be able to end a 
connection on a Branch Point. These are used in conjunction with Signal Paths and/or Sub Nets to 
create specific branching points of a net so that additional parameters can be added. 

Page Link is used to add an off page connector symbol. This is only available if you have changed 
the Net to be a global net, i.e. available to other pages of the design. This first displays the Insert Doc 
Symbol dialog to choose the Documentation Symbol to use (unless this net already has a page link 
symbol it can copy). Then it displays the Add Page Link dialog to choose the page to link to.  

None is used when no new item to start/end the connection from is required. This allows you to pick 
an item from where to start/end the connection. 

Once you have chosen an item to start/or end on, it is displayed at the end of the cursor for you to 
place. Use a single click to place a start item, or a double click to place an end item.  

Adding ‘Dangling’ Connections 

A dangling connection in Pulsonix is a connection that starts or finishes in ‘free space’. This is 
perfectly legal and can be useful if you start a connection and cannot decide its destination right now. 
You can leave it dangling as unconnected at one end until a later stage. Once a connection is 
dangling, to continue it, double-click on its end (to Edit it), or if using the Insert Connection option, 
select its end and continue with the connection path. 
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Starting Connections on other electrical points 

You can start a connection on other electrical items such as junction points and other connections. 
However, to do this you cannot use the Drag method, and the Double-click method only works in 
some instances. 

To start a connection on a junction point (the dot that indicates two or more connections connected to 
each other), you may use the Insert Connection mode or double-click on the junction. From this, a 
new connection will be started. 

 

If you wish to start a connection from a corner of an existing connection you should use the Insert 
Connection option or double-click on the corner. The drag method will only move the corner. By 
starting on a corner of a connection a junction point will automatically be inserted. 

 

If you wish to start mid-point on an existing connection you can only use the Insert Connection 
method. Attempting to use double-click will edit the connection. Using the Drag method will move 
the connection segment. 

 

By starting on the middle of a connection a junction point will automatically be inserted. 

Changing Segment Modes 

While editing connections you can change the 'mode' of segment to enable different 'styles' of editing 
to take place. For example you can use the Orthogonal mode that provides you with two dynamic 
segments on the connection being edited, or Angle that gives you a mitred corner when you change 
directions.  
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Free enables the connection to be added at any angle, and Curved works the same as Mitre except 
that the corner added is curved. 

In addition to the Segment modes, you also have the Editing Options. These provide you with 
additional options for use during Insert Connection. 

 

Auto Corner will automatically insert corners when any change of direction is made during Insert 
Connection. This will use 90 degree corners if the Segment Mode is set to Orthogonal, or Mitred 
corners if Mitre is set. 

If Auto Mitre is set, when a change of direction is made, a Mitred corner will be added regardless of 
what is set in the Segment Mode. The Mitre will be a fixed size using the setting in the Options, Edit 
Connection dialog. 

For both the Segment Mode and the Editing Options, you can either change these while editing or 
inserting a connection, or before the session using the Options and Edit Connection dialog. 
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This dialog is also used to set other options related to inserting and editing Connections. 

Starting a Connection on a Bus 

To start a connection from a Bus (Busses are explained in more detail later on in this chapter on 
Using Open & Closed Busses) you must use the Insert Connection method. Click on the bus 
segment you wish to start from and you will be presented with a dialog from where to choose the net 
name.  

 

When using Insert Connection and adding to a bus, there are rules covering Open and Closed 
busses that are adhered to. There are covered in detail in the chapter on Using Open & Closed Busses 
later on. 
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Showing Junctions over Pins 

If two connections are attached to a Component pin, a junction is only drawn if the Draw Implied 
Junctions On Pins check box is checked in the Options dialog and Display. 

The example below shows how the 'implied' terminal would look in the design:  

 

This can be overridden on individual pins if required by selecting the pin and using Properties: 

 

Changing the connection grid 

While adding a connection, use the Change Grid option to ensure connections are placed on 
predefined grid points as required. Connections will snap to the Working Grid or no grid if the Use 
No Grid option is selected.  

 

Inserting Components to split a connection 

Once a connection has been added to the design, it is possible to move or insert a Component over the 
connection to split the net. This is useful to add a capacitor or resistor into a section of circuit that 
already exists. 
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This situation can only occur with 2 pin components and where the connection is orthogonal 
horizontally or vertically, the process is automatically exercised once Pulsonix detects this situation. 

First the Component is selected or inserted and moved over the connection so that the Component 
pins are in-line with the connection.  

 

Once the Component has been moved over the connection, the weld markers are displayed (small 
round blobs): 

 

A warning dialog is displayed to show that the net is split into two, with one retaining the original net 
name (if assigned): 

 

The Component is then dropped in place with the original connection split. 

 

Disconnecting Terminals 

If you wish to disconnect a connection and put it on another terminal use the Disconnect Con End 
option. This option is only available when editing a connection and can be found on the context 
menu. 
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The end that is dynamic for editing will be disconnected when edited. This direction can be changed 
using the Reverse Edit Direction option available on the context menu under the Change 
Segments> option. 

Add Connection Modes 

Sketch Connection Mode 

The Sketch connection path mode is available in the Schematic design editor. This allows you to 
interactively make a connection between two points using a basic ‘sketching’ mode, or by using a 
point-to-point mode. This is an alternative method to dragging off terminals or using Add Connection 
mode. 

Using the Sketch Connection mode from the Insert menu, you can add connections to the design. 
Once in this mode, this is verified by the display of a modal cursor, a cursor which shows a mode. 

 

This picture shows the 
approximate path that you 
‘sketch’ in. The modal cursor 
is also shown. 

 This picture shows the final result 
after completion and tidy-up. 

Immediately after using sketch mode, the tidy routine will snap the connection onto the grid and 
remove all the rough edges for you. Once added, the connection path can be tidied up using normal 
connection editing options. 
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Context menu options 

While using the sketch mode, you can select options from the context menu. 

 

Sketch on Grid should be used if you require the connection to be on grid, this mode is 
recommended. 

On the context menu, you can select Sketch Point To Point mode. This allows you to point and click 
to add a connection path. After the mouse click, the path will be tidied back to the last click, this gives 
you a ‘guided’ routing path which is automatically tidied as it goes along. This may be a preferred 
mode of operation to the normal sketch mode. 

Sketch modes can be pre-selected from the Options dialog and Edit Connection page. 

Connection Options 

The Options dialog and Select page allows you to use drag or double click to add a connection from 
a pin on a net with no connection. This is particularly useful for reverse engineered designs. The 
default is drag to sketch and double click to use normal add connection. The default sketch mode is 
point to point. 
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Naming and Renaming Nets 

By default, any connection added to the design will contain a default net name. This name can be 
changed during the addition of the connection or renamed afterwards.  

Using default Net Name properties 

Nets have a number of default properties - Net Name, Net Class and a local state. New Nets will 
automatically be assigned a default Net Class and made global when added to the design (a global net 
can be used throughout the design, for example +5V or GND). Nets that have previously been named 
in the Technology file will already have a Net Class assigned to them, and be marked local or global 
(local nets are considered to be page specific, for example, on a multi-sheet hierarchical design). 

Naming Nets & Renaming Nets 

At the addition of connections or the editing of connections you can name them using your own name 
as an alternative to a system default net name. You can press the <F2> shortcut key this will display 
the Change Net Name dialog. This option is also available on the context menu.  

 

Local and Global Nets 

When designing your Schematic, by default, net names are considered global. That is, even when 
using multiple pages, everywhere a net name is used, it refers to the same net. Items using the same 
net name are connected to the same net.  

It is possible to define a net name as local, which means that only items on the same page can be 
connected to that net. The Local Net Names section of the Design Settings tab and Naming dialog 
controls the creation of these local nets, and how their names are generated. This ensures they are 
unique when producing netlists, or passed forward to PCB. These parameters can only be changed for 
a new design that doesn’t already contain net names or for the Schematic Technology file. 
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Names Unique Across Design, when checked, ensures that the local net name is only used on one 
page. So if 'Page1' has a local net called 'Net1', 'Page2' could not have any reference to a net called 
'Net1'. When this option is unchecked, it is then possible for 'Page2 ' to also have a net called 'Net1', 
but it is not the same net and they are not considered connected. Of course when such a design is used 
in a PCB application these two nets must have unique names. This is where the other controls on the 
dialog are used. To make the net names unique, the page name is added to them. The way this is done 
is configurable. You can choose to have the page name before or after the net name, and also have a 
prefix and infix. In our example, if we chose a Local Name Prefix of '$$', a Page Net Separator of '-' 
with the Page Before Net Name, the nets would be named '$$Page1-Net1' and '$$Page2-Net1'. 

If using these options, consideration must also be taken if the design is to contain hierarchical blocks. 
See the section under Hierarchy for more information. 

Defining Track & Vias styles in SCM and Translated to PCB 

When working with Schematic designs, there are two methods for defining the Track and Via styles 
in the PCB. The method used depends on how specific you wish to be up-front.  

• You can either use a Net Class on a net to create a collective of ‘similar’ nets that can have a 
Track and Via style defined, that is, passed into the PCB and use Net Types with the same effect. 
Net Types can also be used in the same way. 

• The second method is to be more specific and to define net or groups of nets with Track & Vias 
Rules. Rules can be defined generically, such as all nets or ADD*, or very specifically, such as 
CLK uses XXX rule and SDQ_* uses YYY rule. Once in the PCB (and with the Design Settings, 
Synchronisation switch set), defining them in this dialog means they are directly converted in 
the Schematic into Net Styles in the PCB. 

Setting the switch in Design Settings, Synchronisation in the PCB Design 

A option in the Design Settings option under Synchronisation allows Net Styles in PCB to be 
created from the Track & Via Size Rules in the Schematic. Use the Apply Schematic Track & Via 
Size Rules to Net Styles switch to enable this feature. Without this switch enabled, this feature will 
not operate. 
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This means, where you need to specifically define Track and/or Via Styles in the Schematic, they can 
be passed through into your PCB where they will be used in Net Styles. Both the Translate To PCB 
and Synchronise Designs options will use this feature once the switch is set. 

If Translating to PCB to create the initial design, your PCB Technology used must already have this 
switch set in order to pass across the settings. Once set, use the Synchronise Design option to update 
the design with these settings. 

Design Settings Synchronisation 

Once the Apply Schematic Track & Via Size Rules to Net Styles switch has been checked in the 
PCB Design Settings Synchronise dialog, you can then define the Track & Via styles in your 
Schematic design. 

Defining Track & Via Size Rules in the Schematic 

From in the Schematic design, use the Technology dialog and DFM/DFT Rules – Track & Via 
Size Limit dialog. These should be defined in accordance to your requirements. They can be generic 
such as all Net Names in the design, or more refined such as specifically named nets such as DQS*. 
Other parameters can be selected from the drop-down list as well as Layers, Sides and Within 
Areas. 

 

These are the rules that will be passed into your PCB design. 

 

Translate to PCB 

During Translate to PCB, with this switch set in your PCB Technology file, this setting will be 
initially applied to the new design and your Schematic Track & Via Size Limit Rules will be 
defined in the PCB 

If the Track & Via Size Limit Rules are applied to the PCB, it will add new Track styles and a new 
Pad Style to the Technology. Two new Track Styles will be created based on the Min and Max 
Track width defined. The Pad style created will use the Min and Max Via Dimeter to create a pad 
of the Max diameter size with a drill using the Min Diameter value. 

A new Via Pad style is added to the Pad Styles dialog:  
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New Track styles are added to the Track Styles dialog: 

 

Matching settings in the Net Styles dialog for the nets requiring them will also be created using the 
new (or matched) Track and Via Styles. 

 

Electrical Rules Checking (ERC) 

ERC Modes of operation 

There are two modes of checking the electrical rules; Online and batch checking. The batch check is 
more comprehensive and checks all rules set. The online checking option checks a subset of the full 
batch checking option and is restricted to Pin Types only.  

Online ERC 

Online rules can be switched on and off in two ways; through the Options dialog and Online ERC, 
and by use of the context menu during Insert Connection. 

The Online ERC dialog on the Option dialog allows the mode to be switched on, and then as with 
Online DRC mode in PCB, allows it to be continuous or enabled On-Drop or After Edit. You can 
also opt to Add an Error Marker to the design on the detection of an error. 



 Chapter 5 – Schematic Capture Editor   147 

 

If you check the Treat All Dangling Bus Connections As Unfinished, any dangling connections 
from a bus are flagged as unfinished when running the Dangling Nets or Dangling Connections 
checks in the DRC option. With this left unchecked, the check is ignored for these connections. 

Electrical Rules Checking Dialog (batch checking) 

As well as the Pin Type Rules there are also additional rules that can be checked when the Electrical 
Rules Checking option is run.  

 

Different rules can be selected for checking in this design. The online ERC option will only check Pin 
Type rules, the Electrical Rules Checking dialog contains additional rules for batch checking.  

Acceptance Rule Set 

The electrical rule switches that are shown in this dialog can be saved into the design to form the 
acceptance rule set. This is the set of rules that should be checked before the design is to be accepted 
as finished. Use the Load button to change the switches in the dialog to the acceptance set in the 
design, and the Save button to change the acceptance set in the design to the switches in the dialog. 
The summary at the end of the ERC report says if all acceptance checks were checked or not. 
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Defining the Rules 

The Electrical Rules Checking (ERC) mechanism allows pin type rules to be set, then checked on 
components that have been allocated these rules. The checking is carried out using an online option, 
or the batch option. 

The order in which this process works is:  

1. Define and add the Pin Type to the pin number in the Part editor. 

2. Define the Pin Type Rules in the Schematic design or its technology. This is done using the Pin 
Types and Pin Type Rules dialogs. 

3. Add the Component(s) to the design, these must be components that have Part definitions with 
Pin Types defined. 

4. Enable the Online Electrical Rules Checking (ERC) and start adding connections to the design. 
Errors found during this process will be displayed, or; 

5. Use the Electrical Rules Checking option from the Tools menu, this is used to check all of the 
connections and components in the design. 

Pin Type Rules 

You must set up two items within the Technology dialog: Pin Types and Pin Type Rules. One 
defines the Pin Type Name and the other defines how each of the Pin Types react with each other.  

Pin Types Dialog 

The Pin Type name is added to the Pin Types dialog under Technology. By default, Pulsonix is 
supplied with a list of industry standard names, there are no built-in Pin Types as such but a set 
predefined for you. Any of the names can be edited but care must be taken if you do this, as the 
names will potentially not match Part library Pin Type entries. This list also includes any user-defined 
Pin Types.  

 

Use the New button to create a new Pin Type name. 

Any names added can be checked once they have been added to the Pin Type Rules definitions and 
provided they have been assigned to a pin on a Part. 

From the Pin Type dialog you can specify if a Pin Type is power/ground/no connect and if it is 
allowed on block ports. 

When a Pin type is defined as Power or Ground then when the Part is brought into the design, if the 
design has more than one net name assigned to any power net classes then a dialog will prompt you 
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for the net name for which to connect to. A Pin type of No Connect will not allow any connection to 
connect to it. 

The Allow On Block Port check box allows the Pin type to be used for Block Ports and applies 
block port rules to block ports when using hierarchy. Block instance pins use the normal pin rules. 

Pin Type Rules 

The Pin Type Rules dialog is used to define how the Pin Types will react with each other when 
connected together. The first column displays a list of all the Pin Types defined (taken from the Pin 
Types dialog). The second list displays the rule against the corresponding Pin Type, these are colour 
coded depending on the rule. Any text in blue is noting a Warning Rule with Red noting an Error 
Rule.  

A rule can be defined by selecting the Pin Type and clicking the Edit button, or by double clicking 
the Pin Type name. 

 

The Edit dialog allows single or multiple selections of Pin Types on which to then apply a rule. The 
Ignore status is the default and is shown in the normal text colour, only Warnings and Error rules 
are displayed in the appropriate colour. 

 

Pin Type Rules can be reported using the Pin Type Rules report found on the Output menu under 
Reports. 

An example report looks like this: 



150   Chapter 5 – Schematic Capture Editor 

<Undefined>                    

<Undefined> {Block Port}       

 

Bi-Directional                 

 Ground                        Warning 

 Input {Block Port}            Warning 

 Power                         Warning 

 Output                        Warning 

 Output {Block Port}           Warning 

 

Ground                        Ground 

 Bi-Directional                Warning 

 Open Collector                Error 

 Open Emitter                  Error 

 Tri-State                     Error 

 Output                        Error 

Load Technology Pin Types 

The Load Technology option will load Pin Types and Pin Type Pair Rules if required. 

The ERC Error Browser 

When the design contains error markers (added when the ERC check is run and errors are found), you 
can show a list of all the markers by displaying the ERC Error Browser.  

The browser can be invoked when running ERC from within the dialog by using the Show Errors 
Bar check box or from the View menu or from the Dockable Views toolbar.  

You can select an error marker in the Errors Browser and highlight it in the design. 

Viewing Errors 

To view an error of a particular type, click on the box next to ERC Errors. This will then display all 
the actual error types found in the design. Click on the box next to the error type that you want to look 
at. This will then give a list of the pages that have this error. Click on the box next to the page name. 
This will then list the position of all errors of this type on this page. If you then double click on one of 
the positions in the list, the view centre of the page will move to this position. The error marker will 
be drawn in the current highlight colour.  

 

Right clicking inside the ERC Errors Browser 
will display a context menu. From this there 
are menu items that allow various 
complimentary options to be run. 
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Documentation Symbols 

Overview 

As the name suggests, Documentation Symbols are typically symbols that have no real electrical 
significance on the design but are used for annotation or documentation purposes.  

These symbols could be used for design items such as Testpoints, Power & Ground symbols and 
Cross Page Link Symbols etc. 

The main difference between Documentation Symbols and 'ordinary' Symbols is that they have no 
Part definition, and they reside in their own Documentation Symbol library. Most importantly, most 
Documentation Symbols are not transferred to the PCB design when using Translate To PCB or 
appear in any Parts Lists created. There are a couple of exceptions in that Testpoints and Mounting 
Holes are ternsferred to PCB. 

Schematic Documentation Symbols are used for several purposes. It is therefore necessary to specify 
the purpose of each symbol when it is created. In this way, the program can ensure that the symbol 
satisfies the requirements of its purpose (for example that it contains exactly one pin) and that you are 
only presented with symbols of the correct type when adding them.  

 

There are a number of documentation symbol types:  

Block Port is used within a block to connect with the enclosing level. It is a terminal used to connect 
between hierarchical levels. A block port symbol must have a single pin, and can contain any shapes 
you wish. To add a block port, use the Insert Block Port command.  

Block Symbol is used to represent a block instance. When you create a block, you can nominate a 
block symbol to represent that block. You can also choose the symbol when inserting a block. A 
block symbol must have a pin for each Port in the block it is to represent.  

Branch Point is a symbol used with the high speed option to create ‘branches’ within a net so that 
specific rules can be defined using Signal Paths and/or Sub Nets.  

Bus Reference is a symbol used to display the nets range on a bus. The symbol must contain a single 
pin. Whilst adding a bus, use End Connection On from the context menu.  
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Documentation Symbol can be used in many ways. For example, it could contain a logo. You can 
add a documentation symbol to a design by using the Insert Documentation Symbol command.  

Mouting Hole can be defined in the Schematic so that it can be assigned a net name when passed 
through to the PCB. 

Net Label are attached to nets to highlight the net name. These can be formatted with shaped and 
coloured boxes.  

Page Link is a symbol to represent a link to another page. When this symbol is used, it can be 
associated with another page in the schematic. You can then 'jump' to the specified page using the 
Jump to Page command, when the symbol is selected. Whilst adding a connection, use End/Start 
Connection On from the context menu.  

Signal Reference is a symbol used to represent a break or link on the net. The symbol must contain a 
single pin. It would typically be used for a ground or power symbol. Whilst adding a connection, use 
End Connection On from the context menu.  

Star Point is a symbol used when multiple nets containing different names are to be connected 
together at a common point.  

Testpoint is a symbol used to represent a testpoint. The symbol must contain a single pin. Testpoints 
can be added using the Insert Testpoint command. Whilst adding a connection, use End Connection 
On from the context menu.  

Using ‘general’ Doc Symbols 

Documentation Symbols can contain any documentation shapes, electrical pins, text and attributes. 
They can be created or edited using the Schematic Documentation Symbol editor. These would be 
used for general documentation purposes, such as drawing borders, drafting notices etc. They are not 
used for electrical notation such as power and ground labels. 

You should add Documentation Symbols from the library to the design using the Insert 
Documentation Symbol option.  

 

This dialog uses standard Pulsonix functionality. 

• Set the Documentation Symbol library you wish to add from (Look In). A list of Symbol names 
will appear in the dialog. Use the filter to reduce this list to the Symbols that you are interested in.  

• Filter the name and/or the Number of Pins to refine the list. 

• Choose the Documentation Symbol you wish to add from the list.  

• From th drop dwn list, select the Page or pages you wish the symbol to be Drawn On.  

 

The Preview check box allows you to preview the symbol before it is add to the design. 
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The Add button will dismiss the dialog from view and will allow you to interactively add as many 
Documentation Symbols of the type selected as you like to the design. If you require a different 
Symbol you should cancel this process by pressing the <Esc> key on the keyboard. This will 
immediately return you to the Insert Documentation Symbol dialog from where you can make further 
Symbol selections. If you wish to cancel Insert Documentation Symbol completely, having finished 
this process, or use the Cancel button from the dialog. 

Using Doc Symbols 

Like components in the design, they can be selected and the symbol from the library edited using the 
context menu. If modified in the library and already used in the design, they should be reloaded using 
the Reload from Library option from the context menu, or the Reload options on the Utilities menu. 

Doc Symbols can be placed in to the Component Bin for use at a later stage. 

When using Doc Symbols in the design they can be connected to and added directly onto a 
connection by releasing it on the connection itself. 

Using the Next and Previous Symbol option 

When adding Doc Symbols, from the context menu, you can select Next Symbol and Previous 
Symbol. This will select the next (or previous) symbol in the list displayed in the Insert dialog. Any 
filters created will also be applied. 

 

Block Ports 

These Doc Symbol types relate to hierarchical block use and are used to indicate lower level block 
connections to the upper level. 

Block Ports are added to the design using Insert Block Port and are only available if the system 
detects that you are on the correct level of hierarchy. When creating Block Ports, the Pin Name 
attribute is predefined for use. Shapes can be added to the symbol to annotate it.  
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The use of these Doc Symbols is described further in the section on Hierarchy. 

 

Block Symbols 

Block Symbols are used to represent hierarchical blocks that have been saved. 

When creating these Doc Symbol types the Block Name and Block Instance Names are added by 
default.  

 

You can add any number of pins to represent the connections to the lower level circuitry. These will 
be available for selection for use during Insert Block Instance, Properties and Change Block. 

Block Port and Blocks 

These are disccused under the Hierarchy section below. 

Branch Points 

Branch Points are added to the design using the Insert Signal Reference option. These are connected 
to a net to indicate the point at which a Signal Path or Sub Net would be defined to/from. These are 
used when using the High Speed Design option and will be available when you have this license 
feature. 

The illustration below shows how a branch point may be connected as an integral facet of the net 
(Branch 1) or as an isolated standalone item (Branch 2): 

 

Once these have been added you can then create a Signal Path or Sub Net to which these can be 
referenced. They do not form and part of a net other than an indicator to a branch. These points are 
translated to PCB when they can be positions.  
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Bus References 

Bus References are similar to signal references and can be added to Schematic designs via the new 
menu command Insert Bus Reference. These are attached to buses and used to label the bus. They 
display the nets within the bus.  

 

A bus can be started and ended on a Bus Reference. This can be configured within the symbol to 
display various details of a bus, for example, the Net Name. 

Documentation Symbols 

Documentation symbols in a schematic are used for adding additional information without the 
information being passed to the PCB or appearing on a bill of materials (BOM) or having any other 
significant electrical meaning. This might including drawing borders or special drawing/drafing 
information such as WEEE or Static symbols. 

 

Mounting Holes 

When used, Mounting Hole Doc Symbols can be added to an existing net to enable their net 
connectivity in your PCB design. They might countain a Pin plus a Net Name attribute and some 
documentation outline as required. 
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Following successful Translation to PCB, Mounting Holes are added to the PCB using the 
Mounting Holes setting in the Design Settings, Defaults page. This setting will select the layer for 
the Mounting Hole and Pad Style used. 

 

Net Labels 

Net Labels are used to 'hang' on a net to explicitly show the net name on your Schematic design. 
Because it uses a special Doc symbol, it means you can customise how it looks and where it is 
attached to. The symbol's net name is dynamic and will update as the name changes.  

On creation, the symbol will contain a Pin and an attached Callout with the Net Name attribute 
stored in the callout.  

You can add net labels by using the Insert Signal Reference and selecting the Type as All or Net 
Label.  

 

Page Link 

In Pulsonix, a Schematics design can consist of multiple pages, each representing a separate sheet of 
the final schematic. You can add links between these pages enabling a page to refer to another page. 
These links enable you to easily switch the current page you are editing to the page referred to.  
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Page Links are added through the Insert Signal Reference dialog. Wduring creation, the {Page Link} 
and {Net Name} attributes are added along with a pin. When added to your design, it will ask you to 
provide the page that the link refers to.  

 

 

Page links are often used to join a global net connection leaving one sheet and entering another. These 
are for documentation purposes only as all parts of a global net are always connected together when 
creating a PCB design from the Schematic. 

 

Adding Page Links 

Pulsonix page linking is performed using the special <Page Link> attribute. The attribute's value is 
the name of the page that the link refers to. Double clicking the mouse when the cursor is over one of 
these attributes will change the page currently being edited to the page the link refers to. This way 
you can use the mouse to easily traverse the schematic's pages. There are two ways of adding a page 
link attribute; using the Insert Attribute option and the Insert Page Link option. 

���� To add a page link  

1. Select the item you wish to add the link to, or select nothing if the link is to be added to the 
schematics page itself. Right click the mouse to use the Add Page Link option from the context 
menu. Choose from a list of names of the pages in the schematic, or type the name of a future 
page to be linked to. The attribute will then be added. 
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2. The page link attribute may be visible, in which case you can use it directly to switch pages as 
mentioned above, or it may be left invisible. If invisible, selecting the item the page link is on 
will allow switching pages using the context menu. 

Interacting With Page Links 

���� To use page links  

1. Double click on a visible page link attribute name to switch pages, if the named page exists.  

2. Select the page link attribute, or the item the attribute is on and right click the mouse to use the 
context menu.  

3. Use Jump To Page to switch to the page referred to. 

4. Use Change Page Link to alter the name of the page the link refers to, or to change the visibility 
of the <Page Link> attribute.  

5. With nothing selected, right click the mouse to use the context menu. If this page is itself linked 
to another page you will be able to use Jump To Page and Change Page Link, mentioned in the 
previous section.  

When To Use Page Links 

Documentation References 

Often the sheet outline title block contains lists of the names of the other pages that make up the 
design. Adding these names as page link attributes means you can also use them to switch pages.  

Cross Page Signal References 

Where separate pages are simply used to split up a complex design, you have the situation where a 
connection leaves one page and enters another. This is usually done by ending the connection on a 
symbol that represents an off- page connector, with the name of the page it is going to next to it. 
Pulsonix handles this by ending the connection on a single pin documentation symbol that has a page 
link attribute. The advantage of this is you can actually use these symbols to switch to the page that 
the connection is going to. 

To make it easier to do this, when adding connections on global nets, you can right click the mouse to 
use the context menu to start, or end, the connection on a page link symbol. You simply have to 
choose the name of the symbol to use and the name of the page to link to and an off page link will be 
dropped into the design. 

Signal References 

Signal References can be used for a number of purposes but effectively they all have the same effect, 
that of adding additional documentation to your schematic. They can take the form of cross sheet 
signal references, power & ground symbols or simple signal references.  

The Insert Signal Reference dialog from the Insert menu allows you to add any of the categorised 
documentation symbol types and add them to your design. By using the Type drop down list, the Sig 
Refs will be presented in the Symbol list using their category. You can use All to present all 
documentation symbols regardless of category. Categories for these symbols would have been 
specifed during their creation using the New dialog or when saving to the library. 
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Other special doc symbols, such as Doc Symbols, Testpoints, Branch Points, Moutning Holes, 
Blocks, Block Ports and Star Points are all handled from their own Insert dialogs. 

Reassigning Sig Ref Symbols for other use 

Existing Sig Ref symbols already in the library can be re-categorised by editing them and using the 
Symbol Properties dialog from the Edit menu or by using Save To Library and choosing the new 
type from the list:  

 

Power and Ground Symbols 

Power and ground symbols are often required in the Schematic to indicate a connection to a power 
source. These symbols are required for aesthetic purposes and are not translated to the PCB. The 
signals they represent are connected together at the translate stage by ‘implied’ connectivity.  

 

The power and ground symbols themselves can contain inherent net name properties that are 
automatically used when the Symbol is attached to the net. 

Nets that are invisible in the design but that provide connectivity are generally referred to as ‘implied 

nets’ because they are not directly visible but are translated to the PCB design where they become 

connected together using their net names. 
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When creating Signal Reference symbols for use with power and ground nets you can be specific or 
semi-specific in your use of the Net Class and Net Name matching that will be used in the design. 

When in the Doc Symbol editor you can select the Symbol Pin and right click to get its Properties. 
From this dialog you can opt to automatically Connect To Net when it is used in the design. 

Connect To Net allows you to specify that the pin should connect to a net of the given net class type 
(Power, Ground or Signal, or to a given Net Name). This is useful, for example, if you wish to 
create a ground symbol that should obviously be connected to a Ground net. If the design only 
contains a single net of the appropriate type, the symbol will be automatically connected to it. If there 
is more than one net, a dialog offers you the choice. If there is no such net, a dialog offers you the 
option of creating one. Similarly, for a given net name, if the net exists, the pin is automatically 
connected. 

 

You can Connect To Net, provide the Net Type and/or Net Name. 

 

���� To add Power/Ground symbols 

1. From the Insert menu click Insert Signal Ref 

2. From Type: select Signal Reference from the drop down list 

3. From the Symbol name drop down list, select the Symbol required 

4. Once the Doc Symbol is dynamic on the end of your cursor, you can position it over a net. 

5. When released a dialog is displayed (if applicable): 

 

If only a Net Class Type has been specified when the symbol was created when you add the Symbol it 
will automatically connect to the ground or power net in the design unless there is a choice, in which 
case you are prompted to select one. 

6. From this dialog, select the Net Name for the Doc Symbol. 

7. The Net being connected to will now take on the net name specified. If the Net already has a 
name, a warning dialog will be displayed requesting the net name to use. 

Cross Sheet References 

The principle described above for power and ground symbols also applies to normal signal references 
used for inter-sheet or cross sheet notation. The main exception is that the pin used in the symbol has 
no predefined Type or Net Name. The Net Name is applied to the pin when used. 

When creating Signal References in the Doc Symbol editor, the Net Name attribute is predefined for 
your use.  
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A Signal Reference in the Schematic might look like this: 

 

Star Points 

Star Points or Delta Points as they are sometimes called, allow you to connect multiple named nets 
together at a common point. This might be the GND and Digital_GND nets for example, where they 
have the same input point but need to be isolated from each other except for the source point. 

Star points are used in both Schematic and PCB designs and are recognised by Translate to PCB and 
Synchronise Designs.  

The process of using star points in Schematics is straightforward. The Doc Symbol is defined as being 
a Star Point type. This can have any number of terminals but the nets connecting to them remain 
independent regardless of whether a single terminal or multiple terminals have been defined.  

 

When translated to the PCB design, the first segment of the tracks only will not cause DRC violations 
with each other. It is also recommended that in PCB you have the switch Allow Single Pin PCB Nets 
set to off. 

Testpoints 

As with Signal References, Testpoint symbols are very basic. During creation in the doc Symbol 
editor, the Testpoint Name attribute is pre-selected for use.  

 

These will be used when the Insert Testpoint option is 
selected and when a connection is selected to end or start 
on a Testpoint.  

 

Using Busses  

A bus is a shape that represents a collection of signals on the schematic design. This makes the 
schematic less cluttered as many parallel connections running from one side of the drawing to the 
other will not be required. You can add a connection from an electrical pin to the bus that carries the 
required signal.  
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Closed Busses 

A newly added bus is Open to carry any net names. You can Close it to only carry a closed set of 
allowed names by selecting it and using Properties from the Edit menu.  

Once closed, you can only add a connection to the bus if the connection is on one of the nets defined 
in the bus's set of net names. When trying to connect to a closed bus, you will be presented with a list 
of the bus's net names to choose from. 

The set of allowed net names can be displayed next to the bus using a condensed range format. Select 
the bus and right click to use Show Net Name from the context menu. Then drag the name range to 
the desired position.  

Bus Terminals 

When a connection as attached to a bus segment, the end of the connection is bent at 45 degrees as it 
touches the bus. This 45 degree segment is known as a Bus Terminal. The Bus Terminal takes its 
colour and width from the Connection, but it is not part of the connection.  

To set the default Bus Terminal length use Design Settings and the Defaults tab and change the bus 
offset to the required value, and also its exit direction from the bus, Up (or Down unchecked) on 
vertical bus segments and Right (or Left unchecked) on horizontal bus segments. 

  

The bus terminal may not be initially added in the preferred direction, to alter this select it and use the 
Rotate option to Flip between the allowed angles. 

When the connection segment attached to the bus terminal is moved, the bus terminal moves with it to 
the nearest place on the bus. When the bus segment is moved all bus terminals attached to it are move 
with it to keep the bus together. 

The net name can be displayed next to the bus terminal. Select the bus terminal and right click to use 
Show Net Name from the context menu. Then drag the name to the desired position. Use the Options 
and Interaction tab to enable automatic display of net name when connecting to a bus. 

When a connection to a bus is deleted, the bus terminal is also deleted.  
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Bus References 

A Bus Reference Doc Symbol can be added to a bus to indicate its use or for documenting the nets it 
contains.  

 

Translate To PCB 

Busses are not important when translating to PCB; they are simply a way of simplifying the 
Schematic using an annotation for multiple nets. All items connected to a bus will be joined to any 
other items on nets of the same name. 

���� To insert a bus  

1. Before entering Insert Bus, select another existing bus if you want to create a bus with the same 
line width and allowed net name set.  

2. Click the Insert menu and click Bus.  

3. Click to pick the start position, and click to add each corner. Double-click the mouse button to 
finish.  

4. If required use Properties to add or change the allowed net names to the bus.  

Changing Net Names on a Bus 

The Bus tab is available when using the Properties option on one or more selected bus segment(s). 
You should use this to change the selected bus line style and allowed nets.  



164   Chapter 5 – Schematic Capture Editor 

 

Locked is used to lock the bus from future editing or moving. Once the bus is in its final position, 
lock it to avoid accidentally altering it. 

Choose the required Line Style for the bus from the list of line styles already defined in the design. 
These can be altered using the Technology option from the Setup menu. The width for the selected 
style will be shown in the edit box. 

If you don't know the name of the style then type the required line width in the Width edit box. The 
style that matches the typed line width will be selected from the list. If no line style in the design 
matches the typed width then the line style name box will be left blank. Type the new name for the 
line style, or leave blank for the system to assign a default name for you. 

Listed here are the Allowed Net Names that represent the signals that the bus can carry. If any net 
names are listed the bus is Closed, so only the listed nets can be connected to the bus. If there are no 
names listed the bus is Open, so any net can be connected to it. 

Add Net is used to add some net names to the closed bus. It displays the Add Net To Bus dialog that 
allows you to select from net names already in the design, or add your own new net names (see below 
on how to do this). If the bus was open (i.e. no names listed), and it has nets already connected to it 
then you will be asked to add these nets to the list automatically. If the bus has default named nets 
connected to it (e.g. N0001) you cannot turn it into a closed bus. 

Remove Net is used to remove the selected net name from the Allowed Nets list. You cannot remove 
names of nets that are already connected to the bus. 

Remove All Nets is used to turn a closed bus into an open bus by removing all of the net names from 
the Allowed Nets list. 

Allowed Nets Range initially displays the list of Allowed Nets in range format. This is the string you 
would see if you displayed the net name on the bus. Details of the range format are shown in the next 
section on Decoupling Capacitors. 

You can use this to type in the required closed bus nets directly in range format or select from a list of 
name ranges used on other busses in the design. If the text is changed the Apply Range and Reset 
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Range buttons are available. Apply Range allows you to apply the changed string to the Allowed 
Nets list. Reset Range resets the string to match the current names in the Allowed Nets list.  

���� To add net names to a bus  

1. From the Bus Properties dialog, click the Add Net button. This dialog is used to specify the net 
names are allowed on the closed bus. Only connections on those nets can be attached to the bus. 

 

2. This lists all the named nets that exist in the schematics design that are either global or local to 
the page that the bus is on. Select one or more net names from the list that you want to add to the 
bus. 

3. If you want to add new net names to the bus that are not in the list, use the New Nets box at the 
bottom of the dialog. Type the name of the new net into the Name: box. If adding a range of net 
names, type the first name into the Name: box and the last name in the range into the to: box.  

4. Click Add To List to add the new net names to the above list. These names are selected ready to 
add to the bus. Note: New net names added using this method are always added to the design as 
global nets. If you want to change them to local nets, use the Technology dialog and Net Names 
facility. 

5. When you have selected the names, use OK to add these names to the allowed net names list on 
the bus.  

Auto-weld Connections to a Bus 

You can also drag a Component in the Schematic design so that when the pins of the Symbol are over 
a bus segment it will weld it to the bus.  
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For Closed Buses 

Move a Component or Gate (Symbol) so that the pins are coincident with the bus, ensure the pin grids 
and bus grid are the same:  

 

Weld Markers between the bus and Component pins are displayed indicating the component can be 
welded:  

 

When a bus is closed (i.e. with named nets), a dialog will be presented to choose the net names from 
the bus for each of the pins: 

 

When choosing nets to add to the pins, it will always select the first matching number of nets/pins. 
However, the Bus Nets can be individually changed by picking them from the list, the Shift and Ctrl 
keys can also be used to aid selection. 
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Moving the symbol away from the bus will show the connections and bus terminals clearly.  

 

Open Bus 

If the bus is an open bus you cannot pick from net names on bus, but can type the required net name 
range (or pick an existing closed bus name range from a drop down list). 

 

If other closed buses are defined within the design, you can choose the nets using the drop down list 
using Chosen Nets: 

Bus Names in PCB 

Bus Net Names are translated to the PCB and can be used in options that have an interest in them, 
such as the Bus Routing option. These can be used to easy select bus net names for bus routing. More 
information about this function can be found in the Online Help Bus Routing Usage.  
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Hierarchy 

What is hierarchy and why use it? 

Hierarchy in Pulsonix is the ability to add ‘blocks’ to a design that in-turn can contain circuitry. 
Blocks are simply shapes that represent a lower level of the design, these are often used to declutter 
the schematic or to reuse existing blocks of know good circuitry.  

 

There are two, not unrelated, reasons for using hierarchy.  

• To allow a schematic design to be structured, so that it can be broken down into its functional 
elements. This promotes Top Down design; break down a problem into functional elements, then 
define the detail of each element.  

• To facilitate the re-use of commonly used circuit elements. This promotes Bottom Up design; use 
predefined elements to build a solution.  

In practice, you may want to use a combination of both Top Down and Bottom Up design. 

Overview of Hierarchy 

Blocks 

A block should be a functional element that has a well-defined purpose and interface. In design terms, 
a block is a special schematic design that describes the implementation of its function; it also has a 
symbol associated with it that represents the interface.  

A block can be instanced in a schematic design (or another schematic block design). The symbol 
representing the block is placed in the circuit, and can be connected to, in a similar way to a 
component. However, as well as the symbol being added to the design, all the pages of the block 
design are also added. Component and net names are resolved so that there are no conflicts. 
Connecting to the symbol pins joins the nets with those defined in the block instance.  

In many respects, a hierarchical schematic design is no different to a normal multi page design. The 
net lists would be the same, and the drawings are largely the same. However, it is easier to navigate, 
because you can Push into the pages representing the block instance, from its symbol, and Pop out of 
the block instance, back to the symbol. It is also possible to update the contents of a block instance, 
from the original block design.  



 Chapter 5 – Schematic Capture Editor   169 

Top Down Design 

To work top down, that is, from an ‘upper’ level schematic sheet, you can add an existing block or 
generated a block instance for each part of the design that is, as yet, undefined. At a later stage, you 
can Push into the block instance to edit or define its circuit. From the top level, you can then connect 
to the block instance using Insert Connection (or Insert Bus), either connecting to an existing pin on 
the block symbol, or adding a new one by clicking anywhere on the symbol outline.  

Bottom Up Design 

You may want to create libraries of commonly used blocks, such as power supplies or signal 
converters. You can do this by taking an existing Schematic design and creating a Schematic 
Hierarchy block design from it. This is saved into one of the nominated Schematic block folders. 
When creating a Schematic Design it is then possible to insert a block instance of one of these saved 
blocks. 

Navigating a Hierarchical Design 

To navigate up and down in the hierarchy of a design, use the Push and Pop commands. To Push 
into a block instance, select any part of the block and select the Push into block command from the 
context menu. To Pop out of a block instance, back up a level, select the Pop out of block option 
from the context menu. You do not need to select anything it is sufficient that the active page is part 
of a block instance.  

Push/Pop to and from blocks 

Once the block has been added to the design, you can move down into the block by using the ‘Push’ 
command. This is available on the context menu once the block is selected, or by using the <PgDn> 
key on the keyboard.  

At the lower level, you ‘Pop’ back up into the hierarchical block using the option from the context 
menu or by using the <PgUp> key on the keyboard. 

If you have the Workbook mode switched on, the blocks can be navigated using the tabs at the 
bottom of the screen. You can also use the Design Browser Window. 

Once you’ve pushed into the lower level you can now add your circuit and Block Ports. 

Using the Design Browser and Hierarchical Blocks 

The Design Browser in the Schematic editor supports and shows Hierarchical blocks. It also shows 
the lock status of the block indicated with a small padlock symbol. This is discussed later in this 
section under Multiple Instancing. 
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Connecting Through Hierarchy 

Using Connections 

Instancing hierarchical blocks gives you the internal connectivity of the block, but you will want to 
connect these nets up through the hierarchy. There are two ways to do this.  

If the net in a block is defined as not local (global), then it may be used anywhere in the entire design. 
So the same global net name can be used inside and outside a block instance, and the attached items 
will be connected together. This is fine, but you will want to define connectivity inside a block 
instance that cannot be connected to outside the block instance. This is achieved by using a local 
name. Net names are defined in the Technology file.  

To connect a local net to items outside the block instance, you will need to use a Block Port inside 
the block. This will match with a pin on the block instance symbol. The mapping between the two is 
defined in the Block Properties. 

When a connection is moved over a block, the ‘F’ Finish marker is displayed to indicate that you can 
automatically connect to the block using a block port when a block port would be legal. 

 

If the block has no defined ports on the lower level then a new block pin is added without prompting. 
If the lower level has spare block ports defined, you will be prompted with the Select Block Port 
dialog. Use this to select or type the name of the block pin. When OK is clicked, the connection will 
be attached to the block with a block pin. 

 

Connecting a Bus to Hierarchy using ‘Bus Pins’ 

Like connections connecting to a block, you can also connect a Bus to a Block Pin. When editing a 
Bus, move it over the Block Pin in the same way you would a connection and the the ‘F’ Finish 
marker will be displayed. Any Net Names within the Bus will be carried into the hierarchical block 
via this Bus Port. A corresponding Block Port added on the lower level will also contain these Net 
Names and can be connected to using a Bus.  
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Setting up your design for hierarchy 

When starting a Schematic design there are settings that you should check in order to use hierarchy. 
Settings appropriate to hierarchy are defined in the Design Settings option, General page and 
Naming page. 

Allowing Multiple Instanced Hierarchy 

Multiple Instanced Hierarchy is the ability to take one hierarchical Block use it multiple times on the 
design but to have all instances referenced back to one ‘master’ block. For example, an RGB channel 
of three identical blocks or a sound mixing desk of many multiple channels. 

If you want to use multiple instancing of blocks you must enable the Allow Multiple Instanced 
within the Design Settings option under General and Blocks. If using this for the first time or if 
unsure, leave it unchecked.  

 

Blocks which share the same definition and edits on one instance can be applied to the other 
instances. Without this, each instance is completely independent. This needs to be set before any 
blocks are added. 

The Schematics Top Level Name is used in hierarchical schematic designs. It is the name of the top 
level owner scope and is applied to net names local to the top level (i.e. not in a block instance), using 
the naming rules. 

Multiple Instanced Properties 

Once this has been selected, the block can be multiple instanced, without this selected, the Properties 
of a block will show the Can Be Multiple Instanced greyed out and you will not be able to instance 
it: If Locked Instance is checked, it prevents the contents of this instance from being edited. This is 
used in conjunction with the Can be Multiply Instanced property, to control which instance can be 
edited. 

Description is the description defined on the block. It can be edited on an unlocked block instance. 
The check box alongside the name shows if the description is currently displayed on the block 
instance symbol. 
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Once a block has been instanced, it is possible to edit them independently so that they diverge from 
the original definition. More likely, you would want to keep the definitions in step, either with the 
original block design, or with each other. This can be achieved, by using Reload Block and updating 
from the original block design, or by applying changes from one instance, to all the others.  

A block instance also has a Locked instance property that prevents the contents of the instance from 
being edited or changed in any way. This ensures that it remains a copy of the original definition. A 
block instance also has a Can Be Multiple Instanced property. By enabling this, multiple instances 
of the block are locked together. Only one of these instances can be unlocked and edited. They can be 
brought back into line using Update Multiple Instanced Block  

The function Unlock Multiply-Instanced Block appears on the context menu when selecting a block 
instance, or with nothing selected when editing on a page in a locked block instance. This option 
allows you to unlock the block for editing. Within the Design Browser you can see the lock status of 
blocks (see below). 

With the Multiple Instance enabled and the block allowed to be multiple instanced, once copied 
there are other additional options on the context menu that are displayed. 

Use Update Multiply-Instanced Block to apply changes made to the design to all other instances of 
the block. 

Revert block option. If you have unlocked and made changes to a block that is a multiple instance 
you can revert it back to look like the locked copies using this option. 

If you unlock a block instance and switch off Can Be Multiple Instanced from Properties, you will 
not be able to apply the instancing back to the block. 

Net Names on Blocks 

The Design Settings should be checked so that the program handles the Blocks and Net Names 
correctly. Under the Naming tab you should set the way in which Local Net Names are used. Set 
Default to Local Names and Name Unique Across Design to on (checked). This will ensure that net 
names used within each hierarchical block will be local (and not Global) and that net names across 
the design will be unique. 
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In summary, the Design Settings should be like this: 

For Hierarchy but not multiple-Instanced: 

Allow Multiple Instance Off 

Default to Local Names On 

Name Unique Across Design On 

 

For Hierarchy but using multiple-Instanced: 

Allow Multiple Instance On 

Default to Local Names On 

Name Unique Across Design Off 

Folders and Schematic blocks 

All previously saved blocks are located under the Schematic Blocks search path defined on the Setup 
menu and Folders option. Change this if you wish to add a user location or network drive.  

 

Creating a new block to add to your design 

Starting with Top Down design means you will start with a new block and after pushing down into it, 
will add the circuitry.   

The process for creating a new block from the top down is as follows (and this assumes a new block 
rather than an existing block will be used): 

���� To add hierarchical blocks using Generate New Block 

1. It is assumed that you have adjusted the Design Settings accordingly. 

2. From the Insert menu, use Insert Block Instance to add a block to the design. 

3. Select Generate New Block.  
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4. If the number of ports (input and output pins) is known then these can be set. If not set it to zero 
(0) and adjust it later on. 

 

5. The bottom section of the dialog is the Preview area. This allows you to preview the block before 
it is added to the design. 

 

6. Press OK to add the block to the design. 

7. Double-click on the block outline to Push down into it, or right click and select Push Into Block 
from the menu. On a selected block, you can also use the shortcut key <Page Down> 

8. Once pushed into the lower level block, create the circuit or copy and paste it from another 
design. 

9. At the lower level you add Block Ports to the design (using Insert Block Port) to create 
interface links back to the upper level. There will always be a direct 1:1 relationship between the 
lower Block Ports and upper level Pins of a hierarchical block.  

10. From the Insert menu, select Insert Block Port 

11. Block Ports are added from the Doc Symbol Library and are defined as Block Ports during their 
creation. Use the Insert Block Port option to add Block Ports to the design.  
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12. The Insert Block Port dialog allows you to specify the Libraries to be searched in and the 
Name of the Symbol. 

13. When adding Ports, if the number of pins was typed in during Generate Block, then the Port 
Name and Pin Number will match this number, e.g. if 4 pins were requested then a, b, c, and d 
will be available for Port Names and the Pin Numbers will show 1 to 4 and 5 <new> as the next 
new pin number. Port Names are automatically created and incremented. You can type a name 
into the Port Name box for use. The next Port added will then be incremented using this name 
plus one, e.g. the name Port1 is incremented to Port2 etc. 

14. You can also specify the Pin Type for the Block Port. By default this list is artificially restricted 
to Input, Output and <Undefined>. If you wish to use more Pin Types then they must be 
enabled through the Technology dialog under Pin Types. Checking any of the pin types in the 
Allow on Block Port column will enable them to be listed.  

15. Insert the required number of block ports. 

16. Connect your circuit to the Block Ports. Any next names used will appear on the upper level 
block. Block Ports can be left unconnected if you wish to come back to them at a later time. 

17. Pop back up to the upper level using the Pop command from the context menu or you can also 
use the shortcut key <Page Up> 

18. Now you need to add Block Pin to the block. 

19. For this example, we’ll add block pins to the block automatically. 

20. With the block still selected, right click and select Regenerate Block Symbol 

21. It will now automatically add the corresponding number of Block Pins to lower level Block Ports 
(regardless of whether they are connected or not). 

The block now has a circuit at its lower level, each of the ports at the lower level match the number of 
ports at the upper level. This is the basic hierarchical design. 

Saving Blocks 

An auto-generated block can be subsequently saved for use later in another sheet or design. To do 
this, right click on the block and select Save To Block File. 
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From the Save As dialog, type a name and press Save. This block will be saved in your pre-selected 
Folders. 

When you need to use this new block, from the Insert Block Instance dialog, select Use Existing 
Block and choose the Block Name: Your new block will appear by name in the drop down list. With 
the Preview box checked, you can also preview it to check it is the required one. 

Blocks, Pin Types and ERC 

Pin types and Blocks 

If you wish to use more Pin Types within your block they must be defined and enabled through the 
Technology dialog under Pin Types. Checking any of the pin types in the Allow on Block Port 
column will enable them to be listed.  

 

The Block Ports dialog on Block Properties allows you to change the Name of the pin, the pin 
Number sequence on the block and the Pin Type (used in the Electrical Rules Checking option).  
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The Up and Down buttons enable the order of the ports to be changed so that they physically change 
on the block symbol. These buttons are only enabled if the pin is not connected to a net. 

Electrical Rules Checking 

All Block Port and Block Pins with Pin types defined are checked using the Electrical Rules 
Checking option and Pin Type Rules. 

Using an existing Hierarchical Block in the Design 

The process for ‘Bottom Up’ design is much the same as Top down but you use existing blocks that 
have been saved to the library to build the circuit. Common blocks can be used and reused to create 
circuits making the design process much easier. 

���� To add hierarchical blocks using an Existing Block 

4. From the Insert menu, use Insert Block Instance to add a block to the design. 

5. Select the Use Existing Block radio button. 

 

6. You can select which folder to looking or select <All Folders> (from the folders defined and 
enabled in the Folder dialog). 

7. Choose the Block Name: from the drop down listed presented. 



178   Chapter 5 – Schematic Capture Editor 

 

8. With the Preview box checked, a preview of your block will be displayed for verification. 

 

9. Click the Add button to add the block to your design. 

10. The block in your design can now be navigated using the Push and Pop commands. 

11. The inserted block can also be modified (the Block shape, number of Block Pins and lower level 
Block Ports and the actual circuitry). This can then be updated and resaved. 

Creating a Hierarchical Block from an existing Schematic Design 

Below is a brief description of when you have an existing Schematic design and want to create a 
block from it. 

���� To create a block file from an existing Schematic 

1. From within the open design, in free space, right click and select Save To Block File 
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2. From the Save As dialog, choose a block name and press Save.  

3. This saved Block will now be available when you select Use Existing Block from within the 
Insert block Instance option. 

Cutting an existing Schematic Circuit to a block 

If you need more space in the design or wish to save a section of the circuit to reuse at another time or 
in multiple instanced, you can ‘cut’ a section of a circuit out to a block. 

���� To create a block from an existing section of circuit 

1. From within the open design, from the Edit menu, select the Cut To Block option. 

2. With the Cut To Block modal cursor displayed, either draw a frame around the required circuit to 
make the selection or right click to display the context menu. 

 

3. From the context menu you can choose to make the selection using a Frame Select or Polygon 
Select depending on which mode is appropriate to your required selection. You can also Change 
Grid to make the selection more accurate. 

4. This selection can also be pre-defined and changed using the Frame Select switch setting under 
the Options option and Interaction tab. You have the option for Frame Select to Select If 
Completely Framed or open selection if left unchecked. 

5.  Draw your selection around the required circuit. 
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6. In the above example you will see that a section of the design will be cut out and pasted to a 
lower level block. 

7. The block will be created and the appropriate number of Block Pins added to it. Connections 
around the cut block can be edited and repositioned. 

 

8. The resultant lower level now looks like this when the block is pushed into: 
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9. There is no repositioning of lower level Block Ports, they are added in exact relative positions 
from when cut. However, they are a direct 1:1 relationship with the block pins added to the block 
above, this also includes Net Names. 

10. You can see that where connections existed, these have been terminated to the upper level using 
block ports. The block ports have been automatically named. 

11.  

12. Block Ports can be suitably repositioned and the Schematic circuit edited. 

13. The modified block can then be saved here using Save To Block File. At this point, the block 
hasn’t been saved, just simply created. 

 

14. Where the design contains multiple sheets, these will also be saved to the block file. 

15. This block is now available to use again using Use Existing Block from the Insert Block 
Instance dialog. 

Editing a block shape 

Once a block is used in the design, its shape can be edited. There are some points to note if doing this:  

If the port has no block ports and you use the Regenerate Block Symbol option from the context 
menu after adding block ports to the lower level, the shape will be replaced with another 
automatically generated block symbol. 

The modified shape is saved with the block in the Block Library. 

After selecting the block, there are various options available for use from the context menu. 

 

Reload Block will reload the block with the one saved in a block file. If a block file has not been 
saved for this block then it will not allow you to reload. 
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If the Block was Generated when it was added (i.e. it was not read from an existing Block file), then 
the block name which was specified at that time, may not exist and the reload will fail. A warning 
message is given when this is the case. 

Save To Block File will allow the block (and its lower level contents) to be saved to a block file, to 
be used at a later date. 

Regenerate Block Symbol will automatically generate a new symbol based on the current number of 
pins or block ports. If the Edit Symbol option has been used and the shape not saved, then this will be 
lost and overwritten with an automatically generated one. 

Edit Symbol allows you to edit the current symbol. If you use this you can also save this symbol to 
the Doc Symbol library using Save To Library to be used and modified later on. If you save the 
Symbol (using Save) from this mode, the block will automatically load this Symbol by name from the 
library. 

Naming/Renaming blocks 

Blocks can be named, and once named, can be renamed. This helps you identify then by their 
functionality perhaps, i.e. Memory, PUSE etc. Initially the block can be named by typing its name 
when using the Insert Block Instance dialog.  

Once in the design, it can be renamed by selecting it and using the Properties dialog and Block tab. 
Name is the block instance name, i.e. B1, B2 etc. (the same block can be instanced multiple times), 
and Block is the block file name (if multiple instanced, this will be the same block name in all 
instances, the Name will change though). You can also add a Description if you wish. 

 

Details from this page can be exported to a report using the Report Maker option. 

Changing blocks in the design 

On the Properties of a block instance, the Block page has a Change button.  

 

Use this button to change the block using a different block file from the block library. You have the 
choice whether to replace the symbol or not. The Change Symbol button means that the block can be 
changed with or without changing the Symbol that is saved with that block. 
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Once OK has been pressed, the Reload Block confirmation dialog is displayed. 

 

Check the Reload Symbol box if you want the top level symbol to be reloaded at the same time.  

Check the Try to preserve design net name box if you want net names to be as similar as possible to 
the nets in the existing block. This obviously depends on how much the connectivity has changed 
within the block.  

Working with Multi-Instanced Blocks 

A block instance has a Locked Instance property which prevents the contents of the instance from 
being edited or changed in any way. This ensures that it remains a copy of the original definition. A 
block instance also has a Can be Multiply Instanced property. By enabling this, multiple instances 
of the block are locked together. Only one of these instances can be unlocked (Unlock Multi-
Instanced Block) and edited.  

 

They can be brought back into line using Update Multi-Instanced Block. If you unlock one instance 
of a block and make edits to it you can throw away these edits to make it the same as the other locked 
blocks using the Revert Multi-Instanced Block option from the context menu. 
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Use the Update Multi-Instanced Block command from the context menu to cause all multiply 
instanced copies of the block to become the same as the unlocked instance (only one unlocked 
instance is allowed).  

Adding More Pages to the Design 

Once the design has been started as a single page, you may need to add new pages as the design 
grows, or modularise the design into logical blocks of circuit functionality. 

To add new pages to the design, you should use the Insert Page option that is available on the Insert 
menu. From this dialog you can name the page that will be added to the design:  

 

Or you can use the right click option within the Design Browser window. 

 

Once the new page has been added, while it is still selected, you can rename it. 

You may also subsequently use the context menu to Rename or Delete the page.  

Any page can be opened for editing, or closed using double-click on its name in the Design Browser. 
The new page will not be saved into the design until a Save or Save As has been completed. 

The Design Browser is recommended for use if using multiple pages as it will allow you to navigate 
through the pages by simply double-clicking on the one required. 
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Combining Schematic Pages from other Designs 

There may be a requirement to work with other engineers who have Pulsonix or another Schematic 
capture system, and to combine all the Schematic sheets into one master design to create a single PCB 
design.  

There are two different methods depending on where the Schematics is taken from. 

Adding a Pulsonix Schematic design 

If adding an existing Pulsonix design to an already populated Schematic page in another design, you 
should use the Copy and Paste options from one to another. To ensure that the complete design is 
selected, you should use the Select All option from the context menu (or use the keyboard shortcut 
Ctrl-A). For specific areas of circuitry to be copied, use the Frame Select or Polygon Select options 
also available on the context menu. 

During the Paste, any duplicate Net Names will be highlighted by the Resolve Net Names dialog for 
you to resolve. This will allow you to combine net names as required, for power and ground nets, for 
example. Any duplicate Component Names will automatically be resolved without warning but will 
be incremented, if the name already exists, to the next available in the sequence. Components can be 
renamed at a later stage manually or by using the Component Rename option. 

If you wish to add the design page to create a new page in the existing Schematic, you should add a 
new page first and then Copy and Paste the contents into it. Again, any duplicate net names will need 
to be resolved and the Component names will automatically be resolved as before. All Schematic 
pages under a design are checked for duplicate net and Component names. 

Adding another system's Schematic design 

If taking the Schematic Design from another system, you must first import it. In brief (this procedure 
is described in more detailed later on in the manual), use the Open option from the File menu. Locate 
and select the Schematic design and click OK. The Pulsonix Import filter will automatically detect 
the format and import it into Pulsonix. If you are familiar with the Data Transfer Wizard, you can 
also use this mechanism for a more guided import approach. Once in Pulsonix, the Schematic will 
behave as if it originated in Pulsonix itself. 

The procedure then for combining this imported Schematic and the existing Schematic design is as 
already discussed above in Adding a Pulsonix Schematic Design. 

Building up the Design using Copy and Paste 

Now that the design has components, Busses and Connections added it, a fast way of building it up is 
to use Copy and Paste or the Duplicate option, to copy sections of circuit to use elsewhere on the 
page or other sheets. Cut and Paste can also be used successfully to move sub-circuits to other pages. 
Copy and Paste are detailed in an earlier Chapter on General Utilities, but we will deal here with 
naming issues when pasting to an existing Schematic design.  

Resolving Net Names when using Paste 

During a Paste or Duplicate operation, Component and Connector Names are automatically 
incremented to use unique names but net names need user interaction to resolve.  

The Resolve Net Names dialog shown below is displayed. This allows you to choose the nets that are 
to be connected to those already present, and that are to be renamed so that they do not join existing 
nets. 
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Nets that are unchecked in the list have a Rename applied to them based on the Rename criteria 
chosen. 

���� The resolving net names process 

1. The first step is to identify those nets that need to be connected to existing nets. This is done by 
'checking' the names of those nets in the list. 

2. To do this, you can either click on each of the checkboxes directly, or use the Select Items filters 
to help you quickly select and then check/ uncheck whole groups of nets in one go. 

3. The next step is to define the Rename criteria to be applied to the net names left unchecked in the 
list. 

4. When you have chosen how you wish the nets to be resolved, press OK and the Paste or 
Duplicate operation will continue. The current settings for the Rename criteria will be preserved 
and used next time the dialog is displayed. 

Using the resolve net names dialog 

The Don’t Ask Me Again check box is used to switch off this dialog after making a selection. The 
warning can be switched back later on using Options dialog and Warnings. 

Net Names shows the net names being duplicated or Pasted that are already in the design. Nets can be 
checked/unchecked from this list directly by picking or by using one of the Select Item methods. 
Checking them to merge with existing nets, or by leaving them unchecked, the rename criteria is 
applied. 

Auto Number applies an automatically generated default net name to the unchecked net (or nets). 
The number used is the next available in the default net name sequence, e.g. A0 could become 
N0027, where N0027 is the next unused default net name available in the sequence. 

Auto Increment is used to increment the unchecked net name to the next available unused net name 
in the sequence, e.g. A0, A1 and A2 becomes A3, A4 and A5 respectively. 

Prefix - this radio button is used to direct the rename to use a predefined prefix at the start of the 
existing net name. E.g. C10 becomes ZC10 if the Prefix is set to Z. This Prefix is applied to all 
unchecked net names. 
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Suffix - this radio button is used to direct the rename to use a predefined suffix at the end of the 
existing net name. E.g. A10 becomes A10_B if the Suffix is set to _B. For all the rename types, it will 
continue to increment the resulting name until it finds one that does not already exist in the design. 
This suffix is applied to all unchecked net names. 

Select Items is used to select the net names in the nets column based on selection criteria. Once 
selected, use the Check or Uncheck buttons to check or uncheck the selected nets. 

All selects all names. 

None deselects all names. 

Named allows you to type in a name or string with wildcards to make the selection, i.e. A* will select 
every name starting with A, e.g. A0, A1 etc. More refined selections can be made by increasing the 
characters to filter, e.g. A2* 

With Class allows the Net Class associated with the nets in the list to be used as the selection criteria. 
This enables you to select nets using Net Classes of Power for example, which in-turn can be checked 
for connecting to an existing named nets. 

The Check/Uncheck buttons are used to check or uncheck the selected nets in the nets names list. 

Using Testpoints 

Testpoints are used for a number of reasons on a Schematic design:  

• To annotate a theoretical testpoint that an engineer might use on the PCB to ‘probe’ a given 
electrical statistic or measurement. This may be on a particular Component pin, or added 
separately using a documentation symbol to indicate that a particular net is to be tested. These are 
passed through to the PCB design during Translate To PCB. They do not appear in the design’s 
net or part lists. 

• To define a physical testpoint part on the PCB, that is added as a Component on the Schematic by 
the engineer and is again passed through to the PCB design during Translate To PCB. These parts 
do appear in the design’s net and part lists. 

 

Pulsonix provides an Insert Testpoint option, on the Insert menu, for adding each of these types of 
testpoint. Alternatively you can select a Component pin and use the Change Testpoint option from 
the context menu to mark the pin as a testpoint. 

Testpoints are Doc Symbols with the property of Testpoint, defined during their creation. See the 
Doc Symbols section previously. 

���� To Insert a Testpoint 

1. Click the Insert menu and click Testpoint.  

2. Right click to use the context menu to choose whether to Insert Testpoint Part or Insert 
Testpoint Doc Symbol. 
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3. Use Change Testpoint Symbol from the context menu if a different symbol is required. Note 
that if a symbol has not been setup yet, you may enter the Change Symbol dialog automatically. 

4. Right click to use Change Name from the context menu to change the default name supplied 
(shown on the status bar). The default testpoint name stem is taken from the testpoint Defaults in 
the Design Settings dialog. 

5. Select an item on the net to be tested. A testpoint part or doc symbol will appear at the end of the 
cursor for you to move into the correct position. It is connected to the picked item. 

6. Click to drop the testpoint in place and either add another or press the <Esc> key to exit this 
mode. 

Doc Symbol Testpoints (not Parts) translate to the PCB design as floating test lands (PCB Doc 
symbols) ready for the PCB designer to place in appropriate positions on the net to be easily probed. 
The point of adding these to the schematic is to indicate to the PCB designer the nets need to be 
probed. 

Testpoints added directly to a Schematic symbol pin are translated into the PCB design. These are 
added automatically to the corresponding pad of the Component. The pad is made into a testpoint (as 
you would if you selected the pad and used Properties,| Testpoint to add it). 

Adding Shapes 

Within the Schematic design, shapes are sometimes required. You can use the Insert Shape option 
from the Insert menu to add documentation shapes. These shapes can be Open or Closed, Filled or 
Unfilled and Hatched or not. You can also change the Style of the line (when using non-filled 
shapes) to be dotted or dashed in appearance. 

The default shape used when adding documentation shapes is taken from the Design Settings and 
Defaults dialog. As well as the Line Style of the shape, the Hatch Style can also be defined provided 
the Closed, Filled and Hatched check boxes are selected. 

Once a shape has been added to the design, you are able to use the Insert Cutout option to cut shapes 
out of the existing shape. 

���� To add documentation shapes  

1. Click on the Insert menu, click Shape 

2. Draw the shape onto the design using a single click to insert corners. 

3. At any time you can use the context menu to change options of the shape, e.g. Style, Closed etc. 

4. While inserting the shape or editing it, you can also select Common To All Pages from the 
context menu. This will put the shape onto all pages within the current design, e.g. if it represents 
a page border. 
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Use of Attributes in Schematic Capture 

This section details specific attributes associated with Schematic Capture. The general process of 
adding attributes has already been covered in the Chapter under Setting Up The Design.  

Displaying Attributes 

All attribute names in the design are available in the Colours dialog. These can be set to be Displayed, 
Selectable and to have their individual colours changed. All system attributes are shown in brackets 
e.g. <Component Name>, <Date> and user defined attributes shown without brackets e.g. Cost. 

 

System Attributes 

There are a number of system attributes that present themselves in the design as part of Components 
and Nets and other used design items. Attributes such as Component Name, Gate Modifier, Part 
Name, Part Description, Net Name etc. are used throughout. 

There are some attributes that can be used to add design-level information that changes dynamically 
as the design is updated. For example, Date, Last Save Date/Time and Design Author are a 
selection of the available design-level attributes. 

User Defined Attributes 

New attributes can be added to any design item within Pulsonix. These user defined attributes can be 
extracted using the Report Maker output. In Schematics, attributes would generally be used for 
showing Costs, Preferred Manufacturer, or simulation parameters such as Model Name etc. 

Attributes on components that have their attribute names marked as being 'both' design types (PCB 
and Schematic) will be copied to the corresponding PCB Component when Translate To PCB is used. 

Translating the Schematic to PCB 

The final process before starting on the PCB design itself is to translate the Schematic design into the 
PCB design environment.  

With the concurrent checking and procedures that Pulsonix Schematics adheres to, by the time you 
translate to PCB there should be very few warnings or errors to resolve before the design is 
acceptable to start design the PCB with. 

Before starting this process, you should check that there are no components in the Component Bin 
that should be translated. Any components in the Bin are not translated unless part of a multi-gated 
device already used in the Schematic. 

When you are in a position that you wish to go-ahead with this transition, you should use the 
Translate To PCB option from the Tools menu. 
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This dialog provides you with the option to name the new PCB Design although a default name 
matching the Schematic design name is provided. If you decide to use this, it will make it easier later 
on when you use the Synchronise Design option, or Cross Probing, as both options use the same 
Schematic and PCB Schematic design names as default. 

The Technology box allows you to choose a PCB Technology file to use. The technology defines the 
layers, power planes, pad styles, track styles, etc.  

The Profile box allows you to choose a PCB Profile file to use. This will give you a jump-start, 
because you can have your board outline and other general annotation predefined. You can also have 
critical components pre-placed in the profile, e.g. edge connectors. 

Check the Unplaced components to bin option if you want to use the Component Bin, otherwise 
components are stacked in the design area or around the board outline if one is available. 

You can opt to Show Bin if you have selected the option to place unplaced Components into the bin 
and wish it to open automatically to view its contents. 

Libraries 

Parts from the Parts library have already been used in the Schematic design, these will have the 
corresponding PCB Footprint symbol associated with them. When the translate process begins, the 
Parts used in the Schematic are extracted and used in the PCB design along with its footprint. 

If any Part used has more than one entry in any other Parts library within the Libraries search path, 
the first entry found will be used. 

The Path for the libraries is defined in the Folder option located on the Settings menu. 

Doc Symbols 

During the Translate To PCB process doc Symbols are not translated. These are retained in the 
Schematic design for documentation purposes only. 

Predefined Signals 

Normally, you would not display all the Power and Ground pins on gates in your Schematic. Instead 
these are added as Net names on the appropriate pins within the Parts in the Parts library. These 
Power pins will be automatically connected when the Schematic is translated to PCB. Predefined net 
names on pins that are not on a gate in the Schematic will not be added when translate to PCB is 
performed. 

PCB Footprint Selection 

You may edit the footprint name on a Component in the Schematic, or leave it blank to use the default 
on from the Part definition. Translate to PCB will try to use the supplied name, but will use the 
default name if it cannot find it. 
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Interpreting messages during Translation 

There are three types of messages displayed during Translate To PCB: 

• Information 

• Warnings 

• Errors 

 

Information in the report will inform you of what has been completed and whether it is successful or 
not. It will also provide you with other related information such as the time and date translated, the 
file name, folder etc. This may be required for any quality procedures or audit trails. 

Warnings are non-fatal messages that inform you of automatic changes that the program has done 
during the translation. All warnings should be read and noted. You may wish to correct warnings 
before continuing with the PCB design. Any corrected design should be re-translated to use the 
corrections. The warnings could also be for items, such as Attributes or Net Classes that exist in the 
Schematic design but not in the PCB Technology File. These are automatically passed through and 
added to the PCB design. The warning will inform you that they've been added and to check and edit 
them in the PCB design. 

Errors are displayed where the program finds illegal data. For example, a Part used in a Schematic 
that no longer exists in the library because it has been removed, renamed or not available from the 
folders path defined. All errors must be checked and corrected to ensure the full integrity of the PCB 
design against the Schematic. 

Once any corrections have been made to the Schematic, the translation process must be undertaken 
again. On any subsequent translation, ensure that all warnings and errors are verified and if necessary, 
resolved. 

Exporting Netlists 

From Pulsonix you can output a netlist from your Schematic design in ASCII format specific to other 
systems using the Export Netlist option located on the File menu.  

During the output, a netlist is collated and written in a PCB format suitable for import into other 
system's PCB design editor. This means the netlist contains unique Component names and net names 
that are fully resolved with all associated names connected e.g. power and ground and busses etc.  

The netlist is written in an ASCII format, in the format of the target system that you choose from the 
drop down list box. 
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The export list is not exhaustive but does cover all of the commonly used and widely accepted file 
formats. 

The netlist required for export should be chosen from the drop down list available under Netlist 
Format. By default, the netlist will be written to same location as the design, use the Browse button 
to change this location. 

Dialog Options 

Options on this dialog allow you to create a file with Neutral Net Names or Part Names. If you are 
sending the file to an external company, this will help you to preserve your IP. 

Using Part Mapping Files 

If using the Pulsonix Schematics system and another vendors PCB system, you may find that the Part 
names used in Pulsonix are different to that in the other system. Instead of editing the Parts in one of 
the libraries to match, you have the ability in Pulsonix to use a mapping file. This mapping file is 
generated automatically and contains the Pulsonix Part name and Footprint name, and mapped 
equivalents that would be used in the other system.  

Exporting Spice Netlists 

You can also export Schematic designs in Spice netlist format. Within Pulsonix, you can prepare 
components for Spice output and add circuit stimuli and fixed probes, then generate a Spice netlist.  

To set the Spice Netlist Type 

Before running a Spice netlist, you must choose the type to export to, each one has its own ‘flavour’ 
of Spice. Select the Set Netlist Spice Type from the Simulation menu in Schematics. 

First choose the Spice Netlist Type from drop down list for the simulation file. The simulator 
commands in the netlist file will be formatted to suit the chosen simulator.  

 

If available, you can choose to use the Run Simulator check box to specify whether you can directly 
run a simulator as well as producing the Spice netlist. This will seamlessly write a Spice netlist, then 
run the appropriate Spice engine without having to re-create the Schematic and no addition user 
intervention. 

Use the Browse button to locate the program to be run on your computer. Where possible we have 
added filters to this dialog to suggest a possible simulator program name. 

Add any command line switches that are needed to run up the simulator, either before or after the 
output filename. Initially these will be set to default values for each simulator type. If you change 
them you can use the Reset button to revert back to the default values. 
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Press OK to accept the change. If Run Simulator is checked you will be able to use the Simulate 
Design option to pass your Spice netlist directly to your simulator. 

Outputting a Spice Netlist 

To generate a Spice netlist in the format you have chosen, If the Program has been previously set up, 
use the Run Simulation option from the Simulator menu. If this has not been set up, you have to use 
the Create Spice Netlist File> (from the Simulator menu), then choose one of the page options and 
the location using the Save As dialog.  

Reverse Engineer 

From within a PCB design, it is possible to take your PCB and reverse engineer it back to create a 
new Schematic design. Other than the PCB option to initiate the Reverse Engineer, all the 
functionality of this option is within the Schematic editor. In PCB, the Reverse Engineer dialog on 
the Tools menu allows you various options and selections to be made when the option is run.  

   

Components can be added to the Component Bin in the Schematic design. The bin is divided 
between unused and used gates; you should place all the used gates onto the Schematic pages to 
complete the design. 

 

Components in the PCB design that are flagged as PCB Only Parts are not reverse engineered. If you 
wish to reverse engineer Components, they need to be edited in the Part editor and Schematic 
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symbols added, then use the Reload option to reload those updated Parts to the design. After this you 
can use the Reverse Engineer successfully. 

For components that don’t have a Parts library entry (because they came from an external source for 
example), these components will be reverse engineered but the Schematic Symbols will be 
automatically created for you. The shapes of these Symbols will be generic boxes and not the real 
shapes. 

Schematic Routing 

When the All Components to bin check box is not selected, components are placed in the design 
using their relative PCB design positions and using suitable placement spacing (or Autoplaced using 
the other radio box selection). 

 

Having the All Components to bin check box unchecked enables you to also select the Route 
Connections check box. Once the design has been placed in the Schematic the connections can be 
automatically routed using the Schematic connection router. 

Printing and Plotting the Schematic Design 

When you wish to obtain a hard copy of your design, there is a choice of two methods for outputting 
prints and plots from Pulsonix:  

• The Print option from the File menu that will print the current design exactly as it appears on the 
screen. It will output to the selected Windows printer and will be automatically fitted to the paper 
size. 

• The CAM Plot option from the Output menu to Print or Plot a user defined output to a selected 
device using defined parameters. This allows you to also choose not to include some design item 
types. Using this method, Pulsonix plots everything in the design on a per page basis unless 
excluded from a plot. The control over the size, scale, position and contents can be defined using 
the tools provided. 

Using the Print Option 

The print option is a quick and easy method of generating a print of the Schematic using your default 
Windows printer. 

When selected from the File menu, the Windows printer dialog is displayed. 
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From this dialog you can select the number of copies to be made and select the print range. 

This dialog also gives you access to more advanced printer specific options allowing you to change 
settings such as Colour/Black & White, paper size and orientation of the print. You can also force the 
print to All Colours Black and the Print Contents. 

If a more specific and consistent print is required, independent of the screen view, the CAM/Plot 
option on the Output menu should be used. 

The CAM/Plot option is a fully configurable single 'shot' output mechanism that allow you the full 
flexibility to output the plot(s) required. 

Using the CAM/Plot option 

The CAM/Plot output option is available on the Output menu.  

The CAM/Plot set up parameters are defined in the Technology, if they are not available the first time 
you try and enter this option (or the first time you enter the Technology and CAM/Plot tab) you are 
presented with a dialog to request auto-generation of the parameters. 

 

If you click No to this, the CAM/Plot mode is entered ready for you to create the parameters 
interactively. If you click Yes, the Auto Generate CAM/Plots dialog is displayed: 
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From this, you can select the default plot mode for each page or block of your design. 

Once in the CAM/Plot dialog, you can select other print or plot types for any page. You can also opt 
to have a Windows and Pen Plotter output for each page if required. As well as defining plots or 
prints, you can also output reports from the format files created. 

Overview of the CAM/Plot dialog 

The dialog itself is split into three sections with a panel at the base of the dialog used to run the plots. 
This panel is available during the use of all three dialogs. 

 

Plot Preview is used to display a preview of the final plot. This should provide you with an idea of 
what the plot will look like before it is plotted or printed. 

CAM Plots is used to set up the characteristics of the plot, the scale, rotation, plot type etc. 

Plot Settings is used to set up the plotter or printer. This dialog also contains a location for the 
destination of the plot output if a file is being output. 

Run is used to start any plots that are enabled and to save the current settings. Cancel is used to exit 
this dialog and Apply is used to save the current settings but not run the plot. The Close button is 
displayed instead of Cancel once the Apply button has been pressed, this closes the dialog also. 

Plot Preview 

The Plot Preview dialog allows you to select the page required to preview.  
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The page is represented using a Plot Name defined on the CAM Plots dialog; this also helps identify 
the type of plot being output if a sensible name is used. The Enable check boxes will allow you to 
select which plots will be output when the Run button is pressed. This means you can opt to run all 
plots required in one single button press regardless of the plot type or even if mixing plot types. 

The Fits column will display an X if the plot does not fit the paper. Most times you will be able to see 
if the plot will fit but if marginal, this acts as positive confirmation that it will or won't fit. 

The preview window displays the plot selected in the list. It shows two main boxes (shown with a 
'cross' in each to help identify the centre). The first is the plot bed (the paper extents or the bed size), 
this is the large box shown in Red. The second is the design extents shown in Blue. Also shown are 
elements of the design to give you an indication of the orientation and the scale relative the paper. 
The preview window can be switched off by deselecting the Preview Design check box. 

All other information shown in this dialog is confirmation of the CAM Plots dialog settings. 

CAM Plots 

The CAM Plots dialog is used to set up the plot for output and how the plot will appear relative to the 
paper being used. 

If a standard plot is required, the plot can be almost completely defined used the Auto Generate dialog 
when you first enter the option. The only setting you may need to adjust is the plotter type for 
Windows or Pen Plotter or the Exclusion of items not required in the plot. 

The grid matrix displays the options selected for each plot. Each of these can be edited interactively 
or by using the Plot Wizard once a row or item on a row is selected. The Plot Wizard is enabled once 
the row is selected by clicking on the Edit button. 

If no plots exist or you require a new plot, you can use the New button that will use the Plot Wizard 
to complete this task. This will lead you through the plot type generation process to create a new line 
in the plots table. If you have a plot selected, New copies the properties of this plot into the Plot 
Wizard. 

 

The Edit button displays the first page of the Plot Wizard. Each of the pages of the plot wizard will 
allow you to set up facets of the plot to be output. See later on in this section for an overview of the 
Plot Wizard. 

The Delete button is used to remove any unwanted plots from the grid. 
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Add To Plot is used to combine plots and is more relevant to the PCB Design editor. When selected, 
it displays the Process page of the Plot Wizard from where to choose a process to add to the plot 
selected. The Add To Plot option will add the plot to any other plot selected. If it gets added to the 
wrong plot by mistake, select it, and use the Delete button to remove it. 

If when you started this option, you clicked No to Auto Generate the plot type, you may now use the 
Auto Generate option to create a set of plots ready for use. This can be an alternative to using the 
New plot option. 

The Reports button is used to generate a summary report listing the plots and their settings, in case 
you need to keep this for future reference. This is in addition to any reports generated at the time of 
actually running the plots. 

Step & Repeat is used to create ‘panelled’ designs. See the later section in this chapter on Step & 

Repeat. 

Using the Plot Wizard 

The Process page defines the Name of the plot and the Schematic Page to be output. The plot name is 
for reference only to identify the plot and if left blank will be automatically completed using the Page 
name. 

The Output selection is used to define the device used for the plot. In Schematics this will be 
Windows, Gerber, Format file, HP-GL Pen Plot or Nothing. Nothing would be selected if the plot 
type was undetermined at that time. 

 

The Style of the plot can be either Artwork or Outline. Artwork will give you the true width of all 
items whereas Outline will only output the item as a centreline unfilled shape. 

 

The Mirror check box enables you to select whether the plot is mirrored or not. 

If output to Format File has been selected, you can choose a format file form the drop down list 
presented. 
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From this page you can also select which items to Exclude from the plot. If nothing is selected in this 
dialog, all items visible in the design are plotted. 

 

The Size page uses selections to define the Scale and Rotation of the plot. For Scale, the choice on 
the drop down list is Auto Fit and 1.00 (a scale of 1:1). You can also type in your own scale choice. 
The Rotation drop down list allows you the choice of Auto Rotate, No Rotation or Rotate 90 
degrees (forcing the rotation to 90 degree from its original position). 

 

The Design Position page defines the position of the plot relative to the plotter type being used. 

The Design Position provides a number of options from where to move the design on the plot. The 
design location specified here is aligned with the location on the paper or plotter table specified in the 
Device Registration Point. This is set in the Settings tab of the Output dialog. This allows accurate 
and repeatable registration of plots to be achieved if the correct combination of values is chosen. 

 

For example, if both Position and Device Registration are set to Origin, the design origin is aligned 
with the origin (0,0) on the plotter. 
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If either the Position specified here or the Device Registration Point are set to Auto Shift, then the 
plot is positioned as best as possible on the output device. 

The Step & Repeat button indicates that the plot can be duplicated on the same sheet. This must be 
used in conjunction with the Step & Repeat option on the main CAM Plot dialog. 

The Finish page provides you with a summary of the options selected in the Plot Wizard. Once the 
Finish button is pressed, the plot type is generated and added to the plot grid. 

Plot Settings 

The Plot Settings page is used to set up the printer, plotter or output device, such as Windows or 
PDF and the location of the files output. 

 

From the Output Device section of the dialog, you can view and change the settings for each kind of 
output device available. Use the drop-down list to choose the output device you wish to look at, and 
the current settings will be displayed in the large text area below.  

If you need to change any of these settings, press the Setup button to access the Setup dialog for the 
output device. The actual dialog that is displayed is different for each kind of output device 
(Windows, HP-GL Pen etc.). 

The Folder For Output Files section defines where the output files are written. You can choose from 
three different settings by selecting from the drop-down list.  

Design Folder: output files will be written to the same folder as the design file.  

This Folder: you specify the folder where all output files are written. The same folder will be used 
for all output files generated.  

This Folder below design file: you specify a folder name that will be appended to the folder in which 
the design is stored. For example, if your design is stored in "C:\My Projects\Board 6\Revision 
2.pcb", you can set the output folder name to "Plots" and all the output files will be written to the 
folder called "C:\My Projects\Board 6\Plots".  

File Names Based On 
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This section allows you to choose the way your output files are named. You can choose from three 
different settings by selecting from the drop-down list.  

Design Name: output file names will be based on the name of the design. A number will be added to 
the end of the name to generate a unique name for each file generated in any one plot "run".  

Plot Name: the output file name will be derived from the Layer/Span/Page name of the plot. For 
example, a plot file that is generated by processing Layers will be named according to the layer name 
being plotted.  

Design Name + Plot Name: plot files will be written to a file using the design name followed by the 
plot name (in brackets) and using the default extension for the type of plot. e.g. "MyDesign (Top 
Electrical).hp"  

Change Output File Name 

Use this if you want all output files to be based on a specified name. A number will be added to the 
end of the name to generate a unique name for each file generated in any one plot "run". If you leave 
the file extension off, the default extension for the type of plot being generated will be added. If you 
just type a file name with no directory, the mentioned above folder will be used. 

Leave unchecked to use the above mentioned default plot file name.  

Plot Report 

Create a report use this switch to elect whether to write the CAM Plot report or not. 

View When Run: You can choose whether the plot report that is written at the end of each run will 
be displayed on the screen after it has been generated.  

Append To Existing: The plot report will normally be overwritten each time press Run. Check this 
option to append (add) to any existing report, instead of overwriting. You will then need to scroll to 
the end of the report to view information about the latest plot.  

Save With Output Files: Use this to direct the plot report to be saved with the output files.  

Save To Reports Folder: Use this to direct the plot report to the reports folder.  

Outputting a plot 

Once the Auto Generate dialog has been used, the bulk of the work to create a plot has been done 
apart from 'fine tuning'. The Auto Generate dialog has been designed so that any rotation, any scale 
plot to fit the page will be specified by default. This means the plot will fit the paper if the Run button 
is pressed. Obviously, you can use the CAM Plot dialog to redefine the plot as required.  

Check that the plot is as required using the Preview dialog, and press Run. 

Printing to Active PDF 

The plot to PDF output is used to write PDF format file with active annotation. Once the PDF file is 
created, you can hover your cursor over design items and properties of that item will be displayed.  

In a Schematic design, all pages in the design and hierarchy are plotted (including lower level 
hierarchical blocks). 

Writing the PDF files 

Within the CAM Plot option, the PDF output is additional to the standard Windows driver and you do 
not need to install a separate driver for it. If you have a PDF Windows driver already installed, you 
can still use it. The Pulsonix PDF driver has the added ability of the active annotation which your 
standard PDF output will not have. 
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The PDF output is accessed through the CAM Plot dialog and New or Edit when you create a plot. 
Simply select PDF from the drop down list of available output types. 

 

Using the PDF file once created 

Once the PDF file has been created and it is open, you can hover your cursor over design items, such 
as Components or connections. A small context menu is displayed from which you can view entities 
of the item chosen. 
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Setting up the PDF output 

You can configure the PDF output using the device Setup option from within the CAM Plot dialog. 

 

Two settings are of note for Schematic plots; the first is for combining or not combining plots. By 
selecting your requirements in Combine Plots, you can export invidual plots for each Schematic 
page. This setting allows All plots to one PDF document and plot Groups as well as Separately.  

The second setting to note is for combining both the Schematic design pages and the PCB design to 
one PDF plot file.  

When running a combined plot, the program will either use the same name as the ‘other’ plot or will 
use the design name defined in the Design Settings, Synchronise, Synchronise Design Name 
option. 
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Chapter 6. PCB Design Editor 

Getting Started with the Design 

There are a number of ways to start a new PCB layout. The way in which you start will depend on, 
whether you have a Pulsonix Schematic design, a netlist or a sheet of paper with a Schematics design 
on it. 

• Using Pulsonix Schematic Capture as the 'front-end' to the PCB system. The nets and components 
are translated to PCB in the integrated environment. 

• Using a netlist that is derived from another CAE or Schematic system. 

• Using the Pulsonix PCB design editor interactively creating the design on the fly. This means 
without an initial netlist just adding connections and components as you design the PCB. 

This chapter will guide you through the different options that will enable you to build up the design in 
the order that you naturally progress the layout with. 

Starting a New PCB Layout with Default Files 

Regardless of where you start the PCB design from, you are required to provide basic information at 
the starting point. This would normally be the name of the Technology file and the Profile file you 
may wish to use, both of these files are optional and can be loaded at a later stage if required. 

Obviously, how you start the PCB layout will be determined by how you intend entering the 
Component lists and netlist. 

For the process of this discussion all methods will be explored but we start with the New PCB design.  

���� To start a new PCB layout 

1. Click the File menu and click New. 
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2. Click PCB Design  

3. You will also be able to select the name of a Technology file in the drop down list box. There are 
a number of choices available as supplied with Pulsonix, each of which represents a different 
type of design technology, e.g. Double Sided, 4 Layer, etc. If the Technology file required does 
not match one of these you can select [None] from the list. 

If you are unfamiliar with this style of drop down list, select the small arrow on the right hand side of 

the technology file name and then click on one of the names presented to select it.  

4. You can also select the name of a Profile File from the drop down list box. The Profile file can 
contain your board outline or drawing blank etc. If you do not require a profile file or wish to add 
one later, select [None] from the list. 

5. The Set Units check box enables you specifically select the units for your new PCB design. This 
overrides the Technology file units and will be subsequently used in the design. Choose from 
Imperial or Metric and select the precision required. 

6. Click OK to start a new PCB design session. 

The PCB editor is now ready with a Technology file loaded and optionally, a Profile ready for use. 
From here you may add a netlist (from another non-integrated system) using one of the supported 
netlist formats. Alternatively, you may wish to create the design on-the-fly adding Connections or 
Tracks and components directly. 

At any point, you can load a full or partial Technology file, and load a Profile file. Partial Technology 
files enable you to mix and match technologies or to create Technology files of individual 
technologies, such as layer stacks or Spacing classes for SMD, BGA designs etc. 

Later on in this chapter, methods for using the Translate from Pulsonix Schematics and using a netlist 
are discussed in more detail. 

Design Setup for PCB Layout 

Before getting started in the design itself, you should check that when you start adding design items, 
the design editor will behave as you expect or require it to. 

Many of the characteristics of design items are set up in the Design Settings dialog and in particular 
on the General, Defaults and Naming tabs.  

The Defaults pages set up the Layers, Styles, Testpoints and other feature options used when adding 
new items to the design. Access these pages through the General/Defaults page and Edit Defaults 
button. 
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Unless an item is pre-selected, the default style defined in this dialog is used. If a similar item is pre-
selected, inserting a new item of the same type will inherit the Layers and style of the selected item.  

The Naming page contains very specific information regarding the characteristics of design items, 
items such as the leading character or symbol used for the default system net names, e.g. whether 
$001 or N0001 is used (or another leading character). Pulsonix uses $ as its default leading character. 

 

This dialog is set with built-in settings and should only be changed if you understand what they do. 
Some of the settings can only be changed before a design is started, where there are no design items 
in the design. Some items can be changed after the design is started but the system updates itself to 
adjust all the design items that already used these settings, e.g. Default Net Name stem.  
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The Default and naming options are 
saved in the design, and so only effect 
the design you are editing. Other 
options are saved to the system's 
Registry and so are set up for every 
design that you subsequently create or 
edit. They can be set up in the 
Technology files. Once your 
preferences have been worked out, the 
Technology files should be changed so 
that these options are then used for 
future PCB designs. 

Once you start editing the design and 
adding new items to it, you can also 
check the Options dialog under the 
Tools menu to see if the Edit Track, 
Move and Interaction tabs are set to 
your preferences. These can be changed 
interactively during the tools use from 
context menu options. Pulsonix is a 
very flexible system and allows many 
of the options to be customised to suite 
your particular style of working.  

Unlike Design Settings, Options are 
stored in the registry and are therefore 
machine or login specific, these are 
normally user preferences rather than 
design preferences.  

Setting up a PCB Technology 

The concept of Technology files has already been discussed in a previous Chapter. This section 
details the specifics of Technology data with the PCB Layout editor.  

The most important considerations when choosing a Technology file or setting up your technology 
data is the final manufacturing process that your manufacturer can handle. A consideration to make 
when design your PCB is the cost of the technology you intend using. Changing your track styles 
from 8 to 6 thou for example, could have significant costs implications. You should always check that 
they can actually make the board you propose as well. For example, if you use blind and buried vias, 
not all manufacturers can make these in-house. 

PCB Technology dialog 

Styles 

The PCB technology data contains a number of styles that define the appearance of PCB design 
items, (components/Documentation Symbols, Connections, Net Classes, Tracks, Copper, 
Names/attributes and Text). 
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The illustration below shows the major styles used in components and Doc Symbols, Connectors and 
Testpoints. Generally speaking, each symbol is made up of a collection of the same type of styles but 
in some cases not all of them. 

 

 

Pad Styles 

Pad styles are used to define an electrical point of contact for nets and tracks but also as a physical 
pad for the Component. These can be any one of the predefined shapes available, and are defined a 
Width and Length, but can also include a Drill Hole if used as Through hole pad along with the drill 
hole Plating status.  

User Defined Pads will show a shape of Special as they have been specially created. These are 
discussed below under the heading User Defined Pad Shapes.  

The Name can be Typed by you as required or it can be defined from the Pad Naming Rules 
(defined in Technology under Naming and Pad Style Naming). Template is used to match a single 
rule for one pad style.  
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The Shape of a drill can be defined to provide slotted pads. Pads of Round are considered normal 
drill holes. 

An Offset value can be defined for both X and Y offsets for the pad position. This enables you to 
display the pad in an offset position from the actual connection point of the pad. 

An Offset value is also available for the Drill position. This enables you to define the position that 
the drill is located within the pad. 

Vias are included in the Pads Styles dialog and are defined in the same way as normal pads. 

For Use By enables you to preselect the refinement of the pad styles for when they are used. For 
example, creating a style used specifically for vias, such as Via (18) and choosing Vias from the list, 
this pad style will only be available for pad styles and not when adding pads or moutning holes. 

Slotted Pads 

If you wish to define a slotted pad style, you can do this using a User Defined Pad, or preferably, 
using a slotted pad style defined in the Pad Styles dialog. When editing a pad style, you will need to 
edit the Drill style to be an Oval, Rectangular or Rounded/Chamfered Rectangular drill style. This 
makes your ‘drill’ hole a ‘slotted’ style rather than a drilled style.  

 

When in the CAM/Plot dialog, this pad style would be (generally) machined using the Excellon NC 
Drill output but would have a separate drill run for slotted pads, these would be milled rather than 
drilled. 

On the Process page of the CAM Plot Wizard, the Non Round Hole Shape would be selected for 
output. You may have two separate outputs for Plated and Non-plated Slotted pads.  
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Line Styles 

The Line Styles dialog is used for line widths of Component outlines, Placement outlines, Areas, 
Templates, Copper, Arrows, Thermal Spoke Widths and Board outlines.  

Connection Style 

Connection Line widths are taken from a system value and cannot be changed.  

Track Styles 

The Track Styles dialog is used to define the thickness of tracks. These styles are used when defined 
as a rule in the Net Styles dialog 

The Net Names dialog is used to list the user defined net names used in the PCB. You can set a nets 
Net Class name using the Net Class dialog (see below).  

User Defined Pad Shapes 

User defined pads can be used where the standard Pulsonix pad shapes do not represent the actual pad 
shape required. A pad style editor is provided that is run from within the Pulsonix PCB design editor 
itself. This means you can create a special pad shape by drawing the actual pad shape and drill shape 
required. This mode may be used to create new pad styles or edit existing ones. 

The Define Pad Shape mode is entered using the option from the Setup menu. This editor is similar 
to any other Pulsonix editor mode, such as the Footprint Editor. Obviously, it has limited functionality 
relative to creating pad shapes. When the pad shape editor opens, various shapes are shown, these 
represent the following: 
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Edit an existing pad style in the Pad Shape Editor and you can delete, resize, move or edit the red 
circle drill shape. You are able to delete it first then add a new shape (a Rectangle, for example) to 
draw in a slotted pad. If you then select it, you can use Change Layer to select a new special layer of 
<Drill Shape>, this specifies the shape to be the drill hole.  

To add a Pad Exception to your user defined pad shape (a different pad shape on another layer), 
simply add a new shape and use the Change Layer dialog to define its layer. 

 

The <Default Shape> entry shown means that the selected shape will appear on all the layers in the 
layer stack unless changed to a specific layer. 

Once the pad shape has been defined, from the File menu, use Save to save the shape and exit. 

Define Pad Shape - Multiple Shapes Allowed 

In Define Pad Shape, you can add multiple shapes for on a Non-Electrical layer. For example, to 
define multiple glue spots. This can be done by adding the extra shapes and changing their layer to an 
appropriate one. 
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Define Pad Shape now contain Text, Dimensions and Callouts 

When using the Define Pad Shape editor you can also add Text, Dimensions, Construction Lines 
and Callouts. Properties, Technology Styles, Defaults and Colours are available to support these 
documentation items. 

Saving Documentation items for reuse 

You can save all of these items within the Pad Shape so that they can be recalled for use on future 
edits. Effectively, for special Pad Shapes that have this additional information you will create a set of 
Pad Shapes in your library. To save these Documentation items, you must save the Pad to a PCB 
Doc Symbol in a library. If you choose not to save the Pad to a Doc Symbol then the additional 
information will be lost. Not saving the Pad Shape will still mean it retains any user defined shapes as 
before. 

When saving back to a style in the PCB design, if the Pad Shape is in a library or if the Pad Shape 
contains documentation items, you are asked if you want to save to a Doc Symbol library. 

 

Choosing Yes will display the Save To Documentation Symbol Library dialog: 

 

This can also be accessed from the File menu using the Save To Library option. 

Choosing No will exit the Pad Shape editor, save the pad shape defined but will not save any of the 
additional documentation information, this will be lost. 

User defined pad shapes can be added to the Vault as well as your PCB Documentation Symbol 
Library.  

Saving a Pad Shape as a Doc Symbol will be saved as a new symbol type, Pad Shape. These can be 
edited the same as any other Doc Symbol and accessed from the PCB Doc Symbol Library 
Manager. 

Load Pad Shape From Library 

When editing PCB pad style, from in the Footprint Editor for example, if you wish to use a Pad 
Shape that has already been saved as a Doc Symbol, then for a selected pad, you can use Load Pad 
Shape From Library from the context menu.  
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If the pad style name is already in a library or vault you will be asked if you want to load it when first 
editing the style. 

 

Hatch Styles 

Hatch Styles is used to provide a mechanism for hatching Closed and Filled areas, e.g. Copper or 
Shapes etc. Hatching is an alternative to a solid and can be defined as either Hatching using a single 
line, or Cross Hatching using diagonally opposing lines.  

 

 

 

The Name can be Typed by you as required or it can be defined from the Hatch Naming Rules 
(defined in Technology under Naming and Hatch Style Naming). Template is used to match a 
single rule for one pad style.  

The Angle specifies the angle of the hatching. 0 is horizontal, 90 degrees is vertical. Cross Hatched 
causes a second set of hatch lines to be added, orthogonal (right-angles) to the first set. Coverage % 
specifies the percentage of the area covered by the hatch lines. This dictates the distance between 
hatch lines, which will be related to the thickness of the line style used and if it is Cross Hatched. A 
Cross Hatched area will have a greater line separation than a singly hatched area with the same 
Coverage.  
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For coverage where the spacing between the lines and the line thickness are the same, you should use 
a 50% coverage. Where a larger spacing is required, use a smaller % coverage. Where a smaller 
spacing is required, use a larger % coverage. 

Offset (%) gives the offset of the hatch lines, given as a percentage of the line separation. Must be 
between 0 and 100%.  

As the hatch style is edited, the preview window is updated automatically to show the style.  

The Hatching or Cross Hatching will be created using the Copper Line Style. Thus if you change the 
Copper Line width where hatching is used, the proportions of spacing to line width will automatically 
change to reflect the current % coverage. 

Style Naming Rules Pages in the Technology Dialog 

Style Naming Dialog 

As a switchable option, you can opt to have Pulsonix automatically create style names for you. This 
means that, for example, when creating new pad styles, you could use the auto-naming option to use 
the IPC naming convention.  

Style Naming is available for all Styles within the Technology dialog. Each page works like any other 
Rules page within the Technology except that generally speaking, you’d only ever have one or two 
rules for each naming style. 

 

The edit portion of the dialog is used to define specific naming items, this varies for each item style. 
The right side of the edit pane defines the Rule that will be created. Once the rule has been defined 
using keywords selected from the Field: drop down list, use the Insert button to add it to the Rule. 

 

Buttons on the Navigation bar under Replace All: enable you to add a rule to the rules pane replacing 
any existing rules. A button on all pages (Basic Set), is used to set up a basic rule for you to use. This 
can be edited to your own style if required. On the Pad Style Naming page, an extra button (IPC Set) 
is used to define a more complex string for the IPC naming rule.  

Basic Set & IPC Set Buttons 

On each of the pages is a button named Basic Set. On the Pad Style Naming page, there is an 
additional button for the IPC Set. These buttons are under the heading Replace All: and are used to 
create you a basic style naming rule tailored for each of the particular styles. As it says, using this 
button will add you one style naming rule to the grid and will remove all other rules defined. The rule 
won’t be applied until the Apply or OK buttons are used at the bottom of the dialog. 
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Note: When using the IPC Set button, this also sets up the Settings dialog as well as the rule 
definition. The IPC rule is a combination of both the rule and pad style/usage mappings. 

Style Naming Settings Dialog 

Each of the Style Naming dialogs has a Settings button. Each one is the same except for Pad Style 
Naming which has additional settings that can be used. The Settings dialog defines the Units and 
Units Text for the Style Naming. This is independent of the main Design Units dialog and is only 
used for Style Naming. 

The Pad Style Naming Settings dialog also enables additional Mappings for Shapes and Pad 
Usage. This is used where specific styles require mapping so that can be correctly defined, the IPC 
naming style for example.  

 

Technology Styles Dialog 

In addition to the Style Naming dialog for each of the styles, the actual Style page has been modified 
too to enable the naming. 

Under each of the Name: fields for the style, there are now three additional radio buttons to define 
how the style will be Named by: There is a choice of Typed (manually named), Rule (using the new 
Style Naming rules for that style item) and Template (which is a hybrid, a combination of both Rule 
and Typed). 
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Technology General/Defaults Dialog 

From with the Technology dialog and Design Settings, General/Defaults page, there is an additional 
switch related to Style Naming called Make named styles use naming rules. When selected, this 
will force the addition of new named styles use the naming rules. Leaving it unchecked enables a 
Typed rule to be defined. 

 

Spacing Rules 

The Spacing Rules dialog is used to specify the minimum clearances required between different kinds 
of electrical design items. The spacings you set up in this dialog are used by the Design Rules Check 
to calculate whether or not any of the electrical items in your design are too close together.  

Using the Spacing Rules dialog 

The spacing values are presented in a grid, allowing you to easily change the values directly. 

 

Click on the text of the value you wish to change, and edit the text to show the required value. You 
can also take the value from one cell and apply it across the whole row, down the whole column, or to 
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all the cells of the whole grid, by right mouse clicking and selecting the required option from the 
context menu. 

As an additional ‘lower’ level of spacings available, Net Class Level Rules enable you to specify 
spacing rules based on Net Classes. You also have the ability to specify rules based on Net Name and 
Net Attributes using the Match Pair Level Rules spacing. This dialog enables you to define Layer 
and Area based rules as well. 

Special Design Level Rules 

Design Level Rules contains additional tabs for specific items spacings.  

 

Component rules defines the Component to Component spacing. This is used as the minimum 
space is used by the Design Rule Check option to look for overlapping components. The Optimum 
space is used when using Push Aside whilst manually moving components, in order to space the 
components out a little. The spacing rules value is applied to the boundary extents of the Component. 
It is more efficient, and easier to manually place, any components that contain a placement outline 
defining its boundary. This boundary would be defined at the Footprint creation stage and would be 
drawn using an area shape.  

Match Pair Level Rules 

These Rules are similar to the Net Class Level Rules, except they only apply between two net items.  

 

 

The mm check box at the bottom of the dialog enables you to set the units to mm or thou (Mils) 
within the dialog only and overrides the main Design Units. 
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To use this dialog, you must define the Net Item the rule applies to. To do this, press the New button. 
You should select the two Net items, you can also use a wildcard string to match several items.  

You can also specify if the rule applies to electrical layers. These can be defined as Top, Bottom or 
all Inner/Outer electrical layers. Rules can also be defined for an area(s).  

For example, if you have net classes called Ground, Power +5 & Power +12, you could define a rule 
pair between Ground and Power*, so the rule would apply between Ground nets and all Power nets 
(but does not say anything about rules between Power +5 & Power +12).  

The rules are applied in the order they are shown looking down the list, so if more than one matches, 
only the first match will be used. You can use the Up and Down buttons to move the selected rule 
pair up and down the list. The Delete button deletes the selected rule pair. 

Colour Coding For Match Pair Spacing Grid 

The grid is colour coded to show what values apply: 

Black shows values inherited from Design Level  
Green for Minimum Spacing 
Blue for an explicit value  

You can change a Spacing value back to the default by selecting the value in the grid and deleting it. 
An explicit value can be removed by deleting it.  

Import Spacings Rules using CSV Format Files 

From within the Spacing Rules dialog, you can import Class to Class Spacing Rules into the 
Schematic or PCB design Technology using a CSV file.  

Using the Import CSV feature 

The Import CSV button appears on the Spacing Rules Match Net Class Pair rule level dialog. This 
would be used in conjunction with the Export CSV option which would have exported a set of rules 
as a template ready for editing. 

There is also a button for Import Custom CSV. This option allows different styles of CSV files to be 
imported. Currently, this accommodates a number of format ‘styles’ that have been seen within our 
development department.  

 

When selected, the Open CSV file dialog is displayed. You will be prompted to select the CSV file to 
import. The File of Type drop-down list is set to *.CSV.  
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Note: If you have been editing your spacing rules in Microsoft Excel for example, you will need to 

save the rules into a CSV file format. To do this, when using the Save As option select CSV (Comma 

Delimited) (*.CSV) format from the File of Type drop-down list. 

 

Select the file required from the dialog and press Open. From here, you can edit the rules presented.  

The Import CSV Report 

The Report button on this dialog can be used before running to inform you of what will be imported 
and a report will be created after import to tell you what has been imported. You can also run it a third 
time to verify the original file against the current Spacing contents, to check for differences. This way 
you can use this feature to check for any different values from the original spacings spreadsheet. 

DFM/DFT Rules 

Further tabs contains rules for functionality for: Copper Pour, Footprint rules, Teardrops, Test 
Points and Thermal rules. These are considered DFM/DFT rules (Design For Manufacturing and 
Design For Test). 

Copper Pour 

Copper pour rules are using to ‘pour’ copper into a Template shape. This would be used in 
association with the Thermal Rules dialog also. 

 

For the Copper Pour area, the Avoid Same Net check box causes tracks and copper on the same net 
as the Template to be avoided, so the only physical connections to the poured copper are through the 
pads. Otherwise, the copper will flood over such items. The Minimum Island Size is in the current 
design units squared, this defines the minimum area of a piece of copper generated by Copper Pour. 
Remove Isolated Islands means that each piece of generated copper must be connected to the 
designated Net. If no connection is possible, the island will be deleted.  

You can define a Hatch Style to be used with each piece of copper generated. 

Teardrop 

Use the Teardrop options to change the shape and size of new teardrops to be added.  
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You have a choice of teardrop shapes depending on your requirements - Triangle, Curved Triangle 
and a customised length Triangle. The V-Angle allows you to define the length of the teardrop 
based on its angle between the two items. A 60 degree angle is set as the default but can be changed 
as required. By adding Length, you can extend the ‘V’ to elongate it. 

Once the teardrop has been added, the Shape and V-Angle can be interactively changed using 
Properties on the item. You should select the teardrop(s) first and then select Properties to change 
this value. 

Thermal 

The Thermal Pads parameters are used when using copper pour on pour areas of the design and 
when using the automatic power plane generation in the CAM/Plot option. 

We define the following major items with refinement available in the Thermal Rules dialog. 

 

Thermal Rules are available in the Technolog dialog: 

 

The Isolation Gap is the gap between the Pad and Copper plane creating the isolation. The Spoke 
Style is the small copper line connecting the Pad to the Copper area. This value is taken from the 
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Line styles entries in the Technology and is presented in the drop down list, this then displays the 
Spoke Style width. A value can also be typed in if preferred.  

The Number Of Spokes connecting the Pad to the Copper area.  

The First Spoke Angle is in current angle units (other spokes will be relative to this first spoke). The 
Number Of Spokes will be the total number added to each pad. A number of 4 or 5 is normal but this 
will depend on your manufacturer. The Minimum Spokes value is set if you really do have a 
minimum number required. If the minimum number cannot be reached, then no spokes are added to 
that pad. You should run the Net Completion Report to ensure that all pads are connected to the 
plane.  

Testpoint 

The Testpoint rules are used during the Testpoint Analysis when using Auto Insert Testpoint and 
Insert Testpoint. 

Testpoint rules are defined in the Technology dialog: 

 

The Probe Side under Test Points allows you to select Top, Bottom or All. These are used during 
the manual inserting of Testpoints and when using the Design Rules Check option. The Side can also 
be extracted using the Report Maker for reports of a specific testpoint side. 

CAM Plot 

The CAM/Plot pages and dialog are covered in detail in the Chapter on PCB Manufacturing Tools. 

Layers 

The Pulsonix PCB design system supports an unlimited number of layers in any combination of 
Electrical, Non-electrical, Wire, Construction and Documentation layers. These layers are used to 
detail the physical 'make-up' of the manufactured printed circuit board. 

A typical default layer configuration 

Below is an illustration of a typical 4 layer PCB showing the 4 electrical layers, 2 outer layers - Top 
and Bottom and the inner power plane layers - Ground and Power. As well as electrical layers, you 
may also need non-electrical layers for additional manufacturing processes that are not constructed as 
physical layers. A typical requirement for this type of layer might be a Silkscreen layer that is printed 
on top of the Top electrical layer.  
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For additional information that is not a manufactured process, you may require an additional layer; 
this can be added as a Documentation layer. This layer might contain the board build information for 
example that is used by the manufacturer to inform him how to build the board itself. 

 

Pulsonix also supports a more advanced layer structure where the actual construction layers are 
defined as well as the basic layers. Layers such as the fibreglass board (FR4) or the copper attached to 
it, can be defined, as can their thickness and materials. You can also specify Wire layers for jumper 
wires and die pads (when using the Chip Packaging toolkit option). 

How to set up layers 

If using one of the supplied default technology files the layers are already defined for you, these can 
be edited or modified though as you require. If you wish to check or edit the layers on one of the 
boards, you can do so using the Layers tab on the Technology dialog. Once Layers have been 
changed, you can save these to a new Technology file or you can overwrite the original Technology 
file. 
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The Layers dialog allows you to position the layers in the order that they appear in the finished PCB. 
These are easily positioned by selecting the layer first and then using the Up and Down buttons, it is 
advisable to use the build order for the layers in this dialog as it makes it easier for anyone else 
reading the Layers dialog to understand the layer construction. The layers must be grouped by 'side', 
so all the 'Top' layers are first, followed by the 'Inner' layers, then 'Bottom'.  

This dialog enables you to add new layers or edit existing ones in the design. Not all of the items in 
this dialog are mandatory, but the following are: Name, Class, Side and Bias. These describe the 
layer Name to identify it, how the layer will look and plot, which side of the physical board the layer 
resides and the routing bias or usage of the layer. 

Each grid cell is editable or has a drop down list that contains selections of relevant information. 

When a Power Plane layer is specified (by selecting Powerplane in the Bias box) you should 
associate it with a power net, such as GND. Use the Net drop down list to choose the net name.  

The Colour box allows you to change the default colour for that layer. Once set the colour can be 
edited using the Colours dialog. 

The Material and Thickness of the layer allows you to complete the board for manufacturing 
purposes, but is not essential. 

Layer Classes are used to define the type of layer that will be added. Pulsonix is supplied with 
predefined Layer Classes, but you can add your own if required. 

Layer Classes 

Layer Classes contain information about how the layer will appear on the screen and when plotted. 
By using these, it allows you to define additional characteristics of any new layer added to the design, 
or to change existing ones by simply changing to another Class. It also provides a mechanism for 
defining the items which are plotted when using the CAM/Plot output.  
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The Layer Class Edit dialog contains information about the visibility of Pad items on the layer and 
the type of pad (Pad Condition) that appears e.g. SMD or through hole. This dialog is also used to set 
up the plotting over or under size when the layer is used for such types as Solder Paste Mask or 
Solder Resist. 

The Layer Type is always one of five types: Construction, Electrical, Non-electrical, Wire or 
Documentation and cannot be changed, (Electrical layers are used to hold Electrical items such as 
tracks, copper etc. These are checked during Design Rules Checking). You have to always specify 
one of these layer types from the choice in the drop down list. The Layer Type will be selected based 
on its use in the design. The sample Technology files supplied already have these defined as a guide 
to their use. 

If a Footprint contains items on an Essential layer, it cannot be added to a design which does not 
contain a matching layer. Similarly, items on non-essential layers will not be added to a design 
without a matching layer, but the Footprint itself can still be added. This can be useful for 
construction lines, dimensions or alternative outlines. Use the Essential For Manufacture button to 
enable this.  

Materials 

Activated from the Layers dialog, the Materials dialog is used to specify the material type that the 
layer is made of. For example, a construction layer could be made of FR4 fibreglass material, or the 
'glue' layer used between two FR4 laminates could be a Prepreg 2125 material.  
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This is used by Pulsonix to create a fully documented layer structure for documentation purposes and 
also for the Design Calculators. For normal Pulsonix use, this level of detail is not mandatory. 

Pulsonix is supplied with different Technology files containing different layer configurations. If, 
when using a technology file, you find that it does not contain the layers required, you can edit the 
existing technology to add more layers, or use the Load Technology option to load a different 
technology file, that does have the correct number of layers. 

You can also import Materials (as well as Layers, Layer Classes and Impedance rules from an 
IPC-2581 Layer Stackup file produced by 3rd party products, such as Polar Instruments. This is 
available from the Technology page and Layers dialog using the Import button.  

Layer Spans 

A Layer Span defines the possible layers a Via can penetrate through the board. Often these are right 
through the board, from the Top to the Bottom Electrical layer. You can also have Blind vias (where 
the via goes from the Top or Bottom to an Inner layer), and Buried vias (where the via goes between 
two Inner layers). As these require an additional drilling process during board fabrication, you should 
consult your manufacturing house to check if they can handle it and the cost, as it can be an expensive 
process. 

Layer spans are also used for board outlines to create Flexi-Rigid Boards, and for Board Cutout 
Areas to create Board Cavities and also areas spans if you have the Advanced Technology option. 

���� To set up through-hole layer spans 

Layer Spans are setup using the layers already defined in the Layers dialog, these are used to define 
spans used for Vias and Micro-vias. Under normal circumstances, the <Through Hole> technology 
spanning the complete design, regardless of the number of layers, would be defined using the <Top 
Side> and <Bottom Side> layer spans. This would encompass any layers used in the design.  

 

To create a layer span if not already defined in the technology file, use the New button. 

Choose the From Layer and To Layer spans from the Layers available in the drop down list, this 
dialog will not allow duplicate layer spans to be created. It will allow overlapping spans but will warn 
you when you press OK and when you exit the Technology dialog. 

���� To set up blind and buried layer spans 

For more advanced PCB technologies, blind and buried vias can be defined in the design. 

Again, using the Layer Span Edit dialog the layer spans can be defined for blind and buried via 
technologies. 
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In the diagram below, the <Through Hole> technology has been set up as a system default (denoted 
with the brackets < > ). The dialog shows a 4 layer example of 2 outer layers and 2 inner power plane 
layers. The span Blind Top - Ground has been set up to allow vias to be placed between the Top 
layer and the Ground power plane. This example would be used for connecting surface mount devices 
through a stub route to the power plane using a via. 

 

This example is manufacturable and would look like this as a cross section of the finished PCB: 

 

If an extra 2 layers in-between the Ground and Power layers were introduced, these could be 
connected together through a layer span and could only be connected to other layer spans if 
subsequently manufactured in a specific order. There would be layer combinations using these layers 
that would not be manufacturable but they are allowed under warning. The dialog will check for legal 
layer spans and warn you if un-manufacturable. 

Displaying Layer Stacks 

You can view the Layers,Via stacks and layer spans by selecting the View Layers button from the 
Layers, Layer Spans and Back Drill Spans dialogs (Back Drills when using the High speed option). 

 

Use the Print button to print a copy of the Layer Stack Preview.  

This can also be added to your design using the Insert Layer Stack option. 
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Changing the Colours in the PCB 

All entities of the PCB design can have their colour changed. Each layer based item can have a 
different colour on each of the layers defined in the design. So, for example, you can differentiate 
between Copper on the top of the board from copper on the other side. Colours are accessed from the 
Setup menu Technology and Colours, or from Setup and Colours. They both go to the same 
location. 

 

The PCB Colours dialog is been divided into two grids for Layers and Multi-Layer Items (such as 
pads) that appear on the Top Side, Bottom Side and Through Board layers.  

Multi-Layer Items 

 

The three special layers, that represent groups of layers; through the board (<Through Board>) and 
sides (<Top Side> and <Bottom Side>) are in a separate table at the bottom. These layers only 
become visible if one of the layers in the group it represents is also visible. For example, pads on the 
<Top Side> would be visible if the Top electrical layer were made visible and the <Top Side> were 
also visible. A special case for this is when all the layers in the top table are not visible, in which case 
you can view the special layers alone.  
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Translating from Schematics 

An integrated element of the Pulsonix Schematic/PCB design environment is the option to translate 
the Schematic design to a PCB design without using a netlist or other commands. The Translate to 
PCB option is available on the Tools menu. When selected, you are presented with the following 
dialog:  

 

This dialog provides you with the option to name the design although a default name matching the 
Schematic design name is provided. If you decide to use this, it will make it easier later on when you 
come to use the Synchronise Design option, or Cross Probing, as both options by default use the 
corresponding Schematic design names. 

The Technology box allows you to choose the PCB Technology file to use. The technology defines 
the layers, colours and other aspects of the ‘make-up’ of the overall PCB design, this includes power 
plane layers, pad styles, track styles, etc.  

The Profile files box allows you to choose which PCB Profile file to use. This will give you a jump-
start, because you can have your board outline and other general annotation predefined. You can also 
have critical components pre-placed in the profile. If the Schematic uses the same Parts, the critical 
components will be taken from the Profile. 

Check the Unplaced components to Bin option if you want to use the Component Bin, otherwise 
components are stacked in the design area if no board outline exists, or around the board outline if 
one is available. 

The Show Bin option is available if you have selected the option to place unplaced components into 
the bin, use this to display the Component bin automatically. 

Once run, a new PCB design session will be started using a New PCB design containing a 
Technology file loaded (if selected), a Profile file loaded (if selected) and a netlist loaded containing 
all the nets and components from the Schematic. The components may be placed in the Component 
Bin or around the board profile outline depending on whether the Unplaced components to Bin 
check box was selected. If no Profile file was specified, and the Component Bin not used, the 
components and nets will appear in a 'stacked' column within the design area. 

At this point the design is ready for Component Placement and Routing. 

Importing a Netlist 

Pulsonix can import many ASCII netlists from other systems in different formats if you decide to use 
a different CAE application to create your schematics or if your netlist source is external. You can use 
this mechanism to start your new PCB design. During import, it will expect a collated netlist with all 
duplicate Net and Component names resolved. It will check these on import anyway and reject the 
netlist if errors are found. 
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Use the Import Design Data option on the File menu. Select the format required using the Files of 
Type: drop down list box. Select the file to import and press the Open button. 

 

You can optionally choose to map the part names used in the other system to the part names that are 
used in Pulsonix. 

 

During the import, the Parts used in the netlist will be loaded from the existing Parts/Footprint 
libraries. If these Parts don't exist, an error will be displayed. All errors must be corrected to ensure 
100% accuracy of the imported netlist. 

If a Pulsonix Profile file has been used when creating the new PCB, you will need to either remove 
any components first before loading the netlist or use the Import ECO option after, to check the 
original netlist against the design and make any changes necessary to bring the two into line. 

For details on importing netlists from other systems please refer to Chapter 12 under the section 
Importing Netlists into Pulsonix PCB. 

Creating a Board Outline 

The board outline is an outline that defines the extents of the manufactured printed circuit board. 
There are two methods to create a board outline in Pulsonix. You can create a board outline on-the-fly 
using Insert Board, or you can load an existing board Profile file. You could also import and extract 
a board outline from another PCB system or create it from an imported DXF file or STEP file.  

Insert Board 

The Insert Board option is available from the Insert menu.  

Insert Board allows you to interactively create a board outline by drawing it into the design. This 
mode allows you to a add board outline using one of three shape styles provided: Rectangle, Circle 
and Polygon. Board outlines would normally be created using an unfilled shape that is non-
intersecting and that has a closed start and end point. While adding these shapes they can be 
carefully added to create the exact shape, or edited in more detail after being added. 

Board outlines are not layer based items, therefore they appear on all layers as <Through Board>. 

If creating designs that use multiple board outlines, e.g. flexible circuits, these can be added to the 
design but you cannot add additional board outlines to act as cutouts. If you require cutouts, use the 
Insert Cutout option to add ‘real’ cutouts within the board outline. 

The Board outline default shape is taken from the Design Settings dialog and Defaults page. The 
Line style used is defined in the Technology dialog under Line Styles. 
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For more complex shapes, use the Construction Line feature. This provides advanced drawing 
capabilities from which you can then create the board outline. 

���� To insert a board outline 

1. On the Insert menu, click Board shape. 
By default, the Board Polygon shape is available on the PCB toolbar as pure rectangles or circles 
are rarely used. 

2. Click to start the first corner. Move the mouse to create the first segment of the outline. By 
moving the mouse you will notice that orthogonal segments are added, one horizontal, one 
vertical but moving together in synchronisation with each other and stretching dynamically. By 
clicking the mouse you will insert corners into the outline. 

3. On each subsequent cursor move and click, more corners will be added to create a polygon shape. 
The length of each segment can be seen on the status bar at the bottom of the Pulsonix window 
(dx and dy). An example polygon might look like this: 

 

4. Double-click the mouse to finish the polygon. If during the insert, you decide that you wish to 
cancel, press the <Esc> key on the keyboard. 

During the creation of the board outline, clicking the right mouse button you can open a context 
menu. This has additional commands applicable to this mode of operation. For example, Curved 
corners and Angled segments through the Editing Options, as well as line style and grids. 

From the context menu for a selceted board outline, you can also choose to Type the Coordinates 
and/or Type the Offset of the shape being added. 

 

It is recommended that you create the board outline away from the edge of the design area and 
starting on a grid point to make it easier to edit later on.  

Importing DXF and STEP Files 

Both DXF and STEP mechnical CAD files can be imported though the Import Designs option on the 
File menu. This is explained further in Chapter 9.  
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Using the Shape Information Bar 

The Shape Information Bar (previously described) can also be used to create and edit board outline 
shapes. This will enable complex shapes to be created using coordinates or lengths.  

 

Insert Mounting Holes 

Mounting holes are used to support the board within an enclosure or other mounting device. 
Mounting holes can also be included in the Footprint library used for mounting components when 
used on the PCB.  

Insert Mounting Hole is used to insert a mounting-hole pad into the design from the range of pad 
styles defined in the Technology file under Pad Styles. The mounting hole may have a net name 
connection in exactly the same way as any other type of pad in the design. 

 

Though there are similarities in the way pads and mounting holes are regarded by the system there are 
some important differences: 

Mounting holes do not appear in the pad count when creating footprints and do not appear in the 
overall pad count when creating Parts. They must be added using Insert Mounting Hole for this rule 
to be active. 

They are regarded as unnamed pads that do not appear on the Parts List output. If you need them in 
the Parts list you should create the equivalent Part. 

The system recognises that the drill hole size in the mounting hole may need to remove the whole 
copper area of the pad, hence You will warned of this when creating the Pad Style used. 

Mounting holes 
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Like ‘normal’ pads, mounting holes can be defined on the Top, Bottom or Through Board layers. The 
layer can be changed while adding them or afterwards. 

The mounting hole is recognised as such by the system and has its own Spacing Rules defined in the 
Technology under Spacing Rules 

During the Insert Mounting Hole operation, the default pad style selected is defined in the Design 
Options dialog and Defaults. 

���� To insert a mounting hole 

1. Click on the Insert menu, click Insert Mounting Hole 

2. The default Mounting Hole shape as defined in Design Settings, Defaults will then be visible, 
positioned at the end of the cursor. You may then place the Mounting Hole at the required 
position in the design. Click the mouse to complete the Mounting Hole positioning operation. 

���� To change the mounting hole pad style 

1. Select the mounting hole pad and right click. 

2. From the context menu, select either Change Styles or Item Properties. The styles available 
have been defined in the Technologies dialog under Pads. From the context menu you can also 
add new styles. 

Mounting Holes and the Schematic Design 

Mouting Holes can be defined in your Schematics and attached to a Net if required. This is then 
passed into the PCB during Translate to PCB as a PCB Doc Symbol. 

Using Profile Files 

Board Profiles are stand-alone design files that contain data describing standard board types that you 
can use as a starting point when designing a PCB board of that type. They can be used as an 
alternative method to using the Insert Board Outline option. 

Profile Files can contain the Board Outline that has the shape and size required for manufacturing as 
well as documentation (Text) and annotation required (Dimensions and Shapes). They can also 
contain Mounting Holes, components (such as standard connectors along the edge of the board) and 
Documentation Symbols. Origins, Copper, Pouring Templates, Areas and Attributes can also be 
included in Profile Files to make them as ready as possible to start a new design. 

Board profiles can be designed in Pulsonix or extracted from a design previously converted from 
another system. Once in Pulsonix PCB the board profile information can be saved as a Profile design 
file in its own right. 

Even if a PCB design is completely finished, the profile data within it can be extracted into its own 
file using the Save Profile option on the Setup menu. 
Pulsonix is extremely flexible in that it can save and load individual entities of a design, even when 
the design has originated in another design system.  

There are examples of predefined industry standard board profiles for you to use, these can be located 
in the Pulsonix\Profiles folder by default. 

Loading Profile Files 

The Load Profile option allows you to load an existing board outline as well as other design based 
information, such as a page border or assembly/mechanical information. These files can also be used 
along with Technology files as your starting point when using the New PCB Design option. 
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���� To load a profile file 

1. On the Setup menu, click Load Profile. You are presented with a dialog containing a drop down 
list from where to make a choice of profile files. 

 

2. Select the file required from the list and click OK. 

3. For other profiles that may be located outside the immediate search path defined in the Folders, 
Profile Files path, you will need to add the Profile File location to the list of search paths in order 
to be able to load them. 

The Profile will be added to the design but remains selected for repositioning. Click in free space to 
deselect it. If you wish to move it, select the outline and drag it to the new location. The picture below 
shows one of the supplied Profile files. 

 

Any Technology file items that are used within the Profile file are automatically resolved during the 
insertion into the design. Style items that match existing styles in the design are mapped to the 
existing style. Styles of the same name but different contents are added using a new style name. 

Once created Profile files can be added to the design like most other items. These can be added at any 
time during the design process but it does make more sense to add them early on to give you a guide 
to the size of the board and the area you have to work in. 

A range of standard Profile files is supplied as part of the Pulsonix installation.  

Component Pre-placement in PCB 

When Loading Profile files as part of the Translate to PCB mechanism and when using the Load 
Profile file option from the Setup menu, if the Profile file contains any pre-placed components 
(connectors for example) then the following happens: 
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• If the Schematic or Profile file contain a Component of the same Part as that used in the PCB 
design, the Component placed in the Profile file will be used. 

• Component names used in the Profile file will be changed to match the ones used in the 
Schematics. Any components in the Profile that do not match components in the Schematics will 
be discarded. 

Loading a Page Border 

Page borders can be loaded using the Load Profile option. Alternatively, you can use a 
Documentation Symbol or create a border interactively using the Insert Shape option. 

Setting the Design Origin 

The design origin is called the Coordinate System Origin in Pulsonix. By default this is located at an 
absolute co-ordinate of 0,0 or the bottom left hand corner of the working area.  

The origin can be changed at any time using the Design Settings option and Coordinate System tab. 

 

The Coordinate System and Relative Origins can both be changed using the appropriate options on 
the context menu of a selected item, i.e. a Pad. The Set Symbol Origin and Set Relative Origin 
commands are located on the Select> sub context-menu for a selected item. 

 

It is better, and more consistent to change it at the start of the design process. The process to change 
the design origin has been discussed in Chapter 5, Setting Up The Design. 

Inserting Components  

One of the first processes to attempt once the Technology file and Profile files have been loaded is the 
insertion of components into the design. Pulsonix provides the Insert Component function for this 
purpose. This process would only be used if a Pulsonix Schematic or netlist from another system has 
not already been loaded.  

You can also use the Part Browser or Parts toolbar options to load Parts, these have been discussed 
in a previous chapter.  

Part and Footprint contents are created and saved into corresponding libraries. The Part entry must 
contain a Part name, a Footprint and a corresponding Schematic Symbol or multiple symbols if the 
Part represents a multi-gate Component. In PCB, an instance of a Part used in the design is called a 
Component. 

The actual creation of Parts will be covered later on in the manual in the Chapter on Library 

Management. 

Using the Insert Component dialog 

Insert Component is a dialog driven option that allows you to select the required part from the 
appropriate library. 
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Use Look In to choose the libraries you are going to search for the required Part. Normally [All 
Libraries] will be used to search all libraries in the Library folder, otherwise, select the library name 
or use [Current Design] to search components in the design. All other libraries available in the drop 
down list will be shown using their own name. 

Which Parts enables you to filter the search list to find specific Parts. The Filter box can take any 
name and wildcard characters. Use the Apply box to use any filter wildcards entered. 

Wildcards can be used to make the filter more efficient. (Wildcards are special characters that are 

used to match any character rather than being specific, for example * and ? ). For example, 74HC* 

More information about using Wildcards can be found in the on-line help. 

The Pins box is used to limit the matching parts to those with a known number of pins (blank means 
any pin count but you can also use * for any). 

Once a Part or range of Parts matching the Filter selection have been found, the first Part available 
will be shown in the Part list. This will display the full Part name (74HC00) and the Library from 
where it came, shown in braces, e.g. {74}. 

From the Part library entry, the available alternative Footprint entries will be loaded into the Part 
drop down list, e.g. DIP14. These may be surface mounted options or different packages available for 
the Part. Choose the required Part and Footprint. 

The Name box shows the default name stem for this Part (taken from the Parts library default 
Component Name Stem entry) and the next available number in the sequence. Both the name stem 
and the number can be edited if required.  

The Symbol box lists the symbols that can be used to represent the component or gate in the 
schematic design. If an alternative to the default is required, select it from the dropdown list. If the 
part has multiple gates the symbol selection applies to the currently selected (and highlighted) gate.  

The Component Bin check box can be selected if you wish to add the Component(s) to the 
Component Bin. These components can then be dragged from the Bin into the design at a later stage. 
The Number Of Copies box allows you to add multiple parts to the Bin in one operation. Please refer 
to the section later on Using The Component Bin for more information. 

The Preview check box opens the preview window allows you to view the Component before it is 
inserted into the design, this gives you chance to visually inspect it to ensure that it is the current one. 
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Once you have the Part you require (shown in the Preview window) and its Footprint and Name are 
correct, you can add it to the design using the Add button. 

If not adding components to the Component Bin, the Add button will dismiss the dialog from view 
and will allow you to add as many Parts of the type selected as you like to the design. If you require a 
different Part you should cancel this process by pressing the <Esc> key on the keyboard. This will 
immediately return you to the Insert Component dialog from where you can make further Part 
selections. If you wish to cancel Insert Component completely, having finished this process, you 
can select any option button from any Toolbar and Insert Component will be immediately cancelled. 
If already in the Insert Component and you wish to exit, you can again select <Esc> from the 
keyboard or use the Cancel button from the dialog. You can also exit the Insert Component mode by 
clicking the Select button on the toolbar (the Select button is the small 'Windows' arrow button).  

Interactively positioning a Component 

Whilst using the mouse to position the Component, you can use the context menu to change its angle 
and to mirror it, for example. This is explained in detail in the Chapter General Utilities under 
Moving Items and more specifically for PCB components later on in this Chapter.  
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Once in the design, components can be positioned to their required location using the Move option or 
by selecting and dragging them. 

Further detail of moving components and the options available is discussed later on in this section. 

Reloading Parts 

Once components have been loaded into the design, you may need to change the Footprint or the Part 
definition and reload it.  

You should select the Component you wish to edit. From the context menu you are provided with 
options to Reload From Library (once the Part and/or Footprint has been edited), Edit Part In 
Library and Edit Footprint In Library to edit the actual Part or Footprint items. 

If you select one of the two Edit options, you will be automatically placed into the Part or Footprint 
editor with that particular Part or Footprint loaded ready for editing and saving. You should make 
your changes and save the updated library item. This is detailed later on in the Chapter on Library 
Management. 

Once the Part and/or Footprint item has been changed, you need to then reload it back into the design, 
effectively 'swapping' out the existing item for the new one. 

To do this, use the Reload From Library option. With the Component selected in the design, you 
can use the option from the context menu, or the Reload From Library options on the Utilities 
menu.  

Note: All other components using the changed Part or Footprint will also be reloaded. You cannot 

have two different versions of the same Part or Footprint in a design. 

Performing the Reload 

When the reload process is started, if you did not use the Browse method of starting it you will be 
presented with a confirmation dialog: 

 

Check the 'Only reload if different version in the library' box if this is required. Leave it 
unchecked if ALL chosen items are to be updated even if their version is the same as in the library.  

The system will then analyse the design and work out what items will be updated. When this is 
complete you will be presented with a summary dialog in order to decide whether to go ahead with 
the update, or just produce a report at this stage.  
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You are prompted with a summary page detailing the status of the Parts and Symbols within the 
design or the selection. 

 

From this you can view the report (View Report) of the changes to make, and then once satisfied 
with the proposed changes, can Perform Reload to actually make the changes. 

If using the Reload From Library option from the Utilities menu, you can Browse the Parts, 
Symbols and Documentation Symbols to change. 
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This dialog allows you to make a more refined selection based on the name of the library item rather 
than its selection or a general ‘reload all’ option. 

By using the Reload All option, and 'Only reload if different version in the library' switch, you 
can use the View Report button to get a report of the library items used in the design have been 
updated in the libraries since you created the design. 

Press Perform Reload to carry on with the reloading. If you had errors detailed in the summary 
dialog, but did not notice you will be presented with a warning. Press Yes to perform the reload on 
the parts and symbols that can be found in the libraries. Press No to abort at this stage.  

Connected Components 

If your Component were connected, it would normally be reloaded with a component with the same 
number of pins in order to not affect the nets. The connections or tracks will be attached to the pads 
with the matching pin name in the new part. 

If you reload a part with more pads, the extra pads will remain unconnected in the design. If you 
reload a part with less pads than on the component, any connection to a pad that does not exist on the 
new part will be removed, and any track in the same situation will be disconnected and left dangling 
for you to sort out in the design later. 

For schematic components, as well as pins being matched up, gates are matched so that if you reload 
a four gate Component with a single gate Part, only pins on the first gate of the original component 
will retain their connectivity. All connections to pins on unmatched gates will be disconnected and 
left for you to sort out later.  

Using the Component Bin 

This section details how the Component Bin is used in the PCB design editor. An overview on how 
the Component Bin works generally can be found in the Chapter Using Pulsonix.  

The Component Bin in PCB is used for holding unplaced components to free up the design area while 
placing other components. This makes the design area less cluttered, especially on dense complex 
designs. 
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Moving Components to/from the Bin 

Components can be moved to the Bin using a number of methods:  

• By dragging the Component to the Bin from the design 

• By using the right mouse button and the Move To Bin option 

• From the Insert Component option 

• From within the Auto Place option using Move To Comp Bin 

• By using the Translate to PCB option within Schematics 

Dragging Components to the Bin from the design 

The most practical method of placing components into the Bin is by clicking and dragging the 
components from the design. Multiple components may be selected and dragged into the Bin also. 

If the Component is connected with connections only, the connections remain in-tact when the 
Component is moved into the Bin but are not displayed until the Component is brought back into the 
design. Electrical connectivity and total design integrity are maintained at all times (even though the 
connections may not be displayed). This principle is for PCB only, the Component Bin Schematics 
editor works differently. 

If tracks exist to a Component, a warning dialog is displayed if a Component move is attempted to the 
Bin. You can at this point select to discard all tracks to the Component by clicking Yes, or returning 
to the design by clicking No or Cancel. 

 

If you click Yes, when the Component is replaced into the design the tracks are not rebuilt, and the 
Component remains unrouted. At this point only Undo can restore the tracks if you've made a 
mistake, provided you have enough Undo levels set to get back to the point where the Component 
was routed! 
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During the move of components to the Component Bin, if components are locked, a warning dialog 
will be displayed. 

 

This provides you the opportunity to confirm the move of the components but is an additional safety 
feature for critical components that may have been deliberately locked. 

From the context menu 

Another method of moving components to the Bin is by selecting the components and right clicking. 
On the context menu, from the Components/Symbols> sub menu, the Move To Bin option will 
allow you to directly move any selected components to the Component Bin.  

This context menu option is also available if a frame select has been executed, even if it includes alien 
objects such as board outline, copper or free text etc. 

 

Again, the same rules apply for routed components losing their tracking information when placed in 
the Bin as before. 

From Insert Component 

Insert Component provides a check box and Number Of Copies entry to send components directly 
to the Bin ready for placement. 

 

From Auto Place 

Another quick method for moving all components from the design to the Component Bin is to use the 
Auto Place option located on the Tools menu. Within this dialog is a selection to move the 
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components to Component Bin. By selecting this, all unlocked components in the design will be 
moved to the Bin. 

 

From Translate to PCB option within Schematics 

Within the Translate To PCB option in the Schematics editor, you have the option to send all 
Unplaced Components to Bin during the translation process. 

 

Moving Components from the Bin 

Components can be moved from the Bin using a number of methods: 

• By dragging the components out of the Bin into the design  

• By using the right mouse button and the Move From Bin option 

• By using the Auto Place option 

Dragging Components from the Bin 

The Component Bin is designed to be an interactive tool for fast ‘drag & drop’ usage. To place 
components in the design from the Component Bin, you select the Component required in the Bin or 
in the Preview window, and drag it into the design. 

Note: during move the drag may be cancelled by dropping the Component back into the Bin, by 

pressing the <Esc> key, or once released, by using Undo (Ctrl-Z). 

Once in the design the Component can be moved until released. 

Using Move From Bin from the context menu 

From within the design and with nothing selected (and outside the Component Bin), if you right click, 
the option Move From Bin is available. 
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This will move the currently selected Component in the Bin into the design ready for positioning. 
Once the Component has been released, the next Component available in the Bin will be moved into 
the design ready for positioning. 

Placing Components around the Board Outline 

To aid placement, there are a number of placement options that Pulsonix provides. Each option will 
depend on the designers’ own preference and design practices but Pulsonix is flexible enough to 
allow any of them to be used when required. You have Place Around Board, Auto Place, Place 
From Component Bin and Manual Place.  

Following a the Translate To PCB process, if the components are not sent to the Component Bin and 
no board outline exists or a Profile file has not been specified, the components will be placed in an 
orderly row in the design area (away from the 0,0 origin). If a board outline exists or a Profile file 
specified, Place Around Board is automatically used. 

As it suggests, the Place Around Board facility is used for fast placement of components around the 
outside of an existing board outline. This placement methodology is an alternative to the 'stacking' 
method and is often preferred by designers. The Component Bin placement facility is another 
alternative and will be generally preferred overall for users manually placing designs. 

The Place Around Board option is used when you require the components to be 'stacked' close to the 
working area and around the board outline ready for manual placement. 

When run, it places the components, grouped by Part Name, spiralling around the board outline. If 
there are many components in the design and the board outline is too small, the spiral will continue 
again around the board continuously until all the components have been placed. 

Components that are already routed or locked will not be placed. 
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���� To place around the board outline 

1. From the Tools menu, click Place Around Board 

2. The components will be placed around the board outline. 

You may need to press the <A> key (Frame All) to see the whole design after placement but you will 
notice that the components have been stacked around the board outline. This feature uses the Part 
name for its selection criteria, stacking components of the same Part name in columns around the 
board outline. 

On-line Design Rules Checking (DRC)  

Pulsonix supports On-line design rules checking (On-line DRC) for use during any interactive 
activities, such as Manual Placement, Manual Routing, Insert Text, Move etc. Each of these options 
will be discussed throughout this chapter of the manual, where the On-line DRC process will also be 
detailed.  

With the checking enabled, all interactive modes will be continuously checked to the Spacing Rules 
defined in the Technology Spacing Rules dialog. See previously in this chapter for more details. 

From the Options dialog and Online DRC page, if the On-line DRC box is checked, some level of 
design rule checking will be performed during manual editing of the items in the design. The depth of 
this checking is determined by the following options: 
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Continuous is used to automatically avoid creating design rule errors during some interactive 
operations. Generally it is used if the operation involves editing a single item on an electrical layer. 
For example, whilst adding a track it will not be able to cross other items on the same electrical layer. 
Moving a Via will not allow you to place it on top of any tracks on layers it spans. A Component is 
regarded as too complex to use continuous checking on as it would be too slow to check every layer 
for ‘Through hole’ pad violations on the fly. 

On Drop is used to automatically check the changed items in the design after any interactive 
operation. If an error is found, you will be asked if the error is allowed, or if the operation should be 
reversed. 

 

For example, if you drop a Component on top of another (during Move) you are warned of a Pad to 
Pad error. You may then leave the Component in error, or carry on moving it to find a legal location. 

The Check Attached Tracks On Drop option is used when moving or rotating a Component that has 
dynamic tracks attached, it is difficult to drop the Component in a location where the tracks do not 
violate other design items. Generally, these tracks would be tidied up at a later stage. Uncheck this 
box to avoid getting errors reported for these tracks. 

After Edit is used to automatically check the changed items after editing when using Item 
Properties. If, when applying the changes in a Properties dialog, an error would occur you will be 
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asked to confirm if the error is allowed. If not, the changes are not applied and you are returned to the 
Properties dialog to amend the change.  

If using On Drop or After Edit and you wish to continue even though the change will result in an 
error, use the Add Error Marker switch to automatically insert an error marker into the design. This 
is a visual reminder of the error so that you can fix it at a later stage.  

Show Design Rule Clearances 

To aid the On-line DRC mechanism, from the Options and Online DRC page, there is also the Show 
Design Rule Clearance option that is used to automatically display the clearance around static items 
during some interactive operations.  

 

Generally, it is used if the operation involves editing a simple single item on an electrical layer. The 
clearance shown is set to the size of the allowed spacing between the static item and the item being 
interactively edited. This clearance shows how close the item can be placed to another without 
violating it. As the dynamic item moves within the allowed clearance gap, the clearance will change 
colour to indicate that the moving items is in error. 

 

When checked, there are three modes of operation available; On All Items, Within Set Distance and 
With Grid Steps. 

With On All Items selected, as you start the interactive operation, all the electrical items that are 
visible on the same layer as the item being edited will have the clearance drawn around them. This 
will be cleared when the operation has finished.  

Within Set Distance set, when the item being edited comes within the entered distance of another 
static item on the same electrical layer, the static item will have its clearance drawn around it to warn 
you that you are getting close. The clearance will disappear as you move away from the static item 
again.  

Within Grid Steps set, when the item being edited comes within the entered number of grid steps of 
another static item on the same electrical layer, the static item will have its clearance drawn around it 
to warn you that you are getting close. The clearance will disappear as you move away from the static 
item again.  

This mode can also be switched on or off from the context menu during some interactive operations. 
On the context menu, this option is shown as Display Clearance. 
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The Clearances colour can be set up in the Colours dialog on the Highlights tab. You should choose 
a contrast colour to make it visible against other design items. 

 

Placing Components interactively 

There are many advanced features within Pulsonix for placing components in the design. However, 
the basic operation of moving components is very straight forward following basic Microsoft 
standards.  

The Component Move mode is activated by using the Move option or by dragging the Component 
(using a pick and drag action). When any Component is placed in the design, from Insert Component 
or out of the Component Bin for example, it remains ‘dynamic’ on the end of the cursor ready for 
placement. 

Individual components or groups of selected components can be moved at any time. Using this 
method, anything else selected by mistake will also be included in the move as part of this transient 
group. 

Overview of Component placement options 

During Component Move you have a number of features available, you can: 

• Rotate and Mirror a Component 

• Optimise connections that are attached to the Component during Move 
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• Show the optimal position of the Component using a ‘Force Vector’ 

• Free dynamic tracks segments attached to the Component to make the placement clearer 

• Push other components out of the way, and Spring other components back to their original 
positions Place or Rotate the Component in its Optimal position 

• Change the Placement Grid of the Component 

As part of the Component interaction, you also have facilities that can be accessed during the 
selection of a Component, these are in addition to the options available during Component Move: 

• Cut, Copy, Paste, Delete and Duplicated the selection 

• Enable the Move mode 

• Optimise nets attached to the selected Component 

• Lock or Unlock the Component 

• Unroute tracks attached to the Component 

• Automatically route nets attached to the Component 

• Edit the Component in the Footprint or Parts library 

• Reload any changed components 

• Move selected components to the Component Bin 

Setting up the options 

Most of the options available during Move can be pre-defined ready for use using the Move tab on 
the Options dialog. You can also access all of these options from the context menu when moving a 
Component. 
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Options available on the context menu 

There are modes of operation that can only be accessed from the context menu.  

Change Angle To> - Select from the list of angles, 90, 180 and 270 degrees. 

Rotate by 90 - This is a manual rotate feature using a 90-degree step. If you wish to use the Rotation 
Step defined in the Options dialog on the Interaction tab, use the shortcut key <Alt-R>. Rotation 
steps are always defined and implemented Anti-clockwise (counter-clockwise). 

Mirror - Mirror will flip the selected Component(s) to the other side of the board. This will mirror all 
the pad positions and any associated text e.g. Component name U1 etc. and silkscreen outlines 
automatically. All pad stacks are automatically mirrored as well, although with SMT devices pads 
will only be defined on the top or bottom electrical layers anyway and will mirror to the opposite side. 

Optimisation Mode (Connections) - When moving items that are on nets, the dynamic items are 
connected to stationary items. Where these connections are not tracks, unrouted connections are 
drawn from the moving items to the static ones. You have the choice of how these unrouted 
connections behave using the Optimise parameter as follows:  

Continuous - The nets attached to the moving items are continuously optimised dynamically on-the-
fly to show the minimum unrouted connections required to connect to the moving item at its current 
position.  

Never - The unrouted connections are not optimised. They stay connected to the same stationary item 
that they were originally connected to.  

On Drop - The unrouted connections are not altered whilst dynamic, but as soon as you release the 
Component into its new position, all nets attached to the moving items are optimised.  

Whilst moving items on nets, you can right click the mouse to use the context menu options Optimal 
Position and Optimal Rotation to take the items to the position pointed to by the force vector.  

Optimal Position 

By selecting this option, the Component selected will move to the position the system calculates as 
the optimal placement. This is the most balanced point in the design relative to its attached connection 
length and the number of connections attached to its pins.  

Optional Rotation - Like the Optimal Position option, the Optimal Rotation option will determine 
the best rotation based on a balanced assessment of the Component, its attached connection lengths 
and number of attached connections. The mirror axis is taken around the Footprint origin.  

Force Vector - The force vector is a visible indicator that shows you how far, and the direction to 
move the dynamic items to their 'optimal' position.  

This position is where the nets attached to the moving items would be balanced to reduce overall 
connection length and avoid very long and very short connections. In other words to place the items 
where they are not too close nor too far from other stationary items on the same nets. If you consider 
the connections from the moving items to the stationary ones as springs, the optimal position is where 
the moving items would come to rest if you 'let go'. 
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The force vector is drawn using the Highlight colour defined in the Colours dialog on the Highlight 
tab. There are two types of indicator available as follows: 

Long Arrow - An arrow is drawn from the centre of the moving items to the optimal position. 

Compass - A circle is drawn centred on the moving items with a small arrow on it pointing towards 
the optimal position. Another filled circle is drawn inside this circle to indicate how far away the 
optimal position is. The filled circle gets smaller as you get closer to the optimal position. 

Optimise Selected Nets - Optimise is completed based on the current selection. 

Free Angle Adjoining Segs - If a routed Component has tracks exiting its pads orthogonally, the Free 
Angle Adjoining Segs option will allow the track end segments to become free angle segments 
loosing their orthogonality. To subsequently restore the free angle segments to 90 degree segments, 
the tracks must be edited and the segments reinstated.  

 

Auto Weld Now - With the Auto Weld option switched off in the Options dialog, you can weld 
items on command. 

Push Mode - Whilst moving components, the option is available to push other components out of the 
way in order to make room for the moving Component. Components that are locked will not be 
pushed, and components will not be pushed outside of the board outline.  

The following parameters govern the Push Aside characteristics:  
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Continuous - Stationary components are continuously pushed out of the way whilst moving 
components.  

Never - No push aside is attempted when this is set to Never. 

On Drop - You can move the components and when dropped, any components in the way will be 
moved aside to make room for the dropped ones. The direction they are pushed is controlled by the 
Push Direction. 

During Push Aside, the Optimum Component to Component spacing defined in the Design Rules 
page on the Technology dialog is used in order to space the components out. The outer boundaries of 
the Component are defined as the maximum extents of any Placement or Silkscreen outlines, and 
Pads/Mounting Holes. 

 

 

Following placement, the Minimum Component to Component space is used by the Design Rule 
Check option to check for overlapping components, again, using the Component boundaries for 
checking. Boundaries are taken to mean the Component Body Area or Component Clearance Area if 
defined in the Footprint. If these haven’t been defined, the option will use the maximum extents of the 
component bounding box as its boundary. Additional rules apply to component body and clearance 
areas when placed alongside each other. 

 

In the diagram above, figure 1 shows Component Move being initiated by the Component at the 
front. At this point, the components still have their original placement position and spacing. 2 shows 
how, during the pushing sequence, each Component ‘butts’ up against the next using the Component 

To Component spacing. 3 As the components are pushed, they now start to move together, adhering 
to the Component spacing rule.  

Push Direction – enables the direction that the stationary components will be pushed to be defined – 
the choice is Horizontal, Vertical or Both. The example below shows how the Component would be 
pushed in the vertical direction if Vertical was selected.  



 Chapter 6 – PCB Design Editor   253 

 

Spring Back – With this switch selected it will enable a Component that has been pushed out of the 
way, to return to its original position once the pushing Component has passed or cleared the position. 
It is only relevant when Component Pushing is enabled. When the Push mode is set to Never, Spring 
Back is disabled regardless of its switch setting.  

From the Change Grid option you can change the grid to use during Component placement when 
using Move, and get to the Grids dialog from where the grids can be changed. Once a Grid has been 
selected, each time you come back to move components they will use that grid.  

 

From this menu, you can switch the Screen Grid on or off. It is quicker to use the default keyboard 
shortcut for Display Grids of <Ctrl-G>. 

Component placement features available on ‘select’ 

These features are available when a Component is selected but not in Move mode or being moved. 

Lock/Unlock 

This provides the ability to fix a Component in place so that it cannot be moved. A lock status will 
also disable other functions being performed on it until unlocked, e.g. Move to Bin etc.  

If you attempt to move a Component that is locked a dialog is displayed. 

 



254   Chapter 6 – PCB Design Editor 

This provides you with the option to perform the option anyway, to cancel or to deselect the 
Component. 

Nets>> Optimise Selected Nets - With any components selected a single Component optimise can be 
performed. The nets attached the selected Component will be reconnected to the nearest node points 
to create the shortest connection length. 

Nets>> Unroute Selected Nets - Any tracks attached to selected components will be unrouted back 
to connections for the complete net, including any changes to layer and vias. Care should be taken 
using this option as the complete net will be removed back to connections, including connections 
spanning any number of components. 

Nets>> Autoroute Selected Nets - when used on a selected components all nets attached to the 
Component will be routed automatically using automatic routing properties. 

Reload From Library will reload the Component instance on the design with one from the library. A 
small dialog is displayed that provides you with a selection of switches to define how to reload the 
Part from the library. This option would also be used if the Edit Part in Library or Edit Footprint 
in Library options have been used. 

Edit Part in Library - The system will look for the Footprint with the same name as the Footprint 
the selected Component uses in the available footprint libraries. These libraries are defined using the 
Library Folders facility. If the Footprint is found it is read from the library and opened for you to 
edit. 

This is just the same as if you used the Library Manager to edit the footprint. The Technology File 
used for the footprint will be the current selected Technology file from the Library Manager PCB 
footprint dialog. 

Edit Footprint in Library - The system will look for the Part with the same name as the Part the 
selected Component uses in the available Parts libraries. These libraries are defined using the Library 
Folders facility. If the Part is found it is read from the library and opened for you to edit. 

This is just the same as if you used the Library Manager to edit the Part. The Technology File used 
for the Part will be the current selected Technology file from the Library Manager Part dialog. 

Move to Bin enables you to send any selected components to the Component Bin. Components that 
are locked will not be sent to the Bin. Components that have tracks attached can be sent to the Bin but 
the tracks are lost, the tracks are returned to connections so the connectivity is not lost (it is unusual to 
send routed components to the Bin unless performing design modifications). In any case, a warning 
dialog is displayed for you to confirm the removal of the tracks before sending them to the Bin. If you 
press OK but mistake, Undo can be used to recover the situation. 

Using the Properties option to move components 

When a Component is selected the Properties option displays information about the components.  
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Fields that are not editable are displayed greyed out. This dialog enables you to change Component 
Names and their position using the co-ordinates displayed. This dialog also enables you to change the 
components Rotation, Mirror and Lock status as well as the Part type, and Footprint. 

Adding Connections 

Connections are used in Pulsonix to indicate the point-to-point connectivity of the netlist. When using 
Pulsonix in 'interactive' design mode and designing PCBs on-the-fly, the ability to add connections or 
tracks directly is essential to create the netlist. This design practice is easy to accommodate using 
some basic modes of operation.  

PCB Safe mode 

However, Pulsonix also features a design setting to allow or not allow the PCB netlist to be modified. 
The PCB in Safe Mode of operation would be used when a ‘master’ Pulsonix Schematic or external 
netlist is being used. This would mean that with the switch checked, no modifications can be made, 
including addition or removal of connections. By default, this switch is set Off (unchecked) so that 
modifications can be made. 

If using the PCB design as the ‘master’ (rather than the Schematic), you should uncheck this switch 
so that PCB modification, like adding connections or Parts, can be made. 

The PCB in Safe Mode switch is located on the Design Settings dialog under the Synchronise tab. 

 

Connection Properties 

Connections or Nets carry a number of properties that give its characteristics. These are: 

• A user defined Net Name or default Net Name 

• A Net Class that itself contains: Track style, Via style, Guard Spacing 

• Attributes (if applied to the Net) 

These properties have been discussed in detail previously in this Chapter under Setting Up A PCB 

Technology. 

Connections can be connected to a number of electrical items: 

• Pads, Free pads and Mounting Holes, Testpoints, Vias 
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• Tracks 

• Copper, Copper Pouring Template areas 

For most of these items the attaching of connections is straightforward and obvious in use. For some 
though they require more explanation: 

Vias – connections can be attached to an existing via. Once routed, the track will then ‘copper share’ 
the existing tracks. 

Tracks – a connection can be added anywhere on a track that means that it will ‘copper share’ the 
existing tracks or nets back to the connection node. Once routed, this connection will act as though it 
has been created as a track but overlaid on an existing track of the same net and following the same 
routing path. This situation may be created to form a ‘T’ route. 

Copper – connections can be attached to copper items so that the copper is attached to a particular 
net. 

Templates – by attaching a net to a Template, when poured the copper will inherit the net name. This 
means that when the shape is poured, it will automatically associate itself with the attached net name. 

There are also ‘Wire’ items in the Pulsonix product, these are not the same as connections. Wires are 

used as ‘jumpers’. These are discussed later on. 

Default Connection values 

When adding a Connection to the design, the default values it uses for Net Class, Name Layer and 
Name Style are defined in the Design Settings dialog under the Default Tab and Nets.  

The Name Layer and Style are used when Show Net Names is enabled. 

Inserting Connections 

���� To add connections using Insert Connection 

1. From the Insert menu, click Insert Connection.  

2. Click on the first pad to start the connection, click on the second ‘target’ pad. A connection will 
be made between the pads. 

3. Move the cursor to the next item and click to make another connection. The insert connection 
mode works in 'daisy' chain from one point to the next until released. 

4. Press <Esc> to end Insert Connection mode. 

During Insert Connection you can also use the context menu that allows additional options: 

 

Type Pin Name allows you to start a connection on a pad or add to the next pad by typing it’s name, 
for example, click to start the connection and then type in IC2.9 in the Type Pin Name box to connect 
to the IC2 pin 9. 
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Change Net allows you to add or change the existing Net Name of the connection. The standard 
Change Net dialog is displayed. This is discussed in the next section, Managing PCB Nets. This 
option is available during the Insert Connection operation. 

Mark Net is used to highlight the complete net so that you can view the complete net path within the 
design. This switch toggles the Mark Net option on and off. This is very useful and is also assigned to 
the shortcut key <H>. 

Show Finish Markers switches on and off the finish markers and is directly linked to the Options 
dialog. 

Once added to the design, if you select the connection and right mouse click, the context menu 
displays a number of options: 

  

The Select option displays a number of Selection and De-selection options as well as Select Next and 
Select Previous. This will allow you to select the next item under the current cursor position, 
likewise, will allow you to select the previous item. This is used when the cursor is above a number of 
connections in a tight area. 

The Edit option opens to the standard Cut, Copy, Paste and Duplicate options. 

You can apply a 'Lock' status to a connection that disables it from being Optimised or Deleted. 

Nets will reveal the options Change Net, Split Net, Mark Net, Optimise Selected Nets, and Route 
Selected. Split Net is discussed in more detail in the section below, Managing PCB Nets. 

Edit Segment - once the connection has been added you can double-click on it or use the Edit 
Segment mode from the context menu to start routing it. 

Remove From Net is used to remove any connections from the selected net. 

Show Net Name this displays the net name on the selected net. The Style of the text used for the net 
name can be changed once displayed by selecting it and pressing the S key for Style. 

Properties displays the characteristics of the Connection, Net and Net Attribute. You can have any 
number of net attributes that can hold characteristics for other purposes, e.g. routing, simulation or 
Guard Spacings for additional spacing clearances on that net. 

Managing PCB Nets 

By default, any connection added to the design will contain a default net name. This name can be 
changed during the addition of the connection or renamed afterwards.  

Setting the default net name suffix 

Pulsonix is installed with pre-defined. Obviously, these settings can be changed if not suitable but 
care should be taken when changing them. You should only change them if you know what you're 
doing. Use the Design Settings and Naming dialog to do this.  
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When you add a new net to the design, it is assigned a default name. This can subsequently be named 
if you so wish, but this part of the dialog is concerned with the format of the default names. The 
default name consists of an optional stem followed by a number (that are allocated sequentially). The 
name stem is specified in the top Name Stem control. The Number Width control specifies the 
minimum width of the number that will be padded to the left with leading zeroes. 
For example, a name stem of 'Net' and a number width of '2' gives net names of the form 'Net01'. You 
can change these values after you have begun designing, but this will result in nets being renamed that 
could be undesirable. 

Using default Net Name properties 

Nets have a number of default properties - Net Name, Net Class and a Connection Width. 

Nets that are not named will automatically be assigned a default Net Class and display width when 
added to the design. As previously described, these values are taken from Options and the Defaults 
dialog. 

Nets that have previously been named in the Technology file will already have a Net Class assigned 
to them, and subsequently will also have a connection thickness. 

Naming Nets & Renaming Nets 

At the addition of connections or the editing of connections you can name them using your own name 
as an alternative to a system default net name. You can press the <F2> shortcut key that will display 
the Change Net Name dialog. This option is also available on the context menu. 

 

From the drop down list you should type the name of the net into Net Name: or select its name from 
the drop down list presented. Using this dialog, the Net Class can also be selected from the drop 
down list. 
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Splitting Nets 

Use the Nets and Split Nets options from the context menu when a net is selected. This allows the 
net to be split in ‘two’, creating two nets from the original one. A dialog presents the options from 
which to choose:  

 

The original net name is displayed at the head of the dialog and the new name displayed in the New 
Net Name box. A default net name is displayed, this will be the next available in the sequence and 
will be unique, you can type in your own net name as required. 

The Remove From Net button is used to remove the split net instead of renaming it. All connections 
and tracks in the split net will be removed and all remaining items in the split net will be removed 
from being on a net. 

You cannot split a net when the removal of the selected PCB connection or Track does not result in 
the net being split into two. For example, when the connections form a loop and one is removed, or 
when the selected item is not on an isolated part (subnet) of it's net. In these two instances, an error 
message will be displayed. 

Use the Rename Other Half button to swap the names of the two nets. The two nets alternate 
between being highlighted. Use this to show where the two nets are, and to choose which net remains 
as the old net name. 

Deleting Nets 

As discussed previously, the Delete option cannot be used to remove nets from the design. You must 
use either Split Net or Remove From Net. 

Select the net and use Remove From Net from the context menu. When a Connection or Track is 
selected, it will be deleted and the items that were at each end of it will be removed from the net only 
if they do not have any other tracks or connections attached. 

Back annotating name changes 

The Back Annotation of design information to the Schematic is covered in more detail later on in this 
Chapter under Back Annotation to the Schematic Design. 
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Optimising Nets 

Optimise will create a connection pattern which represents the shortest distances between 
unconnected subnets in a net. A subnet is a collection of items on the net that are already physically 
connected. You would normally want to route all these connections, so that there are no longer any 
connections in the design.  

There are three Optimise options available from the Tools menu, All Nets, Browse and Selected 
Nets. 

Optimise All Nets is used to perform optimise on all the nets in the design in a single operation.  

Optimise Browse Nets will only perform optimise on the nets you select from a browse dialog. 

Optimise Selected Nets will only perform optimise on the currently selected nets in the design. This 
option is also available on the context menu for a selected Component or for any selected net in the 
design. 

You can use the Optimise Nets option in a Latched Mode, this means that you select the option first, 
and then interactively select design items on nets you wish to Optimise. This continues until you 
deselect the option or select another option. 

Once any nets have been optimised, the overall connection length can be checked by running the 
Connection Length Report from the Reports option on the Output menu. 

Manual Gate and Pin Swapping 

Gate and Pin Swapping are the processes for exchanging (Swapping) Gates and/or Pins of like 
devices either between Parts or between gates and pins of the same device to shorten the connection 
length between them. 

Gates are the internal ‘packages’ within a device that make up the complete Part. For example, a 7400 
is made up internally of 4 identical NAND gates.  

These gates are the same and therefore could be swapped if allowed and defined in the Parts library.  

 

Gate Swaps 

This is used to swap all connections between two equivalent gates. Two gates are equivalent if they 
are in components that have the same Part type and are in the same swap group in the Part data.  

When used, the gate swap is recorded in the Back Annotation data used for updating the 
corresponding Schematic design. 

The Back Annotation data can be viewed using the Back Annotation Report available from the 
Output menu and Reports option.  
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���� To swap Gates 

1. First select the Swap gates option on the Utility menu. 

2. Choose the first gate on the component. 

3. Use the mouse to move the cursor over the component pads in the design. If a pad is part of a 
gate that can be swapped, all pins on that gate are drawn in the select colour whilst the cursor is 
over them. The name of the selected gate is reported on the status bar.  

4. Click on the selected gate that you wish to swap.  

5. After the first gate has been selected, all equivalent gates that can be swapped will have their 
pads drawn in the highlight colour.  

6. Choose the second gate by clicking on the selected pad to choose the second gate for the swap.  

7. As soon as two gates are selected the connections are swapped between the corresponding pads 
on them and the swap is recorded in the design's back annotation data. All gates are then de-
highlighted and deselected ready for the next set of gate swaps.  

Swap Rules 

The following rules restrict the swapping of Component gates:-  

• A gate can only be swapped if all pins have no routes attached.  

• The two gates must be on components of the same part.  

• The two gates must be in the same swap group in the part data. 

If no swaps can be performed because the Part's swap data is not set up, use the Part Editor option to 
add the swap data to the Part in the library. Once completed, use the Reload From Library option to 
update the components in the design. 

The contents of the Parts library and how to create this information is discussed in detail in the 
Chapter on the Library Management Tools. 

Pin Swaps 

This is used to swap all connections between two pins. There are two modes of operation.  

• Normal operation is to only allow the swap of two pins that are equivalent. 
Equivalent pins are on the same gate, within the same Component, and in the same swap group. 
In this mode the swap is recorded in the Back Annotation data used for updating the 
corresponding schematics design. 

The Back Annotation data can be viewed using the Back Annotation Report available on the 
Outputs menu under Reports. 

• The other mode is to allow swap of any pins in the design. 
In this mode the swap is not recorded for back Annotation. This may be useful in some cases, but 
is not recommended as it could lead to synchronisation problems with the Schematic design.  

���� To swap Pins 

1. First select the Swap Pins option on the Utility menu. If Swap Any Pins mode was last used, 
you will asked to confirm to continue in this mode. 

2. Use the context menu Swap Any Pins option if you wish to disable the normal swap mode. You 
must select a pin on a Component before this is available on the context menu. 
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3. Choose the first pin. 
Use the mouse to move the cursor over the Component pads in the design. Note: if a pad can be 
swapped it is drawn in the select colour whilst the cursor is over it. Click on the selected pad that 
you wish to swap.  

4. After the first pad has been selected, all equivalent pads that can be swapped will be drawn in the 
highlight colour. If allowing Swap Any Pins no pins will be highlighted as all pins can be 
swapped.  

5. Choose the second pin. 
Move the cursor over the highlighted pads in the design. Click on the selected pad to choose the 
second pad for the swap.  

6. As soon as two pads are selected the connections are swapped between them and, if the normal 
swap mode, the swap is recorded in the design's back annotation data. All pads are then de-
highlighted and deselected ready for the next set of pin swaps.  

Swap Rules 

The following rules restrict the swapping of a Component pin: 

• A pin can only be swapped if it does not have any routes attached.  

The following rules apply when using the normal swap mode: 

• The two pins must be on the same Component.  

• The two pins must be on the same gate within the part data.  

• The two pins must be in the same swap group in the part data. 

If no swaps can be performed because the part's swap data is not set up, use the Part Editor option to 
add swap data to the part in the library. Use the Reload From Library option to update the 
components in the design.  

The contents of the Parts library and how to create this information is discussed in detail in the 
Chapter on the Library Management Tools. 

Swapping Routed Gates & Pins 

When attempting to swap routed gates and pins you have two options Swap Routed Pins and 
Attributes Must Match. 

The Swap Routed Pins option exists on the context menu when using Swap Gates or Swap Pins. 
Check it to allow selecting of pins that have routes attached. The track segment attached to the pad 
will be unrouted prior to swapping. 

 

The Attributes Must Match option command exists on the context menu when using Swap Gates. 
Check it to only swap gates between components that have the same attributes (this is how version 4.0 
worked), or leave unchecked to ignore attributes. 
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Manually Routing the Design 

Manual routing is the process of adding copper tracks in Pulsonix. This can be done by ‘converting’ 
connections into tracks, or by adding tracks directly into the design.  

Pulsonix allows you to work using one of three fundamental 'modes' when creating a PCB and 
subsequently routing the design (and this excludes the automatic routing process for now). You can 
start a PCB design starting: 

1. With a netlist, from an external source to Pulsonix, or from a Pulsonix Schematic design 
translated into the Pulsonix PCB design editor, the routing would be edited in by converting the 
connections to tracks. 

2. From within the PCB design directly and adding in the connections on-the-fly to create a PCB 
only netlist. From the connection based netlist, the connections would be edited into tracks. This 
would be used in preference to 3) below if a full or mainly complete netlist is required for 
checking before tracking has commenced and differs from 1) in that because the netlist is derived 
on-the-fly it is more prone to errors unless carefully checked. Using the known netlist allows 
system options to do the checking for you, as well as correcting any synchronisation problems 
between the PCB and the master schematic. 

3. By adding in new tracks directly without a netlist. A design created truly ‘on-the-fly’ but no less 
as accurate as with a connection-based netlist (the tracks actually provide an underlying netlist). 

In addition to manual routing methods, you also have the automatic routing option that can be used to 
accelerate this task. The auto router is discussed in the Advanced Features Users Guide supplied as a 
PDF file in this installation. 

Starting to route tracks manually 

To start editing connections (and subsequently convert them to tracks) you can: 

Double-Click on a connection, or; 

Select the connection and right click, select Edit from the menu, or; 

Select Insert Track from the Insert menu. Select the connection or track to add the track to. 
If adding tracks into a PCB design without any previous netlist or connections you can use the Insert 
Track option or double click over a Component pad to start the track. 

       

  Before     After 

The two illustrations above show the how the design looks before manual routing has started, and 
how it looks once a connection is edited. Also shown are the Display Clearances around each object. 

Overview of the basic modes of routing 

The basic commands for editing tracks are:  

Single-Click, once editing, will insert a corner and enable you to change direction. 
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<L> (Change Layer) followed by <Enter> will enable a layer change to the opposite side of the 
design. 

Ctrl-Click will add a via and change layer while routing. 

S (Change Style) followed by <Enter> will enable the style of the track to be changed to the 
alterative track style defined in the Net Class. If this is thinner than the current style, a ‘necked’ track 
will be started. 

Double-Click while editing a track will activate a Route to Finish, the double-click functionality can 
be user defined in Options and Edit Track. It will add a track directly from the last corner inserted to 
the end target pad, it will not add any corners or layer changes. If a layer change is required to finish 
for a surface mounted pad for example, a via will be automatically inserted. 

Shift-Click will always force a corner on the track. This is used when a track is over another item and 
the Finish Here ‘F’ marker is being shown, Shift-Click will insert a corner and not finish until 
required. 

As with most features in Pulsonix, there are multiple ways of entering a mode of operation. This 
section will concentrate on the methods that are the most productive for use. 

Setting up the options 

Most of the options available during manual routing can be pre-defined ready for use using the Edit 
Track tab on the Options dialog. You can also access all of these options from the context menu 
when routing. 
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Track Segment Modes  

This defines the default restrictions on the orientation of segments when creating or editing a track. 
You can change the Segment Mode at any time whilst creating or editing a shape by using the 
Change Segments option on the Edit Track context menu.  

Free Angled 

 

Any-angle segments can be used when editing a track with no restrictions to the segment orientation, 
this creates a free angle track segment.  

Orthogonal 

 

Only 90 degree segments are inserted using two trailing segments to create the angle using alternate 
vertical and horizontal segments.  

Orthogonal (Mitre) 

 

Alternate shape segments are vertical and horizontal lines with the corner being a 45 degree mitre.  

Orthogonal (Fillet) 

 

Alternate shape segments are vertical and horizontal lines with the corner being curved.  

45 Angled 

 



266   Chapter 6 – PCB Design Editor 

Alternate shape segments are orthogonal and 45 degree lines. A 45 degree angle is inserted when a 
corner is added. When the mouse is being moved horizontally and vertically, 90 degree tracks are 
added.  

45 Angled (Fillet) 

 

Alternate shape segments are orthogonal and at 45 degrees with the corner filleted.  

Curved 

 

Alternate shape segments are orthogonal and 90 degree curve. Like the 45 degree mode, where 
corners are required a curved corner is added.  

Pull Tight 

 

Pull Tight is a special mode which will produce a minimal orthogonal and 45 degree pattern. This 
mode will automatically add corners to wrap or ‘hug’ around obstacles using the shortest distance 
possible, pulling tight all the time. In this mode you can automatically remove any corners that have 
been added by re-tracing the cursor back over the track.  

 

Restricted Movement 
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Restricted Movement is a special mode which will restrict the movement of the current segment by 
snapping its angle to 45 or 90 degrees in whichever direction you are predominantly moving the 
cursor. Clicking the mouse adds a corner. 

Segment Mode on Context Menu 

Alternatively the segment type may be selected on the context menu using Segment Mode and 
selecting the mode type to be used. 

 

Orthogonal Mitre (Auto Mitre) and Curved Mitre 

During track editing, the completion of an individual segment within the overall track is determined 
by a single click, normally followed by a change in track direction. With Orthogonal Mitre (Auto 
Corner) set, a change in direction with the cursor will indicate that a corner or angle should be 
automatically inserted. 

With orthogonal routing it may be desirable to mitre the 90 degree angles and with Auto Mitre set a 
mitre is automatically inserted at each 90 degree intersection. 

If this option is checked, this defines the size and shape of mitres that are added when the Segment 
Mode is Orthogonal. Mitres differ from the Angled (45) and Curved (90) Segment Modes because 
the mitres are of a fixed size that is specified in the Size edit box. The Size is the orthogonal width 
and height of the mitre not the distance across the mitre segment. The mitres can be a 45 degree 
straight line (Mitre) or 90 degree curve (Fillet). 

Mitre 

  

Mitre gives fixed size 45 degree angled segments.  
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Fillet 

 

Fillet gives fixed size 90 degree curved segments. 

Auto Corner 

This is an advanced editing feature that allows tracks to be drawn without having to click the mouse 
at each corner. (Note, this feature does not operate in Free segment mode). 

You must define a Tolerance, this is the distance the cursor must move away in a perpendicular 
direction from the first segment you are adding before a corner is added. You can still click at any 
time to add a corner. It is recommended that the Tolerance is larger than any grid and mitre size you 
are using.  

 

In the example above, the cursor is at the bottom of the second selected segment (shown as a lighter 
colour). As you move right the first selected segment gets longer. When you move down so that the 
second selected segment is longer than the auto corner tolerance, a corner is added and the first 
selected segment is complete. 

Apply Segment Mode To Tail 

When checked from the Options dialog or selected from the context menu under Editing Options> 
Apply Segment Mode To Tail, this mode applies the same segment mode to the lead and trailing 
segments when editing an existing track segment. 

 

No Seg Mode To Tail   Apply Seg Mode To Tail 

 

Trailing segment is at a free angle. Segment mode is applied to the trailing track segment. 
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Show Finish Markers 

These take the form of Modal Cursors or, if Modal Cursors not enabled through the Options dialog 
and General tab, then dynamic markers are drawn in the highlight colour. They appear at the cursor 
position to indicate that clicking would do something different from just the normal add corner. The 
following 3 Markers exist: Can Finish Here, Can Finish On Via and Remove Loop 

Can Finish Here 

  

This will display the ‘F’ finish marker when nearing the terminal node on a single track route. As you 
get close to an electrical connection point for the track you will see an F appear on the cursor, this is 
the finish marker. As soon as the F appears on the cursor then a single left click on the mouse will 
command the system to finish the final connection and attach it to the item underneath the cursor.  

Can Finish On Via 

 

Control Click whilst this marker is shown will result in the track being finished on a via through to 
the item underneath the cursor. 

Remove (Track) Loops 

 

This is used to allow loop removal when tracks are finished. This is the normal mode, but 
occasionally you may want to create loops in tracks. If this mode is not checked, the loop removal 
marker is not used. Loops will only be removed within the track path, not anywhere on the net. Loops 
may be required on specific nets such as power or ground, or on nets that are required to create 
‘rings’. Left click whilst this marker is shown will result in a loop in the track being removed from the 
track. 

Auto Share Tracks 

This is used to automatically remove overlaid tracks after finishing editing or moving a track. A 
junction will be created where the overlaid tracks end. If this option is not checked, any overlaid 
tracks will remain overlaid. You can use the Share Tracks option to remove all overlaid tracks in the 
design at a later stage. 

Allow Nets to be Joined  

Allow Nets to be Joined will give you the ability to join nets with different net names. With this mode 
switched off, you will not be allowed to join any different nets together. The overriding switch on this 
is the Can Alter PCB Netlist switch on the Design Settings dialog under the General tab. If this 
switch is uncheck to not allow changes then the Allow Join Nets switch is inoperative. 
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Always Mark Net Being Edited 

Use this to show the net currently being edited in the Marked Net highlight colour. 

Show Connection to Nearest Node 

Use this when adding tracks to show a line (connection) between the moving cursor and the nearest 
item that you can finish on the same net. With the option selected, the connection is shown to the 
nearest node. This may not necessarily be the original target pad but will be the closest node to make 
a legal track end. This will also allow you to connect to track segments, copper items, vias or 
testpoints. 

When editing a connection you get two lines from the cursor, one to the nearest node and one to the 
original connection end. 

 

Double Click Completes Track 

Check this so that when adding a track, double click attempts to finish the track to the end of the 
attached connection. It will use the current segment mode to complete the track. If On-line DRC is 
enabled in Continuous mode and there is an obstacle in the way of the attempted finish path, a more 
intelligent routing algorithm will be used to try to complete the track. Uncheck it to let double-click 
finish the track in space. 

Setting up Default Values 

There are default track settings for Tracks in Design Settings dialog on the Defaults tab.  

Layer 1 and Layer 2 define the swap layer pair used during routing. When routing you can swap 
between these layers when using Change Layer. 

Track Style is used to define the style used when adding a track directly into the design without using 
a connection. In this mode, the track will also pick up the default Net characteristics also defined on 
this tab. The actual track thicknesses are set up in the Technology dialog under Track Styles. 

Options available on the context menu 

There are modes of operation that can only be accessed from the context menu during Insert Track. 
These are discussed below, where functionality is common this will have already been discussed 
above. 
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Cancel Add Track - This exits you from this option completely without saving the routing. 

Finish Here - Finish Here will finish the editing of the track from the current mouse position and will 
leave a 'flying' connection back to the end pad. 

Complete as Track - At any stage during insert track mode you may command the system to 
complete the single track route automatically. In Insert Track mode use the context menu and click 
Complete As Track. The system will attempt to finish the route. This function does not use the 
standard autorouter and should not be seen as a replacement for this, a more sophisticated product.  

Changing Layers  

To change layer, in insert track mode use the Shortcut Key <L> or the Change Layer option. 

 

The required layer may be selected from New Layer. If track segments are already placed, then in 
switching to a new layer a via will be inserted at the default size. A quick way to use this option is to 
set up the swap layer pair in the Options dialog and Defaults. When the Change Layer option is 
selected, you will automatically be presented with the alternative swap pair layer. By pressing 
<Enter> you will automatically insert a via and swap layers. This means you can swap layers very 
quickly by pressing <L> <Enter> without looking at the dialog.  

Another useful shortcut is Ctrl-click will add a via and change layers while routing. This will switch 
tracks to the bottom of the board and hence this shortcut is not suitable in a multi-layer design where 
in inner layer is to be selected. 

Changing Track Styles (or Track Widths) 

To change track styles during Edit Track mode, right click the mouse and select Change Styles or 
use the Shortcut Key <S>.  
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A New Style may then be selected from those predefined in the Technology dialog. In the Width box 
a size may be inserted that is not currently defined in the Technology file. A new style name will be 
offered and this new style will be included in the Technology. You can also type in the name of the 
new style. 

A quick method of ‘necking’ a track (the process of changing the track from a fat width to a thin 
width, or vice versa) can also be obtained using this dialog. 

By default the New Style offered will be the alternative style defined for the track in the Net Class 
dialog. This is defined in the Technology dialog under Net Classes. 

If using a thicker width, and by default the style used will be the Nominal style (Nom. Track) defined, 
you can instantly get to the thinner style (Min. Track) by pressing S followed directly by <Enter>.  
So as with changing Layers, you can select the alternative Style by pressing <S> <Enter> without 
looking at the dialog. 

Change Net 

This is used to change the net of the net being edited. This has been described in more detail 
previously in this Chapter under Managing PCB Nets. 

As a shortcut, it is quicker to use the default shortcut key of <F2> to get to the Change Net dialog.  

Mark Net 

Mark net is used to highlight the current selected net using the Highlight colour. A predefined 
shortcut key <H>, enables you to toggle the highlight on or off quickly. 

Change Default Via Style 

This allows you to change the default via style set in the Net Class setting for this Net Class name. If 
a name is typed in and is not in the existing Styles dialog for vias, you are prompted to add it in or 
keep the style local. 

End Track On 

The system may be commanded to end the track on a Via or a Testpoint Via. In track insert mode r/h 
mouse menu and select End Track On. A menu opens with the following options: 

Via - This will add the net class default via style to the end of the track.  

Testpoint - This will add a testpoint to the end of the track segment 

None - No via or testpoint is inserted on the end of the track segment 

Editing Options 

These are the track editing options (Auto Corner, Auto Mitre etc.) already discussed above. 

Change Segment options, Next, Previous etc. 

Segment Mode options (Free, Angled, Orthogonal etc.) have been discussed above. 
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Edit Segment 

When editing track segments, these modes give the opportunity to 'back-track' to predefined locations 
along the current track segment without exiting the edit and starting at the location required on the 
same track.  

First - The first segment of the track, default shortcut key Home. 

Previous - The previous segment to the one being currently edited, default shortcut key Num sub (-) 
[keypad -]. 

Next - If you have moved from the end segment, Next takes you forward one segment, default 
shortcut key Num plus (+) [keypad +]. 

End - This takes you to the end track segment, default shortcut key End. 

Flip Dynamic 

Use it to swap the type of the dynamic segments you are currently editing e.g. from Orthogonal XY 
to Orthogonal YX. Note: this is not available when the segment mode is Free as this is single 
segment editing.  

Before Flip Dynamic Segments 

 

After Flip Dynamic Segments 

 

Adding orthogonal X segment followed by 
orthogonal Y segment. 

Now adding orthogonal Y segment 
followed by orthogonal X segment. 

Flip works for each segment mode as follows: 

Orthogonal 
Before: X Line followed by Y line. 
After:   Y Line followed by X line.  

Angled 
Before: Orthogonal line followed by 45 degree line. 
After:  45 degree line followed by orthogonal line.  

Curved 
Before: Orthogonal line followed by 90 degree curve. 
After:  90 degree curve followed by orthogonal line.  

Free - Not applicable.  

And vice-versa.  

Delete Segment this will delete the current segment back to the previous corner, shortcut key 
Backspace. 

Online DRC (On-line Design Rule Checking) 

Online DRC will constantly monitor the spacing limitations as set in the Technology data during 
manual track insertion or track edit, and will prevent spacing error violations being introduced.  

To set the Online DRC, in insert track mode right click and select Online DRC from the menu. 
Online DRC will operate either Continuously, meaning as the track is moved close to the 
unconnected item the system will prevent tracks from being placed, or On Drop, meaning the Online 
Design Rule Checking is only invoked as the track is finally connected. 
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To switch between Continuous and On Drop, select Options from the Tools menu and the Online 
DRC tab. Here you may select Continuous and/or On Drop. 

 

Pulsonix has the facility to Display Clearances around items during track edit mode or full Online 
Design Rule Checking to prevent design spacing errors being introduced.  

To set Display Clearances, in insert track mode right click and select Display Clearances from the 
menu. During track insertion as you move close to an unconnected item a warning colour will appear 
around the item: 

 

The orange outline (shown as the lighter ring around the pad) indicates the track is at the boundary 
point for placement of unconnected items. 

If the track continues to be placed closer to the item then the colour will change to red (shown as the 
darker ring around the pad): 

  

This clearly indicates that the track is too close to the item and the spacing limitations as defined in 
the Technology have been violated, (fortunately, with the use of bright colours on-screen, this is 
clearer). 

Display Clearances 

The Display Clearances parameters may be modified by selecting Options from the Tools menu, 
and select Online DRC. With Show Design Rule Clearance checked the parameter On All Items 
may be checked. This will show a continuous boundary around items in the design indicating the 
nearest that a track may be placed without causing a design rules error. 

Display Clearances 
shown here 

This pad highlight as in error 
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Within Set Distance is the minimum distance in units from the item before the warning boundary 
colour comes on. Alternatively, Within Grid Steps will cause the boundary colour to come based on 
the number of Grid steps around the item. 

The default colour for nearest point is orange and violation of spacing rules in red. These colours may 
also be modified by going to the Setup menu and Colours. Under the Highlights tab are shown the 
colours for Clearances and Online DRC.  

Push Mode 

Track pushing is available on this menu. The settings for pushing are defined in the Options dialog 
and Edit Track page. 

 

Change Grids 

The track grid may be defined by selecting Grids from the Setup menu. Select Tracks from the drop 
down list, here the track grid size may be determined. During insert track mode, the track will snap to 
a grid point defined by this Track grid, or to Gridless or Working Grid if switched.  

Changing to Gridless 

At any point in the track insertion process you may switch to gridless routing by right mouse clicking 
and selecting Change Grid from the menu. You then have the choice to switch to Gridless, Working 
Grid, or back to the predefined Track grid. 

 

Options available by selecting a track segment 

These features are available when a track segment is selected (selected and not being moved or 
edited).  
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The picture below shows the full context menu broken into two halves. 

  

The Select option displays a number of Selection and De-selection options as well as Select Next and 
Select Previous. This will allow you to select the next item under the current cursor position, 
likewise, will allow you to select the Previous item. This is used when the cursor is above a number 
of connections in a tight area. 

The Edit option opens to the standard Cut, Copy, Paste and Duplicate options. 

Move will put you into Move mode. The segment can be moved until the mouse button is clicked, 
this will release the segment in its new position. 

Lock/Unlock 

This provides the ability to fix a track segment in place so that it cannot be moved. A lock status will 
also disable other functions being performed on it until Unlocked, e.g. Move, Edit, Auto Routing, 
Optimise or Deleted etc.  

Net>> will reveal the options Change Net, Split Net, Mark Net, Optimise Selected Nets, Unroute 
Selected Nets and Route Selected. Split Net is discussed in more detail in the section below, 
Managing PCB Nets. 

Edit Segment - once the track has been added you can double-click on it or use the Edit Segment 
mode to route it. 

Arc>> there are several modes where the selected segment can be edit to create an arc. There are 
predefined options and options to allow the Radius or Diameter to be entered. 

Remove From Net is used to remove any connections from the selected net. 

Show Net Name this displays the net name on the selected net. The Style of the text used for the net 
name can be changed once displayed by selecting it and pressing the S key for Style. 

Optimise Selected Nets will optimise the selected net only as a ‘one-off’ operation. 

Unroute Selected Nets will unroute the selected net back to a connection. 

Route Selected will automatically route the selected net. This option is only available if the Auto 
Route option is installed. 
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Unroute Track Segments 

This will only unroute the current selected track segments. This option is a way of controlling the 
amount of unrouting or the selection of unrouting to be done. 

Unroute Track Path 

This will only unroute the current selected track path. Again, this option is a way of controlling the 
amount of unrouting or the selection of unrouting to be done.  

Properties displays the characteristics of the Track, Net and Net Attribute. You can have any number 
of net attributes that can hold characteristics for other purposes, e.g. routing, simulation or Guard 
Spacings for additional spacing clearances on that net. 

Options available by Editing a track segment 

There are some options only available during the Editing of existing tracks. 

Disconnect End Track this option will enable you to remove the track from one electrical item and 
connect it to another. If this is the only connection point to that item, the item will become isolate 
from the net.  

Reverse Editing Direction this is used to swap the direction of the segment you are currently editing 
from the shape.  

Before Reverse Direction   After Reverse Direction 

 
 

Editing from the square pad to the round pad. Now editing from the opposite direction 

Miscellaneous items associated with editing tracks 

When a item shows a butterfly connection marker this is an indicator that that item can only be 
connected to a power plane (that uses the same net name) using a via. 

 

Typically a surface mounted pad, as shown above, will contain these markers if a connection to the 
power plane is required. These would normally be routed using ‘stub’ routes. 

Adding Stub Routes 

Stub routes are small track segments that stem out of a surface mounted pad, although they can 
emanate from any electrical item Generally, they are used to connect to a power plane layer but can 
also be used on dense designs where a short track is required to exit the surface mount pad to make 
more space for other tracks and vias.  
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The image above illustrates how short track segments are extended from the surface mount pads and 
connect directly to a via that in-turn connects to the power plane (assuming that the net name and 
power plane net name are the same). 

���� To add stub routes for connection to a power plane 

If you have lots of stub routes to do then change the default setting of the Track Editing Double 
Click Operation option under the Options dialog, Edit Track. You can make the default double 
click setting to be Finish On Via. 

 

1. Edit the connection from the surface mount pad that you wish to create into a stub route. You can 
also insert a track from the pad to start, if using this method.  

2. Drag the mouse out of the pad to draw a small track segment, click once to confirm the segment 
or add a corner. 

 

3. Double-click the mouse to add a via. 

 

4. You are exited from this option and the stub with via is added. 
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���� To add stub routes to connect to other layers 

1. Edit the connection from the surface mount pad that you wish to create into a stub route. You 
can also Insert a track from the pad to start, if using this method. 

2. Drag the mouse out of the pad to draw a small track segment, click once to confirm the segment 
or add a corner. 

3. Right click and select Change Layer, or click <L> to Change Layer. 

4. Select the required layer and click OK or <Enter> to accept the default layer change, this layer 
will be your default swap layer. 

5. You can now continue routing on the new layer. 

Adding additional vias to tracks 

Once the track has been added you can add additional vias to it without changing the layer for the 
track segment. This could be used if a power track also requires multiple entry points, using vias, to a 
power plane even though it is routed fully. This method can also be used for copper areas or suchlike 
but will be discussed in context in the section on Inserting Copper. 

���� To add additional vias to tracks 

1. From the Insert menu select Insert Via. This will present you with a free standing via that can 
be placed on the track. 

2. The Via can be positioned anywhere until released. Once released it is truly connected to the 
track and will move if the track is moved. 

 

Changing via sizes and via spans 

Once a via has been added to the design its style or layer span can be changed to something other than 
that that is specified in the Net Class. 

Both the style and layer span of the via can be changed using through the Properties dialog.  

���� To change the via style and layer span 

1. Select the via or any number of vias. 

2. Select Properties from the context menu, alternatively select the via and press <I> (for 
Properties) and choose the Via tab. 
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The Layer Span list box is used to choose between all of the suitable layer spans defined in the 
Technology dialog. A layer span is available in the list if it includes the connected span of the 
selected via.  

Allow Automatic Changes - Normally, just as vias are automatically added by layer changes, they 
can be deleted by swapping layers of attached tracks back so that they are no longer required. You 
can stop this deletion from happening by unchecking the Delete If Not Routed switch. This will lock 
the via from automatic deletion.  

Similarly, if you have multiple layer spans defined in your technology, vias will have their layer span 
automatically reduced if possible to the 'best fit' span. This again will happen with a track layer 
change. To stop this from happening uncheck the Reduce Layer Span switch. 

When enabled, Allow Suppress Lands will allow a land to be suppressed when appropriate (i.e. a 
Suppress Land Rule has been defined and this via is not connected on that layer). Uncheck this 
option to not allow any land suppression on this via. 

The Via Style is used if you want to change pad style of the Via. You can change it to another 
predefined Pad Style by selecting one from the Name drop down list. 

You can alternatively change it to a new Pad Style by defining alternative parameters. This can be 
done by changing the Width and or Length, or the Drill size, or by changing the Shape drop down 
list. If there is no Pad Style to match these parameters then a new Pad Style will be added with the 
name that you want to call it.  
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Track Breakouts (Fanouts) 

Breakouts (fanouts as they also called) are used to create predefined or potential track patterns for use 
where the pads are restricted on a Footprint. Typically these patterns would be used where routing is 
very dense on a surface mounted device, and where ‘human’ intervention is the most sensible option. 
The breakout patterns are more suited to designs where automatic routing will take place. They often 
give the router more solutions to what may appear a ‘fixed’ option. For instance on a surface mounted 
QFP where all the pads are on one side of the design, by using breakouts and breakout vias, the pins 
then become accessible to all layers if the vias are defined as <Through-Hole>. 

 

Breakouts can be used on SMD and through-hole pads. 

In Pulsonix, breakouts are generated and stored in the Footprint definition. This means that the 
definition always knows about the breakout and can apply or reapply the original breakout pattern at 
any time. 

The process of using breakouts 

The ‘flow’ for using breakouts is as follows: 

• Create the breakout pattern in the footprint using the Footprint editor and save it. 

• In the PCB design the breakout guide will be displayed. 

• Either edit a track/connection to the breakout that will be a legal finishing point and will be 
shown as node point on the net. The breakout automatically gets converted to a track, or; 

• Select the breakout or Component and from the context menu select Hide Breakout or Convert 
Breakout To Track. 

Breakouts in the Design 

Once a Footprint is used in a design, the breakout is a self-contained item, at this point it is not a track 
or via but a ‘guide’ to the final track pattern when connected.  

For breakouts to work the pads to which they are attached must be on a net. If a single (or multiple) 
breakout is required on an unconnected pad then the pad must have a net name. A single pin net name 
can be assigned in the Schematic design so that the Synchronise Designs option doesn’t rip out any 
single pin net in the PCB. 

To differentiate breakouts from ‘normal’ vias or tracks they have their own colour slots in the 
Colours dialog. Under the Vias tab you have Breakout (vias) as a Layer Span, and under the Track 
tab, you have Comp Breakouts. By default in the supplied Technology files these items have their 
own colours so they are visible when tracks and vias are used in a design. 

To use breakouts that exist on Footprints you have a number of options, all available on the context 
menu for selected Footprint entities: on a selected Component(s), on individual pads on a Component 
that have breakouts and on the whole design (but the design must have breakouts on at least one 
Component): Hide Breakouts, Show Breakouts, Convert Breakouts To Tracks. .  
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Hide and Show Breakout will allow the breakout to be hidden or shown on a Component. If the 
breakout has already been converted to a track it can still be shown even though it may be redundant. 

 

The example above shows a track that has been connected to a breakout. The breakout has been 
converted to a track and the breakout via removed. Automatically the breakout is switched to 
‘hidden’. If you need to see the breakout pattern, for confirmation purposes of its original direction 
for example, you can then select the pad and from the context menu select Show Breakout. 

 

The example above shows one side of the IC routed to the pads without using the breakouts. One pad 
has no connection and still shows the breakout. 

 

The example above shows the whole Component with the breakouts hidden. Connections can still be 
seen to the Component, as these must still be routed. 

If converted to a track or if the breakout is left unrouted, you can select Remove Redundant 
Breakout Tracks to remove them.  

If a track is completely unrouted thus also removing the breakout path, the breakout can be 
‘regenerated’ by right clicking on the pad and selecting Show Breakouts. 

While editing a connection that is attached to a pad with a visible breakout, if a breakout is at the end 
of the connection you have picked, an initial track will be created from the breakout. 

If a breakout is at the other end of the connection, the connection will be re-drawn to end at the end of 
the breakout. Using Complete As Track option in this situation will use the breakout path for its 
completed track. 
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Also, double click in select mode on a visible breakout in a PCB design will add a new track that uses 
the breakout path from the selected point back to its pad. You will then be in Insert Track mode to 
complete the track. 

Plotting breakouts 

You cannot output breakouts directly through the CAM Plot option, they must be converted to tracks 
and vias first. Remember, Breakouts are transient objects in the design to highlight possible track 
paths when applied. 

Create Breakout Pattern (BGA Fanout) in PCB 

Within the PCB design, there is also a command available in the Tools menu called Create Breakout 
Pattern. This is used to create breakout (fanout) patterns within the design without the need to create 
a Breakout pattern in the footprint first. To use the option, select a component or a pad on the 
component and use the Create Breakout Pattern option on the context menu. A dialog is displayed 
from which to choose the pattern required: 

 

The dialog will only create a pattern for components that have at least one pad that is on a net and 
does not already have a routed connection. Applying a pattern will not delete or edit any existing 
tracks that are attached to pads on the component (no changes will be made to these pads). 

When applying a pattern, a DRC check will be performed. Selecting No will remove the inserted 
pattern. You cannot use this option if the selected component in your PCB design already has 
breakouts. 

Using the AutoDim option 

The Dim Other Layers option is only relevant to layered designs in PCB, and as a consequence of 
using Fast Redraw, making it feasible to draw the layers other than the current layer in dimmed 
colours. This makes it much easier to see obstacles on the current layer, but at the same time, not 
losing sight of items on other layers. Selecting the All Dim in One Colour option means all the other 
layers dimmed are one colour and not their layer-dimmed colours. 

To switch this option on, select the Dim Other Layers check box from the Options dialog and 
Display tab. You must also have switched on, Fast Redraw and Draw Current Layer On Top so 
that Dim Other Layers is available. 
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Unrouting Tracks 

You may sometimes have a requirement to unroute part or all of the design. Unrouting is the process 
of removing tracks back to their connection or net paths. Pulsonix contains a number of options that 
allow varying levels of unroute to be accomplished:  

The Unroute Nets option is available through the Tools menu. The three options available control the 
amount of unrouting allowed. 

All Nets is used to unroute all nets in the design regardless of any nets already selected. 

Browse displays the browse dialog for a net selection. Individual nets can be selected by using the 
pick and Ctrl-Shift pick methods. 

Selected Nets will enable you to choose the tracks to be unrouted from the design. You can choose 
single or multiple tracks or individual track segments. 

The Delete key from the keyboard can also be used to unroute tracks but is not recommended. 

The Unroute Track Segment and Unroute Track Path options are also available from the context 
menu when a net is selected. 

Using Shapes and Cutouts 

Shapes 

Shapes are used in Pulsonix for a number of design items. For ease of use and clarity, the shape types 
have been separated into their own options. This makes the selection for the tool and the 
characteristics of the shape easier to understand when adding to the design.  

Shape Types 

You can add shapes for: 

• Board  

• Copper 

• Documentation (shapes) 

• Areas 

• Copper Pouring (Templates) 

Shape Properties 

For each of the shapes there are properties that give it its characteristics. All shapes can be Open or 
Closed and Filled or Unfilled (unless shown otherwise below) in addition to unique properties: 
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Board – Used on <Through Board> layers (or specific layers or layer spans if you have the Advanced 
Technology option), cannot be an Open shape, Filled or Hatched. 

Copper – Used on electrical layers, can be Hatched and can have a Net Name. 

Shape – Used on non-electrical layers, can be Hatched. 

Area – Used on any electrical layer and layers of <Through Board>, <Top Side> & <Bottom Side>, 
(or specific layers or layer spans if you have the Advanced Technology option), cannot be an Open 
shape, can be Hatched, also has Keep In/Keep Out characteristics for Copper, Tracks, Vias, Micro-
vias, Testpoints and components.  

Template – Used on electrical layers, cannot be an Open shape, can be Hatched, can have a Net 
Name, used for pouring copper into. 

Splines, Ellipse, Waves – used for creating special shapes. 

All shapes (except Open shapes) can also have a cutouts inserted into them. Cutouts are discussed in 
more detail later on in this section. 

The Shapes Available 

There are different types of shapes available and others can be made from these: 

• Polygon 

• Rectangle and Square 

• Circle 

• Triangle 

• (Straight) Line 

• Spline 

• Ellipse 

• Wave 

Each shape is access from the Insert menu under their respective shape types. The example dialog 
below shows the Insert Copper shape sub-menu but not all Insert Shape dialogs are the same format: 

 

From these three shape types you can create any shape required in the design, including straight lines 
using Insert Line or an Open Polygon shape. Each of the different types of Shapes is also available as 
shortcut commands and as buttons for the toolbar. A basic shape toolbar containing a selection of the 
most used tools is supplied by default although this can be modified to suite your requirements. 

Shape Styles 

Shape styles are defined on the Design Settings dialog under Defaults.  
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For each shape type (Area, Board, Copper, Doc Shape and Template) its default status as added to the 
design can be determined using the shape selection. The dialog above shows the Copper defaults. 
Copper is the most complete shape in terms of what can be predefined with the other shapes using 
some of these choices under their own default. 

Each shapes default Layer can be defined. For each of the shape types the layers allowed will be 
relative to the type of shape being added, e.g. Board can only be added to <Through Board> layers, 
Doc Shape only added to Documentation layers etc. 

When the shape is added, the default Style of the shape added can be selected using Line Style. This 
can be changed during or after the shape is added. 

Some shapes can be an Open shape. This means that the Closed button would not be checked. If the 
shape cannot be Open, the Closed button will be greyed out and checked.  

 

The example above shows an Open shape where the start and end point don’t coincide. 

Note: Having a start and end position coincident isn’t enough to make this a closed shape. The shape 

must also have a ‘Closed’ status as well. 

If the shape was Closed it would look like this where the outline would be one continuous shape: 

 

If a shape is defined as Closed, it can also be Filled and Hatched, but it cannot be Open and 
Filled/Hatched. Likewise, a shape cannot be Unfilled and Hatched.  

 

A Filled shape could also have any number of cutouts added to it. Cutouts are discussed further on in 
this section. 

Solid or Hatched Filling might be used give a shape more emphasis or in the case of Copper for 
specific electrical purposes.  

Shape doesn’t ‘finish’ and 
doesn’t have a Closed status 
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The style of the Hatching can be defined using styles setup in the Technology dialog under Hatch 
Style. The style can be Hatched or Cross Hatched. 

Inserting Shapes 

���� To insert a shape 

1. On the Insert menu, select Insert Shape then select the shape as required. The shape may then 
be created in the design.  

2. For a Rectangle or Circle drag the mouse to create the required size. For a Polygon, single click 
to start, single click at each corner point required and double click to finish. 

3. If Inserting a Rectangle but a Square is required, right click and select Square. 

 

4. During Insert Rectangle and Circle, you can use the Define From Centre option on the context 
menu to drag the shape from the centre rather than the edge. 

5. During Insert Triangle you can create a triangle in a number of modes; Free Movement allows 
uneven lengths of sides, the Equilateral Triangle mode allows all sides to be equalised. After 
the first corner has been added, the context menu displays the following options: 
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6. Using this mode you can create a proper triangle without calculating the angles and side lengths 
to make the correctly formed triangle. After the first side has been added, Orthogonal mode 
snaps the moving segment side to a 90 degree triangle or to the centre to create two other equal 
sides of the triangle with a 45 degree angle. With the triangle corner dynamic, a right click will 
enable the triangle to be snapped into the Equilateral Triangle mode to fix this corner.  

7. At any time you can right click and select an option from the menu. Each of these is discussed 
below. 

Shapes and the Technology dialog 

The Technology dialog is used to initially create the styles used for the shapes and their defaults. 

Layers, the Layer Class and Layer Type determine which layer the shape will be used on, 
depending on the layer type is selected: Construction, Electrical, Documentation and Non-Electrical. 
Only particular shape types will be allowed on these layers when added to the design. 

Line Styles defines the overall outline width of the shape and the thickness of the hatch lines when 
used in Hatch styles. The Line Style entry contains a single thickness value in the current design units 
and a style name for the line. 

You can also make line styles dotted and dashed and various combinations as well as solid. This 
applies to doc shapes and unconnected copper. There are various dot and dash line styles available - 
dotted, dashed, dot/dash, and user defined dot/dash spacing. Each of the standard line styles is 
available from a drop down list.  
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The diagram below shows how the entries in the dialog relate to the actual dashes and gaps produced 
in the design. 

 

Hatch Styles will define the Hatch style and whether it is Hatched or Cross-Hatched. The line style 
used to create Hatch or Cross-Hatch will be the line style used to define the shape outline. 

 

The entry defines the Name of the Hatch Style, the Hatch Angle in degrees, the Coverage % 
meaning the percentage of copper that will be in the copper filled area using this style, and whether 
the style is Hatch or Cross Hatched. 

Note: By defining the Coverage % and Width %, this will enable you to more accurately determine 

how much copper is left on the finished board after etching. 

Shape Selection and Move 

Individual shape segments can be selected simply by selecting them. If you wish to select the whole 
shape however, you must select the shape while pressing the Shift key. This will then select the 
complete shape ready for moving or editing.  

If you wish to Move the complete shape, you should select the shape while holding the Shift key. The 
shape will now be dynamic on the end of the cursor ready for positioning. 

Modifying Shapes 

After inserting a shape it may be edited simply by clicking on the segment. If the shape is a rectangle 
or polygon, you can drag the segment to the new position. If the shape is a circle, then you cannot 
drag the shape to edit it, dragging a circle will only move it. Instead, double-click the circle outline 
and drag it to change its shape. 

���� To add an arc to a segment 

1. To add an arc into a straight line segment, select the segment and right click. From the context 
menu select the Arc option. 

 

2. From the menu, select the option required to create the arc. 
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���� To edit the end of a straight line segment 

1. If you wish to edit the end of a straight line segment to increase its length or add additional 
corners for example, you can still double-click on the line but must select its end point.  

 

2. If you select the end point this will be indicated with a small circle. From this you can move the 
end segment by dragging it. 

 

While editing the segment you can use options available from the context menu. 

Changing the Style of the shape 

At any time during the addition of the shape or after it has been added, the style used can be changed. 
This means that the Line Style, Closed/Open status, Filled/Unfilled style and its Hatch/Cross-Hatch 
style can be changed. In addition to these styles, the shapes Rotation, Mirror status Lock status and 
Layer can all be changed.  

Rotation is carried out about the shapes Start/End origin using one step rotation. 

 

Mirror is carried out about the Start/End point origin axis.  
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When a whole shape is selected (using Shift-pick to select it), pick an option from the context menu. 
The menu below is displayed when a documentation shape is selected: 

  

The Move option can be used as an alternative to using Shift select on the shape. 

Edit Segment will have the same effect as double-clicking on the shape.  

If the line is edited rather than selected, slightly different options are available but in the most they are 
the same. You get Closed Shape (for an open shape or line segment), Editing Options and Change 
Segments. 

As well as selecting options from the menu directly, the Properties option will display a dialog from 
where you can change all aspects for the shape selected. 

 

Some shape types also have their Own Colour selection to help more easily identify specific shape 
items. Use this carefully as it may well lead to confusion if selected over the standard colours set in 
the Colours dialog. 
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���� To change the line style 

1. Select the line or shape. You can right click and select Change Style from the menu (keyboard 
shortcut S), or right click and use Properties (shortcut I).  

2. When the Change Style dialog is displayed you can select a Style from the drop down list box or 
type in the width required. 

 

3. If you type in the width required, when you press OK you will be asked to confirm the new 
default style name if it doesn’t already exist in the Technology. 

4. If changing the style of the line to a thicker width, be aware that the thickness is added around the 
centre line of the shape, effectively making the shape bigger. If changed on electrical layers, you 
should run a Design Rules Check to ensure that the shape still has enough space around it. 

���� To change the shape layer 

1. Select the line or shape. You can right click and select Change Layer from the context menu 
(keyboard shortcut <L>), or right click and use Properties. 

2. When the Change Layer dialog is displayed you can select a new layer from the drop down list 
box. 

 

3. Press OK to confirm the layer change. 

4. You should run a Design Rules Check to ensure that by changing the layer, you have not created 
any errors. 

Design Rules Checking Shapes 

Shapes placed on electrical layers have their own Spacing rules defined in the Technology dialog and 
should be Design Rules Checked along with all other electrical items on these layers. Shapes on non-
electrical layers are ignored. This can be done as part of your Design Rules Checking process. 
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Copying and Growing Shapes 

In Pulsonix, shapes can be duplicated, copied to another shape type, or duplicated and grown/reduced. 
Detail has been provided below on how to perform these tasks.  

Duplication of shapes may be required the same shape exists multiple times, e.g. corner cropping 
markers defined using copper shapes on the four corners of a board. 

 

Duplicating a shape 

To duplicate a shape is straightforward. Any shape can be copied in Pulsonix and pasted back into the 
design. There is also a Duplicate option that does the Copy/Paste for you. Where Duplicate is 
described below, you can also substitute this for a Copy (<Ctrl-C>) and Paste (<Ctrl-V>), but one 
key sequence to Duplicate (<Ctrl-D>) is quicker.  

���� To duplicate a shape 

1. Shift click to select all of the shape to be copied. <Ctrl-D> to duplicate. 

2. The copied shape will appear on top of the existing shape and on the cursor ready for positioning 
as required. 

3. While the shape is on the end of the cursor, right click to obtain the context menu if you wish to 
change its properties. 

Copying and changing the shape type 

If you wish to copy an existing shape but then change its shape type you can use another method. 

���� To duplicate a shape 

1. Shift click to select all of the shape to be copied. Press <Ctrl-D> to duplicate. 

2. Select Insert Shape from the Insert menu and press <Ctrl-V> to Paste. 

3. The copied shape will appear on the cursor ready for positioning as required. 

Because you have put a copy of the shape into the clipboard, once you then select an Insert Shape 
operation, this shape (but only the shape outline) will be pasted into the design taking on the new 
shape’s default properties. 
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For example, you could copy a Board Outline shape, and paste it back into the design as an Area 
shape. Moving on from this technique, you could also paste it back into the design and shrink or grow 
the shape so that it is an exact copy, a different shape type and smaller! 

Resizing shapes 

Pulsonix has the ability to grow and shrink shapes. Provided the whole shape is selected the Resize 
Shape option can be used (this option is also used to shrink shapes using negative numbers [-20] ).  

���� To resize a shape 

1. Shift click to select the whole shape. 

2. Right click and select Resize from the menu. 

 

3. From the Grow Shape dialog, type in the size to grow the shape by. A negative number will 
reduce the item in size (e.g. –20). 

The Resize option is available at any time when a whole shape is being added to the design, Pasted, 
Duplicated or Moved. 

Below is an example of an instance where an exact replica of the board outline might be required but 
with additional manufacturing clearances allowing for board cropping.  

���� To create a template within the board outline 

The description below combines some of the techniques described previously as a working example 
for creating a Copper Pour Template within the board outline. It will leave a consistent gap from the 
copper to the edge of the board boundary even when the board profile is an odd shape. 

The diagram below shows the original board outline that was started with: 

 

1. Shift click on the board outline to select the whole shape. 

2. Press <Ctrl-C> to copy. 

3. Select Insert Template from the Insert menu 

4. Press <Ctrl-V> to Paste. The board outline will be copied as a Template. 

5. From the context menu, select Resize. By using a minus sign before the size, the Template will 
reduce in size consistently leaving a boundary gap to the required distance. 

6. Position the Template and release. 
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The example below shows how it would look when reduced in size to create a boundary gap. 

 

The Properties of the Template would be as defined in the Options dialog for Template Defaults. 

Using Shapes in Footprints 

Shapes can also be used when creating Footprints in the library. Footprints can contain Copper, 
Shapes, Areas and Cutouts. More details about Footprints can be found in the Chapter on Library 

Management Tools. 

Areas 

Area shapes can be added to your design or to a Footprint definition in the library. An area added to 
the design could be used for example for Keep In or Out of items such as Copper, Copper Pour, 
Drill, Tracks, Vias or Components. You could also use an area to act as a Board Cutout within an 
existing Board outline. If using the Advanced Technology option, this could also be used across a 
defined Layer Span to act as a Cavity within a Board stack.  
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Another use of an Area is for defining a specific region for overriding Spacing rules and Net Class 
Rules. You may use this for example under BGA to provide you with tighter Via to Pad spacing rules 
where small vias are used on the end of short stub route breakouts. 

Footprint Areas 

When using an Area within a Footprint in the Library, you have additional parameters that you can 
specify.  

These define the area use within the footprint; Placement Clearance, Body and Model Placement. 

An area nominated to be a Placement Clearance area, defines the area required around the 
component. For example, you may require a space along the sides of the component to allow for the 
jaws of a placement machine. The body area of another component cannot overlap with this 
Clearance area. Clearance areas may overlap as long as the body areas are legal.  

The Body is the actual physical body of the component and is used to determine if something (such as 
a testpoint) is underneath the component. Check this box to specify the area as a Body. This area (or 
areas) is used in the automatic placement of components and for checking the component to 
component spacing. The rules are applied such that neither a body, nor a Placement Clearance area, of 
another component may overlap a body. Also, Body areas must be at least the Component to 
Component spacing apart. If no Body or Clearance areas are defined, the bounding box of any 
documentation (e.g. silkscreen) shapes is used.  

Use the Area Height box to specify the height of the component body. This height will be used in 
checking against component keep out areas. Note: if no units are added to the end of the height value, 
it will use the units of the design when used.  

An area marked as a Model Placement area is used for aligning STEP models when producing STEP 
output or displaying a STEP Preview. The relative height and width of the area is used to determine 
the correct orientation of the STEP model with respect to the overall height and width of the footprint.  
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Merging Shapes 

Merge Existing Shapes  

You can merge a set of selected shapes using the Merge Shapes command (also see Insert Merge 
below). Shapes must be Closed in order for them to be accepted for merging. 

 
 

Add two shapes to the 
design. 

Select both shapes and select Merge Shapes 
from the context menu. 

The two shapes are 
merged as one. 

Insert Cutout 

Adding a cutout removes the cutout shape from the outline if they intersect.  

 

 

Once the shape is drawn, select Insert Cutout. Select 
the shape. Draw the cutout starting outside the shape. 
Draw ‘across’ the initial shape and finish. 

The resulting shape is now minus the 
shape ‘cutout’. 

Insert Merge 

A set of commands allows you to add a new shape to be merged with an existing shape. The function 
is similar to Add Cutout, except the shape is added rather than removed. 

Cutouts 

Cutouts are used within a shape to define an area or void within that shape. Other options within 
Pulsonix understand the difference between shapes and cutout shapes within them, this is particularly 
important when a router needs to avoid this cutout and not route across it for example. Cutouts also 
know the shape they belong to and will move to with the shape if the shape is moved. 
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The rules for using Cutouts 

Cutouts can be used on all electrical and documentation shapes provided they are a Closed shape. The 
cutout shape can protrude outside the shape in which it exists but will become a ‘removed’ shape not 
a cutout, like in the example below. 

 

���� To insert a cutout 

1. On the Insert menu, click Insert Cutout  

2. Click the shape for which to add the cutout. 

3. The shape will highlight and the required shape may then be created within the ‘host’ shape. 

4. If you attempt to release the shape in an illegal position, a warning dialog will be displayed and 
the shape will not be released. 

Board Cutouts 

Board Cutouts 

A Board Cutout is available to be used to add a separate cutout within a board (using the Insert 
Cutout option). This will be treated differently; it cannot be routed over (with a DRC error), it cannot 
have copper poured over it and cannot have components placed in it. 

This style of cutouts uses the same plate/not plated status and is detailed to the manufacturer when he 
receives manufacturing notes.  

The display of these Board Cutouts is defined in the Layer Class page of the Technology dialog.  
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Board Cutout Areas 

You also have Board Cutout Areas which can be added as required, these are added using Insert 
Area. This is particularly useful if the cutout in a board needs to be processed in a different manner, 
such as plated or punched or routed. This area type is also available in Footprints for component 
based specific cutouts for example. A Board Cutout can be defined as Plated or left unchecked, as 
not plated.  

Once added to the design, Properties of an Area can be modified as Board Cutout and then Plated 
or not Plated (by leaving it unchecked). 

 

Inserting Copper  

The copper facility in Pulsonix allows areas or shapes to be added to electrical layers that can 
subsequently appear on the final plots, and hence PCBs.  

The Insert Copper option is used to add these copper items regardless of their shape. This type of 
shape might be used for cropping markers on the edge of the board or specific sized shapes. If the 
shape is required on a non-electrical layer the Insert Shape option should be used.  

Note: Insert Copper is not Copper Pour and does not automatically create voids around Component 

pads, tracks, etc. For this type of copper, you should use the Copper Pour option. Refer to the next 

section Templates and Copper Pour. 

Copper shapes can be defined as Open or Closed and Filled or Unfilled, used on any electrical layers, 
can be Hatched or Cross-Hatched and can have a Net Name. 

The use of Shapes and Cutouts has been described extensively in the previous section. This section 
details specifics of Copper shapes. 

Setting up the Technology dialog 

Copper line styles are defined in the Technology dialog under Line Styles. 

 

The Width describes the outline line style and is also used as the line style where Hatch or Cross-
Hatch styles are used on the copper shape. 
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Copper Spacing Rules 

Copper has its own spacing parameters defined on the Technology dialog under Spacing Rules. 

 

All listed items, as well as Copper itself, can be checked against Copper items within the design. 

���� To insert copper 

1. From the Insert menu select Insert Copper then create the shape required.  

The copper shape can then be created within the design. At any time, right clicking the mouse will 
display the context menu from where to select an option. 

Changing the Grid 

During Insert Copper or Move, you can change the grid on which the copper is positioned. This can 
be found on the context menu under Change Grid. You can change between the Use Working Grid 
or Gridless (Use No Grid). 

On-line DRC and Display Clearance 

When added copper shapes, you can select use the On-line Design Rules Checking option, and to 
show clearances defined in the Spacing Rules dialog as a visual indicator. Both options provide actual 
and visual indicators that the copper shape being added or modified will adhere to the rules defined 
and does not violate any other electrical items. These options are available on the context menu 
during Insert Copper or Move. 

Add To Net 

Copper can be added to any net in the design once the shape has been added. This can be done using 
the Add To Net option from the context menu or by using Properties of the copper shape. 

 

This can be used where copper shapes are placed up against another item that already has a net name. 
By giving the copper the same net name, the two items will be associated and will not produce errors. 
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Adding vias to copper 

Vias can easily be added to copper shapes. These might be required where the copper shape must be 
connected to a ground plane. The vias providing multiple entry points to the plane for EMC shielding 
purposes. 

 

There are two methods: 

���� To insert vias into copper shapes 

1. From the Insert menu, select Insert Via.  

2. Options from the context menu allow the via to be inserted Multiple times and to be named using 
Change Net. 

 

3. If the copper shape already has a Net Name associated with it, you can release the via over the 
copper shape and the via will take on the same net name. 

4. If the copper is not named, and subsequently becomes named, you will need to use the Change 
Net option on the vias to give them the same net name as the copper. 

���� To insert vias into copper shapes using Apply Via 

1. Select the target shape to apply vias to.  

2. From the Utilities menu, select Apply Via > Apply Vias to Selection 
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3. Select Add Via and select On the shape 

4. Select the via Style you wish to add. 

5. Select the Spacing or use the Spacing Rule and press Add. 

Pouring Copper and Templates 

Copper Pour is used to flood areas of a PCB layout with copper, usually connected to a nominated 
signal, typically Ground (GND) or VCC. This facility will then create voids around tracks, 
Component pads, vias etc.  

If a copper area is to be inserted without the need for voids around unconnected tracks, components, 
pads etc. then the Insert Copper facility should be used. 

The principle of this facility is to create a Template area and ‘pour’ the copper into this area. Different 
properties of the copper can be controlled in the Technology under Rules - DFM/DFT tab - Copper 
Pour Rules and Thermal Rules.DFM/DTF Rules tabs in the Technology dialog. 

Setting up the Technology dialog 

Copper uses its own spacing parameters defined in the Technology dialog, under the Spacing Rules 
tab as previously discussed for Copper. To create the clearances in the copper area it also uses the 
rules defined in the Technology file under Rules - DFM/DFT tab - Copper Pour Rules. 

Copper Pour Rules 
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For Copper Pour Rules you may determine aspects of the poured copper. 

The Minimum Island Size can be set for individual areas of copper within the design in the current 
design units. If a given area of copper falls below this size then copper will not be placed.  

 

The Remove Isolated Islands means that if it is not possible to connect an island to the designated 
Net then the island will be deleted.  

The two examples below show how isolated areas would be removed. 

 

 



304   Chapter 6 – PCB Design Editor 

Avoid Same Net means that any nets that have already been routed or are copper will be avoided 
during pour, provided they are on the same net as the one being poured. If the option is checked, 
isolation will be left around any item on the same net within the pour area.  

With ‘Avoid’ checked off   With ‘Avoid’ checked on 

   

Hatched defines whether the Copper Pour is to be Hatched, and if so, the Style of the Hatch or 
Cross-Hatch. 

Thermal Rules 

 

 

This defines the thermal relief size and isolation of any pads within the poured area (Thermal Pads) 
and the copper itself using the Minimum Island Size and whether it is Hatched/Cross-Hatched or not 
(Copper Pour). 

The Thermal Pads section related to the pads connecting the copper poured area to the nominated 
Net name. 
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For thermal relief you may determine the Isolation Gap, the Spoke Width, the Number of Spokes and 
the First Spoke Angle. 

 

The Isolation Gap is the gap between the Pad and Copper connecting to the designated Net. The 
Spoke Width is the small copper strip between the Pad and Copper. The Number Of Spokes 
connecting the Pad to Copper can be defined as can the First Spoke Angle in current angle units 
(other spokes will be relative to this first spoke). 

The area will flood with copper leaving an isolation area around tracks, pad, vias, connectors, etc. 
plus a copper connecting strip through the Thermal Pad to the nominated net. 

Setting up Default Values 

There is a default style setting for Templates in the Design Settings dialog under the Defaults tab. 
This is used when Insert Template is selected. The values shown by default exist in the Technology 
dialog. 

When poured, the Copper area will use the default values taken from the Copper entry on the same 
dialog. 

Creating a Template 

1. From the Insert menu, select Insert Template then select the shape type (Polygon, Rectangle or 
Circle). Once the appropriate shape type is selected then the shape may be created on the design. 

This Template may be outside the board outline if copper is to fill the complete board area. Any 
Template area outside the board outline will not be poured with copper using this facility. In this 
instance, the copper will be poured to within the Copper to Board spacing rules distance inside the 
board outline. 

Attaching a Net to the Template 

At any time; during addition or selection of an existing Template, a Net Name can be added to it 
using the Add To Net option from the context menu or by pressing F2. 

Where the poured copper is associated with a net, the net name can be attached to the template prior 
to pouring the copper. With a net name attached combined with the Act Poured switch selected, this 
will also enable full checking and net Optimisation to the template even if it isn’t poured. 

The Act Poured switch is selected from the Options dialog and Interaction tab. 
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Pouring Copper 

���� To pour copper into a template 

1. Click the Template outline; you don’t need to select the whole shape. 

2. From the Utilities menu select Pour Copper. You can also use the Pour Copper option from the 
context menu once the template is selected. 

3. The Template area will fill with copper leaving voids around unconnected items. 

4. To create copper hatching after pouring right click and select Hatch. 

Warning: Do not remove the Template after pouring, you will not be able to easily remove the poured 

copper areas afterwards or make modifications to the copper shapes if required. Templates are not 

plotted and will not appear on your plots. 

���� To clear poured copper 

1. Select the poured copper shape or Template outline. 

2. Right click and select Clear Template from the menu. 

Automatically pouring Templates 

When a Template is created, at the point that the shape is completed the Template can be 
automatically poured with copper. This saves you then having to select the Pour Copper option. 

To enable this mode, select the Pour On Add option from the Options dialog and Interaction tab.  

Templates poured automatically can still be cleared using the Clear Template option, and hence why 
they should not be removed after pouring. 

Pouring copper without a Template 

In instances where the design does not have a template, because it was imported from another system 
or where you wish to convert a closed copper shape to a poured copper area with clearances, you can 
select the copper and pour copper into its outline. The copper shape will act as a template without 
having to recreate the copper shapes outline. For this to work successfully, the shape must be copper 
and must be closed. It will still work if the shape is Filled or Hatched. 

Once the shape is poured, it will still be a copper shape without a Template outline but will contain 
voids where pads etc exist. 

���� Pouring copper without a Template 

It is highly recommended that you try and avoid using Copper Pour without adding a template first. 

1. Press Shift and select on the copper shape at the same time. 

2. From the Utilities menu select Pour Copper. You can also use the Pour Copper option from the 
context menu once the template is selected. 

3. The existing copper shape will be replaced with poured copper using the original copper shapes 
outline. 
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Isolating Pads From The Power Plane 

A property exists on Pads (and Vias and Mounting Holes) that allows isolation and solid powerplane 
connections for use with both partial and split power planes, and for use with full CAM/Plot power 
planes. 

For a selected pad, Pad Properties will allow you to alter the Power Plane Connection status for that 
pad instance only. If you wish to change the default status of a set of pads, you might want to consider 
creating a Thermal rule within the Technology to cover your requirement. 

 

The Power Plane Connection property has four possible settings.  

• Default 

• Isolated  

• Not Isolated 

• Thermal Pad 

Default will be the default setting for the pad. 

Where the setting is Isolated, the pad it is attached to will be isolated from the plane or poured area 
without using any ‘spokes’ and will use the Copper to Copper spacing rule. 

Where the setting is set to Not Isolated, the pad it is attached to will be a solid connection to the 
plane or poured area without any isolation or thermal relief. 

Where the setting is Thermal Pad, this is the normal default setting and will allow a thermally 
connected pad to the plane using the Thermal Rules defined in the Technology. 
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The illustration above shows the effect of the Power Plane Connection property using the Isolated 
and Not Isolated settings and with the Avoid Same Net switch set off. 

 

The illustration above shows the same example but with the Avoid Same Net switch set On. 

For information on split planes, see later in the manual in the chapter on Outputs for PCB 

Manufacturing. 

Automatic Copper Pouring 

Once copper is poured into a template, Pulsonix allows you make changes to items that enter the 
copper and for the copper to be automatically repoured. This is a switchable option and is available on 
the Options dialog and Interaction page. The option is named Repour Affected Templates. It means 
that if you move a via or track slightly, the ‘damaged’ area around that item will be repoured without 
reporing the whole template.  
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Using Teardrops 

Teardrops are small copper 'fillets' used to obtain a smooth 'transition' between pad items and track. 
Historically, teardrops have been used to help increase manufacturing yields by reducing the 
possibility of over etching of items with sharp internal corners during the copper removal process 
using acid.  

 

In most cases, over etching has been vastly reduced using modern spray etching techniques, but 
teardrops are still used where manufacturing is poorer or where PCBs are produced in very high 
volumes and yield (and hence reliability) are paramount. For example, in consumer electronics for 
manufacturing Televisions. 

Teardrops are a feature of pad items and can exist between tracks on the following items: Pads, Vias, 
Testpoints, Tracks, Mounting Holes and Free Pads. 

Pulsonix supports two types of teardrops: ‘Normal’ Triangle and Curved Triangle. Both types use 
copper associated with the pad to make the teardrop. The teardrop is dynamic, moving with the angle 
of the track entering the pad. 

The curved triangle teardrop provides a more aesthetically pleasing teardrop but is equally functional.  

 

The colour used for the teardrop will always be the same colour as used for the track that it is 
connected to. 

Setting up the Technology dialog 

Teardrops can be set up in the Teardrop Rules tab in the Technology dialog. 
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The shape and size of teardrops is defined from the teardrop settings. The choice of teardrop Shape is 
for the normal Triangle shape and the Curved Triangle shape. The Curved Triangle shape gives you 
a slightly less harsh shape than the traditional Triangle shape. 

The V-Angle allows you to define the length of the teardrop based on its angle between the two 
items. A 60 degree angle is set as the default but can be changed to your own requirements. You can 
also change the Length of the teardrop to elongate it further than the angle would allow. 

Once the teardrop has been added, the Shape, V-Angle and where they are applied to can be 
interactively changed using Properties on the item. You would need to select the teardrop(s) first and 
then Properties. 

Inserting Teadrops 

Teardrops can be added (and removed) in a number of ways depending on the range of coverage of 
the teardrops within the design.  

From the Tools menu, you have the Teardrops selection that allows the following: 

Add Teardrop To All Nets This is used to make a selection of all the nets within the design 
and perform add teardrop on them. 

Add To Browse Nets This will only perform an add teardrop on nets selected from those 
listed in the teardrops browse menu. 

Add To Selected Nets This will only perform an add teardrop on clicked nets within the 
design. 

You also have a more interactive mode that allows you to Add Teardrops To Selection. This mode 
is not on the menu but is available as a command and as a button for use on the Toolbar, by default it 
appears on the PCB Toolbar. 

Using this mode it provides you with a focused operation, enabling teardrops to be added to single 
pads or both ends of a track segment. You can use it by selecting the item first and applying the 
teardrop with a single click of the toolbar button, or by selecting the button first to ‘latch’ the option, 
then selecting the item. You must cancel the option to remove it from its latched mode. 

���� To insert a Teardrop 

1. Click on the Tools menu, click Teardrops. You may then select one of the options from the 
menu, or:  

2. Select the item first and click the Add Teardrops To Selection toolbar button. 

Removing Teardrops 

Teardrops may be removed by selecting teardrops and the Remove Teardrop alternative to the 
options listed above. 

���� To remove a teardrop 

1. Click on the Tools menu, click Remove Teardrops. You may then click one of the following:  

Remove Teardrop To All Nets - This is used to make a selection of all the nets within the 
design and perform Remove Teardrop on them. 

Remove To Browse Nets - This will only perform a remove teardrop on nets selected from 
those listed in the teardrops browse menu. 

Remove To Selected Nets - This will only perform a remove teardrop on clicked nets within 
the design. 
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You also have a more interactive mode that allows you to Remove Teardrops To Selection. This 
mode is not on the menu but is available as a command and as a button for use on the Toolbar. 

Using this mode provides you with a focused operation; enabling teardrops to be removed to single 
pads or both ends of a track segment. You can use it by selecting the item first and applying the 
option with a single click of the toolbar button, or by selecting the button first to ‘latch’ the option, 
then selecting the item. You must cancel the option to remove it from its latched mode. 

Adding Dimensions 

Dimensions used for documenting the physical measurements of the PCB can be added using the 
dimensioning facility in Pulsonix. Dimensions can be attached to items to be dynamic as that item is 
moved, or they can be unattached. 

Insert Dimension is used to dimension items within the design, or gaps between items within the 
design. It is used to display (in the form of a dimension) lengths of items, radii of arcs and angles 
between lines. 

 

Setting up Default Dimension Values 

There is a default style setting for Dimensions in the Design Settings dialog under the Defaults tab. 
This is used when Insert Dimension is selected. The style values shown by default exist in the 
Technology dialog.  
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This dialog details how the dimensions will appear in the design. The above example is not complete. 

Also on the Defaults tab are Dimension Units. These define the Angle and Length units of the 
dimensions being added. 
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Within this dialog you can set the Angle Units and Precision and the Text that is used if the units are 
displayed. The same applies for the Length Units where the Units are specified as is the Precision 
and the Text used to when the length units are displayed. 

When using Dimensions, you can also change the look and style of the dimension by selecting it and 
using Properties from the context menu. 

Adding Dimensions 

There are five types of dimensions available during Insert Dimension: 

• Horizontal 

• Vertical 

• Free Angled 

• Radial 

• Angular 

 

Each of these is available from the Insert menu and Insert Dimension. You can also select any of the 
dimension types from the context menu once any Insert Dimension mode has been selected. 

How to use Dimensions 

���� To insert dimensions 

1. Select Insert Dimension from the Insert menu.  

2. You are now in one of the Insert Dimension modes, by right clicking you will see the Insert 
Dimension context menu: 

 

3. Select the type of dimension required. 

From the context menu you can also select whether the dimensions will be Directional and an 
Inward dimension, how to Snap the dimension and if it is to be Attached or not. 
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���� To insert dimensions 

Use these options to dimension lengths of items and gaps between items in the design.  

1. Select the Dimension mode from the context menu. 

2. Select your Dimension preference and the Snap mode from the context menu. 

3. Single click to pick the position to start the dimension from, or (if using Snap To Item) pick the 
item you wish to snap the dimension on to. The dimension will now be drawn on the screen. 

4. Move the mouse to position the end of the dimension. The dimension text will be automatically 
updated to show the measurement between the dimension start and end arrows.  

5. If adding a horizontal or vertical dimension, a construction line will be added from the moving 
start arrow head to the original start position. 
If required, right click the mouse to use the context menu to change the type of linear dimension 
you are adding, or to change the layer of the dimension, or to change the grid you are using. 

6. Single click to pick the position to end on, or (if using Snap To Item ) pick the item you wish to 
snap the dimension on to. 

7. Move the mouse to alter the offset of the linear dimension arrows from their original positions. 
Construction lines will be drawn from the moving arrow heads to the original points of the 
dimension. Use the context menu to change the grid that the dimension is moving on. 

8. Single click to finish the dimension.  

���� To reset the dimension text default position 

1. If the text displayed on the dimension was at its default position, it is moved to keep it at its new 
default position, otherwise it is not moved.  

2. Note: If you want to put some dimension text back to its default position, select the text, right 
click and use Reset Text Position from the menu.  

Attached Dimensions 

There is a command, Attach Dimensions available from the context menu whilst adding and 
stretching Dimensions. Check this so that when a dimension is snapped to an item it will be attached 
to it (if it can).  
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Moving items with Attached Dimensions 

Moving or changing the item will cause the dimension to be stretched (and have its measurement 
altered). They will remain attached though. 

Unattaching Dimensions 

Dragging the dimension line attached to an item will present you with a dialog asking if you want to 
unattach the dimension.  

 

Click Yes to unattached it. You can reattach the dimension to another design item and the 
measurement will automatically update. 

Highlighting Attached Dimensions 

The Attached Dimension/Callouts colour setting under the Highlights tab of the Colours dialog can 
be used to highlight half of the dimension that is attached (or the whole dimension if fully attached). 
The unattached portion of the dimensions are drawn in the Dimension colour. 

 

Dimension Tolerances 

When adding Dimensions you can automatically add tolerance text to the end of a selected 
dimension.  

  

From within the Properties dialog of a Dimension, there is a tab to define the Tolerance. 
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The tolerance text is a multi-line text item with its own text style, automatically attached to the end of 
the dimension text such that both text items are aligned through their vertical centres. The multi-line 
tolerance has been provided to create either unilateral or bilateral tolerances, or to be used for any 
other purpose you like. 

  

A Unilateral Dimension example A Bilateral Dimension example 

As well as being able to type the tolerance text, you can use a button to insert the bilateral ± character 
at the start of the text, and use the Insert ± button to set the text to the default for that dimension type.  

Default Tolerances can be set up in the Design Settings dialog, Defaults and Dimensions. These can 
be defined for each of the three types of dimension, linear, radial and angular. A default tolerance text 
style can also be set up. 

 

Saving Dimensions To A Profile File 

Once dimensions are added to a design, they can also be saved to a Profile File for subsequent reuse. 
This is particularly useful if the dimensions detail the physical board and are required for other 
designs. To save the Profile file use the Save Profile option from the Setup menu. 

Show both Metric and Imperial Units on Linear and Radial Dimensions 

Linear and Radial dimensions can display both Metric and Imperial units for the same dimension. 

 

Check boxes to Show Alternative Length Units and Show Alternative Radial Length Units are 
available on the Defaults Dimension Units page. 



 Chapter 6 – PCB Design Editor   317 

When selected, the alternative units text is added after the normal dimension distance text, enclosed in 
the Prefix and Postfix text, for example, 4141 thou (22.61 mm). Brackets and formatting can be 
added using Prefix and Postfix entries. 

 

Text Callouts 

Text Callouts can be used in both PCB and Schematic designs and are used for documenting points of 
interest. Callouts can be ‘floating’ or attached to an item.  

 

Text callouts consist of a text item, a shape around the text (the text box), a line from the text to the 
location of interest (the pointer), and a shape at the end of the line (the pointer end). These items are 
invisibly grouped so that it acts as one dynamic item in the design.  

Text Callouts are added to the design using the option Text Callout on the Insert menu. 

Using Text Callouts 

From selection from the menu, select the pointer end position, you will be presented with a dialog to 
supply the text and layer (in PCB design). The layer can only be a non-electrical layer. The callout is 
displayed on the screen and you can place the text item at the required position.  

The defaults for the styles, layer and appearance of new callouts are defined in the Design Settings 
dialog on the Setup menu. You can override this by selecting a Text Callout or Free Text item in the 
design before using the Insert Text Callout option. 
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Once added, the text callout can be moved for repositioning by selecting the outer edge and dragging 
it. The text box alone can be repositioned by selecting just the text. You can also drag the Pointer End 
to a different position. 

You can change the text callout appearance by selecting it and using the Properties dialog from the 
context menu. You can change the Appearance of each of the entities. 

 

Different styles of text callouts can be 
achieved by changing the Properties of 
these items. 

 

 

Attached Callouts 

The command Attach Callouts is available from the context menu whilst adding and stretching 
callouts. Check this so when the end of a callout is positioned over an item it will be attached to it (if 
it can). Shift-select on a shape will attach a callout to the nearest point on a shape.  

As with Attached Dimensions, if you attempt to move the callout near where it is attached, a warning 
dialog is displayed. 

 



 Chapter 6 – PCB Design Editor   319 

Calllout Attributes 

You can substitute any of the attributes of the attached item in the callout text. For example, when 
attaching to a component the text can contain the Component Name. 

For the Callout Text Properties, enter your text (Component, in our example) plus the substitute 
attribute name ( %%<Item Name>%% in our example). The text callout will then take on the item 
properties. 

 

Measure Tool 

The Measure Tool is used for measuring the distance between points or items in the design. This is 
available in the PCB design editor and Footprint editor applications (as well as the Schematic editor) 
in Pulsonix. It can also be used to show the gap between the edges of two items and the required 
minimum spacing between them. This includes the Drill-to-Drill distance between selected pads.  

The tool also provides information about the dimensions of the picked items, and allows you to record 
the measurement in a report. 

The Measure Results dialog displays information about the measurement made, the pictures below 
are split for ease of viewing: 
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The dialog is shown split here for clarity. The top half displays dimensional information about the 
picked Items, or positions that the measurement was taken From and To. If there is more information 
that can be displayed, the vertical scroll bars are enabled to view all the data. 

The bottom half shows the Layer being used. This shows the layer that the Gap between the items is 
measured on. If the two items are on completely different layers, ‘Different’ is shown. In this case the 
gap is still shown, but may not be that relevant. If a picked item contains different shapes on different 
layers, a pad with layer reassignments for example, you will be offered a drop down list of common 
layers between the items to choose from. When choosing a different layer, the measurement 
information tabs and the line displayed on the design will be updated to show the measurement on the 
chosen layer. 

Under Layer are the Measurement Information Pages. These pages show different measurements 
between the two items. Picking a measurement tab will change the information page and alter the 
measurement line displayed in the design. The different measurements are as follows: 

Distance - Shows the distance between the picked points, and the angle of the line between these 
points. 

Shortest - Is only displayed after two items have been selected. It shows the shortest distance 
between the two items. Widths of lines are not considered for this measurement; use the Gap tab for 
edge-to-edge measurement. If a component is selected the shortest distance is measured to its 
placement area on the relevant layer. 

Gap - Is only displayed after two items have been selected. It shows the smallest gap between the 
edges of the two selected items. If both items are electrical items, it shows the required Spacing 
between these items. This spacing is set to zero if the two items are on the same net. If two 
components are selected the spacing is the minimal component spacing. This page can be used to 
check two items to see if they are in error. If the gap is less than the required spacing, it will be drawn 
in red. If the layer is "Different" then the gap is not relevant unless one of the items changes layer.  

Drill - Is only displayed if one of the two selected items has a drill hole. The distance shown is from 
the edge of the drill hole on these items. If both items have drill holes, the spacing shown is the 
minimum spacing required between drill holes. 

Units 
Use this to change the units used to display the lengths shown in the dialog. The button shows the 
units currently being used, and will show "Design" if the design units are being used. When pressed 
the Units dialog will be displayed. 

During use of the Measure Tool, the context menu offers the Snap To Items and Show 
Measurement options. 

 

Snap To Item allows less accuracy on the picking of an item. This would be the normal mode of use. 
Leave it unchecked to restrict picking to positions in the design. 

Show Measurement enables you to toggle the display of the Measure Results dialog. This provides 
more information about the items being measured and is designed to be placed to the left or right of 
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the screen. If you don't want the dialog in the way then hide it as the basic distance information is still 
displayed on the status bar. 

A line is drawn between the two items representing the distance being reported. 

Using PCB Attributes 

This section details specific attributes associated with PCB Layout. The general process of adding 
attributes has already been covered in the Chapter under Setting Up The Design.  

Displaying Attributes 

All attribute names in the design are available in the Colours dialog. These can be set to be 
Displayed, Selectable and to have their individual colours changed. All system attributes are shown 
in brackets e.g. <Component Name>, <Date> and user defined attributes shown without brackets e.g. 
Manufacturer. 

 

System Attributes 

There are a number of system attributes that present themselves in the design as part of components 
and nets and other used design items. Attributes such as Component Name, Gate Modifier, Part 
Name, Part Description, Net Name etc. are used throughout. 
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There are some attributes that can be used to add design level information that changes dynamically 
as the design is updated. Attributes such as Date, Last Save Date/Time and Design Author are a 
selection these available attributes. 

User Defined Attributes 

New attributes can be added to any design item within Pulsonix. These user defined attributes can be 
extracted using the Report Maker output. Attributes on components that have their attribute names 
marked as being 'both' design types (PCB and Schematic) will be copied to the corresponding PCB 
Component when Translate To PCB is used. 

Design Rules Checking 

The Design Rules Check is used to check that the spacing rules defined in the Design's Technology 
file are not violated within the design or Footprint. This is also used to check various manufacturing 
rules have been obeyed.  

When errors are found Error Markers are added to the design on the appropriate layer to help you 
find and correct the error. 

 

���� To run a Design Rules Check 

1. The Design Rule Check option can be run from the PCB Toolbar, the Tools menu and the DRC 
Errors Browser on the context menu. 

2. A dialog is then displayed that allows you to control which items are included in the check. 
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3. Select the items you wish to check. 

Using the DRC dialog 

Spacing Checks 

Use the check box next to the Spacing title to choose whether any checks on the space between items 
will be performed. Then, if spacing checks are required, choose the types of items you wish to 
perform spacing checks on. Selected item types will be checked against all other items in the design 
in accordance with the Spacing Rules defined in the Design's Technology data.  

Notes:  Split Planes - These are templates that are on power plane layers. This spacing check checks 

for overlapping Split Planes. They are allowed to touch each other, but not cross over.  
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On-Grid Checks 

Use the check box next to the On Grid title to choose whether any grid checks will be performed. 
Then, if grid checks are required, choose the types of items you wish to perform grid checks on. 
Selected item types will be checked for being on their appropriate grids. For example, all track 
segments are on the track grid. Please refer to the Grids on-line help page for details on how to set up 
these special grids. 

Note: Pads do not have their own grid. They are checked against the Track grid.  

Keep In/Out Checks 

Use the check box next to the Keep In/Out title to choose whether any area checks will be 
performed. Then, if area checks are required, choose the types of items you wish to perform area 
checks on. Selected item types will be checked to. You can set the rules on Areas using the 
Properties dialog. Selected item types will be checked to see if they are in or out of any Areas that 
have Keep In/Out rules set up.  

Manufacturing Checks 

Use the check box next to the Manufacturing title to choose whether any manufacturing checks will 
be performed. Then, if manufacturing checks are required, choose the checks to perform.  

Testpoints Checks 

You can choose separate Testpoint checks if required.  

Nets Checks 

Use the check box next to the Nets title to choose whether any of the net checks will be performed. 
Then, if net checks are required, choose the checks to perform.  

Dialog Utilities 

Clear Locked Errors is used to force all locked errors to be cleared from the design. Normally, 
locked errors are retained but ignored on subsequent design rules checks. See the notes below 
regarding locking errors. 

Normally, only the Error Markers of the type you are checking will be removed from the design prior 
to running the checker. If you want to remove all the errors in the design, press the Clear All Errors 
button. This button will be disabled when there are no errors in the design to delete.  

Use the Source button to choose between checking the whole design or just checking the selected 
items in the design or footprint. If no items were pre-selected, the Selection option is not available. If 
checking Selection only, then each selected item will be checked against all other items (selected or 
not) in the design.  

Use the Report button to produce a report of all Errors Markers that are generated by this Design 
Rule Check session. Errors Markers that were already in the design prior to this session will not be 
included. 

Use the Show Errors Bar check box to display the error markers in the Errors Bar once DRC has 
been run.  

Note: If there are several errors between two items, only the first is reported. 

DRC Error Markers 

When an error is found an Error Marker is added to the design on the correct layer and close to the 
error location. This Marker is displayed as a text string showing a Code for the type of error found. 
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Next to the code, in the same colour as the Error Marker is a line showing the gap between the two 
items in error. This line is only included if the error is between two items.  

For more information about a DRC Error, hover the cursor over the error to display the item tooltip or 
select it and use Properties. 

Locking Errors 

Errors can now be locked using the Properties page or from the Errors Browser. This means that 
they are not normally removed on subsequent DRC checks, and are reported separately in the Errors 
Report. The purpose of this is to mark errors that you consider to be acceptable, and that will not be 
brought to their attention next time a DRC is performed. 

Locating Errors 

After DRC Check, you can find the Error Markers in the design using the DRC Errors Browser. 
You are able to locate error markers by type and cycle through them using the Next Error command.  

The DRC Error Browser is used to view all the design error makers as a sorted list. This list is 
displayed in an 'active' browser that, by using double-click to select, can be used to locate the error 
maker in the design. This browser can be un-docked as a modeless dialog or docked as part of the 
Pulsonix framework. Use the right hand mouse button to make this selection.  

 

The browser is categorised in order of rank starting with Design (DRC errors), then Layer, then Error 
type, then the Marker itself. 

Running DRC in the Footprint Editor 

As well as the Design Rules Check and On-line DRC options in the main PCB design editor, you 
can also run the batch DRC option from within the PCB Footprint Editor.  

By moving this process further ‘up-stream’ to where the Footprints are being created, you can check 
them before they are released to the library for use. 
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Synchronising The Designs 

The Synchronise Designs option is available in both schematics and PCB, and can compare and 
make changes in the corresponding design. Using this option you can perform ECOs (Engineering 
Change Orders) to your design.  

You can use Synchronise Designs at any time to verify that the netlists are the same. If there are 
differences, a dialog will appear, allowing you to view a report and perform an update. The report will 
give you a list of changes that would have to be made to the PCB in order to make it match the 
schematic. You can then perform these changes automatically by selecting the Update PCB option.  

Normally you will want to compare the corresponding schematic and PCB designs, but you can 
specify a different design if you wish.  

 

The recommended way of working is to create a schematic design, then use Translate To PCB to 
create the PCB design. The schematic design is considered the master and engineering changes 
should be made to the schematic and passed forward to the PCB using Synchronise Designs.  

Examples of engineering changes are adding or deleting component pins from nets, and adding or 
deleting components. Engineering changes can be destructive and performing an update on the PCB 
may result in tracks being removed. Large scale alterations to the netlist will result in large scale 
changes in the PCB.  

If you do make engineering changes in the PCB, Synchronise Designs will report these differences, 
but updating will change the PCB design, removing the changes you have made. In this case you 
should make the corresponding changes in the schematic by hand, if you wish to make it match.  

Note that PCB only components and PCB only pins on components are not part of the design 
comparison because there is no matching entity in the schematic.  

Annotation changes can be made in the PCB, and these can be passed back to the schematic using 
Back Annotate from within the Synchronise Designs option when back annotation data is available 
(after PCB changes). It will inform you of pending changes and allow you to perform any back 
annotation. It is recommended that you do this before updating the PCB, because the design compare 
it performs does not take any pending back annotation into account.  

Options available on the Options dialog under Synchronisation tab allow you to make additional 
choices of what pin swaps are back annotated during Back Annotation. 

 

You should consider using the PCB Safe Mode option on the General tab in Options. This will 
prevent you from making engineering changes in the PCB, which should be made in the schematic 
design and passed forward using the method described above.  
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Importing ECOs from external sources 

The Import ECO option on the File menu is used for importing external CAE designs or Schematic 
design netlists that have been subjected to modifications or Engineering Change Orders (ECOs). 
These designs will be in an ASCII format and will be recognised and supported by Pulsonix.  

The ECO files for a design created in the Pulsonix Schematic editor will be automatically imported 
using the Synchronise Designs options rather than the Import ECO option. 

Pulsonix automatically knows which source was used to create the PCB design and as such will not 
allow the Import ECO option to be used in some instances, for example, where the PCB was created 
without a netlist or using a Pulsonix Schematic design. The option is greyed out on the menu if an 
Import ECO is not applicable. 

Full ECO Back to the Schematic 

Enabling Full Back ECO 

If you do want to make engineering changes (ECOs) in the PCB, you can treat the PCB design as the 
master and use Synchronise Designs to update the Schematic.  

���� To set up a PCB design as the master 

1. Synchronise the two designs first to ensure they match (select the option from the Tools menu). 

2. In the PCB design, take it out of Safe Mode by unchecking the PCB in Safe Mode box on the 
Design Settings dialog, Synchronise page. 

 

3. Enable Backward Design Changes by checking the Allow Update of Schematic to match PCB 
box for the PCB design on the Design Settings dialog, Synchronise page.  

 

4. In the Schematic design, on the Design Settings dialog, General page, for the Schematics Safe 
Mode entry. The default mode in the standard Technology files is for it to be unchecked (not in 
Safe Mode). 
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���� To apply PCB changes to the Schematic 

1. Make the engineering changes to the PCB design and use Synchronise Designs to update the 
Schematic with the changes. 

2. When performing the Synchronise Designs, you are presented with a dialog from which to 
define the design to update. 

 

3. Once OK is pressed, you can then proceed to the standard Synchronise Designs dialog. This 
now shows the Update Schematic button to show that this is the design type being updated. 

 

4. Any new Components added will appear in the USED ITEMS: section of the component bin in 
the schematic design. 
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Some changes may not be able to be made to the Schematic design, for example, when the change is 
in a multiply instanced hierarchical block. You will be warned if changes could not be made and will 
have to either change the PCB design a different way, or change the Schematic design so that the 
updates can be made. 

The difference between a full back ECO and Reverse Engineer 

In principle, running a full back ECO is the equivalent of running a Forward Design Change, but 
obviously the other way around. Whereas, running Reverse Engineer is the equivalent of running a 
Translate To PCB (but in reverse). However, the Reverse Engineer option will also allow you to 
automatically place the components and route the connections. 

Cross Probing Designs 

Cross Probe works between two corresponding designs, a Schematic and a PCB. Items in the first 
(‘source’) design are selected, and Cross Probe locates the corresponding items in the other (‘target’) 
design. It can operate in either direction, from Schematic to PCB or from PCB to Schematic.  

As with other Latch mode commands, Cross Probe can be used either on the current selection (in 
which case the Probe action is carried out once), or with nothing currently selected (in which case 
Cross Probe is 'latched', allowing you to select a number of items to probe in succession). 

The items you can Cross Probe are: 

• Components  

• Component Pins/Pads  

• Nets  

The action taken in the target design depends on the mode in which the target design is currently 
operating. If this mode (the ‘target mode’) is the default Select Mode, items in the target design are 
simply selected. This allows you to use Cross Probe to help you browse the target design to locate 
items of interest. If the target mode is an interactive editing mode such as ‘Place’, selecting items in 
the source design will actually locate the corresponding items in the target design and allow you to 
place them. 
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Enabling the Cross Probing mode 

There is a setting on Options under the Interaction tab that sets Cross Probe to Bring the probed 
design to the front if you wish. 

 

In the source design, choose Select Mode and make sure nothing is selected. Use Deselect All from 
the context menu if necessary. Now choose the Cross Probe option. The cursor will change to show 
that you are now in Cross Probe mode. As you select on items in the source design, the matching item 
will be selected in the target design, as shown in the picture below: 

 

In the example above, by selecting the Component in the Schematic editor, the corresponding 
Component has been selected in the PCB design. 

Finding Items Using Cross Probe 

Perhaps the most common use of Cross Probe is to help you locate or view items in one design when 
you only really know your way around the other one. For example, you may be familiar with the 
location and arrangement of the components in the Schematic, but you need to find the corresponding 
components in the PCB design. 

���� To find items using Cross Probe 

1. Firstly, open the two corresponding designs. Cross Probe locates items by their type (e.g. 
Component, net) and their name. It will actually probe between any two designs, but the source 
and target designs should really be the matching Schematic and PCB for the same circuit, and 
they should also both be up to date. 

2. Any outstanding back annotation or design changes should be applied before using Cross Probe, 
otherwise the wrong items may be found because the names have not been synchronised. 

3. For ease of viewing, arrange the two designs side by side on the screen. Cross Probe will if 
necessary Pan or Zoom the target design to show the item being probed, but it makes sense to be 
able to see the whole of the target design so you can see what's happening. 
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Editing Items Using Cross Probe 

Using Cross Probe to edit items is very simple and yet extremely powerful. It provides you with the 
capability for engineer driven layout, for example allow the engineer to place critical components on 
the layout before passing the design onwards for completion. 

It operates in the same basic sequence as for simply selecting items. 

���� To edit items using Cross Probe 

1. Open the two designs (Schematic and PCB) that you wish to Cross Probe.  

2. Arrange the two windows so you can see what you are working on. In the target design, select the 
mode you wish to use. For our example, we will use "Place" to allow us to place components on 
the PCB by selecting them from the Schematic. 

3. In the source design, make sure nothing is selected, and then choose the Cross Probe option. The 
cursor changes to show you that Cross Probe mode is operating. 

4. Next, on the Schematic, find the first Component you wish to place, and select it. The 
corresponding item in the PCB design will be picked up so you can place it in the desired 
location. Once the Component has been placed, return to the Schematic and select the next 
Component to be placed. This can be repeated for as many components as you wish to place. 

5. As well as placing components, this powerful feature can be used for many other operations, for 
example to AutoRoute selected nets, or to mirror a whole group of components to the other side 
of the board. 

Selecting Multiple Items 

As well as Cross Probing individual items, you can also probe multiple items using the normal 
selection mechanism. 

���� To Cross Probe multiple items 

1. To Cross Probe all the items in a given area, use Frame Select. Cross Probe will happen as soon 
as the frame select is complete. 

2. To Cross Probe a particular set of Components, use <Ctrl-Select> or <Shift-Select> to extend 
or modify the selection. 

3. When you have selected the desired set, simply Select one of the items already selected, and the 
Cross Probe operation will happen. 

Cross Probe When Items Are Already Selected 

If you choose the Cross Probe option when there are already items selected in the source design, then 
Cross Probe will operate as a 'single shot' action. The program will not stay in Cross Probe mode once 
the probe action has been carried out. 

Printing the Design 

When you wish to obtain a hard copy of your design, there is a choice of two methods for outputting 
prints and plots from Pulsonix:  

• The Print option from the File menu will print the current design exactly as it appears on the 
screen. It will output to the selected Windows printer and will be automatically fitted to the paper 
size. 
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• The CAM Plot option from the Output menu to Print or Plot a user defined output to a selected 
device using defined parameters. This allows you to also choose not to include some design item 
types. Using this method, Pulsonix plots everything in the design on a per page basis unless 
excluded from a plot. The control over the size, scale, position and contents can be defined using 
the tools provided. 

Using the Print Option 

The print option is a quick and easy method of generating a print of the PCB using your default 
Windows printer. 

When selected, the standard Windows Print dialog is displayed. 

 

From this dialog you can select the number of copies to be made and select the print range. 

The Properties button on this dialog gives you access to more advanced printer specific options 
allowing you to change other settings. 

If you wish to make all colours on the screen black regardless of their displayed colour select the the 
Always Print in Black check box. 

Print will reproduce on the paper exactly what is visible on the screen, therefore control of what 
appears in the print is achieved by adjusting the on-screen view. The on-screen view will 
automatically ‘best fit’ to the selected paper size although it is possible to change the chosen 
orientation of the print via the Printer Properties mentioned earlier. 

If a more specific and consistent print is required, independent of the screen view, the CAM/Plot 
option on the Output menu should be used. 

The CAM/Plot option is a fully configurable single 'shot' output option that allows you the full 
flexibility to output the plot required. This is discussed in more detail in the next Chapter. 

Assembly Variants 

Introduction 

Variants allow the creation of multiple build assemblies within a single PCB, or Schematic design 
file. A design with variants has a common bare board (which means that tracks and copper do not 
vary) but has the potential for different component variants. 

How component variants can be used 

There are four possible ‘states’ for component variants:  

• You can have components fitted or not fitted in any particular variant. 
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• For each variant, components can have different Parts for the same Reference name, for example, 
R1 could be a 4308R-102 1K or a 4308R-102 2.2K. If you have the Pulsonix Database 
Connection (PDC) product, this will also show next to the list of Parts available. 

• For each variant, the same component (R1) can have different footprints, for example, R1 Part 
4308R-102 1K could have a RES300 or RES400 footprint. These could even be with a different 
number of pads. 

• For each variant, the same component can have different Attribute values. For example, R1 with a 
value of 1K for the USA variant could be 1K1 for the GB variant. 

These variants can be used in any combination for each component. 

The Variant Manager 

The Variant Manager is available on the Setup menu under Variants. This button takes you to the 
Technology dialog and Variants page. This dialog allows you to create, modify and manage the 
variants for your design. 

 

 

Use the New, Copy and Delete buttons to create and manipulate each variant. 

When you first enter this dialog, there will be no entries. On pressing New, you will automatically see 
<Master Design> displayed as the first entry. With any variants created, this is always available. If 
you delete all variants in a design, <Master Designs> will also be removed. 

Selecting <Master Design> from the list as the current variant temporarily disables the use of 
variants by showing all components as fitted. However, they are not treated as fitted, otherwise you 
would get DRC errors. 

Type the new Variant Name and optional Description in. 

Once a variant has been added, the variants list order may be modified using the Move Up and Move 
Down buttons. You might do this to change the order for aesthetic purposes or to sort them into 
alphabetical order but this does not affect their use. This will be the order they appear in once viewed 
in Properties or within the Variant Spreadsheet. 

If you wish to now use variants, you must select a variant name from the list before exiting the 
Variant Manager. 
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Assuming you have selected a variant by name before exiting, you may now make components in the 
design ‘variant specific’. Again, verify this by checking the Variant name in the program caption at 
the top of the window or within the Status Bar if this option has been selected. 

Dialog Switches 

The selection for Not-Fitted Components allows you to define whether these are displayed in the 
design by checking the Display box. With this deselected, Components that are not fitted will not be 
displayed within the design. 

Under Global Settings: you can use the Show Variant on Status Bar check box to automatically 
show you which Variant is currently in use. 

 

Selecting a variant name from the list and pressing Apply or OK will set this as the current variant in 
the design. 

Viewing the Variant status 

Once a variant has been created in the Variant Manager and selected in the Variants list, the Current 
Variant is displayed in the Pulsonix design caption at the top of the design window. This is your 
confirmation that a variant is selected and that it is the one required. 

The variant is shown as the design type (PCB or SCM) and the Current Variant name in brackets. 
This name changes as a different variant is selected in the Variant Manager. 

 

By double-clicking on the Variant name on the Status Bar, Pulsonix will display a short form of the 
Variant Manager to use. 

 

Components in Variants 

Introduction to the Properties dialog 

For a selected component, the Properties dialog allows you to edit its properties using the Variants 
page. It shows which variants the current component is fitted in and if there are Part variants. A 
fundamental rule of variants is that the bare board will be constant across all variants, so all pads, 
tracks and copper will always appear in the plots and finished board. 
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Parts variants allows you to have more than one component instance with the same component name 
but different Part or Footprint or Attribute Values in each variant. The rule is that only one 
component instance of a given component name can be not-fitted in each variant. 

 

Each named variant is shown for the component (USA, GB and EU). 

Colour coding for Properties dialog 

There are a number of possible colour states to help you use the Variant Properties dialog: 

The name of the Variant currently active in the design is shown in bold type and with an * asterisk. 
In the below example this would be the USA variant: 

 

The red line indicates the currently selected row for editing, it does not indicate the current variant. 

The row(s) for the component instance(s) represented by the symbol or footprint currently selected in 
the design are shown highlighted in blue text. 

If the component instance(s) selected is not fitted, it is shown in light grey. 

 

Instances that share the same symbol or footprint currently selected in the design but have different 
Attributes or Parts are shown in green text. If you change the variant to a different one, the ‘other’ 
component instance will now be highlighted green (as it is different to the current variant). 

Instances that use a different symbol or footprint to the one currently selected in the design are shown 
in a darker grey. This overrides the green colour if the Part or Footprint are different to the selected 
variant. 

The example below shows the GB Variant as the current variant. The USA version has a different 
Attribute value so is highlighted green and the EU variant has a different Part Name so is highlighted 
dark grey. 
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Display of Variants 

The display of your variants can be controlled in a number of ways: 

Through the Variants Manager 

Within the Variants Manager you can opt to display Not-Fitted Components (as well as plot or not 
plot them within a Schematic design, shown in the dialog below). 

 

In Schematics, Not-fitted Components/Gates together with any connections to their pins are not 
displayed (unless the Display Not-Fitted Components option in the Variant Manager has been 
enabled). 

Technology Layer Class 

Within the Technology Layer Class, the check box Comp. Items Visible In All Variants can also 
be selected to control the display of variants on particular layers. All items with an electrical layer 
class will continue to be displayed even when the component is Not-fitted. By default, all other ‘not 
electrical’ items will not displayed for Not-fitted components, e.g. Silkscreen shapes, although this 
can be changed by checking the Comp. Items Visible In All Variants option for the appropriate 
Layer Class. (As with Schematics, the Display Not-Fitted Components option provides a global 
override to force Not-fitted components to be always displayed.)  

It may be that you wish to see (and plot) variant detail on one layer but not another, such as on an 
Assembly layer specific to one variant but not on another that doesn’t require it.  
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If a shape is visible when Not-fitted, it can be drawn with the Design Settings, Variant Style by 
selecting the Use Variant Style option. 

Colours used for Variants 

Within the Colours dialog and Highlights, there are two available colours for use with variants. One 
is for Variants and the other for Not Fitted. 

 

The Not Fitted colour can be used to highlight not-fitted components that are still visible. It is best 
used in conjunction with the Display Not-Fitted Components option in the Variants Manager 
dialog. 

The Variants colour can be used to highlight any component that participates in design variants with 
either a Not-Fitted or Part Variant status change. 

Line Styles used in Not-Fitted Components 

It is possible to specify a line style to be used for drawing any shapes that are still visible for not-fitted 
components. This may be set within the Design Settings dialog under Defaults - Variant. Select the 
Line Style required. The line style is used in conjunction with the Display Not-Fitted Components 
option to provide the desired effect. 

Fitted Component Variants 

The Fitted column shows you whether the component is fitted or not in the design in a particular 
variant (components are fitted in all variants by default).  

 



338   Chapter 6 – PCB Design Editor 

A component cannot be Not-fitted if any other property has been modified, such as it having a 
different Part, Footprint or Attribute. 

Part Variants 

As well as the more simple fitted or Not-fitted status, Pulsonix can also cater for more advanced 
variant conditions of Parts. Part variants can include different Parts for the same component as well as 
different Footprints or Attributes. For example, you may wish to have a completely different Part with 
a different symbol or footprint; this can be positioned and connected independently. Alternatively, 
you may want the component to have different attributes, but still be represented by the same physical 
symbol or footprint.  

 

To make changes to the Part Name or Footprint or an Attribute Value, you can either double-click 
on the Part Name field or Footprint of the Variant you wish to change. 

 

Alternatively, right click on the Part Name or Footprint cell and choose the Change Part option 
from the context menu. This will present you with the Change Part dialog (as above):  
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To change an Attribute Value, double-click on the Attribute Value name and type the new value 
required.  

 

Component Variant Attributes 

As an aid to identifying the component instances displayed in the design, there are a number of 
Attributes specific to Variants that can be added to the Component symbol or footprint:  

Use the <Component Variant Id> where your component has different instances of the same 
component. It may be that the Part and Footprint are the same but the Value attribute changes. 
This unique identifier means the instance can be identified. 

A <Current Variant> attribute can be added to the symbol or footprint, this will display the 
name of the 'Current' variant selected in the design. 

The <Current Variant Description> is extracted for the current variant if it has been defined 
within the Variant Manager. 

You can also assign a <Fitted In> attribute to a symbol or footprint definition. This will 
display all variants the component instances represented by the symbol or footprint are fitted 
in. The variants in which the symbol or footprint represent a different component instance 
(because this has a different Part or Attribute) are shown at the end enclosed in brackets, for 
example,   first_variant,(second_variant)  i.e. USA,(GB,EU) 

These attributes can be added to the symbol or footprint definition using the Insert Attribute 
Position option. This will display the appropriate ‘Attribute’ for the component instance the symbol 
or footprint represents in the current variant. 

Variant Attributes 

Variants Text 

The ability to add text, specific to particular design variants is supported in the form of variant 
specific design level attributes.  

���� To use text variants 

1. Create a design Variant using the Variants Manager and switch to the required variant.  

2. In the design, add your text and position as required.  

3. Select the text and select Properties. On the Variants tab, select whether that text string will be 
Present or not in a selected variant. A description of the variant is also displayed for 
confirmation. 
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Variants Text Callouts 

Text Callouts can be defined as variant specific also. To do this, as with a text variant described 
above, selected the Text Callout and select the Properties dialog and Variants tab. Select the check 
box to show whether the callout is Present or not in that variant.  

 

Text Callouts for variants can be used in conjunction with variant specific attributes or text too to 
make them more meaningful. 

Text callouts that reference variant design attributes using attribute substitution will also not display 
or plot for variants in which the attribute is not present. 

Design Variant Attributes 

An additional Variant Attributes tab on the Design Properties dialog under the Edit menu allows 
design attributes to be enabled/disabled for the defined variants in a Schematic or PCB design or 
Profile.  
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To use Variant Attributes, the attribute name must first be defined in the Design Properties dialog 
under Attributes.  

 

This would be defined as an attribute with no value. The value is then edited within each of variants 
available. 

 

For each selected Attribute in each variant, the Fitted status can also be defined. 

 

Variant Doc Shapes 

You can have Variant Doc Shapes. A doc shape is added to the design and then using Properties of 
the shape, you can define which Variant the shape is fitted in.  

This is a PCB only feature and is not available in Schematics.  

 

Using the Database with Part Variants  

When using Part Variants, instead of using the regular Insert Component option, you can 
alternatively use the Database Connection cost option and specify variants from this instead.  

 

The Database field is now available (as the Part was taken using the Database Connection option). 
Changing Parts, Footprints or Attributes is pretty much the same as if using just Parts except the 
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information is extracted from the Database Change Part option is a field needs to be different for a 
different variant. 

 

If the Part Name is changed for a variant, unless it is chosen via the Database Browser method 
(shown below), any existing database information will be lost and it will revert to being a 'local' 
component for that variant. For a 'local' component, the database column will be blank. 

Other considerations for Variants 

Plotting Variants 

If variants are being used in a design, the CAM Plot tab of the Generate Plot and Technology 
dialogs will display an additional column; Variant.  

This defines the particular variant for which each output will be produced. This may be a named 
variant or <Master Design> in which case the output will be produced for the entire design 
independent of any particular variant. It may also be set to Current Variant in which case the output 
will be produced for the variant that is selected as 'Current' at the time the plot is run. 
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The CAM Plot Wizard Output page also allows specification, if necessary, of the variant for which 
the plot is to be produced. 

 

The Auto Generate CAM Plot dialog has an additional option Generate For Each Variant which, 
when checked, will create a plot per defined variant, for each process type that is affected by variants. 
By default in PCB, this will be the non-electrical layers and in Schematics will be each page in the 
design. 

 

The information included in each plot will be affected by the selected variant and the Components not 
fitted in that variant. In PCB, the Component items plotted are determined by the layer class of each 
item with electrical items, such as pads, always included, whereas other items, such as silkscreen 
shapes, are excluded although this can be changed by checking the Visible In All Variants option for 
the appropriate layer class. The items included in plots are not affected by the Display Not-Fitted 
Components option that applies to screen display only. 

If variants are in use in a design, a CAM/Plot report will show the name of the variant for which the 
plot was produced. 

Translate to PCB 

All variants information defined in a Schematic design will be automatically transferred to the PCB 
design when the Translate to PCB facility is used.  

Synchronise 

Synchronise Designs will additionally check and update all variant information as necessary. 

Optimise Gates 

The Optimise Gates feature in Schematics is variant-aware in that a gate will only be moved to 
another component if it is fitted and Not-fitted in exactly the same variants. 

Design Rules Checking 

Design Rule Checking is variant-aware in that certain types of spacing errors that would otherwise 
be reported are suppressed if the components involved are never fitted in the same variant. The 
spacing rules affected are component-to-component, pad-to-pad and drill-to-drill. Obviously, where 
different Parts or footprints are used on a component in different variants, these are also considered 
and checked. 
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Associated Parts 

The Associated Parts tab in the Design Properties dialog will reflect the design's 'Current' variant. 
Quantities of associated Parts added for components that are Not-fitted in the current variant will not 
be included. Additional quantities of Associated Parts added directly in to the design will be included 
in all variants. 

Quantities of Associated Parts relating to Not-fitted Parts will also be excluded from the Parts List 
Report. 

Auto-Rename 

The Auto-rename option is variant-specific. If a design has a 'Current' variant, Not-fitted components 
will be excluded from the rename. 

Copy and Paste/Duplicate 

Copying Not-fitted components will retain the Not-fitted information only for named variants that 
already exist in the destination design. Duplicate operations take place within the scope of a single 
design so duplicated components will always preserve the not-fitted state of the original but it does 
not retain the instancing. 

Variants Report 

There is a Variants Report supplied within the standard Outputs menu, Report option. This basic 
report lists all variants and Fitted or Not-fitted components in the design in a grid format. 

Report Maker Files and Variants 

Reports created using the Report Maker option can be variant specific by using the Variants 
commands available, such as List of Variants, Set Variant and If “Is Fitted”. 

Using ‘Instances’ for Variants 

Instances for variants are hidden unless you wish to display and use them. You would use Variant 
instances for example when a Component Variant has the same part and footprint but a different 
Attribute. When creating a report, you would then need to identify the instance using that Attribute 
Value. This would be done using the unique instance identifier. 

To enable Instances, right click in any of the cells within the Component Properties Variants page 
or Component Variant Spreadsheet, then choose Advanced View from the context menu. 

 

Once this option has been selected, the view now shows Attribute and Instance identifiers. 
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Variants Spreadsheet Editor 

You can view and edit variants in a spreadsheet style interface. The Component Variant 
Spreadsheet is available on the Edit menu in both the Schematic and PCB design editors.  

 

The bottom half of the dialog contains the edit pane for the component variant: 

 

Component Listing 

The top section is the component variant spreadsheet, with a row for each component and a column 
for each variant in the design. 
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Cells are colour coded to show the state of each component in a particular variant. The colour 
indicates whether the component is not fitted, is a different part, uses different attribute values or uses 
a different physical appearance. This makes the spreadsheet ideal for quickly viewing which 
components in the design use variants and which are not fitted in certain variants. The colour key 
coding can be changed using the buttons to the right side of the dialog. 

Component Edit Pane 

The bottom section of the dialog is occupied by a grid showing the variant details for the component 
currently selected in the top portion of the spreadsheet.  

 

This is similar to the Component Variant Properties dialog for a selected component but with extra 
controls for adding columns and managing values. It contains a row for each variant in the design and 
columns allowing you to change the components variant state.  

Cells in these columns are coloured depending on their 'state' using the same system as the 
spreadsheet. The name of the variant currently active in the design is shown in Bold text and with an 
asterisk * in the appropriate row. The table can be enlarged to show more variants. 

Micro-vias and Layer/Component Span Technology 

For Micro-vias to be created, the individual facets must be created in the correct order to enable 
subsequent processes and particular information defined. . 

Mainly, you must have two suitable layers defined that have Can Have Associated Layers enabled 
and the same facing directions (Top Facing, Bottom Facing etc.). Once in the Layer Spans dialog, 
this will now produce the correct type of layer span when created. 

Micro-via Layer ‘Facing’ Switch 

The Top or Bottom Facing switch in the Layers dialog (Technology, Layers) with Can Have 
Associated Layers checked, is used to define a Micro-via layer. For a Via Span to be a Micro-via 
type, it must have two ‘same’ facing sides. So for example, L2 and L3 must both be defined as facing 
the same way (Top or Bottom Facing). These must be defined before it can be considered as a Micro-
via when creating your Layer Spans.  
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When using Micro-vias, the ‘Facing’ direction must also be defined if the layer is to be used as a Stop 
layer in the layer span definition, Stop pads are described a bit further on. 

Allow Micro-via Stop Pad Either Side 

A check box on inner electrical layers, Allow Micro-via Stop Pad Either Side, allows you to create 
micro-vias onto the electrical layer from above or below, regardless of the facing value of this layer. 
You should only use this if you really know what you’re doing and following consultation with your 
manufacturer. This feature is described further in the online help under Technology Layers. 

Layer Spans 

For Micro-vias, once at least two layers have been defined using the same Facing switch, then the 
Layer Span can be created. Layer Spans are defined in the Layer Spans dialog from within the 
Technology. It is from here you can define layer spans to use for Vias, Micro-vias, Board Outlines, 
Areas and Components.  

A layer span becomes a Micro-via type by having the same Facing side on its Top and bottom 
Layers as we said already. To use a micro-via technology you should define the span between same 
facing layers.  

 

Layer Spans are created as you would normally using the Layer Span option from the Technology 
dialog. When a pair of layers are selected which have the same facing layers, the Type: is 
automatically changed to a Micro-via, this also shows the via ‘drill’ direction. 
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Composite Micro-via Layer Spans 

Composite Spans are used for connecting multiple layer spans together. So for example, you could 
span Top to L2 and L2 to L3 using two individual vias. Because Micro-vias would require these to 
have the same coincident ‘drill’ points for laser or plasma drilling, the most effective method of 
moving these would be as a set moving as one unit. A composite span will allow this to happen but it 
must be defined for use. 

A Composite Layer Span can be defined using a combination of Micro-via and normal spans. It is 
specifically used for creating a via ‘stack’, or more correctly, a Micro-via stack. That is, a stack of 
vias which together complete the span and which move together as one unit, this will usually involve 
a set of Micro-vias and sometimes includes a buried via.  

Defining the Composite Spans 

To do this, you must first define each span within the composite. Once created, define the Composite 
Layer Span by selecting layers from From Layer: and To Layer: using the drop down list. If these 
are legal layers which can create a composite span. The Composite Layer Span check box will be 
available. 

 

The dialog will offer each possible combination of spans which will cover this composite overall span 
(if there is more than one, press Next to cycle through each one). You can change a composite back to 
a normal span by unchecking the Composite Layer Span check box. 

Once you have a composite span defined, you must then define the Pad Style (this will be your via) 
to use on each via in the stack. Only nets which have composite styles defined in the Net Styles 
dialog can use the composite span to create stacked vias. 

Defining a Composite Via Span in Net Styles 

To use a Micro-via layer span or Composite layer span, you will require an entry in the Net Styles 
for a net within your Technology. When composite spans are used it causes a via stack to be added 
rather than a single via, each via in the stack using the pad style defined in the net styles entry.  
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Using Composite Layer Spans 

Composite via stacks can be added using Insert Via, or added automatically by changing layers of 
tracks. If using Insert Via, then the same restrictions to the function will apply as when using Insert 
Multiple e.g. no finish markers, test point or design clearance etc.  

Selecting a via selects all the vias in that stack, and the status bar informs you of this and the layers it 
spans.  

 

This is so the stack can be moved as one, but the individual vias in the stack can still be selected using 
the Select Next option. Once a via has been moved away from the rest in the stack, the stack is no 
longer complete and will not be selected as one item (as a composite). 

Composite span stacks can be shown in the Layer Stack Preview, and in the 3D Viewer.  

Stacked and Tapered Micro-vias 

By defining a Layer Span between two same facing layers, vias using this span are defined as a 
Micro-via. To add extra detail to your Micro-vias, you can define the via (in Pad Styles) as having an 
Entry Pad and/or Stop Pad. 

Entry Pads and Stop Pads 

There are two special Pad Style exceptions (defined in the Technology) for Micro-via Entry Pad 
and Micro-via Stop Pad. These define the pad sizes used on the entry and stop layers when the style 
is used for a Micro-via (unless there is an explicit exception for that layer, which will be used 
instead). These provide a simple method of defining specific Entry and Stop pad sizes, they are not 
mandatory for Micro-vias.  

This pad definition is used for creating ‘tapered’ Micro-vias, where the Entry and Stop pads are 
different diameters to match the ‘taper’ effect caused by the laser drilling. 
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A Micro-via showing a tapered hole 

It is also possible to create a set of ‘stacked’ Micro-vias using a Composite Layer Span. Without 
Stop pads, the laser will simply ‘cut’ to a depth or until it reaches a Stop pad. Multiple ‘tapered’ via 
spans are also possible using Composite Layer Spans using different Via Pad Styles. 

  

Two examples of Stacked Micro-vias (Composite) 

Creating Entry and Stop Pads 

���� To create entry and stop pads  

1. In the Technology and from within Pad Styles, use the By Layer option for a selected pad. 
Select the pad that requires the entry and stop pad definition. 

2. For Type: select Micro-via Entry from the drop down list. 

3. The Layer: box will now be greyed out as un-selectable. 

4. Type a value for Width: if it needs to be different to the default stack value and then press OK to 
exit and save the exception. 

 

5. Normally, you would also do the same for the Stop Pad so the laser knows where to enter and 
where to stop drilling, although this isn’t mandatory for some processes. 

6. The Stop pad is displayed as a solid pad even though the default pad stack is defined with a drill 
hole. The Entry pad is displayed with a drill hole shown (this is controlled on the Layer Class 
settings). 

7. The Pad Style entry for that pad would then look like this for example (shown for Via 400 120): 
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Outputs for drilling Micro-vias 

Micro-vias are ‘drilled’ (using a laser or plasma ‘drilling’ machine), an output is exported from 
Pulsonix using the standard Excellon NC Drill format. Special customised reports can be generated 
using the Report Maker option on the Outputs menu if required. All pad styles on any layers and 
the drill position can be output if required, there are special Report Maker commands to allow this.  

Advanced Technology Features 

Autorouting 

Pulsonix supports a number of Autorouters for automatically routing your design, these are described 
in the Online Help supplied with the product.  

Interactive High Speed Design 

An additional cost option to allow you to interactively route the design using High Speed design 
rules. This option is described in the Interactive High Speed Users Guide supplied as a PDF file and 
available from within Pulsonix under the Help menu and Online Manuals> 
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Chapter 7. Outputs For PCB Manufacturing 

Overview of manufacturing outputs 

Pulsonix provides you with an output mechanism for generating professional PCB layout plots for 
manufacturing. The plot types available will cater for home production of PCBs, right through to 
professional fabrication facilities.  

All the plot and drilling outputs are located in the CAM/Plot option on the Output menu. From this 
option you can select the layer, or combinations of layers to plot, the scale, the rotation, the position 
on the plot and the ‘machine’ driver. 

From this option you can output: 

• Gerber 274-D, 274-X (extended Gerber format) and X2 format photo-plots  

• PDF Files for documentation purposes 

• Numerically controlled drilling (NC Drill) files 

• ODB++ format 

• HPGL Pen plots 

• Windows printer plots using any installed Windows driver 

• IPC-2581, IPC-356 format files 

• JTAG files  

• Format files created in the Report Maker option, such as BOMs, Pick & Place, Flying Probe etc. 

• STEP, DXF and IDF format files 

• SVG graphics format 

• Other formats can be exported if you have an appropriate license 

Plot types 

Plots are available for all aspects of the design but because Pulsonix uses a configurable output 
mechanism, it means that any plot required can be generated:  

• Top, bottom and inner electrical signal layers 

• Silk screen layers 

• Solder resist plots 

• Solder paste masks 

• Copper and power plane (full or split) layers 

• Assembly and manufacturing drawings 

• NC Drilling and profiling/routing files 

• Back Drilling drill files 

• Drill drawing layers containing Drill letter, Symbol 

• Inner layer embedded component layers 

• Embdedd Views 
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The CAM Plot option 

Using the CAM/Plot option 

Use the CAM/Plot output option to export your design to manufacturing files. This option is 
available on the Output menu. It provides you with a mechanism of generating different types of 
plots using one dialog. It also provides you with a process that can saved to be used over and over 
again from a single button press. 

The CAM/Plot setup parameters are saved to the Technology dialog under the CAM/Plot tab. This 
means that different designs using the same plotting parameters can be defined and reused. The 
plotting mechanism uses items within the design and on particular layers to create the contents of the 
plot. The layers are controlled by the Technology file and the Layer Classes within it. 

Outputting a plot overview 

The process for creating specific types of plots is covered in this chapter. The description below is the 
‘fast-track’ to outputting a plot. 

Once the Auto Generate dialog has been used, the bulk of the work to create a plot has been done 
other than any 'fine tuning'. The Auto Generate dialog has been designed so that any rotation, any 
scale plot to fit is specified by default. This means the plot will fit the paper if the Run button is 
pressed. Obviously, you can use the CAM/Plot dialog to redefine the plot as required.  

���� To output a plot 

1. The plot type should be defined in the CAM/Plot dialog. 

2. The correct printer or plotter should be specified in the Settings dialog. 

3. Check that the plot is as required using the Preview dialog and select the plots required using the 
Enabled check boxes. 

4. Check that the plot fits the plot area or ‘bed’. 

5. Press the Run button. 

Outputting a Windows Print to File and PDF 

Pulsonix supports standard Windows printers. This means your plots can be sent to any device that 
Windows supports, such as a laser printer, PDF file or a Windows print File (Postscript for example). 
As well as Windows ‘printers’, Pulsonix also has its own built-in PDF driver which can be directly 
selected as an output device type, the same as you would for Gerber, Excellon, Windows etc.  

Auto Generate Plots  

If the parameters are not available the first time you try and enter the CAM/Plot option (or the first 
time you enter Technology and the CAM/Plot page) you are presented with a dialog to request auto-
generation of the parameters. This is a smart system that matches the class of layer with a potential 
plot type. So, for example, an Electrical Layer class such as Top Copper, would be plotted to Gerber. 
These plots can be changed at any time but creating them using this mechanism gets you started very 
quickly. You can still generate additional plots outside of this mechanism if you require using the 
CAM Plot wizard once in the plotting dialog. 
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If you click No to this, the CAM/Plot mode is entered but you will need to create the parameters 
manually. If you click Yes, the Auto Generate CAM/Plots dialog is displayed: 

 

Once in the CAM/Plot dialog, you can create other plot or output types. For non-plot outputs, such as 
IPC-2581 or DXF etc. you will probably use the CAM Plot Wizard. 

The CAM/Plot dialog 

Overview 

The dialog itself has four pages available through the tabs CAM Plots, Plot Settings, Drill Sizes and 
Plot Preview. 

 

CAM Plots is used to set up the characteristics (or rules) of the plot, the scale, rotation, plot type etc. 

Plot Settings is used to set up the plotter or printer being used. This dialog also contains a location for 
the destination of the plot output if a file is being output. 

Drill Sizes is used to set up drill holes, drill letter association, drill symbol association and suchlike, 
all facets used for drills holes. It also enables you to define drill sizes and tolernances available. 

Plot Preview is used to display a preview of the final plot. This should provide you with an indication 
of what the plot will look like before it is plotted or printed. It is not a 100% 1:1 representation 
showing everything on that layer. 
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At the base of all the panels are controls to Run the selected plots, Cancel the CAM Plots dialog and 
to Apply all the settings within the CAM Plots dialog. Using this will save the plots without running. 
Once Run is pressed, the plots are produced and the settings on this dialog saved. The Close button is 
displayed instead of Cancel once the Apply button has been pressed, this also closes the dialog. 

  

Plot Preview 

This dialog allows you to select the plot required for preview before outputting it. Each selected plot 
is drawn in the Preview window (if the Preview Design check box is selected). The plot is 
represented using a Plot Name defined on the CAM Plots page, it is recommended that you use clear 
concise names to help identify the type of plot being output.  

 

The Fits column will display No if the plot does not fit the paper or plotter area, or Yes if it does. 
Most times you will be able to see if the plot will fit, but if marginal, this acts as positive confirmation 
that it will or won't fit. If the plot doesn’t fit, you will need to change the scale of the plot or change 
the information being plotted using the CAM Plots page. 

The Enabled check boxes will allow you to select which plots will be output when the Run button is 
pressed. This means you can opt to run all plots required in one single button press regardless of the 
plot type or device driver. 
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The Preview window displays the plot selected in the list. It shows two main boxes (shown with a 
centre 'cross' in each to help identify the centre of the plot). The first is the plot bed (the paper extents 
or the bed size), this is the larger box shown in Red. The second box is the design extents shown in 
Blue. Also shown is the board outline and elements of the design to give you an indication of the 
orientation and the scale relative the paper. The preview window can be switched off by deselecting 
the Preview Design check box. 

All other information shown in this dialog is confirmation of the CAM Plots dialog settings, such as 
the Scale, Mirror and Rotated status of the design. 

CAM Plots 

The CAM Plots dialog is used to set up the plot for output and how the plot will appear on the output 
driver plot ‘bed’ being used.  

If a regular plot is required, the plot can be almost completely defined using the Auto Generate 
dialog when you first enter the option. The Auto-generate option can also be run to regenerate the plot 
settings automatically. Some plots may in fact be totally auto generated using this option. The only 
setting you may need to adjust is the plotter type for a PDF output or the Exclusion of items not 
required in the plot. 

 

The grid matrix displays the options selected for each plot. Once created using Auto Generate or 
New button, you can edit the information in each row to suit your requirements. 

If no plots exist or you require a new plot, you can use the New button which will use the Plot 
Wizard to complete this task. The wizard will lead you through the plot type generation process to 
create a new line in the CAM Plots table. If you have a plot selected, New copies the properties of this 
existing plot into the Plot Wizard. 

After the row has been created, it can be edited interactively or by using Edit, but the row or item in a 
row must be selected first.  
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The Edit button displays the Plot Wizard. Each of the pages of the plot wizard will allow you to set 
up facets of the plot to be output. See later in this section for an overview of the Plot Wizard 
functionality. 

The Delete button is used to remove any unwanted plots from the grid. 

Add To Plot is used to combine plots and is more relevant to the PCB Design editor. When selected, 
it displays the Process page of the Plot Wizard from which to choose a process to add to the plot 
selected. The Add To Plot option will add the plot to any other plot selected. If it gets added to the 
wrong plot by mistake, select it, and use the Delete button to remove it. The plot must then be 
recreated with the correct plot type selected first. 

If when you started the CAM Plot option, you selected No to Auto Generate the plot type, you may 
now use the Auto Generate option to create a set of plots ready for use. This can be an alternative to 
using the New plot option but will create a full set of plots for the design, replacing any existing plots 
in the table. Use New if you wish to add to the existing set of plots. 

The Reports button is used to generate a summary report of all the plots and their settings. This is in 
addition to any reports generated at the time of actually running the plots. 

The Step & Repeat button allows you to panelise your designs. This is covered below.  

Step & Repeat 

There are two mechanisms in Pulsonix for creating ‘panelised’ designs. Which option you choose 
depends on what your final requirement is. 

You have the Step & Repeat option on the CAM Plot dialog and a separate integrated Panel Editor 
option. This mode opens a Panel Editor application within Pulsonix from where you can do multiple 
processes such as add V-Score lines, test coupons or tab routs for example. 

The Step & Repeat option on the CAM Plot dialog allows you to plot multiple copies of the same 
plot with a specific offset or defined gap between them. It also allows an overlaid plot of different 
colours in one plot and allows true step and repeat for the same plot by using the Add To Plot button 
and offsetting it each time. It however, doesn’t allow you to plot different PCBs or to add extra 
details, such as test coupons. 

You must have a combination of the Step & Repeat criteria and you must enable each of the plot 
outputs to specify that this feature will be used. This is done using the Step Repeat check box 
available for each plot on the main CAM Plots dialog. 

 

The Step & Repeat button opens up this dialog. From here you can define the number of copies to 
create on the plot for both the X and Y direction in an array. It also allows you to define the offset 
between each board plotted. 
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The Step Offset defines the distance each copy is offset from the previous one. There are separate 
values for X and Y.  You can define the offset as Absolute which means that it is the total offset. 
Therefore an Absolute offset of 0 would put each copy exactly on top of the previous one (not 
recommended).  

A Separation offset is the gap between copies. In PCB this is the separation between Board Outlines 
(if any), otherwise it is the separation between design areas. An offset of 0 would align the edges of 
each plot.  

Number of Copies, defines the number of copies in the X & Y directions. These numbers include the 
original as the first copy (so they start from 1).  

Note: the offset and number of copies are defined in the X & Y directions before any rotation has 

been applied. The Plot Preview will give you an indication of how the final plot will appear.  

Plotting Variants 

If your design has variants defined, an extra tab on the CAM Plots dialog allows you to specify which 
variant it is you wish to plot. You can use specific variants or plot the <Master Design>. 
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Plot Groups 

You can group plots using the Plot Group name option. This enables sets of plots of the same type to 
be enabled or disabled. The Group column only appears if any of the plots have a group name 
defined.  

The Enabled setting (box checked or unchecked) can be applied to plots in the same group by 
selecting this option from the context menu. For example, you could group plots by output device or 
process if you wish, i.e. Windows/Gerber etc. or Documentation/Manufacturing/Prototype etc. 

 

You can create a plot using the CAM Plot Wizard and add the plot to the Plot Group. Either select 
an existing plot group name from the drop down list or type a name in. This group can be selected by 
name when in the main CAM Plot dialog. If you wish to add existing plots to a group, from within the 
CAM Plots page, you can select a name from the Group drop down list or type a name in. 

You can optionally provide a Plot String which is used to satisfy any Attribute Positions of type 
<Plot String> placed on your design. This could be used to define a reference number or other 
identifier on your output. 

 

Using the Plot Wizard 

The Process page defines the Name of the plot and the output type using Output To. This will be 
present all formats available for output or Nothing. Nothing would be selected if the plot type was 
undetermined at the time that the plot type was created.  

The plot name is for reference only to identify the plot. It is recommended that you use meaningful 
names that help identify the plot that they represent.  
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If the selection is set to Windows, you are presented with an extra drop down list from which to 
choose an alternative printer to the default Windows printer. Leave the setting to <Default Printer> if 
you wish to simply use the default Windows printer assigned by your system. 

 

If the selection is set to one of the non-‘plot’ type of outputs, like DXF or IPC-2581 for example, the 
dialog has a Setup button. This provides you access to that formats’ main setup page. This is the same 
as if accessed from the Output menu.  

 

If the selection is set to Format files, then the extra drop down list box is presented for you to make 
your selection. The choice of Format files will be taken from the Folders dialog. You are also 
presented with a choice of Output Locations 
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The Output selection is used to define the style of plot output. 

 

Choose the Variant required from the drop down list if your design has variants defined. You can 
also opt to  

The Process button allows you to select the Layer or process type to be output. 

The Style of the plot can be either Artwork or Outline. Artwork will output the true width of all 
items whereas Outline will only output the item as a centreline unfilled shape. The outline mode 
would be used for check plots, for example. 

The Mirror check box enables you to select whether the plot is mirrored or not. 

When a power plane layer is selected (the layer must be defined as a power plane in the Layers 
dialog) Plane Style is used to determine the style of the plane output.  

The choice of Plane Style are, a Positive (plan & items), a Negative (only plot gaps) plot, a 
Negative (plot isolation) and a Positive (only plot items) plot. Generally, a Negative plot is 
requested which produces a smaller plot file, this will be reversed electronically when plotted by the 
plot house. A positive plot would be used when creating a composite plot of the plane layer that has 
embedded tracks, this is discussed later on in this section. 
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Not available for Pen plot outputs. 

 

Available for all plot types. 

 

Not available for Pen plot outputs. 

 

Available for all plot types. 

Plot Drilled Out Pad Holes - If the current plot is plotting holes in pads, normally this will be a hole 
in the copper land. If the land is smaller than the hole, then the land would be drilled out completely, 
so nothing will be output. However, with this option check, the drill hole is output as a copper shape, 
the same size as the drill hole. This might be useful, if you are hand drilling the holes and need a 
marker. As this is a specialised use, this option is off by default.  

Positive (plane & items)  

This is the full power plane output with isolation gaps and embedded tracks with isolation clearances 
and thermal relief where connected to the plane. 

Negative (only plot gaps)  

This is used to produce a plot of all the oversize items in the plane, mainly for the Gerber output, to 
be reversed and combined with a Positive (only plot items) plot. 

Negative (plot isolation)  

This is used for to create the full power plane with isolation gaps, thermal relief and embedded tracks 
(with isolation) but in negative mode. To create the power plane from this plot, the image would need 
to be photographically reversed. Producing this type of plot saves printer toner and can be 
photographically reversed to get the plot image required. 

Positive (only plot items)  

This is used if the power plane contains 'embedded' tracks or items. This plot is the item itself without 
any isolation or thermal relief. This would be used in conjunction with the Negative (only plot gaps) 
plot to produce a power plane with embedded items for a Gerber plot. 

From the Exclude button you can also select which items to exclude from the plot. If nothing is 
selected in this dialog, all items visible in the design are plotted. 
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Items to be excluded are selected and added, using Add>>, to the right hand pain shown as NOT to 
be PLOTTED. Use <<Delete to remove the excluded item from the list. By default, some items are 
automatically excluded, appearing in this list but from which, they can be removed if required on the 
plot.  

The Size page uses selections to define the Scale and Rotation of the plot. 

 

For Scale, the choice on the drop down list is Auto Fit and 1.00 (a scale of 1:1). You can also type in 
directly into the list to define your own scale factor to shrink or expand the plot, e.g. 5 to make it 5 
times bigger or 0.5 to make it half the size. 

The Rotation drop down list allows you the choice of Auto Rotate, No Rotation or Rotate 90 
degrees (forcing the rotation to 90 degree from its original position). 

The Design Position page defines the position of the plot relative to the plotter type being used. 

 

The Design Position provides a number of options from which to move the design on the plot. This 
design location specified is aligned with the location on the paper or plotter table, and specified in the 
Registration Point which is set in the Settings tab for each device driver. This allows accurate and 
repeatable registration of plots to be achieved if the correct combination of values is chosen. 

For example, if both Position and Device Registration are set to Origin, the design origin is aligned 
with the origin (0,0) on the plotter. 
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If either the Position specified here or the device Registration Point are set to Auto Shift, then the 
plot is positioned as best as possible on the output device. 

The Step & Repeat check box will allow you specify that a plot is to be panellised. See previously in 
this section for a more detailed description of Step & Repeat. 

Use Crop Output To a defined area to prevent items outside this area from being plotted. The 
cropping is only done crudely, so items that cross the area will be plotted. In general, this would be 
used for a set of items which form a coherent subset of the design which you would want to position 
within the overall plot. 

The Finish page provides you with a summary of the options selected in the Plot Wizard.  

 

Once the Finish button is pressed, the plot type is generated and added to the plot grid. If you decide 
to change any of the settings, you can go back to the page directly or by using the <Back button to 
move back through each page in sequence. 

Plot Settings 

Plot Settings is used to set up the printer/plotter and the location of the files output.  
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From the Output Device section of the dialog, you can view and change the settings for each kind of 
output device available. Use the drop-down list to choose the output device you wish to look at, and 
the current settings will be displayed in the large text area below.  

If you wish to change any of these settings, press the Setup button to access the Setup dialog for the 
output device shown. The actual dialog displayed is different for each kind of output device 
(Windows, HP-GL Pen etc.). You can also Save and Load configuration files (Save/Load To File)for 
each of these device types. For example, if you have one plot setting for Gerber 274-D and one for 
274-X, you can define these and save the settings for reuse. 

Options on the right side of the dialog allow you to define where the plots are saved to and how the 
plot names will be formatted. 

Drill Sizes 

The Drill Sizes button enables you to setup the drill table to associate drill letters with particular drill 
sizes, these appear on a drill drawing and drill table in the design. A Drill Drawing is produced by 
plotting a Layer Span to a ‘drawn’ output device (such as Windows or Gerber output). 

The Drill Table 

This page allows you to view the drill sizes used in the design, and assign a string identifier and shape 
to the drill for use with a drill drawing.  

 

There will be an entry for each drill referenced by the Pad Styles defined in the Technology. Plated 
and unplated drills are counted separately. The drill is marked as Used if the drill actually appears in 
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the design (not just in the technology). Subsequent columns define how the drill should appear on a 
drill drawing.  

The Id is a string which will be shown alongside the position of the drill. The string does not have to 
be unique and can be empty if no identifier is required. The text style used for this string is defined in 
the Drill Id Text Style control.  

The Symbol is a shape which will be shown at the position of the drill. If can be any of a number of 
predefined shapes and is create at the size (width/diameter) specified in the Symbol Size column. The 
size can be 0 if no symbol is required. The symbol can be filled or unfilled according to the value in 
the Symbol Filled column. For some shapes the filled value is not relevant.  

Drill Sizes and ID 

The information contained under the Drill table relates to how the drill letters and symbols will be 
presented in the plot.  

 

The Allowed Drill Sizes feature allows you to define a list of drill sizes. This is useful if your 
manufacturing process only allows a specific limited set of hole sizes to be drilled.  

 

Press the Define Allowed Sizes button to define this set. All drill sizes must match sizes from this list. 
Any which do not match are drawn in red in the drill list. For a drill size to match it must be in the 
range [Allowed Drill Size - Step - Tolerance to Allowed Drill Size + Tolerance], if there is more 
than one match, the smallest is taken. The Step and Tolerance can of course be 0, forcing an exact 
match.  

For example, if the allowed drill sizes were 18, 19, 23 with step 2 and tolerance 0.1; actual drill sizes 
of 15.9, 16.5, 18 would match 18; sizes of 18.2, 19.1 would match 19; 15.8, 20 or 23.2 would not 
match any allowed size and would be drawn in red in the table.  
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Manufacturing Outputs 

This section details the creation of specific types which may be required for manufacture. These plots 
may not always have been setup initially with the design or may not be available in the Technology 
file used, so this section will describe the steps you need to follow to set them up. 

Creating the plot types 

Essentially, plots are controlled by a number of factors, all of which can be defined in Pulsonix 
allowing you to create the required plot. Because Pulsonix uses design items to create the plot, if it 
exists in the design then it can be plotted.  

How are the plots controlled? 

The contents of plots are controlled from with the Technology file using the Layers dialog and 
Layer Classes within it. These technology items control any layer information and layer plot 
information for the design that uses them. 

 

Where a specific plot type is required you should create a layer in the Technology file that will be 
used when outputting the plot layer. 

By default, the Technology files supplied with Pulsonix already have ‘standard’ manufacturing layers 
setup within them. If you import a design from another system and elect not to use one of these 
Technology files during import, you will need to add the additional layers before generating the 
manufacturing plots. 

Not only does the layer need to exist but the Layer Class must also contain the correct setup required 
for that layer. This ensures that items will exist on the layer so that when plotted they appear on the 
plot!  

For this purpose, you should create named Layer Classes that can be used for each layer type created. 
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To use this dialog, you must create a Class Name first to identify the Layer Class. The Layer Type 
will define the way in which the layer class is used, and by default, has default settings. 

On non-Electrical layers (Electrical, Construction and Documentation layers are pre-defined), you can 
control what types of Pads will be displayed and plotted using Pad Types. This is used in conjunction 
with the Pad Condition and Pad Appearance sections to customise which Pads are displayed and 
plotted, and how they are plotted.  

For non-Electrical layers, using Pad Condition you can control which Pads are plotted according to 
the type of pad. So you can choose to plot Surface Mount pads by checking the Surface Mount check 
box, or you can ONLY plot pads which are Testpoints by checking the Only If Testpoint check box.  

For non-Electrical layers the Pad Appearance will enable you can choose to plot the Pad Land, its 
Drill Hole, or both, subject to the conditions specified.  

The Areas check boxes are used for selecting whether Component areas or Design areas are enabled 
in the view and plotting of the design. 

Break Silkscreen is used to break the Silkscreen over holes and vias to stop the silkscreen paint 
going down the hole. You select from the two specific options – Break Around Pad and Break 
Around Text. The Gap between the item and the hole can also be defined using the current design 
units.  

The picture below shows the effect of break silkscreen: 

 

Without Break Silkscreen pads  With Break Silkscreen pads 

For pad items to be plotted, the pad item must be enabled on the Layer Class dialog. This also applies 
to the Board Outline that will not be plotted on a particular layer unless enabled on this dialog. 

Plots are created and generated from within the CAM/Plot option. Items not required can be excluded 
and the plot ‘crafted’ using scale, rotation and mirroring to fit the plot bed. 

These features are discussed below as they are used. 
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Types of manufacturing plots 

Top/bottom electrical layers 

The Top and Bottom layer plots, sometimes referred to as Component and Solder layers are generally 
the most basic type of plots. Unless very specific plots are required, they can be generated using the 
Auto Generate option with almost no additional interaction.  

Generally, electrical plots of the Top or Bottom layers will be created to include all electrical items, 
such as pads, vias, tracks, copper, copper text etc., which are also subject to the Design Rules 
Checks. Unless you have excluded any items using the Exclude option within the CAM/Plot 
Wizard, all electrical items defined on these layers (and defined in the Layer Class) will be output. 
The Exclude option acts as an over-ride to the settings in the layer class.  

As most designs will have at least one layer, a Top or Bottom or both, then the Technology file will 
already have the minimum required to generate the electrical plots. 

 

With a Layer Class of an Electrical type, the Pad Type and Pad Condition are fixed. Layer types of 
Electrical are always displayed and hence available for plotting. The only items that are optional for 
your selection are the Board Outline and Drill Hole appearance. The Drill Hole appearance is a user 
preference but the board outline may need further consideration. If you enable Board Outline, it will 
appear output on all plots that use this Electrical Layer Class name, this might not be what you really 
want and an alternative method of adding this is available. A more detailed discussion on adding the 
board outline to a plot, is given below. 

Adding the board outline to plots 

Board outlines can easily be added to plots. There are two methods available for including the board 
outline depending on how you decide to setup the system. 

The default method as supplied with the default Technology files is to include the display (and hence, 
plotting) of the board outline in the Layer Class definition. This is also the default setting when using 
the Reset To Default button. 

Using the Board Outline visibility switch in the Layer Class means that any Layer definition that 
uses this layer class will have the board outline plotted (unless you exclude it from the CAM Plot 
dialog).  
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The second method is to create a separate layer that displays the board outline. The board outline 
exists on all layers in the design, again, its display and plotting is controlled through the Layer Class. 
A new layer class would need to be created. The contents of this new layer class would need to reflect 
the display of the board outline only. All Pads and Vias would be invisible (not selected), as would 
Pad Appearance. The Layer Type would need to be Non-Electrical. 

 

A new layer on the Layers page would also need to be created which uses this new layer class. 

 

 

To use this new layer, you will need to combine this with other plots to include the board outline. 
From with the CAM / Plots option, you will need to use the Add Plot option to add the Board Outline 
layer to other plots. Plot combining is described in more detail below. 
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Creating Silkscreen layers 

Silk screen layers are non-electrical layers which appear on the Top or Bottom layers of the design. 
By default, the supplied Technology files are setup to include a Top and Bottom silk screen layer 
which use the Silkscreen layer class.  

 

The default Silkscreen layer class excludes all pads and vias but includes the board outline, although 
this isn’t always required. 

If the Technology file does not contain a Silkscreen layer this can be added using the Layers dialog in 
the Technology option. This layer should contain a Layer Class that restricts the display and plotting 
of the pads and vias. 

Break Silkscreen is used to break the Silkscreen over holes and vias to stop the silkscreen paint 
going down the hole. You select from the two specific options – Break Around Pad and Break 
Around Text. The Gap between the item and the hole can also be defined using the current design 
units.  

As with the electrical layers, the Auto Generate option will generate both the Top and Bottom 
Silkscreen layers automatically if they don’t already exist in your Technology file. 
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Creating Solder resist masks 

Solder resist masks are used on the Top and Bottom layers to ‘mask’ the electrical layers when using 
a soldering process (automatic or manual). To ensure that only items that require solder are exposed, a 
mask is made of the outer layers. This mask is made up of the plated through holes and surface 
mounted pads including vias, Doc symbols, mounting holes and free pads.  

 

Generally speaking, solder resist masks require an oversize on the plots to allow for mask shrinkage, 
movement and inaccuracies in the plot. For this oversize you should consult your board manufacturer 
but they will require approximately a 5 thou oversize on all the pads. Use the Oversize When 
Plotting entry box to enter a suitable value. You can also grow plots by a percentage value but 
consult your manufacturer first. 

If the Technology file does not contain a Solder Mask layer this can be added using the Layers dialog 
in the Technology option. This layer should contain a Layer Class that contains all of the pads and 
vias. 

Once the Solder Mask layers have been created, you use the CAM Plot option to output the plot. 

The Auto Generate option will generate both the Top and Bottom Solder Mask layers automatically 
if they don’t already exist in your Technology file. 

Creating Solder paste masks 

Solder paste masks are created and used when soldering surface mounted which use a solder paste 
rather than conventional solder techniques. The solder paste is applied to the board using a screen 
printing method. Once the surface mounted devices have been placed on the board the board is run 
through a heat source (a vapour phase or infra-red) and the solder paste melts, attaching the legs of 
the device to the pad. 

For this mask you will require a Pads only plot but of the Surface Mount type only. 
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The mask is usually made slightly undersize to allow for the expansion of the paste when heated. The 
undersize will depend on the manufacturer and the heating method being used, you will need to 
consult the assembly house before specifying this value. Be aware that there is not always an 
undersized value used, a normal size plot is often used with a zero pad oversize value. 

To create the undersize on the plots, use the Pad Oversize: area and choose between Absolute and 
Percentage of Pad Size entry boxes. Add the value using a minus number, e.g. -5.0. This will shrink 
all the pads on the plot by this value. You can also shrink plots by a percentage value but consult your 
manufacturer first. They prefer a plot of the required pads but with no growth or shrinkage so they 
can do this themselves to their own specification. 

A small word of caution, most manufacturers prefer to receive a Paste Mask of the required layers but 
using a zero value over/under size. This allows them to adjust the mask layer to their own 
specifications and tolerances. 

If the Technology file does not contain a Solder Paste layer this can be added using the Layers dialog 
in the Technology option. This layer should contain a Layer Class that contains Component pads, no 
vias and includes surface mount pads. It can also include Doc Symbol Pads, Free Pads and 
Mounting Holes if required and if surface mounted. 

Once the Solder Paste layers have been created, you use the CAM Plot option to output the plot. 

Generating Power planes 

Full layer power planes that are defined as being internal to the board can be generated using the 
CAM Plot option. You can also generate power planes for any layers, internal and external, with and 
without embedded items (such as tracks). This is more involved and is discussed later on in this 
section.  

There are also partial power planes that exist on outer layers normally, although they can exist on 
internal layers as well. These are created using the Copper Pour option and pre-defined Templates. 
They are output along with electrical layers. 

Full power planes can contain one signal for the complete plane or multiple signals on the same plane. 
To create a split power plane you must use an un-poured Template on the power plane layer. This is 
discussed later on in this section. 

For any layer to become a power plane it must be defined with certain criteria. It must be defined as 
Power Plane layer in the Technology file, and if using thermal connections to this plane, must have a 
Net name associated with it. 
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In the example dialog above, the Ground and Power layers have a Bias of Power (Power Plane) and 
Nets associated with them, Gnd and VCC respectively. The New or Edit options will allow you to 
create this layer. 

 

From this, any pads which pass through the power plane and which uses the same net name will be 
connected using a Thermal connection or thermal spoke. The connection will be made according to 
the rules defined in the Technology file under Thermal Rules. 

 

 

With these items defined, the CAM Plot option understands how to process the power plane layer. 
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Unlike other electrical or non-electrical plots where items rather than planes are being plotted, the 
plots required for power planes require more interaction. 

If you use the Auto Generate option to create your basic plot types to start with, power plane plots 
are automatically created and included if your Technology has power plane layers defined. 

If the plane layers are added afterwards in addition to existing layers, you can use the CAM Plot 
wizard in the CAM Plot dialog to generate the required plane plots. 

The Process page of the CAM Plot wizard enables you to define the Name of the plot. Output To 
will allow you to select the device to output the plot to. 

The Output page displays information about the style of the plot because the layer is already defined 
in your Technology, the Process box will contain a layer called Ground, this will be shown as Layer 
Ground.  

The Style of the plot can be Artwork (true size of all items in the plot) or Outline (a centre line 
check plot). For power planes, you would normally use Artwork. Mirror allows the plot output to be 
mirrored. You might use this when plotting the bottom side of the design so that the image plotted on 
film is closer to the board for the photo-resist process. 

 

The Plane Style is used to define the type of power plane plot required. For most instances where a 
power plane plot file is supplied for plotting, a Negative plot is generated. This will be a plot of the 
gaps only but will be reversed by the plot house. The effect of plotting the plane as negative is that the 
plot is significantly smaller than if a positive plot is output, this can be a factor of 20-30 times smaller 
in the case of large designs. 

Where plots are combined as would be the case in a composite plot of a plane with its embedded 
tracks, a positive plot would be used as well. This is discussed later on in this section. 

The following pages of the wizard setup the scale, position and rotation of the plot. This is the same 
procedure for all plot types. 

Verifying the Power planes 

Pulsonix has a feature for viewing the full power plane layers without generating the plot first. This 
option uses the same CAM Plot mechanism used to generate the actual plot files so you can see the 
results live before they are created.  
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���� To view powerplanes in your design 

1. Create a Powerplane layer in your Technology and assign a Net Name to it. 

2. You can use the View Powerplane option to view planes before they are plotted.  

3. To do this, display the Layers Bar (from the View menu) also Ctrl-L by default. 

 

4. For the Powerplane layer in the list, Ground in this case, there will be a Powerplane indicator 
next to the layer colour 

 

5. This indicates the thermal relief of a powerplane. 

6. Select this symbol. The symbol changes to a negative and the design will now be drawn in 
powerplane view. 

 

7. Using the Layers Bar, you can also make the powerplane stand out more by switching off other 
layers. 

8. Once you have finished viewing your powerplane, switch back to a normal view by selecting the 
thermal relief symbol again. It will revert back to a positive image. 

9. Alternatively, you can find this functionality on the View menu under the View Power Plane> 
option. From this, you can Display the powerplane, Regenerate the powerplane view if items 
have been edited or moved on the design, and you can Hide the plane view to revert back to a 
normal view. 
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The full plane is displayed like this: 

 

With a small section when zoomed in looking like this, clearly showing the thermal connections and 
isolation with the plane. 

 

As with all plots though, you should always check that the final plot is what you expect it to be. To do 
this it is highly recommended that you use a dedicated Gerber viewer utility; these are available from 
numerous webs sites on the internet. 

Windows Verification Plots 

You can also use the Produce Windows Verification Plot option from the Gerber Setup dialog on 
the Plot Settings page of the CAM Plot option. This will automatically produce you a Windows print 
every time a Gerber output is run. 

 

Using the Isolate From Plane option 

There are some special cases where you may wish to change the thermal ‘connections’ to the power 
plane to be completely isolated or to be a solid connection without thermal relief or isolation gap.  

For each pad on the net you can select its Pad Properties. From this dialog, using the Pad page you 
can change the property of the Power Plane Connection. This is also available when creating the 
footprint in the Footprint Editor. 
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Isolated will give you a complete isolation from the plane (see note below),  
Not Isolated will make a solid connection to the plane, and Thermal Pad will give you the ‘normal’ 
thermally connected and isolated connection. 

 

When the Isolated option is used, if this pin is not connected to the plane, you can run the Net 
Completion Report from the Report option to identify any splits. 

Composite Power planes 

Where power planes contain additional items such as tracks, the generation of the plane can be done 
in two way; single combined plot or a two-plot composite created in two-stages. The single composite 
plot created in Pulsonix may not be suitable for some manufacturing processes, hence the two-stage 
process plot output would then be required. Both methods are detailed below. 

Single composite plot 

A single plot is created using the Plot Wizard in Pulsonix. On the Output page, the 
Positive/Negative: drop down list will reveal a Positive (plane & items) option.  

By selecting this you will effectively be able to allow Pulsonix to create a combined plot of both 
positive and negative plane views as a composite (as you would if you used the second method 
below). 
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Composite plots 

There are two methods for generating composite plots; a power plane plot with both plane and 
embedded tracks with isolation around them.  

Method One – One single plot combining all information as a finished composite 

Instead of creating two plots (which can still be done if your processing requires this), you will create 
one plot which already includes the embedded tracks and allows isolation around these tracks to clear 
them from the powerplane plot.  

To do this, create a plot using the power (or ground) layer and in the Output page of the Cam Plot 
Wizard, select Positive (plane & items) in the Positive/Negative: entry. 

 

One this layer is included in the CAM Plot dialog, this will be all you need to do to create the 
composite plot. 

Method Two – Two separate plots, composite as a separate process. 

You first must generate a negative plane that contains thermal connections but must also contain the 
gaps required for the tracks to exist. The gap is the thickness of the track plus the spacing clearance 
around it. This negative plot will be reversed by the plot-house. 

 

Reversed, the plot will appear like this: 
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Secondly, you must create a plot of the tracks on this layer, this will be a positive plot of the items 
only. Use the CAM Plot option and the CAM Plot wizard to create this plot using the same plane 
layer as for the plane plot. 

 

The tracks plot is combined with the reversed plane plot to give you a final composite plot that looks 
like this (and as viewed in Pulsonix using the Power Plane Display option): 

 

This technique can be used for outer layers where copper plane coverage with or without net 
association is required. This would be full coverage of the layer rather than partial coverage using 
Copper Pour. The only change to the process described above would be the layer definition in your 
Technology. The Bias would be changed from Electrical to Power Plane. 

You will also need to create the two plot types, one using a negative plot (for the plane) and the other 
using a positive plot (for the tracks). These would be created in the CAM Plot option using the CAM 
Plot wizard. 

Creating Split power planes 

Creating split power planes on the inner layers can be done using any number of splits. This situation 
can be easily achieved in Pulsonix using a combination of a power plane layer and Template area 
shapes. 

Split power planes are generally used where two or more different nets are required as a single power 
plane on an inner layer but where they are not connected, typically these might be analogue and 
digital grounds. The components in the design would be placed where neither signals connected to 
these devices would exist in the opposite plane area.  

There are two methods to achieve this effect depending on the final manufactured requirement. 

When using split power planes, the ‘trigger’ for creating a split plane is the Layer definition in your 
Technology. The Layer must be Bias using a Powerplane type. The Net Name association is 
optional but if used, can be the ‘default’ net name for this layer. 

The Technology dialog below shows the layer Inner and its associated Net Name Gnd. 
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The Template will appear on the Ground layer and will be named using the Net name required to be 
connected to the split plane, in this example ANALOGUE_GND. 

 

By adding any Template area to this power plane layer, providing it has a Net name, any components 
within the area using the same net name will now be connected automatically during the CAM/Plot 
output. The remainder of the area, effectively with the power plane net name, will be processed as a 
power plane as normal. For this to work successfully, the Template area must not be poured. All you 
are doing at this stage is defining a named area that the CAM/Plot out can use and connect the 
relevant devices into. By using a combination of the power plane and the named Template you can 
create the two areas on the same power plane layer. 
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If you attempt to pour a Template that exists on a power plane layer a warning message will be 
displayed. If you ignore this warning and pour the Template, when you process the power plane layer 
through the CAM/Plot option, the plot will not be correct. 

The second method is where you wish to have the power plane layer with its nominated Net name but 
use Templates to define all of the areas of the power plane layer. By using a Template of the same 
Net name used for the power plane layer association, the power plane is effectively ignored.  

The Template areas are still processed as a split power plane layer but any area outside these 
Templates is ignored and in the final plot will be void of copper even if the plane layer net name is 
the same as one used in the Templates.  

 

Design rules checking split planes 

When defining the Template areas, the line style used for the outline will provide the ‘gap’ when 
plotted thus separating the two planes. 

Additional checks are performed by both the On-line DRC and the Batch DRC options. 

 

This option checks for pads within split planes that are on the same net as the split plane, but cross the 
split plane outline. These pads must be completely inside or outside of the plane outline. If they are on 
the outline they may not end up being attached to the plane when plotted. 

There is also an additional check made so that pads that should be included inside a Template are 
actually within the outline and not isolated. 

Breaking Silkscreen 

Break Silkscreen is used to break the Silkscreen over holes and vias to stop the silkscreen paint 
going down the hole. This is available on the Layer Class dialog as layer type specific options – 
Break Around Pad and Break Around Text. The Gap between the item and silkscreen can also be 
defined using the current design units.  
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The picture below shows the effect of break silkscreen when the plot is viewed or created: 

  

Without Break Silkscreen pads   With Break Silkscreen pads 

Creating an output for NC Drilling machines 

Pulsonix can generate NC Drill format files using the ‘Excellon’ format. The format can be changed 
using the CAM Plot Setup option and the Excellon device. Excellon is more of a generic format and 
as such can be used to drive the Chinonberg or the Ceib & Myer drilling machines with small format 
changes. 

To enable the drill drawing option to be used, you must create a set of layers and spans in the 
Technology dialog that will be used for plotting. 

 

As with all plot types, the layers used in the Technology form the basis of the plots required. This 
includes the Layer spans used for NC drilling and drill drawings. 

From the CAM Plot wizard, the Process page is used to Name the plot and specify the output 
device. If you choose Excellon, for the NC Drilling machine type, a drilling output will be created, 
this is reflected in the Style of Drill on the Output page. 

The CAM Plot option will understand the differences in electrical layers and layers defined for 
drilling or drill drawing information. 

 

The Process entry will allow you to select the layer spans created in the CAM Plot dialog. If blind 
and buried vias have been defined in your Technology, these will be available in the drop down list. 

The Drill Type allows you to select All drill holes, Plated or Unplated holes. The plate status of a 
hole is defined for each drill when creating the Pad definition in your Technology. This selection 
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allows you to create a combined plot of all drill holes or to create separate plots of plated and 
unplated drill holes. 

The Hole Shape entry enables you to select specific plots based on whether a hole is round or non-
round, for example a slotted hole. 

 

As with other plots, the Mirror switch can be used to mirror the output plot. For NC Drill outputs this 
is left unselected. 

The remainder of the CAM Plot wizard defined the Scale, Rotation and Position of the plot as 
normal. The report contains information about the drill file produced. This report should be sent alone 
with the NC Drill file to the people manufacturing your PCB. 

Outputting Drill drawings 

Drill drawings are used during manufacturing to help identify changes in drill tools where different 
drill sizes are used. A plot of drill holes/symbols, drill letters and a chart of associated sizes can be 
generated by Pulsonix with control over the drill symbols used and the letter association. 

To enable the drill drawing option to be used, you must create a set of layers and spans in the 
Technology dialog that will be used for plotting. 

 

As with all plot types, the Layers and Layer Classes used in the Technology form the basis of the 
plots required. This includes the Layer spans used for NC drilling and drill drawings. 

There are two methods of exporting drill drawings; 1. Using the method below for exporting specific 
drill drawing information from the CAM/Plot dialog, or 2. Create a Drill Drawing layer (which can be 
viewed in the design) and plot this as you would any other plot, using Gerber, PDF etc. 

The CAM Plot Drill Drawing Output Method 

From the CAM Plot wizard, the Process page is used to Name the plot and select the output device. 
The Name should be something representative of the final plot type. If you choose Excellon, for the 
NC Drilling machine type, a drilling output will be created. If another plot device is selected using 
Output To (for example, Windows), the CAM Plot option will know that the drilling information is 
being used for a drill drawing. It will automatically change the plot Style to Drill Drawing on the 
Output page. 

The Output will be a Layer or Span selection taken from the Technology and Layers definition. If 
blind and buried vias have been defined in your Technology, these will be available in the drop down 
list. 
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The CAM Plot option will understand the differences in electrical layers and layers defined for 
drilling or drill drawing information. 

As with other plots, the Mirror switch can be used to mirror the output plot. For drill drawings this is 
usually left unselected. 

The Drill Type allows you to select All drill holes, Plated or Unplated holes. The plate status of a 
hole is defined for each drill when creating the Pad definition in your Technology. This selection 
allows you to create a combined plot of all drill holes or to create separate plots of plated and 
unplated drill holes. 

As with normal NC Drill outputs, the Hole Shape entry enables you to select specific plots based on 
whether a hole is round or non-round, for example a slotted hole. 

The remainder of the CAM Plot wizard defined the Scale, Rotation and Position of the plot as normal. 

When the plot is produced it will look something like this: 

 

To make a plot clearer, generally the most used drills are not indicated. A representative drill hole 
marker symbol is shown however to indicate a drill position. A drill table or drill report will be used 
in conjunction with the drill drawing plot to associate the drill letter with the actual drill sized used. 
The drill drawing layer can also be viewed in the design and will replicate the settings from the Drill 
sizes dialog. 

Changing the drill letters and symbols 

From the Plot Settings dialog in the CAM Plot option, the Drill Sizes button will open the following 
dialog:  
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From this you can define the drill diameter association with the Drill ID and Drill Symbol to be used 
on the drill drawing plot.  

The setup of this dialog has been discussed previously in this Chapter, please refer to this for a more 
detailed description. 

Automatically adding a drill table to the design 

You can automatically add a drill table of the drills used in the current design to the design.  

For this, Pulsonix has the Insert Drill Table command. This can be run using the Insert Drill Table 
option on the Insert menu. 

When the Insert Drill Table command is run a dialog is displayed from which to select the Layer 
Span of the drills (you can choose any spans including those used for blind and buried vias). The 
Show Table on enables you to select the layer to add the table to. 
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When added, the drill table will look like this: 

 

The table can be moved in the design by dragging it or by using the Move command. 

The table is updated when the Update Drill Table command is run from the context menu (after 
selecting the table), and each time the Print or CAM Plot Run options are used or when the design is 
saved. 

Coloured Drill Sizes & Drill Table 

You can add a Colour to a Drill Size. When used, the drill ID and symbol are drawn in that colour. 
Add the colour using the CAM Plots dialog and Drill Sizes or define it in the Technology file. Select 
the Colour from the drop down list. Selecting Use Own Colour will force that colour to be used. If 
not selected, it will use the default colour. 

 

The drill ID and symbol in the drill table are drawn in that colour. 
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Viewing Drill Drawings in the Design 

You can display a drill drawing layer which will display the drill symbol and drill id in the design. 
These layers can be plotted instead of the existing drill drawing output.  

 

You can also add other items such as the drill ident table to this layer. 

The Drill Drawing layer is defined as a type of layer class, then used with a new Drill Drawing layer. 

The Layer Type to use is called Drill Drawing. This is used to create the layer class used for a Drill 
Drawing layer in the Layers page. 

 

When using the Drill Drawing Layer Class, many items are preselected for use. You can also add 
other useful items to document your drill drawing, such as the Board Outline or Areas. 

The Layer itself is relatively straight forward. You should define a Name for the layer and use the 
Drill Drawing layer class. The Type will inform you that it is a Layer Type: of Drill Drawing. 

You can create more than one Drill Drawing layer, for example, if you wish to have a drill drawing 
per layer span for your design showing layer spans other than <Through Hole>. To do this, create a 
new layer with a new name, use the Drill Drawing layer class and then choose the layer span that it 
will be Associated With using the drop down list of layer spans. 

The Drill Holes check boxes allow you to select the type of drill hole you wish to view on the drill 
drawing. 
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You will only see the full effect of this layer if you switch the drill drawing layer on by itself. If you 
don’t, drill letters can be drawn underneath other items such as copper pads and will be obscured. 

Combining plots 

When generating output plots of your design, you may require information from one or more plots to 
be combined. For example, a Silkscreen plot and a Documentation plot, which combined will give 
you enough information to view Component positions and show the dimensioning of these positions. 
Another example could be where you have a separate board outline layer, this can be combined with 
any other layer which might not have the board outline shown on it in its layer class definition.  

Typically, where Layer Classes have been specifically defined to cater for special cases of layers, 
such as a Board Outline or Solder Paste Mask, there is more of a requirement to combine plots. 

The plot combining is a process of the CAM Plot output option although it uses the Layer definitions 
and Layer Classes defined in your Technology. 

From within the CAM Plots option you can use the Add To Plot button once an existing plot has 
been selected. Plots can be added to existing plots, or you can create a new plot to define the 
combined plot. 

The Add To Plot Wizard is a basic plot wizard but adds the plot defined to the plot selected. 

The Process page will confirm the name of the existing plot selected. 

 

The Output page will require that you select the name of the layer to add. The drop down list will 
provide you with a selection of all the layers in the design. 
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The Offset page will allow you to align the plot with the main plot and it will also allow you to create 
an offset plot. This means you could plot a set of plots by using an offset to plot say 4 layers on each 
quadrant of one page. 

When the Finish button is selected the plot is added to the existing plot. 

Once back in the CAM Plot dialog, the added plots will appear by name in the Process column. You 
can add more than one plot process to any existing plot, these will be shown in order as they are 
added. 

 

Plot Transformations and Positioning in Plot Preview 

The Plot Preview page can define multiple layers using the Add To Plot option, they can be 
individually transformed in the Preview window. This allows you to add multiple plots of different 
types and layers to the same target plot.  

Where multiple plots have been defined using the Add To Plot option, the currently selected plot will 
be highlighted in organge. The original plot that the others are based off will be shown in black. 
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Any transformation performed is given relative to the Plotting Area Registration Point. 

The transformation is given relative to the Plotting Area Registration Point (hence the Shift X & Y 
will be different values to those specified on the CAM Plots page, which give the registration point 
relative to the design origin.) 

The Reset button at the bottom of this dialog is used to cancel any pending edits. 

Fields can be edited to transform the position of individual plots (where more than one has been 
defined using the Add To Plot option). You can edit the Scale, Mirrored, Rotated, Shift X & Shift 
Y values on this dialog. Equivalent values will be set on the original plot where multiple plots are 
defined. 

 

The Shift X & Shift Y values can be defined positively or negatively, depending on how you require 
the plot to be shifted on the bed relative to the original plot. 
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Check Plots 

Check plots are used when you require ‘quick’ plots of the design but not the full detail, and usually 
an outline plot of the design items for checking.  

The option to set to produce an artwork plot or an outline plot can be found on the CAM Plot wizard. 

One the Output page of the CAM Plot Wizard you can select the Style of the plot to be Artwork or 
Outline. Artwork would be used for final manufacturing plots and Outline is normally used where a 
centre line plot is required for checking purposes. This would be used for item positioning checks, 
connectivity of tracks checks etc. One advantage of this type of plot is its clarity, being on an outline 
plot, and the speed at which the plot is produced, especially when using a pen plotter. 

 

This plot style can be used for Windows printers and pen plotters, as well as the Gerber output plots if 
required, although this is not common practice. 

Using Fiducial Marks 

Fiducial marks are registration markers used on a PCB for alignment purposes when using assembly 
machines. There are normally 3 ‘marks’ (created in either copper or as pads/components) on the 
board placed outside the board outline. You can also have fiducial marks inserted inside the board 
outline in localised areas which are used for specific components. Usually large components such as 
microprocessors, or components that has special placement or alignment requirements have these 
marks. Smaller components don’t require this extra accuracy and so don’t use their own Fiducial 
marks.  

The types of machines that require these marks are assembly machines and surface mount ‘pick & 
place machines. 

The marks are usually added outside the board as small round pads of about 75-100 thou diameter. 
These dimensions would need to be confirmed with your board assembly house if using Fiducial 
marks as they may have specific sizes to use. 

You can use either free pads, or create a special single pad Component, or use a single pad 
Documentation Symbol. The free pad and Doc Symbol will not appear on any Parts list but it also 
means that you cannot extract the pad positions for inclusion in a report as well. 

You can also use Copper shapes as registration marks but again, their positions cannot be extracted 
into a report. 

If you choose to use a Component, any Component name or Silkscreen information should be kept 
well away from the pad so that the machine can easily recognise the marks. 

Whichever method you choose to create these markers, you must ensure that they are added to the 
Top and/or Bottom copper layers. This is essential, so that when output, the markers appear as a 
copper item and on the same layer as the Component pads. If they were added as a Silkscreen item, 
for example, the Silkscreen could slip slightly during its process and the markers would then not be in 
their true registration location. 

The markers should be placed outside the board but their exact location should be confirmed with the 
board manufacturer or assembly house. Their location will depend on the panel size, the number of 
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boards on the panel and the alignment tolerances of the machine. An approximate location is shown 
in the example below: 

 

When the assembly house comes to place the components they will either use a report of the Fiducial 
marks which you have produced, or they will use an optical alignment tool on their assembly 
machine. The same will apply to the actual Component placement as well. Pulsonix can generate 
Parts lists in various formats that can be extracted in ASCII using the Report Maker option. Most 
modern machines can accept a Parts list in some sort of format so check what is required by the 
assembly house. A ‘ready-made’ Parts list will also drastically reduce the possibility of errors. 

To produce a report or Parts list of the components and fiducial markers, use the Report Maker 
option located on the Output menu. Refer to the chapter on producing Reports for more information. 

Outputting other formats using the CAM Plot dialog 

As well as regular plots such as Gerber, PDF, Excellon etc. you can also export other formats that 
create a full set of manufacturing data. Quite often you will require the Gerber and Excellon files to 
produce a board, but you may also require additional files to complement them, files such as ODB++, 
IPC-2581, LPKF, IPC-356 or STEP/DXF/IDF or GenCAD. 

 

These would be added to the plot list using the New button and Plot Wizard as discussed previously. 

Additional Manufacturing Exports using the Output menu 

ODB++ format 

ODB++ is an intelligent CAD/CAM data exchange format which helps overcome the inherent 
ambiguity of the Gerber and Excellon formats. This is used by the manufactures as an alternative 
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format. In fact, some PCB manufacturers are offering more attractive PCB fabrication prices if the 
PCB design data is delivered in ODB++ format. 

The ODB++ export option is located on the Output menu. It offers Compressed and non-
compressed (Folder) versions. Make your choice using the Compressed check box.  

 

If Compressed is selected, it uses the TAR format and produces a single compressed file with the file 
extension .tgz. It is this file that you send to your manufacturer for processing. 

Un-compressed uses a Folder structure based on the Browse path setting. When used you must send 
the whole folder structure to the people plotting the design.  

The Use CAM/Plot Layer Combinations check box allows an alternative output, so that instead of 
outputting data for every layer in the design, it will output data for each Gerber and Excellon type 
plot defined in the CAM Plot page of the Technology dialog, this includes multiple combine layers. 
Windows plots will be included if Include Windows Plots is checked. 

In the ODB++ format, the Silkscreen, Solder Mask and Solder Paste layers need to be identified. 
Use the appropriate drop down list to select the layer class which will identify these layers. You can 
select (None) if you are not interested in the layer type.  

The Output and Composite Positive Power Plane options are used when your design contains 
tracks buried on inner plane layers. 
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Outputting to Mechanical CAD Systems 

As a brief note here, you can also export Pulsonix designs suitable for import into mechanical CAD 
systems. Pulsonix supports the export of the STEP format, DXF and IDF.   

The DXF and IDF export options are available on the Output menu and can be selected for output on 
the CAM Plot dialog as one of your ‘plots’. For further information of these format exports, please 
refer to the Online Help within the Pulsonix program.     

STEP Export 

The 3D Design menu enables you to define, Preview and export STEP files. 

 

Outputting for Documentation 

You can set up a CAM Plot to produce an SVG ‘plot’ for use within your documentation. The SVG 
output is available on the list of ‘devices’ on the drop-down list:   
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This appears in the CAM Plot list as its own format. Layer processing and combination is as per a 
regular plot. 

 

Outputting to ZIP Format 

Should you wish to save the whole set of manufacturing exports to a compressed ZIP file, you can do 
this in the CAM Plot dialog. On the Plot Settings page, there are three check boxes:   

 

Check Pack output files into a ZIP to create a ZIP of all the generated output files in the folder 
specified in the Folder for output files section.  

Check Remove individual files after ZIP to delete all the individual output files created, leaving you 
with the ZIP file only.  

In the Plot Report section, check Include in ZIP under the Plot Report section to also add the CAM 
Plot report to the ZIP file. 
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Chapter 8. Outputting Reports, Part and Net Lists 

Standard Reports 

Pulsonix can generate a number of reports for which most vital aspects of the design can be reported 
in detail. The reports also include a set of Parts lists and bill of materials (BOMs). User defined Parts 
and Netlists can also be generated using the Report Maker option, this is discussed later on in this 
section.  

The Standard Reports dialog 

The Reports dialog contains both the built-in reports and any format files supplied with Pulsonix or 
created and saved by you. All built-in reports are designated with the word ‘Report’ as their suffix. 
These can be listed individually if required by selecting the List Reports check box. The list can also 
include Format Files found on the search path defined in the Folders dialog.  

 

Each report can be run separately or all together by dragging the cursor over the list. Multiple reports 
can be run by picking each report required and holding down the Ctrl key at the same time. 

To run a single report, double-click over the report name will act the same as pressing the Generate 
Report button on the dialog. Use OK if you to wish to leave the dialog after generating the report. 

Report Maker 
Use this button to create or alter the format files that control the layout of the your own reports. 
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Report Maker 

As well as the standard Reports mechanism, Pulsonix also provides you with a powerful Report 
Maker option for generating your own formatted reports and outputs. These can be reports, Parts 
lists, Netlists and any combination of Parts and Netlists, e.g. IPC-356 test format. These are saved as 
format files into the Format Files location specified in the Folders dialog.  

Pulsonix is supplied with a number of format files to use and as examples of their layout. 

 

The dialog is broken down into a number of functional areas. 

 

The Format drop down list is a list of all the available report files. These are found by the system 
using the search criteria from the Folders, Format Files page. New, Save and Save As are utilities 
for maintaining the format files. The Description entry is for labelling the format file. This 
description is displayed in the Reports option when the file is selected in the list. It is provided to 
give an indication of the activity of the file when run. Format files can be made to be available in 
either or both of the Schematic or PCB design editors by selecting their respective check boxes. 

If you create a format file for both design types then later switch one of the type off, you may find 
that some commands do not appear on the selection. If used, these will be presented with a small red 
cross to indicate that they are unavailable for this design type. 
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The Commands are used to make up the scripts. The process is to select a command and add it to the 
Format Script area using the Add>> button or by double-clicking the command from the list. 
Commands are grouped in logical functions and in hierarchical design order importance, starting with 
general commands first and ending with specific item commands at the bottom of the list.  

 

There are two extra buttons in the centre panel under the Add>> button are for inserting conditional 
operations to the commands. These are represented with If>> and While>>. The Else operator is 
inserted as part of the If command and is selected from that command’s dialog along with other 
choices. 

Once in the Format Script area, the commands are listed in a tree style.  

 

The buttons down the right hand side of the dialog control the Format Script items. When using the 
Edit button, the contents of the edit dialog will be in context of the item selected. 

Using the Report Maker 

The principle for using this dialog is to decide what output format you require. Make the selection 
from the Commands list that then writes the command to the Format Script list. Once in the list, apply 
the specific command format to the command and sort it in the order required to make the output 
format correct. 

Initially, the Commands list will display 3 sets of commands related to the design. Each set of 
commands is separated by a thin horizontal line. 
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The first set of commands are general, and not specific to any context or command. These are always 
available for use in the script. 

 

The second set of commands are the lists. These commands will be used to create the ‘body’ of the 
script. This is split into two sub categories, one for list variables for List – Reported Count and List 
– Total Count, and the other for listing items within the design, components, Nets and Wires etc. 
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The third set of commands is always context sensitive usually dependant on the item currently 
selected in the Format Scripts list. The initial set presented is applicable to the design as a whole. 

Picking one of the list commands and clicking Add >> will add it to the Format Scripts list, double 
clicking will also add it without having to use the Add >> button. For example, double clicking on the 
List – components will give you this: 

 

You can see that the List of Components is now available and is waiting for a command. 

The Command list and is now changed to be context sensitive for the list of Component fields, shown 
with the heading Component Commands. 

The Design commands are still available at the top of the list (as they always are), the middle list now 
shows List commands in context of what is available for components, and the bottom list are fields 
for items within the list of Components, such as Part Name etc. 
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Where you see a blue box you are expected to add a command from the list to complete the script in 
order for it to run. This box is only displayed when the blank line is selected. The extra blank ‘tree’ 
line under the blue box indicates the end of the command line. 

 

If you selected this line (by default it is selected after adding the List command) and then selected the 
field Part Name and added it to the Format Scripts the format would now look like this: 

 

By clicking the Test button at the bottom of this dialog you can try the script being created. If using 
the Inter.pcb design supplied with Pulsonix, the report would look like this: 

C CP3 41612-M-64 3WP 5WP 26WDP 26WDP 3WP BC184L BC184L R R R R R8C R R 

R R R R SPDT 74LS251 74LS251 74LS32 74LS125 74LS244 74LS244 74LS251 

74LS244 74LS125 74LS251 74LS42 74LS244 74LS42 

 

As you can see, the report is a list of Part Names from the design, there is no formatting as such and 
no filtering for specific names. 

Ideally for a simple Parts list output you would add some Component Names and format the report 
into simple columns. 

By selecting the Part Name field, the Component Name is promoted from the Component Command 
field list to the format script. It appears in the script under the Part Name field. As the Component 
Name field is still highlighted it can be moved up above the Part Name by using the Up button 
located on the right hand side of the dialog. 

Formatting of the output file can be determined by using the Edit button (or double clicking) on the 
Part Name field. Because the Part Name appears after the Component Name, this will be the order 
that they appear in the output report. 
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By selecting the New Line After Field check box, a new line is entered after the Part Name. As there 
is no formatting on the Component Name field this means that the report will now first find a list of 
components, then output the Component Name followed by the Part Name for each unique instance, 
then start a new line and report the next item. 

The report now looks like this when the Test button is clicked: 

C1 C 

C2 CP3 

CONN1 41612-M-64 

PL1 3WP 

PL2 5WP 

PL3 26WDP 

PL4 26WDP 

PL5 3WP 

Q1 BC184L 

Q2 BC184L 

R1 R 

R2 R 

 

This list can be formatted into evenly spaced columns even though the text fields are different sizes. 

Again, using the Edit button, the formatting will need to be on both the Component Name and the 
Part Name. This means you would need to edit both items in the list. 

For each field the Column Width would need to be defined and set. You would always need to allow 
enough space for the largest name in the list. 

 

The report now looks like this when the Test button is clicked: 

C1        C 

C2        CP3 

CONN1     41612-M-64 

PL1       3WP 

PL2       5WP 

PL3       26WDP 

PL4       26WDP 

PL5       3WP 

Q1        BC184L 

Q2        BC184L 

R1        R 

R2        R 

 

To add some headers to the formatted list you can add free Text before the List of Components 
statement. We’ve also added the Underline field and the Blank Line field. The Underline field will 
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look at the previous field and will automatically underline this field matching the field width. The 
underline character can be defined by editing this field. The Blank Line field will add a blank line 
(effectively a <CR>) to the report. The number of blank lines can be changed by editing this field. 

As you can see, to make a header appear once at the start of the list all header fields must be on the 
same ‘level’ as the List of Components and must be above it.  

 

Both Text fields used could have been created using a single Text field with both headers spaced at 
the correct width. The disadvantage of using this method is that if any of the field widths under the 
List of Components are changed then you then have to adjust the text fields as well. 

The report now looks like this when the Test button is clicked: 

CMP Name  Part Name 

+++++++++++++++++++ 

 

C1        C 

C2        CP3 

CONN1     41612-M-64 

PL1       3WP 

PL2       5WP 

PL3       26WDP 

PL4       26WDP 

PL5       3WP 

Q1        BC184L 

Q2        BC184L 

R1        R 

R2        R 

 

The list can also be sorted. This is achieved by using Edit with the List of Components selected. By 
default the List of Components is sorted by Component Name first. 

We will change this so that the Part Name is sorted first followed by the Component Name. This is 
achieved by selecting the Sort By check box and picking a field from the list provided. There are 
three possible sorting levels available. For additional sorting use the Then By check boxes. When 
sorting, the output can be sorted in Ascending or Descending order depending on the selection of the 
Ascending Order check box. 
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The report now looks like this when the Test button is clicked: 

CMP Name  Part Name 

+++++++++++++++++++ 

 

PL3       26WDP 

PL4       26WDP 

PL1       3WP 

PL5       3WP 

CONN1     41612-M-64 

PL2       5WP 

U4        74LS125 

U9        74LS125 

U5        74LS244 

 
You can see that the Part Name 26WDP appears in the report with Component Name PL3 listed first 
followed by PL4, then the next Part Name with Component Names are listed, this is how the entire 
list if formatted. 

Advanced Format Scripts 

Adding IF and ELSE conditional statements to the format script adds further control on the data 
being processed. You can also add Variable fields to the script which can be combined with WHILE 
to test for data conditions.  

IF and ELSE 

IF statements can be added to test a field. 

For our example we will test the List of Components to ensure that our Parts list does not contain any 
Schematics Only Parts. We will need to make the script look like this: 
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To achieve this you must go through a number of stages. You will need to select the Component 
Name field first. This puts the IF statement at the correct ‘level’. The test must be under the List of 
Components, so the script reads, “request a list of components”, “now test to see if the (List of) 
Components are Schematics Only”, “if they are not” then output “Component Name and Part Name 
(with formatting)”. 

The If statement must be added below the List of Components. Select the Component Name field to 
do this and click the If >> button. The Edit If Command dialog is displayed. From this you can edit 
the commands to make the test condition. 

For this example, on the If list we will select Is Schematics Only to test. We will test to see if 
Schematics Only Components Is Not Equal to and then a Fixed Value of true (so the test is for the 
Component not being Schematics only). 

 

For the statement Not Equal to TRUE, you could also say use Equal to FALSE, in other words, test 
are they Schematics only? If not, output them, if they are, ignore them. 

The script now looks like this: 
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Because the If statement have been added below the Component Name field (you selected the 
Component Name field to get the IF statement on the correct ‘level’), you must now use the Up and 
Down buttons to move the Component Name and Part Name fields to be under the IF statement. 

Once the Component Name has been moved down you will notice that the Part Name is now on the 
wrong nested level. It must be under the IF statement but in-line with IF. Use the Up button to move 
it. 

Note that the X “NEED COMMAND_HERE” message now disappears. 

 

Using the Test button the report will now look pretty much the same as before (it is a PCB design 
which obviously can’t contain SCM only components). Save the format file using the Save As button. 
It can be used on a Schematic design, Inter.sch for example. 

The Else statement can also be used when using If to provide an alternative if the If test was not true. 
An example of Else is shown below. 

 

For our example file we’ve added another If statement to test whether the components are SMD 
(surface mounted devices) using If “Is SMD equal to TRUE”, and if they are we will first output the 
Component Name, Part Name and their Side. Then if the Component is not an SMD (tested using 
Else) we will output the Component Name, Part Name and a Text field, the text contains the words 
Through-Hole. 
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Our report now looks like this when the Test button is clicked: 

CMP Name  Part Name 

+++++++++++++++++++ 

 

Q1        BC184L         Top 

Q2        BC184L         Top 

PL3       26WDP          Through-Hole 

PL4       26WDP          Through-Hole 

PL1       3WP            Through-Hole 

PL5       3WP            Through-Hole 

CONN1     41612-M-64     Through-Hole 

Variables 

Variables allow you to set a status on an item, then test that status and perform commands on it.  

In the example below we have used a netlist output that will be driven from within the Schematic 
editor. Use the standard output file Net List.rff and Inter.sch if you wish to try this. 

This script will output a netlist with the Net Name first then a list of pins on the net. By using the 
count variable, the number of pins reported per net name can be restricted to 4 per line, thus keeping 
them readable when viewed in Notepad. 

 

In this example we initially set the name to count, the Variable Type to Integer and a value of 0. It 
will be set to an Integer, as the value reported back on use will be a count number. By setting the 
Variable before the List of Pins it can be tested for at any point after it. 

Inside the List of Pins and following the initial test to see if the components are Schematics Only, the 
next test is to check to see if the Variable is 0. Initially it will still be set to zero until the script has run 
through one pass. The first pass will output the Component Name and Pin Name, the Variable will 
then Increment the count by 1 and go back through the list again. It will do this for each Component 
Name and Pin Name of the same Net Name until the count of 4 is reached. It then performs an End 
Of Line and continues with the same net name. Once it has finished listing the Component Names 
and Pin Names for that net it starts a new Net Name after inserting an End Of Line and a Blank 
Line. The process then starts again until there are no more Net Names. 
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The Edit Variable Command dialog is used to set the Variable Name, its Type and Value. This 
dialog is also used to add and edit the Increment Variable command. 

 

When the report is run it will be formatted like this: 

Net COMPUTER 

PL2.5       U11.4 

 

Net GND 

C1.2        C2.2        CONN1.1     CONN1.31 

CONN1.33    PL1.1       PL1.3       PL3.12 

PL3.24      PL3.25      PL3.26      PL4.12 

PL4.24      PL4.25      PL4.26      PL5.2 

Q1.1        Q2.1        SW1.2       U1.8 

U2.8        U3.4        U3.5        U3.7 

U3.9        U3.10       U4.2        U4.5 

U4.7        U4.9        U5.10       U6.10 

U7.8        U8.10       U9.7        U10.8 

U11.8       U11.12      U11.13      U12.10 

U13.8 

 

Net ID0 

CONN1.14    R5.2        U2.5        U5.11 

U6.11       U9.6 

 

The formatting is best demonstrated on nets with many pins, for example the GND net. 
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 Chapter 9. Importing Designs and Libraries 

Overview 

Pulsonix supports the import of ASCII files for Schematic and PCB designs from other systems, as 
well as Symbol, Footprint and Parts libraries. 

Fundamentally, there are two mechanisms available for importing designs and libraries: 

• The first mechanism uses the Open dialog from the File menu to read in the design (the principle 
is much the same for the libraries but uses the Library Manager’s management features), 

• The second is using the Data Transfer Wizard also on the File menu, which handles the files. This 
allows you to choose the files to create (as well as designs, you could import a design to create a 
Technology File for example), and to choose the Source and Target locations for the files. 

Both mechanisms have their own merits but in general, for an occasional user, the Data Transfer 
Wizard is recommended as it manages the transfer process for you. 

Pulsonix also supports raw netlist files for import into its PCB design system, again using ASCII 
format files. 

The diagram below illustrates the Design, Library and Netlist imports into Pulsonix. 

 

Importing Alien Designs 

Importing designs into Pulsonix is an automatic process using the Open dialog. Once the source file 
has been located and selected, Pulsonix will detect the format of the ASCII file being imported and 
automatically open it. 

Another method to import designs is simply drop their ASCII file on top of Pulsonix where it will 
automatically detect the format and open the import filter dialog. 

Using the Open dialog 

The Open dialog has selections under the Files of type: filter for all supported formats although it 
isn’t necessary to use this unless you wish to only view in the list all the formats of one type. 
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From the list of files to select you can make single selections or multiple selections if there is more 
than one file to import. Each file is treated individually during import will selections for Technology 
Files made on a design basis. 

Once the File or Files have been selected, Pulsonix will read the file and check the format. 

You are presented with a dialog from which to select a Technology File if required. 

 

Unless you fully understand the implications of using a Technology File during this import you 
should select the [None] option. You can always use the Load Technology File option from the Setup 
menu at a later stage. This option would really only be used if the source design doesn’t contain a full 
set of technology data for example (some vendors data doesn’t contain the full set of technology 
data). 

A report is generated during import. This report will contain the status of the design and whether the 
import was successful, it is import to view this report to ensure that the import has completed without 
any unexpected events. Where any changes to the imported data have occurred (changes to invalid 
characters, libraries unavailable etc), these will be written to this report. 

Importing Netlists into Pulsonix PCB 

If using another CAE or Schematic system a netlist may be available as an alternative to the Pulsonix 
Schematic translation or to adding the components and Nets on-the-fly into Pulsonix PCB.  

Pulsonix PCB can import many format netlists from other systems. For a full and up-to-date list 
please consult the on-line help or the Pulsonix customer support desk, or the Pulsonix web site 
www.pulsonix.com 
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This process assumes that the netlist is derived from an external netlist source, created from another 
CAE or Schematic system or from a manually edited netlist created in a suitable format for reading 
into Pulsonix. 

Pulsonix expects a collated netlist with all duplicate net and Component names resolved. 

During the import, the Parts used in the netlist will be loaded from the existing Parts/Footprint 
libraries. If these Parts don't exist, an error will be displayed. All errors must be corrected to ensure 
100% accuracy of the imported netlist. 

If a Pulsonix Profile file has been used when creating the new PCB, you will need to either remove 
any components first before loading the netlist or use the Import ECO option after, to check the 
original netlist against the design and make any changes necessary to bring the two into line. 

���� How to add netlists to the design 

1. Click the File menu, click on Import Design Data or Open. This facility can be used to start a 
new design or from within an existing design. 

2. From the Files of type list available, select the format required. If unsure about the format, select 
the file anyway, Pulsonix will automatically recognise the import type. The Files of type list will 
help you filter the type of file required. 

3. A standard Open dialog is displayed. 

4. Select the netlist file required and click Open. 

5. You will be presented with one of two possible dialogs depending how you entered this option.  

6. If you entered from the Import Design Data option, this dialog will be displayed. 

 

7. From the Open dialog you get the additional options of entering the Design name, the 
Technology file and the Profile file to start the design with. You can also select the Unplaced 
Components to the Component Bin and Show the Component Bin. 

8. A Part Mapping file can be selected if the Part names and Footprint names don’t match those 
used in the Pulsonix libraries. 

 

9. Create allows a new mapping file to be created if one doesn’t exist. If a mapping file exists you 
can Browse to it to select it, or Edit the mapping file. 

10. If you select Edit, the dialog is displayed: 
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11. You can specify two fields to map to and from. The Orig. Part and New Part specifies the 
original Part name and the new Part name. The Orig. Footprint and New Footprint options 
specify an alternative footprint if one is not defined in the original netlist or if you require using 
an alternative one. 

12. Once the netlist is loaded any subsequent Schematic changes (ECOs) should be loaded into the 
PCB design using the Import ECO option. 

Importing Other Formats 

Importing Gerber files 

Viewing Gerber files 

The Gerber import option is used for viewing Gerber files before sending them to manufacture. You 
can also use this mechanism to read Gerber files created in other systems. Using the Import Design 
Data option on the File menu, you must have a PCB design open first. This can be a new design or 
existing design. This process is described in the online help.  

Rebuilding Gerber files intelligently 

The import of Gerber files can also be used to fully rebuild the design back to a full netlist and 
electrical connectivity with components. To do this, use the Intelligent Design Data option. have 

The Intelligent Design Data option is also located on the File menu, you do not need to a PCB design 
open first. This can be a new design or existing design. This process is fully described in the online 
help.  

Importing DXF files 

The DXF import option is available for both Schematic and PCB designs although it is probably more 
useful with the PCB design editor. 

DXF files can be translated into Areas, Boards, Copper, Doc Shapes, Templates and Text. The DXF 
data types that are imported are: Lines, Polylines, Arcs, Circles, Text and Hatching data. All other 
data types are ignored. If the allowable data types are included in Blocks they will also be translated. 
The translation of some closed shapes to be cutouts of other closed shapes is also allowed. 

When creating PCB designs you may wish to import an existing board outline. This may be 
particularly useful if the outline is complex or critical. Specific mechanical drawing packages, such as 
AutoCAD, provide excellent 2D drawing capabilities where intricate shapes are produced. To aid this 
procedure, Pulsonix can read DXF files created in AutoCAD V10 and above. It can also read DXF 
files created outside AutoCAD provided they conform to the DXF standard as defined by AutoCAD. 
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Importing IDF Files 

IDF files in the V2.0 and 3.0 format can be imported into Pulsonix PCB. V4.0 files cannot be 
imported yet as this is a relatively new format. IDF import also includes import of component 
placement data.  

IDF is a neutral data format that can be exported from 3D mechanical design systems. Pulsonix can 
import Board outlines and cutouts, Area, components and Component Placement, Placement outlines, 
Placement keep in and out areas, all other area types (keep in and out) and Mounting Hole (IDF 3.0 
format only) data from this format. IDF data is generally output as a board file and a library file. 
Pulsonix only imports the board file. 

A Pulsonix design must already be open for the IDF import mechanism to work. The design can be 
brand new or can be a partially completed. 

Importing STEP Files 

Board outlines (and board cutouts), and Placement Sites in STEP format can be imported into your 
PCB design file using the Import STEP Board option from the 3D Design menu.  

 

Import Board 

Use this option to import STEP data to assist with mechanical data in your PCB design. This can 
include a board outline created in your mechanical CAD package and exported in STEP format. You 
cannot import complete STEP models or positional changes, only a Board including Board Cutouts, 
Mounting Holes, and Vias. As it is a board only, the STEP file does not require any face, side or layer 
information. It also does not require a local origin.  

By default, the system will try to find board shapes on XY plane. If they have been defined in another 
orientation you can choose the wanted plane from the dialog.  

During import, it uses the best shape that it can find on the specified plane that encloses most of the 
other shapes in the STEP file.  

By default, all units in STEP files are defined in mm. If your design is set as Imperial, during import, 
the units will be converted.  

To import smaller circular cutouts as either Mounting Holes or Vias, simply input the maximum 
diameter of each, respectively, in the designated fields. When a circle is discovered that is smaller 
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than the specified mounting hole diameter, the circular element will be removed from the shape and a 
mounting hole will be created in its place, or a via if it is small enough for that. It assumes that 
mounting holes are bigger than via holes so it does the tests that way round.  

Import Placement Sites 

The positions of items in the STEP file will be used to insert Placement Site attribute positions in the 
design. These will only be added if they are inside a board outline in the design.  

Choose from the Attribute Names listed in the drop-down list, or enter a new attribute name. You can 
also choose the text style from the list.  

The Layer controls allow you to choose the layer on which the attribute positions should be placed. 
The Top Layer is used for all locations with Z >= 0, and the Bottom layer for Z < 0.  

You can also use the Only Within Board checkbox to choose whether or not to keep any positions 
that are outside all board outlines.  

Importing Component Positions 
The STEP Positional Changes option is also available to import a STEP file. Once the design has 
been placed in Pulsonix, this option can be used to read STEP files containing Component positional 
data. It will compare the current positions of the components with positions of the components as 
described in the STEP file. If there are any changes you will be asked if you want to apply the 
changes.  

How to import DXF/IDF/Gerber files 

���� To add a DXF/Gerber/IDF files to the design 

1. With a design already open, click the File menu, click on Import Design Data 

2. Select AutoCAD (*.dxf) from the File of Type list or; 

3. Select IDF (*.idb) from the File of Type list or; 

4. Select Gerber (*.gbr) from the File of Type list or; 

5. The file will be pre-processed to check its validity and to assess which contents and layers used. 

6. The format Import dialog is displayed. 

7. Check the Use Map File box if a mapping file is available or required. 

8. Click the OK button to start the import. 

How to import using the Intelligent Gerber option 

���� To use the Intelligent Gerber Import option 

1. The above import mechanism doesn’t work for Intelligent Gerber files.  

2. For these, from the File menu, use the Intelligent Gerber Import option instead. 

3. This procedure is fully described in the online help. 
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Chapter 10. Library Management Tools 

Understanding Pulsonix Libraries 

Pulsonix libraries are easy to understand and use once your grasp the basic concepts. Pulsonix has a 
Parts library made-up of elements from the Schematic symbol library and the PCB footprint 
library.  

The following illustrations demonstrate the association between the different library types. 

 

symbols and 
footprints either 
combined or on 
their own. 

 

 

 

 

are used to 
produce > 

 

 

Pulsonix Parts Library 

 

 

These normally use the 
proper manufacturers 
component name. 

SN7400 
SN74LS10 
SN74HCT4002 
SN74LS258 
19370K-160mA 
CA3450 

Only the names from this 
library are used in both 
Schematic Capture and 
PCB layout. 

Schematic symbol 
Library 

These have generic 
names like: 
NAND, Buffer, 
OPAMP 

 

PCB footprint 
Library 

These have generic 
names like: DIP14, 
SOIC14, QFP44 
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The benefits of a separate Schematics symbols, PCB footprints and Parts Libraries  

In electronic design there are Schematic symbols and PCB footprints (usually defined on a 
manufacturer’s datasheet). Commonly, integrated circuits and other components use the same 
physical package on the PCB, but have completely different internal digital or analogue circuitry and 
technical specifications. Take for example, the standard 14-pin DIP footprint: 

 

The 14-pin DIP (Dual Inline Package) is used on 100’s of different components. For efficiency, we 
only want to store the 14-pin DIP PCB footprint once and then use it repeatedly to build different 
components or Parts that specify a 14-pin DIP footprint. 

By the same token we only want to store a Schematic symbol once and use it repeatedly in various 
configurations to produce different Parts. Hence, we have a PCB footprint library to store a 14-pin 
DIP footprint plus any other footprints and a Schematic symbol library for a 2-Input NAND gate 
plus any other Schematic symbols. These can then be used on their own or be brought together 
(Schematic symbol & PCB footprint) in many different permutations to create a Parts Library. 
Multiple Parts libraries in Pulsonix are used to make the categorisation of Parts clearer, this can be 
done by manufacturer, type etc. 

Key Point: In Pulsonix it is the only the Part name taken from the Parts library that is used in the 

Schematics Design and PCB Layout 

As an example, this is how you go about creating a simple 7400 Part to use in a Schematic design and 
the PCB layout: 
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4x 2-input NAND gate symbol 
from the Schematic symbol 
library. 

 

1x 14-pin DIP package 
from the PCB 
footprint library. 

We can create a new 7400 Part by selecting 
4x 2-input NAND gates from the 
Schematic symbol library and a 14-pin 
DIP footprint from the PCB footprint 
library. By combining these in the Parts 
Editor and inserting the correct pin mapping 
as per the data-book specification, we 
produce a SN7400 Part. This is then stored 
with a unique Part Name (SN7400 in this 
example) in the Parts Library ready to use 
in your designs. 

 

 

+ 
 

+ 

 

 
= 

SN7400 Part 

 

This is stored in 
the Part 
Library as an 
SN7400 to be 
used in your 
designs. 

 
 

 
 

 

 
 

Schematic only symbols without a PCB footprint? 

You can create a new Schematic symbol and store it in the Symbol Library, but before you can use it 
you have to create a Part to ‘hold’ it. This is stored in the Parts Library for use in your designs. A 
schematic only Part may be a useful stop-gap while you decide which footprint type to use in the PCB 
layout, this information can be added later before the PCB stage is reached. If you wish to have 
symbol in your schematic that is not transferred to the PCB, then you can use a Schematic Doc 
Symbol instead. 

Creating and using Parts and Symbols 

Working this way, any Schematic symbol you produce is stored with an appropriate name in the 
Schematic symbols library. It can then be reused repeatedly to create different Parts using the 
manufacturer’s Component names. Most Parts you produce will be the complete Schematic symbol 
and PCB footprint. Remember, the product you design is comprised of components with unique Part 
names and/or numbers, and your company may have it’s own product code for this component.  

This description of the Part usage for a symbol is easily demonstrated by considering resistors. Each 
range of resistors can use just one Schematic Symbol and one PCB footprint (can have more than one 
footprint if required). This principle is repeated for capacitors, diodes, transistors, inductors etc. this 
helps standardise and rationalise the contents of the libraries. 
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Creating and using PCB only footprint 

This is exactly the same for PCB footprints as with Schematic symbols. Before you can use your new 
PCB footprint in a design you have to produce a Part even though this Part may not have a Schematic 
symbol associated with it. But again, this is a simple step. 

On the following pages is a tutorial that goes through the steps of creating the following 

A Schematics symbol – in this case a simple 2-input NAND gate 

A PCB footprint – in this case a 14-pin DIL package 

A Part – in this case a standard SN7400 to use in your design 

Note: Standards for symbols vary from company to company. The tutorial is presented only as a 

means to understand the process of design and management and how to use the tools available. We 

recognise that the actual finished symbol, footprint and part may differ from your own standard. So, 

as you proceed you may wish to modify the visual appearances of the items to match your standards. 

Libraries Overview 

The illustration below shows how all the libraries fit into the Pulsonix framework. Although each 
library is shown as an individual entity, they are an integral part of the overall Pulsonix product and 
have only been shown separated for clarity, (Associated Parts are not shown). 

 

The libraries fall into two categories; Parts/Symbols/Footprints/Associated Parts, and 
Documentation Symbols. 

There are five types of libraries: 

• Parts – a Part contains the mapping between schematic gates and PCB footprints, as well as 
common properties. The Part is what gets added to both Schematics and PCB, thus ensuring that 
there is consistency between the two. A Part references graphics symbols, one is the Schematic 
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Symbol and the other is the PCB Footprint. 
Note: A Part may also contain additional information such as an Associate Part data and Attribute 
information. 

• Schematic Symbols – a Schematic symbol or gate is the graphical logical representation of the 
Part. This is seen in the Schematic when you add a Part. A Part may contain a number of gates 
that may reference the same (homogeneous) or different (heterogeneous) symbols. 

• PCB Footprints – a PCB Footprint symbol is the graphical physical representation of the Part. 
This is seen in the PCB when you add a Part. A Part may reference a number of footprints as 
alternative representations.  

• Documentation Symbols (SCM and PCB) – a documentation (doc) symbol is not used by a Part 
and does not require a Part, also it does not form part of the netlist. It is used for annotating the 
design, such as drawing blanks, power symbols, off-sheet references, PCB board outlines, logos, 
alignment markers, testpoints etc. 

• Associated Parts – used to ‘attach’ additional Part detail to a Part. Associated Parts are not 
displayed in the design. These can be referenced from ‘real’ Parts available in the Parts library, or 
typed Part names that are not in the library but still associated to the Part.  

• STEP Models – this is a library used by the STEP 3D Preview and export options.  

• 3D Packages – this is a library used to define 3D shapes for use where STEP models do not exist.  

For completeness of terminology, you also have a Component. This can be either a Schematic or 
PCB instance of a Part, that is, when a Part is used in the Schematic or PCB design it becomes a 
Component.  

Part Attributes 

A Part (as defined in the Parts library) can have a set of attributes that get inherited when the Part is 
used (as a Component) in the Schematic or PCB designs. 

Overview of the Supplied Libraries 

Pulsonix is supplied with a set of libraries containing Parts, Symbols, Footprints and Documentation 
Symbols. Your own STEP 3D models can be added to the libraries. 

There are two sets of Libraries installed by default during the initial installation: 

• Master Pulsonix Libraries (installed into Pulsonix\MasterLibraries)  

• User Libraries (installed into Pulsonix\UserLibraries)  

 

The Master Library contains the full set of installed libraries ready to use in your designs. 

The User libraries are a set of empty libraries, one for each library type. These can be edited and 
added to, to create your own libraries. These are supplied to get you started using and are placed in a 
suitable location away from the master libraries as recommended. 

User.pal  User Parts library 

User.pfl   User PCB Footprint library 

User.ssl   User Schematics Symbol library 

User.sdl   User Schematics Documentation Symbol library 

User.pdl   User PCB Documentation Symbol library 
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Index files 

You may also notice files with the same library name but with an x at the end of the extension 
(hardware.palx), these are index files and are automatically generated by the Pulsonix library system 
as required. You can ignore these. They are automatically generated by Pulsonix as required so do not 
panic if you accidentally delete them. They are only updated manually if you wish to add additional 
attributes into the index for use with the Parts Browser. This is described more in the online help. 

Conventions and standards used 

All surface mounted footprints have been created to the IPC Council’s IPC-SM standard and the 
JEDEC standards.  

Additional Library Content 

Pulsonix works with many specialised library content providers who can export their Part (with 
symbols and footprints) content in the .plx format. Currently, Pulsonix supports content from 
SnapEDA, PCB Libraries, Ultra Librarian, Collage and Samacsys. Other providers may also be 
available. Additional content is also provided through one of these suppliers via a manufacturers web 
site, such as TI, or Microchip, or a web site from component distributors, such as RS, Digikey, 
Arrows, Farnell etc.  

The .plx ASCII file can be read by Pulsonix directly by dragging and dropping it onto the Pulsonix 
Library Manager where it will open a save dialog. From here, you can choose the destination library 
and the content to import. You may not always want all items, if the footprint already exists for 
example. 

 

Your new item(s) will now be saved in your library ready for use. 

Another note to make is that not all content providers supply all the Pulsonix library facets. For 
example, PCB Libraries may only supply a dummy Part name but an accurate Footprint created to 
IPC standard. 

With external library contents, you can also ‘mix and match’ content. For example, import Part and 
SCM Symbol data from vendor A but import the footprint from vendor B, or use an existing footprint, 
or create it yourself. 
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The Library Manager 

Overview 

The library manager is used to create, edit and manipulate library files and library contents. 

 

Library folders 

The Folders tab is split into two main sections:  

The upper area of the dialog shows the folders in which the application will search for the particular 
type of file. The lower area of the dialog section is for managing the library files within the folders. 
This page is available on both the Libraries and the Folders dialog from the Settings menu.  
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In the example shown, you can see that there are two folders specified for Libraries. When looking 
for files, the folders will be searched in the order shown in the list, you can use the Up and Down 
buttons to control the search order if you need to. 

To add a new folder to the list, click on the Add Button. To edit an existing folder name, click on the 
name in the list and press Edit. Both buttons use the Library Folder dialog to set up the folder name. 

To delete an entry from the folder list, select the name in the list and click Delete. You will be asked 
to confirm deletion of this name before the name is actually removed from the list.  

Note: deleting an entry from the list will not delete any files, it simply removes the reference to that 

folder so that the application no longer searches the folder when looking for the particular type of 

files. 

The lower part of the dialog shows the actual files found in the folders listed at the top of the dialog.  

 

These are listed in the order they are found, so that you are able to see the actual order in which the 
application will search for information. This can be particularly important for Library files, as this 
allows you to see for example which libraries will be examined first when inserting new components 
into a design. 

If Parts of the same name exist in the libraries the Library search order also becomes important in that 
the first instance of the Part found will be used in the design from Insert Component. 

By selecting each library you can see which library type it is, and a basic description of the library 
contents. 

You can set individual files so that the application ignores them, by clicking on the name of the file in 
the list and unchecking the Enabled checkbox. 

The Delete button is for deleting the actual library file from the folder. A warning dialog is displayed 
when this button is selected which enables you to confirm the deletion first.  
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Warning: once the library file has been removed it cannot be undone or recovered. 

The Move and Copy buttons are also provided to allow you to move or copy individual files to 
another folder. These can be used, for example, if you wish to take a backup copy of a file before 
making major changes to it. 

 

The Close/Cancel buttons are used to exit the dialog, these are displayed on all Library Manager 
pages. If a library change has been made but not saved, the Cancel button is displayed. If the change 
has been saved using the Apply button, the Close button is displayed. 

Using the User libraries 

Pulsonix is supplied with a set of libraries; these libraries reside in the MasterLibraries folder. In 
addition to this master set of libraries, there is also a skeleton library supplied named User, these are 
supplied in the UserLibraries folder.  

It is highly recommended that when using libraries you make copies of any library items and save 

them to the User libraries. If importing any libraries of your own, you should also create new or use 

existing libraries in the UserLibraries folder. 

Using the Library Manager 

Each of the Symbol pages fundamentally work the same way, and to some extent (apart from the 
symbol preview window) so does the Parts page. 

These pages are used for selecting the libraries to search (Current Libraries), selecting (Contents) 
and subsequently creating/editing/copying etc. the contents of the libraries. The Filter enables you to 
refine the search criteria that are displayed in the Contents window.  

 

The Technology File selection is used when New symbols are created or existing symbols Edited. 

The Preview window can be enabled to display symbol selected from the Contents window. When 
the Part page is selected, the Preview button is replaced with Preview and Details tabs. This 
provides you with either graphical or detail information about each entity of the Part selected. 
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Library Selection 

The top part of the dialog allows you to choose which libraries to view. The drop down list for 
Current Library will include all the library files found in the folders you specify on the Folders 
page.  

Note: Any library files that are set on the Folders page as 'Disabled' will not appear in the drop down 

list. The list will only include 'Enabled' libraries, and the special entry <All Libraries> to allow you 

to view the contents of all the libraries at once.  

 

To create a new library, press the New Library button. A standard File Browser dialog will be 
displayed. Enter the name of the new library file and press OK. If you have chosen to create your new 
library file in a folder which is not in the list of folders, an additional dialog is displayed which will 
ask you to choose whether or not this folder should be added to the folder list.  

Note: If you choose not to add a newly chosen folder to the list of folders, your new library will not 

appear in the list of 'known' libraries, and therefore any items added to that library will not be 

available either here in the Libraries dialog or when inserting new items into designs.  

By selecting Report you are provided with a fill report of the names of the library contents for the 
selected library or if selected, All Libraries. 

The Index button is used when a library is Copied or Moved. Libraries are indexed to allow fast 
searching and extraction of the relevant data. 
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Selecting Library Items from the list 

The Contents area of the dialog shows the items contained in the library (or libraries) selected in 
Current Library, sorted into alphanumeric order. To help in finding the items you need, the list can 
also be 'filtered' to show those with names that match a particular pattern.  

 

The buttons down the side of the 
Contents list provide the options needed 
to modify the library items. You can 
change the names of items, move or copy 
items to different libraries, or open items 
for editing. Most operations can be 
performed on one or more items. These 
buttons will be enabled or disabled 
depending on whether or not any of the 
items are selected.  

Filter Selection 

Use the selection filter to refine your current Contents selection. 

You can combine the Filter name and the number of pins (No Pins) to filter the contents to be exactly 
what is required. These two fields can also be used individually to obtain the filter. 

 

In the example above, the filter has been selected to be all items named c0* and with 2 pins. 
Wildcards can be used in the name selection. 

The Apply button is used to apply the filter selection once entered. 

The Preview section of the dialog optionally displays a picture showing the item currently selected in 
the list. Preview only works on a single selected item from the Contents list. 

The Technology File specified at the bottom of the dialog will be used when the New button is 
pressed. For each Symbol type, the relevant Technology Files will be available, each showing its own 
file extension. 
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Merging Libraries 

There are a couple of different ways to merge libraries; you can use the Copy facility and copy the 
contents of one library to another. Depending on how much of the library contents are selected this 
method is very much under your control. This method can, of course, be more error prone if you fail 
to select a library item. If all of a library is required, it may be easier to use the Import method. 

By selecting a library file from the Open dialog during Import, you can import the complete library 
contents into another existing library. 

Changing Symbol Types - To Symbol/To Doc Sym 

The To Symbol and To Doc Symbol options are used in Schematic Symbols and Schematic Doc 
Symbols only. They are used to create a Doc Symbol from a Schematic Symbol and vice versa. This 
is especially useful where libraries have been imported from other systems and you wish to move 
library items from one type of library to another. 

When you select this option, you are requested to choose the library for which to move the item to. 

 

Once the destination library has been chosen, press OK and the library item(s) selected will be moved 
to this library as Symbols or Doc Symbols (depending on which mode was selected. 

Creating Schematic Symbols 

Schematic symbols can be created using the symbol Editor or the Symbol Wizard. For this exercise, 
we will use the Symbol Editor. The Symbol Wizard would be used normally for most types of 
symbols. In practical terms, the basic symbols already exist, so the wizard becomes useful for the 
creation of more demanding symbols, like 244 pin microprocessors for example. 

By using an example, the following text will work through the creation of a common symbol and save 
it to the library. The example used will be a simple 2-input NAND gate, which will then be used to 
illustrate the Part creation mode later on.  
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Using the Symbol Editor 

Starting the Symbol editor 

The Schematic Symbol editor can be invoked from the within the Library Manager using the 
Schematic Symbol tab and the New button. You can also invoke it from outside the Library 
Manager using the New option from the File menu. 

 

From the Symbol editor you can add Pins, Shapes, Attributes and Text to create the symbols. You 
also have the tools to save and rename the symbol as well renumber and automatically renumber the 
sequence of pins. 

The symbol editor works in the same manner as the other editors within Pulsonix, except that there 
are some small variations to allow for the specifics of symbol creation. 

When creating a new symbol, you can add pins or the symbol shape to make a start, it doesn’t matter. 
For some symbols, it may be better to add the shape first then the terminals. 

For our example, we will add the shape first then the pins. 

To see the grid dots, we will need to zoom out a little to start with. 

���� Zoom out to view the grid dots 

1. Roll the mouse wheel to zoom in a little or click <Z> so you can see the grid dots displayed.. 

2. The grid is set to 25 thou by default (as defined in the Technology file). 

���� To add the shape detail 

1. When creating symbols, most of the commonly used commands are available on the Schematic 
Symbol toolbar shown on the left hand side of the design window. 
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2. From the Schematic Symbol toolbar click Insert Shape Rectangle. 

 

3. Hovering the mouse over the button will reveal the tooltip name. 

4. Choose a starting point on a grid dot within the design window.  

5. Click the left button to start and draw a rectangle to create a box 200x400 thou. Draw the box 
downwards. The status bar at the bottom of the design will confirm the size being drawn. 

 

���� To add an arc 

The sequence below shows how to add an arc to one of the shape segments: 

1. The shape must have straight lines with 90 degree corners (you cannot add arcs to non-orthogonal 
lines). 

2. Select the segment, and right click. 
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3. From the context menu, select Arc> and Angle 180. This will insert a semi-circle. If you wish the 
arc to have a smaller angle, choose one of the other options or use the Edit mode to create the 
exact size required. 

 

4. If Angle 180 is selected, the shape will look like this: 

 

���� To add the inverter circle 

1. The symbol requires a small ‘inverter’ circle shape for notation. 

2. From the Schematic Symbol toolbar, select Insert Shape Circle 

3. In free space, click and drag the circle to a radius of 25 thou. The radius will be displayed on the 
status bar. 
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4. Release the mouse to finish the circle. 

5. Click the <Esc> key to exit this mode. 

6. Select and drag the circle and position it at the front edge of the arc. 

 

���� To add line segments 

1. We need to add short single line segments to create terminal extensions. 

2. From the Schematic Symbol toolbar, select Insert Shape Line. 

3. You need to add three short lines to the symbol. 

4. On a start point 100 thou (4 grid dots) above the bottom left hand corner of the shape, drag a line 
100 thou long (4 grid dots) to create a horizontal ‘leg’. 

 

5. Double-click to finish. 

6. Add a second line 100 thou from the top left corner of the symbol shape. 

 

7. Now add the third leg to the right of the symbol. 

8. This will only be 50 thou long and will be added to one edge of the inverter circle. 

 

9. At this stage, there are still no electrical connection points. We will add these now. 
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Adding Pins 

In order to make true electrical connections in a Schematics you must have a pin to connect to. When 
adding Pins (or terminals as they can also be called), the default values for the initial Pin added are 
taken from the Design Settings dialog and the Defaults page. This value is used if no terminal is 
already selected in the design. 

The Pad and Name Styles are taken from the Technology data. The Pad style is used to define the 
shape of the terminal to be added and the Name style is used to define the name style of the pin 
number. 

���� To add a pin 

1. From the Schematic Symbol toolbar, select Insert Pin  

2. A pin will appear on the screen moving at the end of your cursor. If another pin was selected 
prior to entering the option, then the new pin's style and pin number position will be copied from 
it. 

3. The pin will be allocated the next free pin number not already used in the symbol. 

4. Position the first pin at the end of the line shape. 

  

5. Once positioned, another pin using the same style, but with the next pin number will appear for 
you to place next. 

6. Place all three pins. 

 

7. When all pins have been added, press the <Esc> key to exit the insert pin mode. The pin 
currently being moved will be deleted. 

After adding all the pins the pin numbers may be dragged into more convenient positions. Right 
clicking on the pin will enable various characteristics of the pin to be changed using the menu items 
available.  

If, when adding pins, you make a mistake or delete a pin you may then wish to change the pin number 
sequence. This can be done using Renumber Pins or the Auto Renumber Pins option from the 
Utilities menu. 
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���� To position the symbol origin 

1. You will notice that there is a green circle with a cross around it, this indicates the Symbol 
Origin.  

2. The Symbol Origin is automatically added when the first design item was added. It can be moved 
interactively at any time during the symbol’s creation. This will be the point used as reference 
when placing the symbol when used in the design.  

3. By convention in the Pulsonix library, this will always be pin 1.  

4. Select and drag the Symbol Origin, position it on pin 1. 

 

Adding Name Attributes 

The Component and Part Name attribute locators are used to position the Component and Part Names 
when the symbol is used in the design.  

The addition of the Component Name is different to that of other name attributes and both are 
detailed below. 

���� To add the Component Name attribute 

1. From the Insert menu, select Component Name. 

 

2. The Component Name attribute will be positioned on the end of your cursor ready for releasing 
on the symbol at the required position. 

3. By default, this position is normally at the bottom right hand side of the symbol. 
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���� To add the Part Name attribute 

1. We will also add a Part Name attribute to show the process of adding attributes to symbols. 

2. The Part Name does not have its own menu option but is instead added as a name attribute. This 
process would be the same if adding a Part Description or Symbol Name attribute etc. 

3. From the Insert menu, select Attribute Position. 

 

4. From the drop down list, select <Part Name> 

 

5. Click OK.  

6. Position the name that is now on the end of your cursor. 

7. By convention the Part Name attribute is placed under the Component Name attribute. 

 

8. Once positioned, click the <Esc> key to exit this mode. 

Saving the Symbol 

Following these processes, the symbol is in a basic state where it can be saved for use within a design 
as part of a Part definition. This also assumes that when Save To Library is used, all pin sequence 
errors are resolved, although if in error, these will be flagged and the save not completed. 

���� To save the symbol 

1. From the File menu or from the Schematic Symbol toolbar, select Save To Library. 
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2. From the Library list, select the library in which to save the symbol. 

3. In the Name box, type in the name of the symbol. 

 

Adding Other Attribute Detail 

Other attributes, such as the Logic Name may be required on the symbol. These names can be added 
using the Insert Attribute option available from the Insert menu. 

 

The Logic Name is attached a pin as a Pin attribute. This process is straightforward as if adding any 
other name attribute such as a Part Name (except that it is an attribute of a pin). 

The Attribute Value is defined as a Place Holder Only because there is no value to satisfy the 
attribute. This will be satisfied once the value has been added to the Part definition and then 
subsequently used in the design. 

Once the attribute has been added to the symbol you may wish to refine its characteristics. You can 
change the Text Alignment so that when the attribute is satisfied, the text has the correct bias relative 
to the pin. This would be the case for the Logic Name associated with Pin 3 of the 2NAND gate. 

To achieve this, select the <Logic Name> attribute and select Properties from the context menu. 
Change the Text Alignment from the default of bottom left, to bottom right to make it name right to 
left. The final result will look something like this: 

 

If you have followed this process, use Save To Library to save the symbol. 

Decoupling Capacitors 

There is no action for creating decoupling capacitors in the Symbol editor as they are ‘normal’ 
capacitor symbols but have special naming conventions when used in the design.  

For more detail on how to use and name decoupling capacitors, please refer to the Chapter on the 
Schematic Capture Editor and the Section on Decoupling Capacitors. 
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Library Creation Wizards 

Three Library creation wizards are available for the creation of Parts, Schematic Symbols and PCB 
Footprints. 

The wizards break down the process of creating a new Symbol or Part into a series of steps. Each step 
is presented in turn on a separate wizard page. You would complete each step then move onto the 
next one until you reach the Finish page. At any time as you progress, the preview window will show 
you what your final Symbol or Part will look like. 

The procedure for using this wizard is not fully documented here. Use of the wizards naturally guides 
you through the process with context sensitive help available for each page in the dialog. 

Once the Symbol or Part has been created you can save it to a Symbol/Part library, providing its 
Library Name and Name. By selecting the Edit the Symbol/Part now check box, you can directly 
load the new library item into the relevant item editor. For each of the Schematic Symbol and PCB 
Footprints, you can also create a new Part and save it to a named library using a name provided. As 
with the Symbols, you can elect to Edit the Part now using the Parts editor. 

Creating PCB Footprints 

Starting the Footprint editor 

The PCB Footprint editor is used for creating PCB Footprints. It can be invoked from the within 
the Library Manager dialog using the PCB Footprint tab and the New button. You can also invoke 
it from outside the Library Manager using the New option from the File menu.  

Using PCB Technology Files with the Footprint Editor 

If you use the New option from the File menu you can select the Technology File to use when 
creating the Footprint. Pressing OK will start a new Footprint creation session in the Footprint editor. 

If you use the New button from the Library Manager dialog, you are entered directly into the 
Footprint creation editor using the Technology File specified on the dialog. 

 

The drop down list enables you to select the Technology File to use. 

Setting up Technology data 

Technology Files within the Footprint editor have exactly the same use as when used in the PCB 
design editor and as such, should be the same for both. If you create your footprint using a new 
Technology File or you create or edit one while in the Footprint editor, you should save it for use in 
the PCB editor. 

The diagram below illustrates how each of the style tabs relates to items within the PCB footprint. 
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Technology Files for PCB have been discussed in the earlier Chapter on General Utilities under 
Technology Files and the Chapter on PCB Design Editor under Setting Up A Technology. 

Using the Footprint Editor 

From the Footprint editor you can Insert Pads, Mounting Holes, Copper, Shapes, Attributes and Text 
to create the footprint. You also have the tools to save and rename the Footprint as well as tools to 
renumber and automatically renumber the sequence of pads. 

The footprint editor works in the same manner as the other editors within Pulsonix, except that there 
are some small variations to allow for the specifics of footprint creation.  

By using an example, the following text will work through the creation of a common footprint and 
save it to the library. The example used will be a simple DIP14 footprint, which will then be used to 
illustrate the Part creation mode later on. 

Inserting Pads 

The first item to add in the creation of the footprint is the electrical connection point or pad. Pads in a 
PCB design are 3 dimensional. That is, they occupy a layer but also occupy a pad ‘stack’ through 
each layer of the design. These pad stacks are catered for inside the Technology itself using Pad 
styles.  
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The pads chosen for any footprint should be selected based on the final manufacturing requirement or 
your company standards. 

When using Insert Pad option, the default Pad size used will be taken from Design Settings dialog 
and the Defaults tab.  

While adding the pads, you can use the Change Styles option from the context menu to change the 
style of the current pad. 

 

���� To add pads 

1. From the Insert menu, select Pad.  

2. A pad will appear on the screen moving at the end of your cursor. If another pad was selected 
prior to entering the option, then the new pad's style and pad number position will be copied from 
it. 

3. The pad will be allocated the next free pad number not already used in the footprint. 

4. To change the grid step, or work with no grid, use the Change Grid option. It is better to use a 
grid that will represent the grid used in the design when placing footprints. The grid step should 
also be chosen which most closely provides you with the pad pitch (the distance between the 
pads). 

5. Move the pad to the correct position and click to release it. Another pad using the same style, but 
with the next pad number will appear for you to place next. 

6. When all pads have been added, press the <Esc> key to exit the Insert Pad mode. The pad 
currently being moved will be deleted. 

After adding all the pads the pad numbers may be dragged into more convenient positions. Right 
clicking on the pad will enable various characteristics of the pad to be changed using the menu items 
available. 

With the first pad added, the footprint will start off looking like this, notice that the pad has been 
placed on the grid point:  

 

The grid points can the visible Screen grid dots and the Working Grid which is what the Insert Pad 
option will default to. 

Once more pads have been added, the footprint will start to take shape: 
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The pad numbers can be moved around for clarity. 

Tip: Move the number on the first pad and then select the pad. With the pad selected, click Insert Pad. 

The next pad will now take on the properties of the selected pad, including the pad number position 

and style. 

Pad Reassignments 

Pad stacks that require a different pad style (size or shape) on different layers must be defined in the 
Technology under Pad Styles using the By Layers button. Because pads are created as a ‘stack’ with 
a single definition of all the layers you must make a different reassignment for any differences 
required. 

The Footprint Symbol Origin 

You will notice that Pad 1 has a circle with a cross around it, this indicates the Footprint origin. This 
origin is automatically added when pad 1 was added but can be moved interactively at any time 
during the footprint’s creation. This will be the point used as reference when placing the footprint on 
the design. By convention in the Pulsonix library, this will always be Pad 1 for through-hole devices 
or the footprint centre on surface mounted devices. The footprint origin is always added with the first 
item not just when pad 1 is added. 

The Footprint Origin default position is taken from the Design Settings dialog under Defaults. 

Renumbering Pads 

If, when adding pads, you make a mistake or delete a pad you may then wish to change the pad 
number sequence. This can be done using Renumber Pins or the Auto Renumber Pins option from 
the Utilities menu.  

If using the Renumber Pins option you choose the Start Pin Number. You can start at pad one or 
you can start at any point in the number sequence if renumbering from where there is a gap for 
example.  

 

Each time you select a pad, the current pad number in the sequence is assigned to that pad, and the 
sequence number is incremented. So, for example, if you began the renumber sequence a 3, the first 
pad you select will be numbered 3 and the sequence number incremented to 4 ready to select the next 
pad.  

It is possible to get into the situation where more than one pad has the same sequence number. This 
situation must be rectified before the footprint can be saved to a library. The program will not let you 
save the footprint with duplicate pad numbers. 
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You might want to consider using Auto Renumber Pins which provides an automatic way to ensure 
the pads are legally numbered, and can be numbered according to their physical location. This may be 
a better option if you have many pads to renumber. 

Mounting Holes 

Although for our example mounting holes are not used they are worth mentioning here.  

After adding pads to the footprint you may wish to add mounting holes. Mounting holes differ to 
normal pads in that they are not sequentially numbered (in fact they are not numbered at all). This 
means they don’t appear in the pad count when using the footprint during the creation of Parts in the 
Parts Editor. However, because they are pads, they can be connected to, for grounding purposes for 
example, but they don’t appear in any netlist. 

When adding mounting holes to footprints in the Footprint editor, they should be added last, after the 
normal pads. 

Mounting holes take their default styles from the Design Settings dialog and Mounting Holes. 

���� To add mounting holes 

1. From the Insert menu, select Mounting Hole.  

2. A pad will appear on the cursor. Position the pad and click to release it. 

3. As with normal pads, the mounting-hole pad style can be changed by using the Change Style 
option on the context menu. 

4. When the mounting holes have been positioned, press the <Esc> key. The pad currently on your 
cursor will be removed. 

Inserting Shapes 

Inserting shapes to a footprint uses the same process and editing options as if adding a shape to a 
design. You are able to add shapes for Copper, Shapes and Areas. All shape types in the Footprint 
editor are layer specific and will follow their default values as defined in the Options dialog under 
Defaults, (each of the pages for Area, Copper and Doc Shape are the same except that some of the 
options are only available where appropriate for some shape types). 

Using a right click of the mouse will select options that will assist you adding or editing the shape. 
The context menu will also allow you to make the choice of how the shape is presented, e.g. 
Open/Closed, Filled/Unfilled and Hatched/Cross Hatched etc. 

���� To insert a shape 

1. From the Insert menu click Shape type 

2. Choose from the three shapes available (Polygon, Rectangle or Circle) 

3. Draw the shape required. 

4. Change the Layer and Style if required using the options from the context menu. 

5. Double-click to finish the shape. 

For most footprints there may well be more than one shape and more than one type of shape used, 
these will require use of the different shape types. 
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In the example above, the inner shape is a Silkscreen outline placed on the Silkscreen Top layer. The 
outer shape is a placement outline that is placed on <Through Layers> so that it appears on all layers 
and is considered on all layers during placement. For SMT devices, you may well have the Placement 
outlines only defined for a given layer, e.g. Top Electrical. 

You may also wish to add an additional shape that appears only on Assembly layers for example. 

Placement shapes 

Placement outlines are drawn as areas and are specifically defined in the Area Properties as being 
Placement Clearance areas using a check box.  

 

There are three types of component areas: 

A Body area defines the ‘actual’ shape of the physical Component body and is used for example, to 
determine if a testpoint is under a Component.  

A Placement Clearance area defines additional space around a Component. For example, to allow 
for the full opening of placement machine jaws.  
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Clearance areas on different Components may overlap, provided that any Body areas are legal but 
Clearance areas and Body areas may not overlap. When using Component pushing, it is the 
Component Body area and Clearance area of the other Component that are used. Where Clearance 
areas are not used on Components, the Body area is used for the pushing boundary and Component to 
Component spacing. Where a Body area has not been defined for the Component, the component 
bounding box (calculated by Pulsonix) will be used. 

The Body Height value is used for Component Height checking in DRC and for when the 3D 
Viewer feature is used.  

If the area is used when a component has a STEP model assigned to it, the Model Placement will 
identify the area for alignment with the STEP model.  

Additional Component to Component spacing is applied between Body areas and not to Clearance 
areas. 

If placement outlines have not been defined, the Component bounding box will be used. 

A footprint can contain more than one area; you could for example, create an area for each area 
‘style’ (Placement Clearance, Body and Model Placement). These could also be different sizes for the 
same footprint and on different layers if required. You could have the Placement Clearance with 
plenty of space around the pins and the Body area representing the physical device body at a smaller 
size for example. 

Defining Pads as being Surface Mounted 

Where surface mounted pads are used, by default the layer these occupy will be defined as <Through 
Board>. For surface mount use where they do not have drill holes, these should be assigned to be 
layer specific, e.g. Top Side or Bottom Side.  

Generally, or unless specifically required, SMD pads are defined for the Top Layer, and because 
mirroring the Component in the design automatically swaps them to the other side. The Pulsonix 
library items defined as SMD will be placed, by default, on the <Top Side>. 

 

���� To change the pad side 

1. Add the first pad to the footprint. 

2. Assuming that all the pads are the same, you should select the first pad and right click. 

3. From the menu select Change Layer 
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4. From the dialog change <Through Board> to <Top Side> using the New Layer: drop down 
list, and click OK. 

5. The first pad will now be on the Top Side. 

6. You may also wish to change the style at this point using the Change Style option from the 
context menu. 

7. With the first pad selected, select Pad from the Insert menu. 

8. The style and layer of the first pad will be picked up for pad 2 and any subsequent pad. 

9. Insert and place the pads required and then press <Esc> when finished. 

Shapes that swap layers when mirrored 

Where shapes for layer specific outlines are used, for example a Top layer Silkscreen outline used on 
a surface mount device, when the Component is mirrored to place it on the opposite side of the board, 
you will normally also require that as well as the pads swapping sides, the outlines also change sides 
and are mirrored automatically. 

For this you will not need to do anything special to the outlines other than ensure that there is an 
‘opposite’ layer available when the Component is read into the design. So, for example, where a 
Silkscreen Top exists on the Top Side, a Silkscreen Bottom should exist on the Bottom Side. 

 

In this example above, U1 is shown on the Top Side and U2 on the Bottom Side but the Pads and 
Shapes only exist on the ‘outer’ sides having been initially created in the footprint editor on the <Top 
Side>. 

Adding keep-out areas 

As well as documentation shapes and electrical copper shapes, you may well wish to add areas that 
can be used to regulate other Pulsonix processes, processes such as the auto router where it is not 
allowed to route across the area defined. 

For these shapes you should use the Insert Area option, any further information is defined through 
the Properties of the area.  
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From this dialog you can select that Tracks, Vias and Testpoints are defined as being Unrestricted 
or Keep-Out from this footprint area. You cannot assign Keep-In restrictions to areas in the footprint, 
this only applies in the PCB design itself. 

When used in a design, a Design Rules Check can be used to verify that where restrictions apply, the 
rules are observed. This also applies to the On-line DRC option. 

Copper pour in the Footprint Editor 

Copper pour in footprints works slightly differently to that of the main PCB design option. You 
cannot insert Templates in the footprint but can ‘flood’ areas with copper. To create areas of copper 
which have cutouts ‘poured’ into them, you must have the On-line DRC option switched off 
otherwise it won’t let you add the Copper over any other electrical items. 

Adding the Component Name position 

The Component Name placeholder is an attribute that has an entry on the Insert menu for 
convenient use. Within the Footprint editor, the Component Name attribute is unsatisfied, this means 
that until the footprint is used a part of the Part definition in a PCB design, there is no value for the 
Component Name. The value would be the Component Name itself, e.g. U1, IC1, C2 etc. 

 

The Component Name placeholder can be placed anywhere on the footprint but it makes sense to put 
it somewhere representative of its final position. By default the Layer that the name occupies will be a 
Silkscreen layer.  

Note: The Component Name placeholder attribute can also be added to the footprint using the Insert 

Attribute Position option. 

���� To add the component name 

1. From the Insert menu, select Component Name. 

2. The Component Name placeholder will be dynamic at the end of your cursor ready for placing. 
Place it on the footprint and click to release. 

3. The Style and Layer can be changed during placement or by selecting it after and using a right 
click to display the context menu. 

Adding Attributes 

Multiple instances of the Component Name can be added. This may well be a requirement if you wish 
to have the Component Name on a copper electrical layer. 

This can be simply achieved by adding an additional Component Name attribute and changing its 
Layer. 

Likewise, other system or user defined attribute placeholders or names can be placed on the footprint. 
You can add the attribute placeholders as a locator for unsatisfied attributes, attributes which have 
values assigned when used in the PCB design. You can also add attributes with Values into the 
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footprint. These might be attributes which values are relevant to a specific footprint, the Manufacturer 
perhaps. 

���� To add attribute placeholders (position) 

1. From the Insert menu, select Attribute Position.  

 

2. Select one of the system attributes (shown in braces i.e. <Date>), or one of the user defined 
attribute names shown at the bottom of the drop down list. 

3. While dynamic on the end of your cursor, right click and select an option from the menu. You 
can change the Layer and Style from this menu. 

���� To add an attribute with values 

1. From the Insert menu, select Attribute 

 

2. From the drop down list select the item to Add Attribute To 

3. From the drop down list select the Attribute Name. If a user-defined name is required it must 
first exist in the Technology Attribute Names list. 

4. If a user defined attribute name has been selected, you will now be able to type an Attribute 
Value, if not, only <Placeholder> will be available for an unsatisfied system attribute. 
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5. Click OK to exit the dialog. 

6. Place the attribute value that now appears on the end of your cursor. Single Click to release the 
value. 

Associate pads to copper 

You can associate pads to copper (or other pads) in the Footprint editor so that DRC errors don’t 
occur. 

The pad and copper association is done in the Footprint editor using the Add To Net dialog on both 
the pad and the copper. 

���� To associate pads to copper 

1. Select the pad, this must be done first.  

2. Using the context menu option, Add To Net, the pad number will be displayed by default, this is 
the most logical choice for the name but is user defined, click OK to add it. 

 

3. Select the copper to be associated and right click. 

4. Again, select Add To Net from the menu. From the drop down list select the pad number or the 
relevant name to make the association. If using breakouts on any other pads these will also have 
net names or pad numbers so you must choose carefully. 

Plot/Print footprints 

For verification or documentation purposes, you can output the Footprint to a printing or plotting 
device using the CAM/Plot output option from the Output menu. This works in the same manner as 
the CAM/Plot option from within the PCB design editor. Please refer to the previous Chapter, 

Outputting For PCB Manufacturing for more details on using this option. 

Footprint Alternatives 

The Footprint Editor is only used to create individual footprints that are used by the Part definition. If 
you wish to have a Part with multiple or alternative footprints, you should add these in the Part 
definition within the Parts Editor. See later in this section Creating Parts. 

Breakouts in the Footprint 

The Footprint editor has the ability to create breakout patterns, with or without breakout vias. The 
method for creating breakouts is the same as if adding a track to the Footprint in the design.  

The advantage of creating the breakout with the Footprint is that it only has to be done once. 
Whenever the Footprint is used it then automatically has these properties. Each Footprint instance for 
a Component can have the breakouts switched on or off, and they can automatically be converted to 
tracks. 
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You have some specific design features for creating breakouts: Insert Breakout, and once the 
breakout has been added, End On Breakout Via. 

In the Technology file, breakouts use the Track Width and Via Pad Style but are in fact breakouts 
when added to the Footprint. 

The breakouts are created on the normal electrical layers but once the Footprint is added to the design 
these layers act as the ‘default’ layer for the track once converted. 

On the Options dialog there is an Edit Breakout tab, this is only available in the Footprint editor and 
is replaced with the equivalent dialog Edit Track in the PCB design editor. 

Default values for breakouts are taken from the Design Settings option, Defaults and Breakout. The 
default values define the Minimum and Nominal breakout widths and the default Via Style. 

Layer defaults for breakouts are taken from the Track defaults. 

���� To add breakouts to a Footprint 

1. Start to create a new Footprint or edit an existing Footprint from the library. 

2. Select the Insert menu and click on the Insert Breakout option, or select the Insert Breakout 
option from the PCB Footprint toolbar. 

3. Draw in the breakout as if add a new track. Use the options from the context menu to change the 
style and layer etc. 

4. Use the options on the context menu to finish the breakout. This can be with no via, with a via or 
with a Testpoint via. 

5. Save the Footprint to the library and include in a Part definition as normal.  

Once a Footprint contains a breakout it is saved in the normal way using Save to Library. If a 
breakout pattern needs to be changed, the Footprint can be edited and saved, then reloaded in the 
design. You cannot edit breakouts directly in the PCB design. 

Using Properties on a breakout in a Footprint there is a switch you can use to stop it from being 
automatically converted to a track (Automatically convert to Track (when pad is on a net)). The 
only way to convert a breakout that has this flag cleared to a track is to select it directly in a PCB 
design and use the context menu Convert Breakouts to Tracks option. Selecting the whole 
component or net and using the same option will not convert it to a track unless its flag is set. 
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With nothing selected, you must use the context menu option Convert Breakouts to Tracks. This is 
the only way to convert breakouts with the switch mentioned above set on.  

Creating Parts 

Parts are created using the Parts Editor or the Parts Wizard. The Parts Wizard is an automated and 
guided process to enable you to create Parts quickly. This is discussed later on in this section.  

What are Parts? 

Parts or Part definitions are used by both the Schematic and PCB design editors. This definition ties 
the designs together and provides a common name when transferring from one to another. The basic 
Part definition itself contains references to a Schematic Symbol and a PCB Footprint or multiple 
Footprints. The Part can also contain name mappings, Gate & Pin swapping information and 
attributes to build up a more comprehensive Part definition. 

Terminology of a Part Definition 

A Part definition contains various items that are used in the creation process. Below is a quick 
overview of the terminology used: 

Gate – One gate or a number of gates make up the internal definition of a Part. A gate references a 
symbol. A gate and symbol have a 1:1 correspondence. Multiple gates can reference the same symbol. 
Many Parts will be single gates where there will be one gate and the one symbol. 

Symbol – Name reference to the Schematic Symbol to be used in the Part definition. A graphical 
picture of the Symbol is also shown in the Part editor. 

Symbol Pin – This is pin sequence number that you will see when creating or editing the Schematic 
Symbol. 

Pin Name – This is the actual name which appears in the design on the pin/pad and which appears in 
the netlist. This name can also be alphanumeric, e.g. A43, B43, C43 etc. 

Logic Name – A descriptive functional name of the pin, e.g. CLK, RESET etc. 
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Pin Swap – This defines pin swapping information for use with the manual and automatic pin 
swapping options. 

Gate Swap – This defines gate swapping information for use with the manual and automatic pin 
swapping options. 

Net Name – Defines the name of the net to which this pin is connected in the design automatically 
when the Part is used. Usually used for power and ground pins. 

Pin Type – This defines the electrical function of the pin. 

Pin Network – A Pin Network defines one or more components which must be connected to the pin 
when the part is used in a design. 

Footprint Pin – This is pin sequence number that you will see when creating or editing the PCB 
Footprint.  

Part entity correlation 

There are two sets of data, that of the Schematic Symbol and the PCB Footprint. These are tied 
together using the Part definition. This definition pulls together the pins and numbers of the 
Schematic Symbol to the pads and numbers of the PCB Footprint. The Part definition allows you to 
map these pins/pad numbers and to rename or renumber them as well. The Pin Names used will tie 
both sets of pin data together from the Schematic Symbols and the PCB Footprints. 
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Using Part Technology Files 

Part technology files are used in much the same way as other technology files except that because 
Parts are really only definitions as such, they do not have the depth of use. These files contain pre-
defined Net Names and predefined Attribute Names. 

As with other technology files, using a Part technology files allows you to predefine Net and Attribute 
names which provides consistency across all new or edited Parts. This also enables a quick 
mechanism of adding these names to the current Part without having to type the name in, you can 
select the names form a drop down list. 

 

Creating Basic Parts 

From the Part editor, you can create Part definitions or editing existing definitions. This is done by 
selecting a Part library, and clicking the New button on the Contents page, or by selecting an existing 
Part to edit and clicking the Edit button. Once the Part editor has opened the functionality is the same. 

In our example below, we will use an old-school 7400 device from Ti (SN74x00D). The datasheet 
would show the Part pin assignments like this: 
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���� To create new Parts 

1. From the Parts tab of the Library Manager, click New (the button next to the Contents 
window). 

2. This will display the New Part dialog. 

 

3. This dialog will be blank initially and will require completing. 

4. Enter a Part Name, this is mandatory. 

5. Select the Part Type that you wish to create. 

6. If you understand how to create Parts, this will be all that it is required to get started.  

7. However if you need more help, select the Provide Part Details Now check box and fill in the 
detail. You could also use the Part Wizard to guide you through this process. 

 

8. The additional drop down part of this dialog is broken down into 4 separate areas: 

9. The Description, Part Family, Name Stem and Pin Count selection: 
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10. The PCB Footprint selection: 

 

11. The Schematic Symbol selection: 

 

12. The Power Pins selection. 

 

13. With all the additional sections, any of the information can be omitted until later on. You can edit 
the Part definition in the editor and provide the information as you require. 

14. By completing as much of this detail as possible, the program will create as much of the Part as it 
can. You will also note that on some of the entries, by putting in some of the detail required, 
Pulsonix will try and assist you by completing the rest based on the initial entry. 

15. Click the OK button to proceed. 

The Parts Editor 

The Parts editor allows you to create the Part definition using a series of tab driven dialogs.  
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Details Page 

The Details page is used to define the high level definition of the Part. This displays information 
previously entered when creating the Part from new or by editing an existing Part. You can edit and 
change information here if you wish but it will have an effect on the other pages. 

The Spice Type entry is for mapping the name of your Part to a Spice device type if the Part is to be 
used for Spice simulation through the Pulsonix Spice product. For more information about using the 
Spice Type field, please refer to the reference manual supplied with Pulsonix Spice.  

Footprints and alternative Footprints 

The footprint order can be changed so that the item displayed in the drop down list is also the default 
item to be selected when using Insert Component in the PCB design editor or when translating from 
Schematics to PCB. 

You also use this entry to define alternative footprints for this Part definition. You may have a Part 
definition which uses multiple footprints which are selected based on your manufacturing 
technologies. For example, you may have alternatives for through-hole technology, or surface mount, 
or SMT but vapour phase or reflow soldered. These can all be accommodated. 

���� To change or add a Footprint 

1. To change the Footprint displayed in the Footprints drop down list box, click on the small box 
containing the 3 dots next to it. This will display the Footprints dialog: 
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2. The Footprints on the right hand side of the dialog are the ones which are available for the Part 
definition. They all match the number of pins for the Part and are read from the PCB Footprint 
libraries under your Libraries search path. 

3. To add a Footprint to the Part definition, you must select it in the left hand list first and click the 
Add>> button. This will promote it to the right hand window. 

4. Likewise, to remove a Footprint from the list, select it and click the <<Remove button. You can 
also double-click the item to Add and Remove it from the current list. 

5. The order is important, the top most Footprint in the In Parts: list on the top right hand of the 
dialog is the one used as the default when using Insert Component. To change the default 
Footprint use the Up and Down buttons to move the one required to the top of the list. 
This order is also used when viewing a Component in the Properties dialog in your design. 
Each of the Footprints defined in this list will appear as available for this Part definition in the 
design. 

Parts and Attributes Page 

The Parts and Attributes page is used to define Part groups and to add individual Part based attributes. 
Part Attributes are always available on components in the Schematic and PCB designs. Alternatively, 
you should use the Part Attribute editor from the Library Manager Parts dialog. 

 

���� To add or edit Part attributes 

1. To add or edit Part Attributes, select the Part row or cell.  

2. If the attribute field already exists, with data to change or because it exists in another Part name, 
click on the field and right click. The following context menu is displayed: 
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3. From the menu, select Insert Attribute if you wish to add a new attribute, or Edit Attribute if 
you wish to edit an existing one. All the options on this menu are available from the main menu 
under Edit and Insert. 

 

4. Click OK to accept the new attribute value. 

Part Attribute Editor 

Within the Parts library there is a facility for editing Attributes using the attribute editor. This is 
available using the Attributes button on the Parts dialog.  

By clicking the Attributes button you can select all of the library items in the list or the current 
selection (from the Contents list). The All Library Items In List radio button will select everything 
in the contents list, be it the whole library (<All Libraries>), or just a selected library. Care should be 
taken when <All Libraries> is being used as this may take some time to load into the Attribute Editor. 

 

Clicking OK will display the Attribute Editor with the Parts Libraries loaded. For Parts you can edit 
attributes for both Parts and Pins. 

Pins Page 

The Pins page is used to reference and map PCB Footprint Pins to the Pin Names displayed in both 
the Schematic Symbols and PCB Footprints in the relevant design editors. 

The Footprint Pin name is the actual pad sequence number assigned when the Footprint was created. 
This list will not include mounting holes added to the Footprint using Insert Mounting Hole. When 
defined for a Part, this would normally be a 1:1 mapping with the Pin Name but can be different if 
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required. For example, if using alpha-numeric pin names A43, B43 etc. or if creating a Part, such as a 
Relay, where the pad numbers are specifically renumbered to obtain the correct sequence.  

 

The Pin Type field can be used to define the pin type for each pin. This field is used by the Electrical 
Rules Checker (ERC) in the Schematic editor.  

The page can also contain Pin Attributes. These can be added by right mouse clicking on any cell on 
this page. Use the Insert Attribute option from the menu. To display Pin Attributes in the design you 
must add an attribute name placeholder on the Symbol or Footprint. 

 

Predefined Net Names 

Net Names are the signal pins used for pre-defined net names such as VCC and GND as used on 
power pins. These are used mainly for assigning ‘implied’ signals to components used in the 
Schematic design editor. This means you can create a Part which has Net Names pre-assigned, and 
when used in the Schematic or PCB designs, the net with the same name are automatically connected 
together even though they don’t physically show on the design (in PCB they do show as connections 
if more than one component is added). This is particularly useful for de-cluttering the design of 
multiple power and ground connections. 

���� To edit Pin fields 

1. To edit any of the pin fields to add or change the values, double-click on the cell and type the 
value in. 

2. You can click the right mouse button to reveal the context menu.  

Gates Page 

The Gates page is used to add Schematic Symbols to the Part definition and to define the Pin Name 
order or mapping between the Schematic symbol and the PCB footprint pad numbers. It is using this 
column that you can also define pins as alphanumeric. 
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You also use this page to add Logic Names and Gate & Pin swapping information to the Part 
definition. 

When you first enter this page when creating a new Part definition, the page will be empty, ready for 
you to add the gates. You would have already defined the number of pads that the Part has by entering 
a PCB Footprint name. You must now add the corresponding number of gates to the Part for use in 
the Schematic design. 

The empty Gates page will start off looking like this: 

 

���� To add Gates 

1. Gates can be added by selecting any one of the cell names, e.g. Gate or Symbol etc. and right 
mouse clicking. From the context menu, select Insert Gate. This option can also be selected 
from the main menu under Insert or from the Part toolbar. 

2. You are presented with the following dialog: 
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3. From this you can add Schematic Symbols that already exist in the library. The (Schematic 
Symbol) Library list enables you to search the library selected or all the libraries available. 

4. Select a Symbol to use form the list. The list can be searched using the Search By Pin Count at 
the bottom of the dialog. You type in the number of pins on the gate and click Apply to make the 
refinement. Only Symbols with a matching number of pins will be displayed in the list. 

5. You can also choose the number of Gates to Add. If you know there are a number of the same 
gates to add, use this feature. 

6. In the Add box, type the number of gates required. 

7. Click the Add button to add the gates to the Part definition. 

8. If more than one Symbol type is required, select the next gate and click Add. Do this until you 
have defined the number of gates required. Once finished, click the Close button. If you make a 
mistake alone the way, click Cancel and remove the unwanted gate from the definition and 
continue. Use the Delete option from the context menu to do this or use Undo. 
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9. In its most basic form, the Gates page can now be used with the Part definition. 

���� To change or swap Gates 

1. Gates can be changed once added. They can be swapped for a different gate Symbol or moved in 
the Gate order list. 

2. Select any one of the cells on the Gate you wish to change or move. 

3. Right click and from the menu select Change Gate Order or Change Symbol. 

 

4. Change Symbol will display the Insert Gates dialog as before. Selecting the Change Gate 
Order option will display a dialog: 

 

5. From this dialog you can select any gate and move its order using the Up and Down buttons. 
When you are satisfied with the new order, click OK. 

Adding Alternative Symbols 

Like PCB footprints, you can add alternative Schematic Gates to the Part as well to represent different 
symbols, for example, box or ‘Z’ shaped resistors or DeMorgan equivalents. 

���� To add symbol alternatives 

1. Using the Gates page, right click and select Change Symbol from the context menu. 

 

2. Alternatively, in the Symbol cell, select in the cell and off the drop down menu, select Change 
Symbol. 
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3. From the dialog, select the alternative symbol required from the In Library: list. 

4. Click the Add>> button to promote it to the In Gate: list. 

 

5. Click the OK button. 

6. When the Symbol list is now dropped down, it will reveal the alternative symbol selected. 

 

7. Save the Part as normal using the File menu and Save To Library. 

8. When using this Part in a Schematic design, use the Next Symbol option from the context menu 
to swap to the alternative symbol. 

9. The Properties dialog and Gates page will also allow you to change the gate to the alternative 
using the Symbol drop down list. 

���� To add Logic Names and Gate & Pin swapping information 

1. You can add Logic Names and Gate & Pin swapping information to this page by editing the 
relevant cell.  

2. Double-click on the cell to edit it. 
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Note: Logic Names, if used, will require the Logic Name attribute placeholder to be added to the 

Symbol Pin if you wish to display this name when the Component (the Part instance) is used in the 

design. 

Adding Gate & Pin swapping information 

The Gate & Pin swapping information is used by both the manual and automatic Gate & Pin 
swapping options within Pulsonix.  

The general rules are: Pins within the same gate with the same Swap Group are considered to be 
swappable, as are gates with the same Swap Group. A pin or gate with Swap Group set to zero is not 
swappable. 

The Swapping rules 

The following rules restrict the swapping of Component gates: 

• A gate can only be swapped if all pins have no routes attached.  

• The two gates must be on components of the same Part.  

• The two gates must be in the same swap group in the Part data.  

The following rules restrict the swapping of a Component pin: 

• A pin can only be swapped if it does not have any routes attached.  

The following rules apply when using the normal swap mode: 

• The two pins must be on the same Component.  

• The two pins must be on the same gate within the Part data.  

• The two pins must be in the same swap group in the Part data.  

Numbers used for swapping 

When defining Gate and Pin swapping information, the following applies: 

• A ‘0’ (zero) means that the pin or gate is not swappable with items of that same group or gate (the 
numbers used for pins and gates are different). A blank entry also has the same effect. 

• A ‘1’ means that the pins or gates in that group are swappable with anything of the same number. 

• A ‘2’ means that the pins or gates in that group are swappable with anything of the same number. 
The same would apply for any number used which matches another number of the same swap 
group. 

In the example Gates page shown below, the input pins have been set to pin swap group 1 to allow 
swapping between them in each gate. Also, the gates have been set to gate swap group 1 to allow each 
gate to be swapped both internally within a component and externally between different components 
using this part. 
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The diagram below shows how these swap groups would apply to the actual pins on the symbols. 

 

Pin Names 

The Pin Names can be changed in the Pin Names column to map the sequence of pin names 
used on the schematic to that of the actual PCB footprint. These names can also be 
alphanumeric as you would require for BGA devices for example (although the naming is 
carried out on the Pins page not the Gates page). 
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���� To Change the Pin Names order 

1. To use a different number to the default sequence, you must select the cell which is to be 
different. You may do this on the Gates page of the Parts Editor. 

2. Selecting it once will reveal the small ‘down’ arrow to the right side of the cell. 

3. Selecting the arrow will display the drop down list of all the pin names for that gate. 

4. Select the pin name required. 

 

5. The cell will update with the new name.  

���� To make the Pin Names alphanumeric 

1. If you wish to make Pin Names alphanumeric, you must do this on the Pins page of the Parts 
Editor.  

2. Select the cell which is to be the first name in the sequence. For example A1 or B1 if the 
sequence is to be A1, A2, A3 etc. or B1, B2, B3 etc. 

3. type the name required, i.e. A1 

4. Select the range of cells on which the Pin Names are to be renamed. 

5. Right click and from the context menu, select the Apply Increment to Selected Cells option. 

 

6. The selected cells will now be numbered sequentially based on the name of the first cell. 
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Mapping Multiple PCB Pads to same Schematic pin 

You can map one Schematic pin to many PCB pins using the Part Editor.  

This feature allows you to model certain types of Component that have 'internal' connections within 
the Component itself, or those that have multiple pins that need to be assigned to the same net. This is 
an alternative method to connecting pads together in the footprint by adding to the same net or using 
wires. The advantage of this method is that it means the footprint definition can remain neutral and 
generic, where the Part definition is made specific to a device. 

These mappings are made in the Part Editor. You will need to edit the Part that requires this 
mapping. On the Gates page, right click on the appropriate Pin Name cell and then select Map 
Multiple Pcb Pins from the context menu. This will turn the cell into an edit box instead of a drop 
down list to enable you to enter a list of PCB pin numbers. Type the Pin Numbers required into the 
list. 

 

When edited, the Pin Name cell may look something like this for example: 
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Pin Name format 

The list can be separated in two ways depending on how you want them to behave in the PCB: 

• Use of a comma , 

• Use of a plus + sign 

• Separated with commas (to assign all the PCB pads to the same net, with connections in the PCB 
that should to be routed). When this Component is used in the PCB design, all the pads are shown 
connected with visible connections and should be routed to ensure completion: 

 

• Separated with plus signs (to assign them to the same net, but indicating the pins are connected 
internally within the component and do not all need to be routed). When used in the PCB design, 
routing close to an ‘associated’ pin will optimise to that net indicating a legal routing target. 

  

Associated Parts 

Where Parts are defined in the Parts libraries, you may also include additional Parts that although are 
added to the manufactured PCB, do not appear on the Schematic or PCB design as electrical items. 
For example, a transistor which when built must have a heatsink, a thermal washer, a nut and bolt and 
a plastic washer. The design may also contain Associated Parts which must be ordered as part of the 
Bill of Materials but which aren’t electrical items, for example mounting columns and plastic 
insulation washers and nuts.  

These Parts are called Associated Parts and can be of Schematic or PCB or both usages. All 
Associated Parts can then be extracted using the Report Maker facility. 

Where Associated Parts are ‘Footprint’ specific, for example in the case of some transistors where 
there may be up to four different mountings, and hence four different associated Part variants, these 
Associated Parts can be defined with the Footprint itself. This uses exactly the same mechanism as 
the Design level Associated Parts using the Design Properties dialog. 

Associated Parts 

From within the Parts Editor dialog you can associate Parts using the Associate Parts dialog. This will 
provide you with a list of all the additional Parts which will be called whenever the main Part is used 
in the design. 

By right clicking in this dialog you are presented with the Add Associated Parts option on: 

Design shows possible reconnect paths 

Design shows all connections 
associated with these pins 
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You can use the Add Associated Part dialog by either typing in the Part Name into the Part entry 
box or by selecting from the list presented in the Choose box. The Choose box will list all Parts in the 
Parts library that have been defined with no pins. If the Part has pins then you must type in its name to 
use it. 

The Quantity of each associated Part can also be defined so more than one Part can be used for each 
main Part. 

The associate Parts for a Part definition might then look like this: 

 

The Part is then saved. 

Each time this Part is used in the design it will also include an instance(s) of all the associated Parts. 
The full list of Associated Parts for the design can be viewed at any time by using the Design 
Properties option from the Edit menu. 

Design Level Associated Parts 

Quantities can be changed on a design basis using the Design Properties dialog. This dialog displays 
a list of all the Part based Parts Associated, and design based Associated Parts which have been added 
to the design. 
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In the above example, all items except the Bolt 4mm Part have been added as Part based Associated 
Parts. The Bolt 4mm has been added through this dialog as a board (or design) Associated Part.  

The Associated Parts list shows the name of the Part, the minimum number of instances (which are 
associated with components in the design), and the total number that includes any additional instances 
that have been defined through this dialog. You cannot have less than the minimum number.  

The Add button allows you to add an associated part to the design. This displays the Edit Associated 
Part dialog.  

To edit an existing Associated Part, select the appropriate row in the grid and press Edit. This 
displays the Edit Associated Part dialog, with the data from the current row pre-selected. You can 
also change the quantity directly in the grid.  

Use the Delete button to delete the selected row. You can only delete Associated Parts that have a 
minimum quantity of 0. 

Creating Unusual Parts 

All Parts are created using the New Part dialog connectors use the special Connector check box as 
discussed previously. There are some Parts that need a mention because they use a slightly unusual 
configuration. 

Creating Relay Parts 

Relays typically require a limited number of pads but then for the numbers to be to artificially 
sequenced as though the additional pads exist.  

As the picture below shows, a 4 pin relay would have 4 pads placed, and sequenced  
1 – 4 as expected. 

 

However, the relay fits into a socket that has 14 pins, so the pin numbers displayed need to show a 
new sequence. This is achieved using the Pins page and by editing the Pin Numbers to show the 
required pin sequence. This is shown below and includes the new pin numbers on the displayed 
Footprint and Symbol. 
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Documentation Symbols 

Documentation Symbols are created in much the same way as Schematic Symbols and PCB 
Footprints using their own respective Symbol editors.  

Doc Symbols differ from normal symbols in that they do not appear in any Parts list, and in the case 
of Schematic Symbols, are not translated to the PCB design. 

Creation of specific Documentation Symbols has been covered previously in the Schematic and PCB 
design editors. 

Pulsonix Database Connection (PDC) 

Pulsonix supports an advanced ODBC connection structure to external databases through the optional 
PDC product. This product is fully described in the Pulsonix Database Connection Users Guide 
available as a PDF file and installed with Pulsonix., it is available under the Help menu and Online 
Manuals> and also in the Online help. 

Pulsonix Vault 

As well as the standard library mechanism, Pulsonix also has a Vault system. This provides you with 
a controlled system for saving libraries (as well as designs and technology files). Any editing, saving 
etc. is booked through the Vault so that a full audit is available as to when and who made changes. 
The physical changes are also recorded. This option is fully described in the Vault Users Guide 
available as a PDF file and installed with Pulsonix, it is available under the Help menu and Online 
Manuals> and also in the Online help. 
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.plx format files, 424 
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3DConnexion spaceMouse, 43 

4 

45 angled routing mode, 266 
45 fillet routing mode, 266 
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Absolute coordinates, 19, 87 
Active PDF files, 201 
Adjust text to readable orientation, 60 
Adjust to readable orientation, 70 
Admin tools 

vault, 114 
Advanced format scripts, 407 
Allowed drill sizes, 367 
Alphanumeric pins, 459, 466 
Apply via, 301 
Arc mode, 289 
Areas, 285, 295, 444 

area height, 296 
board cutout, 299 
body, 296, 444 
keep in/out, 446 
keep in/out checks, 324 
placement, 444 
placement clearance, 444 

Asscoiated parts, 468 
Assembly variants, 332 
Attached callouts, 318 
Attached dimensions, 314 
Attributes 

attribute editor, 41 
component name, 103 
design, 106 
drag & drop, 53 
dynamic, 108 
editing, 109 
footprint attributes, 107 
names, 102 
overview, 102 
part attributes, 106 
part editor, 458 
PCB, 321 
position, 103 
printing, 110 

properties, 106 
schematics, 189 
spice type, 456 
user defined, 103 
validation, 110 
values, 102 
variants, 339 

Auto Dim, 283 
Auto generate plots, 354 
Auto select mode, 48 
Autorouter, 13 
Autorouting, 351 
Avoid same net, 220, 304 

B 

Backup copies, 79 
Backups, 76 
Barred text, 71 
Bilateral dimensions, 316 
Bill of material (BOM), 399 
Block ports, 151, 153, 177 
Block symbol, 151, 154 
Blocks, 153, 168 
Board 

cutout areas, 298 
outline, 233 
plotting outline, 370 
profiles, 233 

Body area, 444 
Body height, 296, 445 
Branch point, 151, 154 
Break silkscreen, 369, 372, 384 
Break silkscreen text, 369, 372, 384 
Breakouts, 281 

creating, 449 
hide, 281 
plotting, 283 
show, 281 
using, 281 

Bus 
bus pins, 170 
bus reference, 151, 155, 163 
closed, 162 
insert, 163 
names in PCB, 167 
nets, 163 
open, 162 
overview, 161 
terminals, 162 
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C 

Calibrate actual screen width, 44 
Callouts, 317 
CAM Plot, 354 

auto generate, 354 
CAM plots dialog, 357 
check plots, 393 
combining plots, 390 
exclude items, 364 
folder, 76 
overview, 355 
plot groups, 360 
plot preview, 356 
plot settings, 365 
schematics, 195 
slotted pads, 210 
step and repeat, 358 
variants, 342 

Can have associated layers, 346 
Case sensitive pin names, 70 
Change grid, 85 
Check plots, 393 
Checking validation strings, 110 
Checks 

design rules checking, 245 
Netlist (synchronise designs), 326 

Class to class rules, 218 
Colour files bar, 41 
Colours, 97 

dimensions, 315 
load colours, 98 
schematics, 120 
selection flags, 49 

Combining schematic pages/designs, 185 
Combining SCM and PCB PDF plots, 203 
Complete as track, 271 
Component bin, 25 

PCB, 240 
schematics, 122 
using, 26 

Components 
areas, 444 
body, 296 
component to component spacing, 218 
creating, 451 
definition, 423 
embedded, 346 
grid, 85 
lock/unlock, 253 
name position, 447 
next in sequence, 126 
positioning PCB, 237 
positioning schematics, 126 
pushing, 251 

replacing, 238 
spans, 346 
using, 123 
variant editor, 345 
variants, 339 

Composite layer spans, 348 
Composite micro-vias, 348 
Composite plots, 380 
Configuring parts browser, 28 
Connections 

adding danglers, 135 
bus, 138 
changing grid, 139 
changing style schematics, 133 
inserting, 132 
PCB, 255 
power & ground symbols, 160 
schematic, 131 
schematics options, 132 
splitting nets PCB, 259 
splitting schematics, 140 
styles, 211 

Connectors 
using in PCB, 128 
using in schematics, 128 

Context menus, 49 
Convert breakouts to tracks, 281 
Coordinates 

absolute, 19, 87 
display, 18 
relative, 19, 87 
system origin, 86 

Copper, 299 
Copper healing, 308 
Copper pour rules, 302 
Copy, 62 
Copying shapes, 293 
Corners 

45 degree, 72 
curved, 72 

Create PCB Group from SCM block, 65 
Creating 

board outlines, 230 
doc symbols, 471 
parts, 451 
PCB footprints, 439 
schematic symbols, 430 

Cross hatch, 214 
Cross probing designs, 329 
Cross sheet signal references, 158, 160 
Ctrl-delete, 66 
Current grid, 84 
Customising Pulsonix, 20 
Cut, 62 
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Cut block, 179 
Cutouts, 284, 297 
Cyclic backups, 79 
Cyclic picking, 48 

D 

Dark mode, 20 
Dashed line styles, 288 
Database connection, 471 

variants, 341 
Decoupling capacitors, 127 
Defaults 

PCB, 208 
schematic, 117 

Define pad shape, 212 
Defining track sizes in Schematics, 144 
Delete, 65 

extended, 66 
pages, 184 
remove from net, 66 
tracks, 66 
unextended, 66 
unrouting tracks, 66 

Design area size, 86 
Design backups, 76 
Design browser, 29, 184 

hierarchy, 169 
Design origin, 86, 235 
Design properties, 86, 470 

variants, 340 
Design rules 

checking, 245, 322 
setup, 217 

Design security copies, 76 
DFM/DFT rules, 220 
Differential pair chains, 92 
Differential pairs, 91 
Dimensions, 311, 313 

attached, 314 
bilateral, 316 
colours, 315 
tolerances, 315 
unattached, 315 
unilateral, 316 

Disconnect end track, 277 
Doc shape variants, 341 
Doc symbols, 152, 471 

libraries, 423 
schematics, 151 
types, 151 

Dockable windows, 25 
Documentation symbols, 155 
Dongle, 14 
Dotted line style, 288 

Drag & drop attributes, 53 
Drawing profiles, 100 
DRC, 245, 322 

error markers, 324 
errors browser, 30, 325 
in footprint editor, 325 
report, 324 

Drill drawings, 385 
layer, 389 

Drill ids, 367 
Drill sizes, 387 
Drill symbols, 367, 387 
Drill table, 387 
Drilling micro-vias, 351 
Duplicate, 62 
DXF export, 396 
DXF import PCB/schematics, 416 
Dynamic copper pour, 308 
Dynamic optimise, 250 
Dynamic properties, 37 

E 

ECO back to the Schematic, 327 
Edit segment, 291 
Editing tracks, 263 
Electrical rules checking, 147, 459 
ERC, 146, 459 

errors browser, 30, 150 
Essential for manufacture, 225 
Excellon, 384 
Export DXF, 396 
Export IDF, 396 
Export STEP, 396 
Exporting netlists, 191 
Exporting separate SCM PDF files, 203 
Exporting Spice netlists, 192 
Exporting SVG format, 396 
Exporting ZIP format, 397 

F 

Facing side, 346 
Fanout patterns, 281 
Fiducial markers, 393 
Files, 78 
Fillets, 72 
Find, 33 

filter, 35 
Finish markers, 269 
Fit design, 86 
Flip, 57 
Flip dynamic, 273 
Folders, 75 

libraries, 425 
search order, 77 

Fonts, 67 
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Footprint areas, 296 
Footprint attributes, 107 
Footprint editor, 440 
Footprint libraries, 423 
Footprint variants, 338 
Force vector, 250 
Format scripts, 401 
Frame in, 44 
Frame select, 46 
Free angle adjoining segs, 251 
Free angled routing mode, 265 
Full back annotation, 327 

G 

Gate 
name, 123 
parts gates page, 459 
separator character, 123 

Gate & pin swapping, 260, 464 
Generate reports, 399 
Gerber 

import, 416 
intelligent import, 416 
plots, 370 

Global Nets, 143 
Grid, 82 

component, 85 
component PCB, 253 
crosses, 85 
displayed, 85 
dots, 85 
lines, 85 
no grid, 85 
setting up, 84 
snapping, 84 
steps, 84 
testpoint, 85 
track, 85, 275 
via, 85 
working, 85 
Xcrosses, 85 

Groups, 64 
Growing shapes, 63, 293 

H 

Hardware requirements, 13 
HASP key, 14 
Hatch style 

naming, 214 
style, 214 

Hide breakouts, 281 
Hierarchy, 168 

block pin types, 176 
block shapes, 181 
blocks, 168 

bus pins, 170 
cut block, 179 
folders, 173 
instances, 171 
overview, 168 
pin types, 177 
pop, 169 
push, 169 
top down design, 173 
updating block instances, 184 

Hot fixes, 15 

I 

IDF export, 396 
Impedance rules, 226 
Implied junctions on pins, 139 
Importing 

CAE netlists, 414 
designs, 413 
DXF files, 231, 416 
ECOs, 327 
gerber files, 416 
IDF, 417 
overview, 413 
spacing rules using csv file, 219 
STEP files, 231, 417 

Insert 
area, 295 
attribute, 104 
attribute position, 105, 448 
block ports, 174 
board, 230 
bus, 163 
component from vault, 114 
component name, 447 
component PCB, 235 
component schematics, 123 
connection PCB, 256 
connection schematics, 132 
connector pins, 128 
copper, 299, 300 
cross page links, 157 
cutout, 298 
dimensions, 313 
mounting holes, 233 
mounting holes, 443 
pad, 441 
page, 184 
pin, 435 
profile PCB, 234 
shape, 287 
shapes schematics, 188 
Teardrops, 310 
template, 305 
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terminal, 435 
testpoint schematics, 187 
text, 67 
via, 301, 349 

Inspector bar, 37 
Installation, 14 
Intelligent gerber import, 416 
Interaction overview, 55 
Interactive high speed design, 351 
Interface, 18 
IPC naming set, 215 
IPC-2581 Export, 353 
IPC-2581 layer stackup, 226 
IPC-356 Export, 353 
Isolate from plane, 378 
Isolated pads, 307 
Isolation gap, 222 

J 

JTAG File Export, 353 

K 

Keep in/out areas, 446 
Keep in/out checks, 324 
Keyboard commands, 23 
Keys Report, 24 

L 

Latch mode, 49 
Layer class, 368 
Layer class variants, 336 
Layer spans, 347 

composite, 349 
Layers, 222 

browser, 31 
drill drawing, 389 
layer classes, 224 
materials, 225 
spans, 346 

Library 
.plx format files, 424 
additional library content, 424 
conventions used, 424 
default supplied, 423 
library management 
overview, 422 
manager, 427 
master library, 423 
user library, 423 

Light interface mode, 20 
Line select, 47 
Line styles, 211, 288 

PCB, 292 
schematics, 119 

Load profile, 100 

Load technology, 98 
Local nets, 143 
Lock, 61 

components, 253 
locking errors, 325 
tracks, 62, 276 
vias, 62 

Logic names, 463 

M 

Managing PCB nets, 257 
Manual routing, 263 
Manufacturing 

checks, 324 
outputs, 353 

Match net class level rules, 218 
Materials, 225 
Measure tool, 319 
Menu options, 17 
Merge shapes, 297 
Message window, 18 
Micro-vias, 346 

drilling, 351 
facing side, 346 
normal, 347 

Minimum island size, 303 
Mirror, 57 

components, 58 
shape, 58 
shapes, 290 
tracks, 58 

Mitres, 72 
default size, 73 
orthogonal, 73 

Model placement, 296 
area, 445 

Mounting holes, 152, 155, 232, 443 
Mouse 

buttons, 43 
dragging, 45 
operation, 43 

Move to bin, 241 
Moving items, 55 
Multiple instances, 172 
Multiple PCB pad mapping, 467 

N 

Name 
component, 124 
logic, 459 
nets, 143, 257 
pad, 459 
part, 124 

Naming 
basic set, 215 
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IPC set, 215 
styles, 215 

NC drill output, 384 
Negative plots, 363 
Net classes, 91 
Net labels, 152, 156 
Net styles, 92, 145 

composite vias, 349 
micro-vias, 349 

Nets, 91 
checks, 324 
global, 143 
local, 143 
names, 211 
naming/renaming, 143 
net styles, 91 
net type, 92 
optimising PCB, 260 
rename, 143 

Network licensing, 15 
New 

PCB design, 205 
PCB footprint, 439 
schematic design, 115 

No Grid, 85 

O 

ODB++ output, 395 
On grid checks, 324 
On-line DRC, 273 

display clearances, 274 
Electrical rules checks (ERC), 146 
options, 245 

Only plot items, 363 
Optimal 

position, 250 
rotation, 250 

Optimise 
connections, 250 
nets, 260 

Options 
defaults PCB, 208 
design PCB, 208 
track defaults PCB, 270 

Origins 
absolute, 87 
relative, 87 
system, 86 

Orthogonal routing 
curved, 266 
fillet, 265 
mitre, 265 
orthogonal mode, 265 

Outputting netlists 

from schematics, 191 
Outputting separate SCM PDF files, 203 

P 

Pad style naming settings, 216 
Pads 

defaults, 441 
layers, 445 
mounting holes, 443 
name, 459 
numbers, 441 
pad style naming rules, 209 
reassignments, 442 
renumbering, 442 
slotted, 210 
styles, 209 

Page border 
schematics, 121 

Page links, 152, 156 
Pan, 43, 44 
Part attribute editor, 458 
Part attributes, 106, 457 
Part variants, 332, 338 
Parts 

asscoiated, 468 
browser, 27 
creation, 451 
libraries, 423 
reloading, 130 

Paste, 62 
Pasting in schematics, 185 
PCB footprint libraries, 423 
PDC, 471 

variants, 341 
PDF format output, 201, 354 
Perform operation on locked items, 61 
Photo plots, 353 
Pin 

alphanumeric pins, 459 
part editor page, 459 
pin name order, 466 
pin type rules, 148 
swapping, 260 
type rules, 149 
types, 148, 459 

Pin networks, 128 
Placement 

area, 296, 444 
clearance, 296 
clearance area, 444 

Placing components 
PCB, 248 
place around board, 244 

Plotting 
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board outline, 370 
combining plots, 390 
composite plots, 380 
creating plots, 368 
drill drawings, 385 
electrical layers, 370 
full power planes, 374 
multiple plots, 391 
NC drill files, 384 
negative plots, 363 
only plot items, 363 
outputs, 353 
overview, 354 
PDF format, 354 
plot groups, 360 
plot isolation, 363 
plot transformations, 391 
positioning plots, 391 
positive plots, 363 
schematics, 195 
settings, 365 
silkscreen layers, 372 
solder paste masks, 373 
solder resist masks, 373 
step and repeat, 358 
step offset, 359 
to file, 354 
variants, 342 
wizard, 360 

Polygon select, 46 
Pouring copper, 302 
Power and ground symbols, 159 
Power planes, 374 

composite plots, 380 
connection, 307 
split, 381 

Preview bar, 25 
Printing 

active PDF files, 201 
PCB, 331 
schematics, 194 

Profile files, 100 
loading, 100 
PCB, 233 
saving, 101 
schematic, 121 

Prompt window, 18 
Properties 

attributes, 53 
component PCB, 254 
design, 86 
dynamic inspector bar, 37 
multi-item, 52 

Pull tight routing mode, 266 

Pulsonix Database Connection (PDC), 471 
Pulsonix vault, 111, 471 
Pushing 

components, 251 
direction, 252 
push mode, 251 

R 

Reading gerber files, 416 
Redo, 55 
Relative coordinates, 19, 87 
Relays, 470 
Reload from library 

parts, 130 
PCB, 238 

Remove isolated islands, 303 
Remove redundant breakout tracks, 282 
Rename 

nets, 143 
pages, 184 

Replacing 
components, 130 
parts, 130 

Report affected templates, 308 
Report maker, 400 

variables, 410 
Reports, 399 

folder, 77 
Resizing shapes, 294 
Resolve net names 

schematics, 185 
Restore backups, 81 
Restore points, 76, 79 
Restricted movement routing mode, 267 
Reverse editing direction, 277 
Reverse engineer option, 193 
Revision control, 471 
Right mouse menus, 49 
Rotate, 58 

adjust to readable orientation, 60 
bus items, 59 
CAM Plots, 61 
grouped items, 60 
one step, 59 
units, 59 

Routing 
modes, 263 
options, 265 
restricted movement, 267 

Rules, 120 
technology, 93 

S 

Save, 78 
Save restore point, 80 
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Saving libraries, 79 
Schematic 

documentation symbols, 155 
mounting holes, 155 
symbol editor, 430 
symbol libraries, 423 

Screen grid, 85 
Security copies, 76, 79 
Segment modes 

schematics, 136 
Select 

all, 46 
all visible, 46 
Ctrl select, 45 
cyclic picking, 48 
double-clicking, 47 
frame, 46 
from list, 48 
line select, 47 
mode, 44 
next, 48 
polygon, 46 
previous, 48 
selection methods, 44 
Shift select, 45 

Selection flags, 48 
Selection mask, 36 
Setting undo levels, 55 
Setting up grids, 84 
Setting up layer spans, 226 
Setup, 14 
Shape information bar, 40, 232 
Shapes 

areas, 295 
closed, 286 
copying, 293 
cutouts, 297 
filled/unfilled, 286 
growing, 293 
hatched, 286 
merging, 297 
open, 286 
selecting, 289 
styles, 285, 290 
types, 285 
using, 284 

Shift-delete, 66 
Shortcuts 

keys report, 24 
shortcut keys, 23 

Show breakouts, 281 
Show design rule clearance, 247 
Shrinking shapes, 293 
Signal paths, 91, 151 

Signal reference, 152 
Signal References, 159 
Silkscreen layers, 372 
Slotted pads, 210 
Snap cursor to grid, 85 
Snapping to grid, 84 
Solder resist masks, 373 
SpaceMouse, 43 
Spacing rules 

checks, 323 
setup, 217 

Spice 
exporting spice netlists, 192 
spice type attribute, 456 

Split power planes, 381 
Spokes, 222 
Spring back, 253 
Standard reports, 399 
Star point, 152, 161 
Status bar, 18 
STEP 

model library, 423 
Step and repeat plots, 358 
STEP export, 396 
Straight line shapes, 290 
Stub routes, 277 

how to insert, 278 
Styles 

naming, 215 
net styles, 92 
overview, 90 

Sub nets, 91, 151 
Surface mounted pads, 445 
SVG export, 396 
Swap 

gates, 260 
pins, 261 

Synchronising designs, 326 

T 

Teardrops, 220, 309 
inserting, 310 
removing, 310 

Technology files, 88 
essential for manufacture, 225 
hatch styles PCB, 214 
import spacing rules using csv file, 219 
layers, 222 
loading, 98 
materials, 225 
PCB, 208 
rules, 93 
saving, 89 
schematic, 118 
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spacing rules, 217 
teardrops, 310 

Templates, 302 
act poured, 306 
pour on add, 306 
split power planes, 383 

Testpoints, 152, 161 
checks, 324 
grid, 85 
schematics, 187 

Text, 67 
’NOT’ function, 71 
barred text, 71 
force to upper case, 69 
variants, 339 
vertical alignment, 69 

Text callouts, 317 
variants, 340 

Thermal spokes, 222 
Toggle cursor grid command, 85 
Toggle layers bar, 40 
Toolbars, 21 

customising, 22 
docking, 21 
floating, 21 

Top down design (hierarchy), 173 
Track 

changing layers, 271 
changing net names, 272 
editing, 263 
grid, 85 
styles, 271 
unrouting, 284 

Track & Via Size Limit, 144 
Translate to PCB, 189, 229 
Truetype fonts, 67 

U 

Unattach dimensions, 315 
Undo, 55 
Unilateral dimensions, 316 
Uninstall, 16 
Units, 82 
Unlock, 61 

components, 253 
Unroute track, 284 

path, 277 
Update PCB, 326 
Use no grid, 85 
User defined grid, 85 
User defined origin, 86 
User defined pads, 209, 212 
User libraries, 427 
Using composite layer spans, 349 

Using shapes, 284 
Using the vault, 471 

V 

Variables for report maker, 410 
Variants 

assembly variants, 332 
attributes, 338, 339 
cam plot, 342 
components, 339 
database connection, 341 
design properties, 340 
doc shapes, 341 
fitted, 337 
footprints, 338 
layer class, 336 
not-fitted, 337 
part variants, 332 
parts, 338 
plotting, 342 
spreadsheet, 345 
text, 339 
text callouts, 340 

Vault, 111, 471 
admin tools, 114 
insert component, 114 

Verifying power planes, 376 
Vertical text alignment, 69 
Vias 

allow automatic changes switch, 280 
changing spans, 279 
grid, 85 
micro-vias, 346 

View 
actual size, 44 
all, 44 
board, 44 
power plane, 376 
selection, 44 

W 

Web updates, 15 
Wildcard 

examples, 95 
wizard, 95 

Working grid, 82, 85 
World view, 29 

Z 

ZIP export, 397 
Zoom extents, 44 
Zoom in, 43, 44 
Zoom out, 43, 44 
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